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Important Information

SOME TIBCO SOFTWARE EMBEDS OR BUNDLES OTHER TIBCO SOFTWARE. USE OF SUCH
EMBEDDED OR BUNDLED TIBCO SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY
(OR PROVIDE LIMITED ADD-ON FUNCTIONALITY) OF THE LICENSED TIBCO SOFTWARE. THE
EMBEDDED OR BUNDLED SOFTWARE IS NOT LICENSED TO BE USED OR ACCESSED BY ANY
OTHER TIBCO SOFTWARE OR FOR ANY OTHER PURPOSE.

USE OF TIBCO SOFTWARE AND THIS DOCUMENT IS SUBJECT TO THE TERMS AND
CONDITIONS OF A LICENSE AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED
SOFTWARE LICENSE AGREEMENT, OR, IF THERE IS NO SUCH SEPARATE AGREEMENT, THE
CLICKWRAP END USER LICENSE AGREEMENT WHICH IS DISPLAYED DURING DOWNLOAD
OR INSTALLATION OF THE SOFTWARE (AND WHICH IS DUPLICATED IN THE LICENSE FILE)
OR IF THERE IS NO SUCH SOFTWARE LICENSE AGREEMENT OR CLICKWRAP END USER
LICENSE AGREEMENT, THE LICENSE(S) LOCATED IN THE “LICENSE” FILE(S) OF THE
SOFTWARE. USE OF THIS DOCUMENT IS SUBJECT TO THOSE TERMS AND CONDITIONS, AND
YOUR USE HEREOF SHALL CONSTITUTE ACCEPTANCE OF AND AN AGREEMENT TO BE
BOUND BY THE SAME.

This document contains confidential information that is subject to U.S. and international copyright laws
and treaties. No part of this document may be reproduced in any form without the written
authorization of TIBCO Software Inc.

TIBCO, The Power of Now, TIBCO ActiveMatrix, TIBCO ActiveMatrix BusinessWorks, TIBCO
Administrator, TIBCO ActiveSpaces, TIBCO BusinessEvents, TIBCO Designer, TIBCO Enterprise
Message Service, TIBCO Hawk, TIBCO Runtime Agent, TIBCO Rendezvous, and Two-Second
Advantage are either registered trademarks or trademarks of TIBCO Software Inc. in the United States
and/or other countries.

Enterprise Java Beans (EJB), Java Platform Enterprise Edition (Java EE), Java 2 Platform Enterprise
Edition (J2EE), and all Java-based trademarks and logos are trademarks or registered trademarks of
Oracle Corporation in the U.S. and other countries.

All other product and company names and marks mentioned in this document are the property of their
respective owners and are mentioned for identification purposes only.

THIS SOFTWARE MAY BE AVAILABLE ON MULTIPLE OPERATING SYSTEMS. HOWEVER, NOT
ALL OPERATING SYSTEM PLATFORMS FOR A SPECIFIC SOFTWARE VERSION ARE RELEASED
AT THE SAME TIME. SEE THE README FILE FOR THE AVAILABILITY OF THIS SOFTWARE
VERSION ON A SPECIFIC OPERATING SYSTEM PLATFORM.

THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL
ERRORS. CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE
CHANGES WILL BE INCORPORATED IN NEW EDITIONS OF THIS DOCUMENT. TIBCO
SOFTWARE INC. MAY MAKE IMPROVEMENTS AND/OR CHANGES IN THE PRODUCT(S)
AND/OR THE PROGRAM(S) DESCRIBED IN THIS DOCUMENT AT ANY TIME.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE,
INCLUDING BUT NOT LIMITED TO ANY RELEASE NOTES AND "READ ME" FILES.

This product is covered by U.S. Patent No. 7,472,101.

Copyright © 2004-2015 TIBCO Software Inc. ALL RIGHTS RESERVED.

TIBCO Software Inc. Confidential Information
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TIBCO Documentation and Support Services

All TIBCO documentation is available on the TIBCO Documentation site, which can be found here:

https://docs.tibco.com

Product-Specific Documentation

Documentation for TIBCO products is not bundled with the software. Instead, it is available on the
TIBCO Documentation site. To directly access documentation for this product, double-click the
following file:

TIBCO_HOME/release_notes/TIB_businessevents-standard_version_docinfo.html where
TIBCO_HOME is the top-level directory in which TIBCO products are installed. On Windows, the
default TIBCO_HOME is C:\tibco. On UNIX systems, the default TIBCO_HOME is /opt/tibco.

The following documents for this product can be found in the TIBCO Documentation site:

● TIBCO BusinessEvents Installation
● TIBCO BusinessEvents Getting Started
● TIBCO BusinessEvents Architect's Guide
● TIBCO BusinessEvents Developer's Guide
● TIBCO BusinessEvents Configuration Guide
● TIBCO BusinessEvents WebStudio User's Guide
● TIBCO BusinessEvents Administration
● Online References:

— TIBCO BusinessEvents Java API Reference
— TIBCO BusinessEvents Functions Reference

● TIBCO BusinessEvents Release Notes

How to Contact TIBCO Support

For comments or problems with this manual or the software it addresses, contact TIBCO Support as
follows:

● For an overview of TIBCO Support, and information about getting started with TIBCO Support,
visit this site:

http://www.tibco.com/services/support

● If you already have a valid maintenance or support contract, visit this site:

https://support.tibco.com

Entry to this site requires a user name and password. If you do not have a user name, you can
request one.

How to Join TIBCOmmunity

TIBCOmmunity is an online destination for TIBCO customers, partners, and resident experts. It is a
place to share and access the collective experience of the TIBCO community. TIBCOmmunity offers
forums, blogs, and access to a variety of resources. To register, go to:

https://www.tibcommunity.com
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Project Development

You can build a TIBCO BusinessEvents project using core project resources such as channels, events,
concepts, rules, and so on.

TIBCO BusinessEvents Studio® is an Eclipse-based UI used to design, build, and maintain TIBCO
BusinessEvents projects. It is integrated into the standard Eclipse menus where appropriate, and works
with many established Eclipse UI methodologies and plug-ins.

TIBCO BusinessEvents WebStudio is an online component that allows business users to create and
manage business rules in a web browser. In it the user defines an executable rule (business rule) based
on the rule template and on the rule template view defined by the developer in TIBCO BusinessEvents
Studio.

TIBCO BusinessEvents WebStudio is explained in the document TIBCO BusinessEvents® WebStudio
User’s Guide.

A TIBCO BusinessEvents Studio project contains resources used to build, test, and view a design-time
TIBCO BusinessEvents project.

Before you begin to use TIBCO BusinessEvents Developer’s Guide, gain a basic familiarity with the
product by completing the tutorials in TIBCO BusinessEvents Getting Started.

TIBCO BusinessEvents Developer’s Guide provides practical details on using TIBCO BusinessEvents
Studio to build a project and TIBCO BusinessEvents Configuration Guide provides information on how to
configure the project's cluster deployment descriptor.

For in-depth explanations about designing a TIBCO BusinessEvents project and other topics, read
TIBCO BusinessEvents Architect’s Guide. References to relevant topics in that guide are provided in
TIBCO BusinessEvents Developer’s Guide.

When it is time to configure your application for deployment, deploy, and manage it, refer to TIBCO
BusinessEvents Administration.

Creating a Project
This section explains the basic procedure for creating a new project.

See TIBCO BusinessEvents Getting Started for tutorials on building and populating a basic TIBCO
BusinessEvents project.

To import a TIBCO BusinessEvents Studio project into your workspace, select File > Import > General
> Existing projects into Workspace. Do this for current release projects only.

To import a project from a prior release, see TIBCO BusinessEvents Installation.

Procedure

1. Start TIBCO BusinessEvents Studio. In Windows, click Start > All Programs > TIBCO
BusinessEvents Studio .

2. If prompted, select or create the Eclipse workspace directory where your project files will be stored.

If you check the option to use this workspace as a default, you are not prompted again.

3. In the TIBCO BusinessEvents Studio UI, select File > New > Project > TIBCO BusinessEvents >
Studio Project and click Next.

4. In the New Studio Project field, enter a project name.

Names follow Java variable naming restrictions. Do not use any reserved words.
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5. Accept the default location or clear the Use default location check box and specify the desired
location.

6. Click Finish.

Result

A new folder tree appears in BusinessEvents Studio Explorer with a default set of folders you can use
as desired. The defaultVars folder, however, is required.

Source Control
 If the project is under source control using Perforce, editing a resource automatically checks out the
resource and makes it writable.

If the file is not under Perforce but is read-only, you are prompted to make the file writable when a
change is made.

Importing Projects in TIBCO BusinessEvents Studio
You can import projects from earlier versions or same version using TIBCO BusinessEvents Studio.
A command line utility to do the same actions is also provided. After importing using the command
line utility an additional procedure is required before you can work with the project in TIBCO
BusinessEvents Studio.

Procedure

1. Select File > Import .
The Import wizard is displayed.

2. In the Import wizard, select TIBCO BusinessEvents > Existing TIBCO BusinessEvents Studio
Project and click Next.
The Existing TIBCO BusinessEvents Studio Project Import Wizard is displayed.

3. In the Existing project root directory field, click Browse and select the project root directory of the
project you are importing.

4. Select the XPath version to be used for the project in the XPath Version dropdown.

5. Do one of the following:

● Select the Copy project into workspace checkbox. This option copies the project into your
current workspace.

● Clear the Copy project into workspace checkbox and specify an import location.

6. Do one of the following:

● If your project has no HTTP channels, click Finish (this is the only option).
● If your project has one or more HTTP channels, click Next.

7. If you clicked Next then in the Select Processing Unit window select the project CDD in the Cluster
Deployment Descriptor dropdown.

8. Select the processing unit in the Processing Unit dropdown that contains the HTTP properties to be
migrated.
An informational panel displays the settings that will be migrated.

9. Click Finish.
The imported project is displayed in the TIBCO BusinessEvents Studio.
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Finding a Project Element
You can find a project element in various ways, and then take some action relating to that element, such
as opening its editor or creating a dependency diagram. Depending on the size and complexity of the
project, some methods of finding elements might be more convenient than others.

An element can be a part of a resource (such as a concept property):

● Expand the project tree in BusinessEvents Studio Explorer and double-click the element name.
● Select Navigate > Open Studio Element and select an element from the alphabetical list of elements.

You can search using wild cards.
● Select the Resource perspective, then select Navigate > Open Resource (or press Ctrl+Shift+R). A

dialog allowing you to search through all resources in your workspace appears. To display the
whole list, enter double asterisks (**). You can also use the asterisk (*) as a wild card. For example,
to display all concept resources, enter *.concept.

● Open the Project View diagram and navigate to the element in the diagram. You can search using
filters. Double click the element on the diagram to open it.

Exporting (Generating) Concept and Event Schema (XSD) Files
Using the Generate Schema utility, you can export concepts and events to XML Schema Definition
(XSD) files, one per entity, in a specified location. You can generate schema for all concepts, all events,
or both. You cannot generate schema for one selected entity type. The files use the same folder structure
as the project from which they are exported. In addition, _BaseConcept.xsd and _BaseEvent.xsd are
generated in the root of the selected directory.

XML schemas are used for interoperability between TIBCO BusinessEvents and third party tools or
SOA platforms that use well-defined XML for message communication, transformation, and validation.

In the XSD files, concepts are represented as follows:

● Each concept is exported to its own complex type using its own namespace.
● Referenced concepts have a corresponding ref attribute in the parent's complex type.
● Contained concepts have a corresponding type attribute in the parent's complex type.

Generating an XML Schema (XSD File)

Procedure

1. Select the project whose schema you want to generate.

2. From the File menu select Export. In the Export wizard, expand TIBCO BusinessEvents and select
Generate Schema.

You can also reach this utility from the option (right-click) menu anywhere in BusinessEvents
Studio Explorer.

3. In the Schemas Folder field, browse to and select the folder where you want to put the schema files.

4. Select the Override TIBCO BusinessEvents Namespace checkbox to specify a different namespace.

If you do not select a different namespace, an informational message displays. Click Yes to continue
or No to return to the dialog and provide a namespace.

Provide a different namespace to avoid conflicts with the source concepts and events. If you do not
provide a namespace, the default TIBCO BusinessEvents namespace is used. (TIBCO
BusinessEvents events and concepts have a hidden schema.) If the source entities and generated

20

TIBCO BusinessEvents® Developer's Guide



schema files are in the same folders, use of the default TIBCO BusinessEvents namespace results in
a namespace conflict. In this case, you must provide a namespace.

5. In the Select Resources panel, select Concepts or Events or both. Schemas for all concepts or all
events in the project (or both) are generated accordingly.

6. Click Finish.

Result

The XSD files for the selected resources (all concepts, all events, or both) are generated in subdirectories
of the selected directory. Subdirectory names match the project folders. The _BaseConcept.xsd and
_BaseEvent.xsd files are generated in the root of the selected directory.

Validating a Project or Project Resource
When you save a resource, TIBCO BusinessEvents performs validation checks to ensure that all
resource requirements are met. For example, it checks that required fields are completed, names are
valid, syntax in rules is correct and no unknown functions are called.

You can also perform validation explicitly for an entire project or selected project resource.

XML schemas are validated to see if they actually define conflicting elements before marking them with
warnings and ignoring the conflict. If the system property schema.conflictingNS.ignore is true in
the studio.ini file, conflicts in schema elements are not checked, and a warning is not added.

Procedure

1. In BusinessEvents Studio Explorer, do one of the following:
a) Right click a project name, folder name, or a project resource name, and select Validate Project.
b) Select a project name, folder name, or a project resource name, and select Project > Validate

Project .

2. A pop-up window displays the message “Validation was successful” or it displays summary
information about any problems. Details about problems are displayed in the Problems view.

3. Many validation issues can be fixed using the Quick Fix feature. In the Problems view, right click on
a problem and select Quick Fix.

See also Using the Quick Fix Feature in the Rule Editor for a related use of this feature.

4. In addition to validating for internal consistency, you can run a project analyzer feature. It helps
you to understand your project better, and find ways to improve it.

For example, it identifies rule functions that are not used in any rule, and rules that will never be
triggered at run time. See Project Analyzer and Selected Entity Project Diagrams.

Working with External Library and Custom Function Paths
When you work with external libraries or custom functions in your project at design time, and when
you run, test, or debug such projects in TIBCO BusinessEvents Studio, ensure that the engine can find
all libraries (including dependencies on third-party libraries) and custom functions, if the project
requires any.

For example, if a project uses Rendezvous channels, Java allows the user to set a property,
java.library.path, to ensure that the environment path contains a reference to the directory
containing Rendezvous DLLs (or on UNIX the SO files).

Similarly, TIBCO BusinessEvents captures the native library path along with the build path information
to pass to engines running inside TIBCO BusinessEvents Studio. You can enter this information as
described below, or you can enter it when you are configuring a run configuration or a debug
configuration.
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Test Connection Feature
 To make the Test Connection feature work for JMS Connection and JDBC Shared Connection shared
resources, see Enabling the Test Connection Feature .

Adding an External Library or Custom Function Path
This functionality is also available in the Debug Configurations > ClassPath, and the Run
Configurations > ClassPath tab, for your convenience.

Procedure

1. Open the project in TIBCO BusinessEvents Studio.

2. In BusinessEvents Studio Explorer, right-click the project and click Properties (or press Alt-Enter).
You see the properties dialog for the project.

3. In the left panel, select Build Path and then select one of the following:

● The Custom Functions tab, to add custom functions paths
● The Java Libraries tab, to add third-party libraries paths

4. Click Add Library and browse the JAR file.

5. If a library or custom function depends on additional third-party Java archives, follow these steps:
a) Expand the library or custom function entry and double-click the Native library location entry.
b) At the Native Library Folder Configuration dialog, select External Folder or Workspace as

appropriate, and browse to and select the folder containing the native libraries.
c) Click OK to dismiss this dialog.

6. Click OK. One of the following occurs:

● If a custom function depends on third-party Java archives and you did not complete step 5, a
dialog is displayed when you click OK. It lists the name of the class or classes that could not be
loaded. To resolve the problem, complete step 5.

● You see the message: "It is recommended that you rebuild your project after changing the build
path. Would you like to rebuild now?" Click Yes to validate and fix any references already in
code to the JARs you have added.

7. Save the resource.

Result

Deploytime Action Required
 To make custom functions or external libraries available at runtime, complete the following steps on
all machines where TIBCO BusinessEvents is installed:
● Either copy the JAR or JARs to the lib/ext/tpcl directory, or other directory in the class path; or

update the class path in the TRA file to point to the location of the JAR or JARs.

● If a JAR has dependencies on native libraries, edit BE_HOME/bin/be-engine.tra and as needed,
update PATH LD_LIBRARY_PATH, SHLIB_PATH, and LIBPATH as needed, depending on the
operating system.

See TIBCO BusinessEvents Administration for more details.

To Remove an External Library or Custom Functions JAR Path, follow the instructions in Add an
External Library or Custom Function Path, but instead of clicking Add Library, select the JAR file you
want to remove and click Remove Library. The entry for any native libraries it depends on is also
removed.
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Working with Project Libraries
This section explains how to work with project libraries in TIBCO BusinessEvents Studio. You can also
work with project libraries at the command line.

Project libraries (design-time libraries) are archives that enable you to create project resources once, and
share them with other projects.

Project libraries can contain any resources from a TIBCO BusinessEvents Studio project. For example, a
project library might contain some concepts that are standard across projects (such as Person), so that
multiple projects do not need to redefine these concepts.

Project libraries can include, or, as desired, can consist only of the global variables.

Project libraries have the file extension .projlib. TIBCO BusinessEvents Studio includes the following
features to allow the refactoring of project resources into project libraries.

Avoid Conflicting Elements
 Ensure that the project library does not use elements already in use in the local project. If elements in
an imported project library conflict with the local project elements, those in the local project have
priority. The project library element is ignored in this case for build purposes and is not included in
the EAR file.

If multiple project libraries have the same element, then the first one on the build path wins, and the
other ones are ignored.

Creating (Exporting) a Project Library
To create a project library, export selected resources to an archive.

Procedure

1. Optionally, select a project or any of its resources in TIBCO BusinessEvents Studio.

2. Do one of the following:

● From the File menu select Export.
● Right-click anywhere in BusinessEvents Studio Explorer and select Export.

In the Select dialog, select TIBCO BusinessEvents > Project Library and click Next. You see
the Export Studio Project Library dialog.

3. In the Export Studio Project Library dialog, select the resources you want to export. If you selected
resources in BusinessEvents Studio Explorer they are selected automatically.
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The left panel displays folders. The right panel displays resources. Select what to export in any of
the following ways:

● Select a folder to select all resources within it.
● Highlight a folder to display its resources in the right panel. Select individual resources as

desired.
● To reduce the set of selected resources, first select resources then click the Filter Types button.

Select one or more resource types, then click OK. The Export Studio Project Library dialog
selection is now reduced to only resources of the selected type or types.

4. Enter an output location and give the project library a name, then click Finish.

To avoid validation issues, include the library you just exported.

Adding (and Removing) Project Libraries in a Project
Adding a project library does not physically import the files. Instead a pointer to the files is maintained
in the project and the resources appear in BusinessEvents Studio Explorer as if they are in the project.
The physical location can be in the project folders or external to them, as long as they are available to
the project at design time.

You can add a project library to a project in either of these two ways:

● By including a project library
● By importing a project library

After you add the project library, it appears at the root of the project tree as a Project Dependencies
node.
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Including a Project Library (Adding it to the Build Path)

Procedure

1. Open the project in TIBCO BusinessEvents Studio.

2. In BusinessEvents Studio Explorer, right-click the project name and click Properties (or press Alt-
Enter, or select ProjectProperties). You see the properties dialog for the project.

3. In the left panel, select Build Path and then select the Project Libraries tab.

4. Click Add Library and browse to and select the desired project library (.projlib) file.

5. Click OK. You are prompted to rebuild the project.

6. Save the resource. The project library appears at the root of the project tree as a Project
Dependencies node.

Importing a Project Library

Procedure

1. Do one of the following:

● From the File menu select Import.
● Right-click anywhere in BusinessEvents Studio Explorer and select Import.

2. In the Import wizard Select dialog, select TIBCO BusinessEvents > Project Library and click Next.
You see the Import Project Library dialog.

3. Select File field, browse to and select the project library (.projlib) file.

4. Select a project from the project tree or type the name in the field above the project tree area. You
can only import at the root of a project.
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Ignore the New File Name field. It is not used by TIBCO BusinessEvents.

5. Click Finish. The project library appears at the root of the project tree as a Project Dependencies
node.

Removing a Project Library

Procedure

1. Open the project in TIBCO BusinessEvents Studio.

2. In BusinessEvents Studio Explorer, right-click the project name and click Properties (or press Alt-
Enter, or select ProjectProperties). You see the properties dialog for the project.

3. In the left panel, select Build Path and then select the Project Libraries tab.

4. Browse to and select the desired project library (.projlib) file.

5. Click Remove Library.

Changing XPath Version of The Project
If you want to change the default XPath version of the new project to XPath 1.0 or if you want to change
the XPath version of older project to XPath 2.0, you can do that in Studio.

Procedure

1. In BusinessEvents Studio select the project for which you want to change the XPath version.

2. Right click the project and select Properties, or click File > Properties.
The property window for the project is displayed.

3. Select Build Path and select the appropriate XPath version in the XPath Version field.

4. Click OK
Alternatively, you can edit the .beproject file and update the value of the xpathVersion
property to 1.0 or 2.0.
The project now uses the XSLT mapper based on the new XPath version.

What to do next

After the change in the compatible XPath version, check the XSLT mappings for the validation errors
due to new XPath version. Use the autofix option in the Check and Repair dialog to correct the
typecasting and function errors. See Mapping and Transforming Data for more details.

Working with Global Variables
Global variables provide an easy way to set defaults for use throughout your project. When the project
is deployed, all occurrences of the global variable name are replaced with the provided global variable
value or a deploy-time override.

For example, you could assign the value 7474 to the global variable RvDaemon. You can then use the
variable in a Rendezvous Transport resource. At deploy time you can override the default value as
needed.
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● The datatype of the global variable must match the datatype accepted in the field where you use it.
If the global variable is of a different type, runtime errors result.

● An exception to the above allows flexibility in numeric fields: global variables used in numeric
fields can be of any type, as long as the substituted value of the field is numeric.

● A project folder called defaultVars is available but not exposed in BusinessEvents Studio Explorer,
so that you can share the global variables using source control software. It is not used for other
purposes.

Setting and Overriding Global Variables from a Project Library

You can export global variables to a project library and import the library into other projects (see 
Working with Project Libraries).

When multiple global variables have the same name, one overrides the rest and is used in the project.
The name, datatype, and default value of the overriding global variable are used. The override order is
as follows:

● When multiple project libraries have the same-named global variable, the global variable from the
library closest to the top of the project library list overrides any in lower libraries.

● When a local project global variable has the same name as a project library global variable, the local
project global variable overrides the project library global variable.

The Global Variables view presents a merged list. A blue upward pointing arrow in the row for a global
variable ( ) indicates that this global variable overrides another global variable. The source of the
global variable is shown in the Project Source column to the right of the arrow.

To see all global variables, including overridden ones, open the global variable editor and expand
Project Dependencies and project libraries. Global variables from project libraries are not editable.

Adding and Managing Global Variables
In a new TIBCO BusinessEvents Studio project no global variables are predefined. When you import a
project from an earlier version of TIBCO BusinessEvents, however, you see predefined global variables
as well as any others defined in the project.

You may also see global variables in project libraries. All global variables are visible in the editor
including overridden ones. To see the merged list of global variables that are used in the project, open
the Global Variables view in one of the following ways:

● Click the Global Variables View button from the toolbar.
●

● From the top menus, select Window > Show View > Other > TIBCO BusinessEvents > Global
Variables .
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Add and Manage Global Variables

Procedure

1. Open the project in TIBCO BusinessEvents Studio.

2. Open the global variables editor in one of the following ways:

● From the toolbar, click the Global Variables Editor button.
● From the top menus, select Project > Edit Global Variables .

You see the global variables editor listing the variables available, if any.

3. Do any of the following. (See Global Variable Reference for a guide to the fields):

● To add a variable, click Add Variable and complete the fields.
● To edit a variable, select the variable and update the fields.
● To add a variable group, click Add Group.
● To add a variable to a group, first select a group, then click Add Variable.
● To remove a variable or a group, highlight it and click Remove.
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Using Groups
 Groups are used for organizing variables. Variable groups are especially useful if
multiple developers share a project using a version control system. When
referencing a variable that is in a group, use the complete path, for example %
%mygroup/mysubgroup/myvariable%%. (Because the complete path is used, the
name of a variable in a group can be the same as the name of a variable in a
different group.)

You must add at least one variable to a group, or the group will not be saved. If you
delete all global variables in a global variable group, the group itself is also
automatically deleted.

4. Save the resource. Groups and references to the defaultVars.substvar file appear in the
defaultVars project folder.

Using Global Variables

● To Use Global Variables in TIBCO BusinessEvents Studio Project Fields

To use a global variable as the value for a project setting, drag it from the list of variables into the
text box for the setting, or enter it manually. Use the following syntax:

%%Variable_Group/Variable_Name%%

As shown above, you must include the global variable group hierarchy, if one exists.

For example, to use a global variable in a File Path field, you might enter the following:

%%filePathVars/certificateFilePath%%
● To Use Global Variables in the Rule Editor

To use a global variable in the rule editor, use one of the System.getGlobalVariableAs* functions.
For example:

System.getGlobalVariableAsString("myvars/Hostname", "Localhost")

Where myvars/Hostname is the name of the variable group and variable, and Localhost is an
optional literal value to use if the variable is not found.

● To Use Global Variables in Debugger

To use a global variable in Debugger, add it as a VM argument. Prefix the variable with -V, as
shown:

-VVariable_Group/Variable_Name=

Global Variable Reference

Global Variable Reference

Field Description

Name The variable name.

Different groups can have the same-named variable, because the group name is
included when you use the global variable.

Value The variable value. Varies according to type.
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Field Description

Type Data type of the global variable. The values are:

● String
● Integer
● Boolean
● Long
● Password

The type must match the type of the field where the global variable is used, or
errors result.

Deployment
Settable

For deployment with TIBCO BusinessEvents Monitoring and Management
 You can only override global variables if both the Deployment Settable and
Service Settable check boxes are selected.

For deployment with TIBCO Administrator
 If selected, the variable is visible and settable when deploying using TIBCO
Administrator. The values set at that time are saved in the project that TIBCO
Administrator creates from the provided EAR file.

If the check box is not selected, the variable is not visible in TIBCO
Administrator. It is selected by default.

Service Settable For deployment with TIBCO BusinessEvents Monitoring and Management
 You can only override global variables if both the Deployment settable and
Service Settable check boxes are selected.

For deployment with TIBCO Administrator
 If both Deployment Settable and Service Settable are checked, the value of the
global variable can be set differently for each deployable instance.

Even if Service Settable is selected, the variable is included in the
EAR only when the Include all service level global variables
option is selected when building the enterprise archive file.

In all deployment scenarios, values set at the service instance level are passed
to the engine at runtime in the format tibco.clientVar.VariableName=value.

Not checked by default.

Description A helpful description, as needed.

Constraint Optional. For String and Integer types, using this you can provide a range of
allowed values. The constraint field for Strings is an enumeration, for example,
one, two, three. The constraint field for Integers is for a range, for example,
1-100.

Constraints for Integers are currently not implemented in TIBCO
Administrator.

Last Modified Non-editable field that records the date and time this variable was last
modified.
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Overriding Global Variables at Deploy Time
You can override default values by setting global variable values in one of these ways, depending on
how you will deploy:

● For starting at the command line:

— In the design time CDD file.
— At the command line, using the --propVar option, or using the -p option to specify a property

file where the override properties are defined. See TIBCO BusinessEvents Administration.
● For deployment using TIBCO BusinessEvents Monitoring and Management component, set values

in the CDD or MM Console. CDD values can be overridden in MM Console. See TIBCO
BusinessEvents Administration.

● For deployment using TIBCO Administrator, set overrides in the TIBCO Administrator UI. You can
override variables at the deployment level or at the service level. Values set at the service level are
used for the specific engine you are deploying. Service settable global variables are only available if
the Include All Service Level Global Variables check box in the Build Enterprise Archive dialog is
selected (see Building an Enterprise Archive (EAR File)).

Order of Precedence of Global Variable Overrides
Global variable values are selected at runtime using values set in the following ways, shown in order of
precedence, highest to lowest:

1. Command-line arguments at engine startup (highest priority).

2. Property files specified at command-line engine startup

3. MM Console or TIBCO Administrator

4. CDD file (ignored by TIBCO Administrator)

5. TIBCO BusinessEvents Studio Global Variable Editor (lowest priority)

Storing Trusted Certificates Outside of Your Project

Trusted certificates are used when you configure SSL, such as in an HTTP Connection Reference or JMS
Connection Reference.

Trusted certificates can be used to ensure that remote servers are who they claim to be and to ensure
that TIBCO BusinessEvents can identify itself as a valid client when connecting to a server.

You can store the certificates within a project folder, or you can use a special global variable,
BE_GLOBAL_TRUSTED_CA_STORE, to specify the location of an external directory that contains all the
certificates known toTIBCO BusinessEvents.

When you store the certificates within a project folder, then when a certificate changes or expires, you
must import any new certificates or certificate chains into the project, rebuild the EAR file, and re-
deploy your project.

Using the global variable, however, avoids this problem. When you use the global variable to specify
the external location of certificates, then when certificates change or expire, replace certificates or add
new certificates and then restart the engine to load the changes.

You can set the global variable value and then use the variable in the usual ways, as described in this
chapter. For example you could use the global variable as follows:
tibco.clientVar.BE_GLOBAL_TRUSTED_CA_STORE=file:///somePath/myGTCAFolder
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Store Trusted Certificates Outside of the Project

Procedure

1. Create a directory where you want to store the trusted certificates. You must copy this directory to
each machine where engines are deployed. Alternatively, the location can be a shared network area
accessible by all process engines.

2. Create a global variable named BE_GLOBAL_TRUSTED_CA_STORE. See Global Variable Reference for
more information.

3. Set the value of BE_GLOBAL_TRUSTED_CA_STORE to the location of the trusted certificates folder on
your file system. The value must be a file URL, for example, file:///c:/tibco/certs.

The location can be the same for all deployed engines (that is, you copied it to the same location on
each machine or it is a shared network drive). Alternatively you can change the value of the global
variable as needed when you deploy the project

4. Specify a value in the Trusted Certificates field in the SSL Configuration dialog. When the project
runs, the value of BE_GLOBAL_CA_STORE is used, and not the value you specify in the Trusted
Certificates field.

5. Save the resource.
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TIBCO BusinessEvents Studio Tools Utility

TIBCO BusinessEvents Studio Tools is a command-line utility with various operations (tools) you can
use to automate common procedures. This chapter documents the tools that can be useful while
developing applications in TIBCO BusinessEvents Studio. Other tools in this suite are documented in
TIBCO BusinessEvents Decision Manager User’s Guide and TIBCO BusinessEvents Installation

All arguments of a command-line utility must use only ASCII characters.

For full details on deployment of an EAR file, see TIBCO BusinessEvents Administration. The
buildear operation within the studio-tools utility is useful for automation purposes, for example, in
testing environments.

By default, the EAR files are built in memory. The compiler does not use the file system during code
generation. Instead, the Studio JVM is used to load all the Java classes and resources into memory until
the build process is completed. You can choose to use the file-system based compiler to build EAR files
by setting the appropriate options.

Building an EAR File at the Command Line

Procedure

1. Navigate to BE_HOME/studio/bin/ and open a command prompt.

2. Execute a command with the following format (all on one line) at a command prompt:
studio-tools -core buildEar [-h] [-x] [-lc] [-o outputEarFile>] -p 
studioProjectDir [-pl projectLibrariesFilePath] [-cp extendedClasspath]

For example:
studio-tools -core buildEar -o c:\FD.ear -p D:\Workspace\FraudDetection

TIBCO BusinessEvents Studio Tools Options for Building an EAR File, provides detailed
information about the options.

TIBCO BusinessEvents Studio Tools Options for Building an EAR File

Option Description

-core buildEar Within the core category of operations, specifies the buildear
operation for building EAR files.

-h Optional. Displays help.

-x Optional. Overwrites the specified output file if it exists.

-lc Optional. Specifies that the file-based legacy compiler must be used to
build the EAR file. By default, the EAR files are built in memory.

-o Optional. Specifies the filename for the output EAR file. If not specified
the EAR file is the same as the final (leaf) directory name in the
projectDir path.

-p Absolute path to the TIBCO BusinessEvents Studio project directory.
The EAR file is built using this project.
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Option Description

-pl Optional. Specifies list of project library file paths to be used, separated
by a path separator.

-cp Optional. Specifies the extended classpath to be used.

Result

When building an EAR file in memory for a large project, the JVM may run out of PermGenSpace
and/or heap space. In such cases, edit the BE-HOME/studio/eclipse/studio.ini and BE-HOME/
studio/bin/studio-tools.tra file to set appropriate values for the JVM settings. By default the heap
size is set to -XX:MaxPermSize=256m.

Importing an Older Studio Project at the Command Line
This tool is equivalent to the following menu option in TIBCO BusinessEvents Studio: File > Import >
TIBCO BusinessEvents > Existing TIBCO BusinessEvents Studio Project. It is used to migrate older
(4.x, 5.0.x, and 5.1.x) projects to 5.2.

When you run this command-line utility, various migration actions are done, as explained in TIBCO
BusinessEvents Installation.

For migration of version 3.x projects, see TIBCO BusinessEvents Installation.

Before you can use a 4.x project imported at the command-line in TIBCO BusinessEvents Studio you
must do another procedure, explained in Open a Project Imported at the Command Line in TIBCO
BusinessEvents Studio.

Import an Existing 4.x Project at the Command Line
You can import projects from earlier versions or same version using command line utility. After
importing using the command line utility an additional procedure is required before you can work
with the project in TIBCO BusinessEvents Studio.

Procedure

1. Navigate to BE_HOME/studio/bin/ and open a command prompt.

2. Execute a command with the following format (all on one line) at a command prompt:

studio-tools -core importExistingProject [-h] -p studioProjDir [-o 
targetProjDir] [-c CDDprojectPath] [-u PUNameFromCDD] [-xp 1.0|2.0]

For example:
studio-tools -core importExistingProject -p C:\FT\SomeProj -o c:\MyWorkspace
\SomeProj -c COM.cdd -u Invproc -xp 2.0

If HTTP channel properties are migrated (from a specified CDD and processing unit to all HTTP
channel resources’ Advanced tab) you see a message like this:
Migrating HTTP properties of Processing Unit "PUName" from CDD "CDDprojectPath" 
to HTTPChannel(s) present in the project

When the import has completed successfully, you see a message in the command window like the
following:
The existing 4.0 TIBCO BusinessEvents project has been successfully imported to 
c:\MyWorkspace\SomeProj.
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TIBCO BusinessEvents Studio Tools Options

TIBCO BusinessEvents Studio Tools Options for Importing an Existing Project

Option Description

-core 
importExistingProject

Specifies the importExistingProject operation for importing a
TIBCO BusinessEvents Studio project into the workspace.

-h Optional. Displays help.

-p Source project: absolute path to the project directory of the TIBCO
BusinessEvents Studio project to be imported.

-o Optional. Absolute path to the target project directory, where the
project is imported to.

If you specify the source project directory name as the last element in
the path, it is used as the target project directory. If you specify a
different directory as the last element in the path, the directory is
created if it does not exist, and the source project directory is
imported within the specified target directory.

If you do not specify a target project directory, the original project
contents are updated. If the project to be imported is a TIBCO
BusinessEvents version 4 project, it is no longer compatible with
version 4 after the import.

If the target location points to an existing project, the import does not
proceed and this message displays:
The specified target location already exists and cannot 
be used.

-c Optional. The CDD to use for migration actions. Project path of the
CDD (path relative to the root directory of the source project).

-u Optional. If specified, then the -c option must also be specified.
Specifies the name of the PU (within the specified CDD) that contains
settings to be migrated.

HTTP channel settings from this PU are migrated to all HTTP
channel resources in the project.

-xp Optional. The XPath version to be compatible with the project. The
values are:

● (default) 1.0

● 2.0

Open the Imported Project in TIBCO BusinessEvents Studio
To open a project imported at the command line, you must add it as a new project.
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Procedure

1. Start TIBCO BusinessEvents Studio. In Windows, click StartAll ProgramsTIBCOYourEnvironment

TIBCO BusinessEvents 5.2 TIBCO BusinessEvents Studio.

2. From the File menu select New > Project . You see the New Project — Select a Wizard dialog.

3. Select TIBCO BusinessEvents > Studio Project and click Next.

4. In the Project Name field, enter the directory name where the imported project is located. (This is
used as the project name.)

5. (If you imported the project to a directory in your default workspace, skip this step.) If the project
directory is located outside the default workspace, uncheck the Use default location checkbox and
browse to the parent directory of the project imported at the command line.

6. Click Finish. The project folders appear in the Studio Explorer view.

Working With Project Libraries at the Command Line

See Working with Project Libraries for an introduction to project libraries and procedures for working
with them in TIBCO BusinessEvents Studio.

This section explains how to use a command-line utility to complete the following tasks:

● Create a project library (and optionally overwrite any existing library at the same location with the
same name). This action creates the .projlib file. The corresponding action in TIBCO
BusinessEvents Studio is exporting a project library.

● Add an existing project library to a TIBCO BusinessEvents Studio project. The corresponding action
in TIBCO BusinessEvents Studio is importing a project library (or adding it to the build path
property page).

● Remove an existing project library from a TIBCO BusinessEvents Studio project. The corresponding
TIBCO BusinessEvents Studio action is removing the library from the Build Path property page.

Work with Project Libraries at the Command Line

Procedure

1. Navigate to BE_HOME/studio/bin/ and open a command prompt.

2. Execute a command with the following format (all on one line) at a command prompt. Arguments
for creating a project library are shown separately for clarity:

To create a project library:
studio-tools -core buildLibrary [-h] -p studioProjDir [-a] [-r] [-x] -n 
projectLib [-f resources]

To add or remove an existing project directory in a TIBCO BusinessEvents Studio project:
studio-tools -core buildLibrary [-h] -p studioProjDir [-a] [-r] [-x] -n 
projectLib [-f resources]

Examples of Creating a Project Library

Example 1
 The following command creates a project library using the specified project’s contents:
studio-tools -core buildLibrary -p C:\workspace\MyProj -n C:\test\myproj.projlib

Example 2
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 The following command creates a project library at the location specified, and overwrites any project
library already at that location. From the specified project, the project library uses only the resources
specified in the -f argument: the Concepts folder, the MyRule.rule and all dependent resources
referred to by these resources.
studio-tools -core buildLibrary -p C:\workspace\MyProj -x -n C:\test
\myproj.projlib -f Concepts,Rules\MyRule.rule

Examples for Adding and Removing a Project Library

When a project library exists, built either using TIBCO BusinessEvents Studio or using the command-
line options shown in Examples for Creating a Project Library, you can use the buildLibrary
operation to add a project library to or remove a project library from a TIBCO BusinessEvents Studio
project.

Example 3
 The following command adds the myproj.projlib project library to the TIBCO BusinessEvents
Studio project at C:\workspace\MyProj.
studio-tools -core buildLibrary -p C:\workspace\MyProj -a -n C:\test\myproj.projlib

Example 4
 The following example removes the myproj.projlib project library from the TIBCO BusinessEvents
Studio project at C:\workspace\MyProj.
studio-tools -core buildLibrary -p C:\workspace\MyProj -r -n C:\test\myproj.projlib

Table 29 provides detailed information about the options.

TIBCO BusinessEvents Studio Tools Options for Working with Project Libraries

Option Description

-core 
buildLibrary

Specifies the buildLibrary tool for adding, removing, and creating
(overwriting as needed) project libraries.

-h Optional. Displays help.

-p File path to the TIBCO BusinessEvents Studio project. Resources from
this project are used to create the project library.

This filepath is also used to identify the project to which you want to
add a project library.

[-r | -a] Use one of these arguments as needed.

-r: removes the specified project library from the project specified by -
p.

-a: adds the specified project library to the specified project.

-x Optional. Overwrites any existing project library at the location
specified by -n.

-n The absolute path of the project library to be created or added or
removed
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Option Description

-f Optional. A comma-separated list of resources to include in the project
library, using a path relative to the projectDir.

If not specified all resources of the specified project are used.

Migrating Core Coherence Functions at the Command Line
The TIBCO BusinessEvents DataGrid component is the default cache provider for TIBCO
BusinessEvents. Use of Oracle Coherence is also supported for those who want to use their own copy of
this software.

A set of core Coherence functions was renamed in TIBCO BusinessEvents 5.0 (and additional internal
changes were made) so that these functions can be used with either the Coherence or the TIBCO
BusinessEvents DataGrid cache provider.

Migrating existing projects to use the new function names is one of the actions done automatically
when you import a project from a previous release, as explained in Chapter 4, Migrating Projects from
Earlier Versions in TIBCO BusinessEvents Installation.

Separate use of the migrateCoherenceCalls operation may be required in some cases. For example,
you create a project in the current version with Coherence as the cache provider, and enable and use
the Coherence-specific catalog functions, Then you switch to using TIBCO BusinessEvents DataGrid as
the cache provider. You would then use the migrateCoherenceCalls operation to migrate those
functions.

Migrate Core Coherence Functions at the Command Line

Procedure

1. Navigate to BE_HOME/studio/bin/ and open a command prompt.

2. Execute a command with the following format (all on one line) at a command prompt:

Result

studio-tools -core migrateCoherenceCalls –p studioProjectDir

When the migration has completed successfully, you see a message in the command window:
All Coherence function calls have been migrated successfully.

Generating All Project Class Files at the Command Line
You can generate all class files in a project at the command line. Although this is a core component, the
class files are generally used within the context of TIBCO BusinessEvents Decision Manager, where
decision table class files can be separately deployed.

Generate Class Files at the Command Line

Procedure

1. Navigate to BE_HOME/studio/bin/ and open a command prompt.
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2. Execute a command with the following format (all on one line) at a command prompt:
studio-tools -core generateClass [-h] -p studioProjectDir [-n studioProjectName] 
-o outputPath [-x {true | false}] [-lc] [-pl projectLibraryFilePath] [-cp 
extendedClasspath]

For example:
studio-tools -core generateClass -p D:\Workspace\FraudDetection -o c:\temp -x 
true -cp c:\tibco\be\5.2\lib\myjar.jar

You see a success message if the files were generated successfully.

TIBCO BusinessEvents Studio Tools for Generating Class Files
This table provides detailed information about the options.

TIBCO BusinessEvents Studio Tools for Generating Class Files

Option Description

-core generateClass Within the core category of operations, specifies the generateClass
operation used to generate a project's class files.

-h Optional. Displays help.

-p Absolute path to the TIBCO BusinessEvents Studio project directory.

-n Optional. Specifies the name of the TIBCO BusinessEvents Studio project
whose class files are to be generated. If not specified, the final (leaf)
directory name in the path specified for the -p option is used as the
project name.

-o Specifies the output directory for generated classes.

If you do not specify a directory, files are placed in a user temporary
directory. For example, on Windows files might go in a directory like the
following:

C:\Documents and Settings\User\Local Settings\Temp

\BE_1322046141896

-x Optional. If true, overwrites any existing class file with the same name.

-lc Optional. Specifies that the file-based legacy compiler must be used to
build the EAR file. By default, the EAR files are built in memory.

-pl Optional. Specifies list of project library file paths to be used, separated by
a path separator.

-cp Optional. Extended classpath. Use as needed. Provide separate JAR file
paths for each JAR file required for project compilation. For example,
additional classpath information is needed if the decision table uses
custom functions or third-party JAR files.

Separate entries by the appropriate path separator. For example if the
separator is semicolon (;) you might add the following:

C:\customjars\custom.jar;C:\customjars\custom2.jar
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Generating Encrypted Passwords
TIBCO BusinessEvents Studio Tools utility provides a command to generate encrypted passwords.

Syntax

studio-tools -crypto encrypt [-h] [-i inputText]

Definition

The encrypted text is written to STDOUT. The exit status of the command indicates whether the
generation was a success or a failure.

An exit status of 0 indicates success, and -1 indicates an error.

TIBCO BusinessEvents Studio Tools Options for Generating Encrypted Passwords provide more
detailed information about the option.

TIBCO BusinessEvents Studio Tools Options for Generating Encrypted Passwords

Option Description

-h Optional. Displays help.

-i Input text which needs to be encrypted

Running the Tester on the Command Line
Running the Tester on the command line allows you to create test data templates, populate the test data
files, and run tests.

To run the Tester on the command line, you will follow these steps:

Procedure

1. Run the command
-tester generate

This generates the test data template files, which are used for concepts, scorecard, and events for a
given project directory.

The test data template files are either in XLS or CSV format, as desired by the user, and are used to
enter the test data. They will have a project name, element relative path, external ID, column names,
and so on.

Blank columns should be filled with NA.

To generate a file in a specific format, see Command Line Options.
2. Enter the data manually in the generated template files.
3. Run the command

-tester import

This will import the data entered into test data files

*.concepttestdata

and

*.eventtestdata.

These files are similar to the files saved by the Studio Tester when selecting Create Test Data.
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4. Run the command
-tester assert

This will start an instance of the TIBCO BusinessEvents engine and assert the test data generated in
step 2 to the instance.

After the assertion, the result data files will be saved in an output directory that has to be provided
in the user command line options, and in one of these two formats:

● Default Format
: It is either the XML format (default) or HTML format (defined through the command line
option).

● Custom Format
: Output is based on Types or Operation (such as Created, Modified, and Deleted).

The default output is generated based on Operation.

Command Line Options

Result

The -tester operation provides for the following commands:

● generate
● import
● assert

The Generate Command
The command generate reads concepts, scorecards and events from a project and creates test data
template files in comma separated format. The output files can be edited by the user to add test data
and then can be used as an input for the import command to import the test data.

Syntax

studio-tools -tester generate [-h] [-x] -p <projectDir [-t < xls | csv] [-s 
<separator] [-o <outputDirectory]

Options

The following options are used with the command generate.

Option Description

-h (optional). Prints usage help

-o (optional). Specifies the output directory. If not specified, the output directory will
be ProjectDirectory/TestDataTemplates.

-p (required). Specifies the project path.

-t optional). Specifies the output file type. Supported values are [ xls | csv ]. If
this option is not specified, the output will be in CSV format with a comma (,) as a
column separator.
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Option Description

-s (optional. Used only when the output file type is CSV to specify a column
separator. The supported value is [,].

If not specified, the default column separator is comma (,).

-x (optional). Overwrites the output directory if it already exists.

The Import Command
The command import reads the CSV data files and converts them to the appropriate test data format
(such as .concepttestdata, .eventtestdata).

Syntax

 studio-tools -tester import [-h] [-x] -i <inputFile -p <projectDirectory[-o 
<outputDirectory] [-t < xls | csv] [-s <separator]

Options

The following options are used with the command import:

Option Description

-i (required). Sets the input path, which is a path to a directory containing test data
template files, a single test data template file, or a path to Listfile containing
paths of files that must be included for test data generation.

-h (optional). Prints usage help.

-o (optional). Specifies the output path.

-p (required). Specifies the project path.

-t (optional). Specifies the output file type. Supported values are [xls|csv]. If this
option is not specified, the output will be in CSV format with a comma (,) as a
column separator.

-s (optional). Used only when the output file type is CSV to specify a column
separator. The supported values are [,].

If not specified, the default column separator is comma (,).

-x (optional). Removes the TestData root from under the output directory. If it
already exists it creates a new one.

The Assert Command
The command assert is used to assert the test data on a running TIBCO BusinessEvents engine
instance.

Syntax

studio-tools -tester assert [-h] -p <projectDir -c <cddFile -r <earFile -w 
<workingDir[-u <processingUnit][-f <outputFormatType][-o <outputDirectory][-n 
<filename][-i <input path][-x]
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Options

The following options are used with the command assert:

Option Description

-c (required). Specifies the CDD file path.

-f (optional). Specifies the output format type. Acceptable values are ops and type. If
this option is not specified, the default output is generated.

-h (optional). Prints usage help.

-i (optional). Specifies the input directory path. If not specified, it will attempt to use
the TestData directory under the project directory.

-n (optional). Name of the resultFile. If not specified, it creates a file with the name
Run-#.resultdata.

-o (optional). Specifies the output directory. If not specified, the output directory will
be ProjectDirectory/results.

-p (required). Specifies the project path.

-r (required). Specifies the EAR file path.

-u (optional). Specifies the processing unit name. If not specified, it will use the
default processing unit.

-w (required). Specifies the working directory path.

-x (optional). Overwrites the output file if it already exists.
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Element Refactoring Operations

When you make changes to a project element, all references to that element must be updated
accordingly. When such changes affect only the structure and not the behavior of the project, this
operation is known as project refactoring. This chapter explains how to use the refactoring features, and
some related features to do with copy-paste operations.

Renaming Moving Deleting and Copy-Pasting Elements
Changes that affect the structure of a project, but not its behavior, are known as project refactoring
changes. Refactoring ensures that the project structure remains self-consistent.

Copy-paste operations are not strictly speaking refactoring operations. However some refactoring is
also done to support these operations, so they are included here.

You can copy items from one project to other projects in the workspace. Ensure that the items are
suitable for their destination projects.

Moving, renaming, deleting, or copy-pasting project elements are changes that often affect other parts
of a TIBCO BusinessEvents Studio project. Names of elements, element properties, and element
locations, are referenced in various parts of a project such as rules, rule functions, and concept
relationship properties.

When you make changes to a project element, all references to that element must be updated
accordingly. The refactoring wizard has a preview page that enables you to review all these changes
(see Working with the Preview Page).

This section explains the refactoring procedures. See Automatic Refactoring Actions and Limitations to
understand what TIBCO BusinessEvents does for each type of refactoring operation.

Updating All References is Strongly Recommended

To ensure the integrity of the project, it is strongly recommended that you make all changes to all
locations where a renamed or moved items is referenced. Only disable such changes if you are certain
there are no references to the element, or there are unusual circumstances that justify such action.

Eclipse Tips

To Undo Changes
 You can undo additions or deletions in a project. Click Edit > Undo or press Ctrl+Z.

To Revert to an Earlier Version or Restore a Deleted Resource
Using  Eclipse you can compare your work with local history and to revert to any earlier saved
version (not just the last saved version). Right-click a resource in BusinessEvents Studio Explorer and
select Compare With > Local History or Replace With > Local History. Also, if you right-click a folder
and select Restore From Local History you can restore items deleted from that folder.

Project Level Actions

You can rename a project (select File > Rename) and you can copy and paste a project. However, you
cannot move a project.

Renaming Moving and Deleting Elements
Renaming, moving, and deleting are refactoring actions that can have an effect on other parts of the
project where element names and locations are referenced.
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Renaming a Project Element

Procedure

1. Rename the element using one of the following methods:

● Right-click a project element in BusinessEvents Studio Explorer and select Refactor > Rename .
● Highlight the element, then select File > Rename .
● Highlight the element, then press F2.

The first page of the Rename Element wizard appears.

2. In the New Name field, type the new name.

3. If you do not want to rename the element in places where it is referenced, clear the Update
References check box; however, you should update all references to ensure the integrity of the
project (see Updating All References is Strongly Recommended).

4. Click Preview. One of the following occurs:

● The preview page displays so you can examine the effect of this change. See Working with the
Preview Page for details.

● The problems page displays if renaming cannot be done, for example, because a new element
name is used by an existing element. Click Back to fix the problem, or Cancel to cancel the
rename.

5. In the preview page, clear check boxes if you do not want the change to be made in some referenced
locations; however, you should update all references to ensure the integrity of the project (see 
Updating All References is Strongly Recommended).

6. To complete the change, click OK.

Moving an Element to a Different Project Folder

Procedure

1. Move the element using one of the following methods:

● Right-click a project element name in BusinessEvents Studio Explorer and select Refactor >
Move .

● Highlight the element, then select File > Move .
● Drag the element to the target folder (go to step 3).

2. If you opened the Move Element wizard using menus, navigate the project tree in the first page of
the wizard to select a destination folder, then click Preview.

3. One of the following occurs:

● The preview page displays so you can examine the effect of this change. See Working with the
Preview Page for details.

● The problem page displays if the move cannot be made. Click Back to fix the problem, or
Cancel to cancel the move.

4. In the preview page, clear check boxes if you do not want the change to be made in some referenced
locations; however, you should update all references to ensure the integrity of the project (see 
Updating All References is Strongly Recommended).
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5. To complete the change, click OK.

Delete an Element or Folder
When you delete a folder, all elements within that folder are also deleted.

Procedure

1. Do one of the following:

● Right-click a project element or folder name in BusinessEvents Studio Explorer and select
Delete.

● Highlight the element, then select Edit > Delete .
● Highlight the element, then press the Delete key.

2. At the Delete Resources page, click OK to delete without previewing, or click Preview to preview
the effect of the deletion.

3. If you click Preview, one of the following occurs:

● The preview page is displayed so you can examine the effect of this change. For deletions, there
is generally no information. Click OK to delete.

● The problems page is displayed if there is a problem with the deletion. Click Back to fix the
problem, or Continue to force the deletion (or Cancel to cancel the deletion).

Deleting a Project

Procedure

1. Perform either of the following:

● Right-click the project name in BusinessEvents Studio Explorer and select Delete.
● Highlight the project name, then select Edit > Delete .
● Highlight the project name, then press the Delete key.

2. If you want to remove the project contents on disk, select the Delete Project Contents on Disk
check box. If you do not select this check box, then the project is removed from BusinessEvents
Studio Explorer, but the project contents remain on disk.

3. Click OK to delete without previewing, or click Preview to preview the effect of the deletion.

4. If you click Preview, one of the following occurs:

● The preview page is displayed so you can examine the effect of this change. For deletions, there
is generally no information. Click OK to delete.

● The problems page is displayed if there is a problem with the deletion. Click Back to fix the
problem, or Continue to force the deletion, or Cancel to cancel the deletion.
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Working with the Preview Page

During refactoring operations, you can click Preview to examine the effects of the operation on the
project. If a pre-check finds issues that may prevent the operation from completing successfully, a
problem page appears instead.

Checks in the upper panel indicate elements that will change as a result of a refactoring operation.
Expand to take a closer look at individual folders and elements. All elements that appear are affected
by the change. When you highlight an element, details of the change to be made are shown in the lower
panel.

The Original Source panel on the left and the Refactored Source on the right use the persisted format of
the element. Change bars indicate changed areas.

Do any of the following as needed to examine the changes and select a subset of the changes to be done
on clicking OK:

● In the upper panel, use the arrows to navigate up and down a long list of changes.
● Click the Filter Changes button and select Hide Derived Resources. For example, a diagram is a

derived resource. Diagrams are not persisted. You can easily recreate them. So you may not be
interested in seeing those changes.

● If you want to apply the change to only some of the project elements, clear the check boxes next to
the elements as desired. For example, you may wish to replace or delete an element after you have
completed the refactoring operation, so you do not need to apply the change to that element.

Accept all changes to be performed
 Your project can become corrupted if you do not make the changes throughout the
project. Only deselect changes if you have a specific, valid reason to do so.
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Copy-Pasting an Element
Copy-pasting is not a true refactoring operation, because it does change the behavior of the TIBCO
BusinessEvents Studio project.

You would generally make manual changes to your project to use the newly created project element.
However, some limited refactoring is done for your convenience. For example, the definition of a rule
or rule function begins with its fully qualified name, such as the following:
rule SomeRules.Application_Rule

If you copy and paste the above rule into the folder OtherRules, the definition of the rule automatically
changes to:
rule OtherRules.Application_Rule

Procedure

1. In BusinessEvents Studio Explorer, highlight the element (or folder) and do one of the following:

● Right-click the element and select Copy.
● Press Ctrl+C.
● Select Edit > Copy .

2. Highlight the project folder where you want to paste the element, and do one of the following:

● Right-click the folder and select Paste.
● Press Ctrl+V.
● Select Edit > Paste .

Result

If you are pasting an element to the same folder that you copied it from, a dialog enables you to
provide a different name. The default value is CopyOfoldname.

Migrating Core Coherence Functions
The TIBCO BusinessEvents DataGrid component is used as the default cache provider. Use of Oracle
Coherence is also supported for those who want to use their own copy of this software.

A set of core functions has been renamed (and additional internal changes have been made) so that
these functions can be used with either the Coherence or the TIBCO BusinessEvents DataGrid cache
provider.

The renamed functions are in the Standard catalog Cluster.DataGrid category. You must use these
functions going forward. See Mapping of Coherence Functions to DataGrid Functions for details.

For all projects created prior to version 5.0.0, use the 4.x project import wizard, which migrates the core
Coherence function calls automatically.

For occasional use cases where the function calls are migrated manually, you can use the manual
refactoring operation. You can also use a command-line option as explained in Migrating Core
Coherence Functions at the Command Line.

Migrate Coherence Function Calls in TIBCO BusinessEvents Studio

See Mapping of Coherence Functions to DataGrid Functions for details of the functions that are
mapped using this feature.
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Procedure

1. Open the project in TIBCO BusinessEvents Studio (3.x projects must be migrated first). Migrate the
function calls using one of the following methods:

● Right-click the project name in Studio Explorer and select Refactor > Migrate Coherence
Function Calls .

The first page of the Migrate Coherence Function Calls wizard appears. It displays an
informational list of the functions that the utility renames.

2. Click OK to make all necessary changes without previewing, or click Preview to preview the effects
of the change.

3. If you click Preview, one of the following occurs:

● The preview page displays so you can see the list of affected elements (which include rules,
rule functions, expiry actions and state modeler transition, exit, and entry rules). You can scroll
the list and view the original and refactored sources for each affected element. You can
uncheck the checkboxes of elements you wish to remain unchanged (and later make changes
manually as needed). Click OK to make the changes to all or selected elements.

● The problems page displays if there is a problem with the change. Click Back to fix the
problem, or Continue to force the change (or Cancel to cancel the change).

● The preview page displays this message: The refactoring does not change any source code.
Click OK and complete the migration anyway.

Complete the refactoring operation even if no project code is affected
 This refactoring operation makes additional changes to your projects so that your
projects will work correctly with the new function names.

Mapping of Coherence Functions to DataGrid Functions

Mapping of Coherence Functions to DataGrid Functions

4.x Coherence Category Function Name DataGrid Category Function Name

C_CacheGetEntityById() CacheGetEntityById()

C_CacheLoadConceptByExtId() CacheLoadConceptByExtId()

C_CacheLoadConceptById() CacheLoadConceptById()

C_CacheLoadConceptIndexedByExtId() CacheLoadConceptIndexedByExtId()

C_CacheLoadConceptsByExtId() CacheLoadConceptsByExtId()

C_CacheLoadEntity() CacheLoadEntity()

C_CacheLoadEventByExtId() CacheLoadEventByExtId()

C_CacheLoadEventById() CacheLoadEventById()

C_CacheLoadParent() CacheLoadParent()
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4.x Coherence Category Function Name DataGrid Category Function Name

C_CacheName() CacheName()

C_CacheReevaluate() CacheReevaluate()

C_ClassName() ClassName()

C_EnableCacheUpdate() EnableCacheUpdate()

C_Index() Index()

C_Lock() Lock()

C_TransactionProperties TransactionProperties()

C_UnLock() UnLock()

Automatic Refactoring Actions and Limitations
This section explains what is done for each kind of refactoring operation. It also lists some limitations.

Refactoring Limitations
Changes made to certain items are not refactored in this release. You must handle reference updates
manually.

References to moved or changed folders in strings
 References to changed or moved folders are not updated in strings, including CDD and XSLT strings.
CDD strings are used in the Cluster Definition Descriptor editor to point to project resources using
their project path. XSLT strings are used in mapper functions, which are completed using the Function
Argument Mapper. (Such references are, however, updated for entity refactoring operations).

Copy-paste of folders
 Elements inside the pasted folder are not updated.

References to global variables and shared resources
 Refactoring does not handle changes to global variables and shared resources. You must manually
update references to global variables and shared resources that you change.

TIBCO BusinessEvents destinations and property definitions cannot be moved.

Refactoring for Move and Rename Operations
Move and rename refactoring operations change only the structure of a project. For example, when you
change a concept name, that name must change everywhere the concept is referenced in the project. If
the element has its own file, the file must also be renamed.

References to the changed or moved element are handled as shown in Table 36. Projects can be
complex; this list covers the main cases.
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Refactoring for Move and Rename Operations

Renaming this... Updates references in these places...

Concept Concepts that inherit from this one

Event expiry actions

Property definitions for contained or referenced concepts

State models

Rules and rule functions

Event Events that inherit from this one

Event expiry actions

Destination (Default Event)

State models

Rules and rule functions

Property of a concept
or an event

Event expiry actions

State models

Rules and rule functions

Domain Model Domain models that inherit from this one

Associated properties

Channel Event default destination paths

Destination Event default destination paths

Rule The rule source

Rules and rule functions

Rule Function Event expiry actions

State models

The rule function source

Rules and rule functions

Folder All location that this folder is used in a path, for example path to a default
destination in an event, property definitions for contained or referenced
concepts, and in rules and rule functions. For folder refactoring limitations,
See Refactoring Limitations .

Refactoring for Delete Operations
Element deletion can affect project behavior. Ensure that your project behavior is as desired after the
deletion refactoring.

Deletion removes all references to the deleted object only in specific cases:

● References to a deleted domain model are removed from concepts that refer to it.
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● Reference to a deleted state model are removed from the owning concept
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Working with Channels and Destinations

One project can have multiple channels of different types with multiple destinations as needed. For
more information, see TIBCO BusinessEvents Architect’s Guide, Channels, Destinations, and Events.

● For TRA file updates required for Rendezvous and JMS channels that use TIBCO Enterprise
Message Service, see TIBCO BusinessEvents Administration:

● For configuring SSL over HTTP when the Identity Resource is of the type Certificate/KeyURL, you
need to setup native Tomcat libraries. See TIBCO BusinessEvents Installation guide.

The general procedure for creating channels and destinations of all types is the same, though the
configuration options are different. A TIBCO Rendezvous channel is shown as an example.

Channel Serializers
For each type of channel (except local channels), TIBCO BusinessEvents uses a serializer to convert
events to messages and a deserializer to convert incoming messages to events.

Local channels do not require serializers. HTTP channels also provides you the option of using action
rule functions on the message instead of converting messages to event using deserializer.

Serializer and Deserializer Behavior

When you configure a destination, you select the appropriate serializer. (It actually includes the
serializer and deserializer).
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Mapping Incoming Messages to Non-default Events
Incoming messages can be mapped to default evenst or to specified event types.

The fields in a message header instruct TIBCO BusinessEvents to map the incoming message to a
specified event type:

● The field named _ns_ takes a namespace as a value. The namespace points to the event type, for
example, www.tibco.com/be/ontology/Events/MyEvent

● The field named _nm_ takes the name of the event, for example, NewMyEvent

● The field named _extid_ takes the unique external id of the event.

These fields are added and filled automatically for events created using TIBCO BusinessEvents rules.
You can also add these fields to messages coming in from other sources, if you have control of those
messages.

See also Default Destinations and Default Events.

Working with Rendezvous Channels
The type of the event from which the outbound message is serialized is added to the Rendezvous
message header using _nm_ and _ns_ fields so that if the message is used in TIBCO BusinessEvents
again, the correct event type is used to deserialize the message (ignoring the default event specified for
the destination).

Note that the Rendezvous serializers use UTF8 encoding for XML payloads.

For TRA file updates required for Rendezvous and JMS channels that use TIBCO Enterprise Message
Service, see TIBCO BusinessEvents Administration.

Rendezvous Message Header

For Rendezvous messages, the only header that TIBCO BusinessEvents interprets is _sendsubject_ of
type String. It is a read-only property. The event has to define this property to receive the value. The
value is the actual Subject on which the message was sent.

Basic Serializer

The basic TibRvMsgSerializer serializer is used for efficient handling of events and messages that do
not have payloads. It ignores payloads in messages and in events if any exist.

Serializer for Use with Payloads

To include a payload in a Rendezvous message, ensure that the message has a _payload_ field. To pass
contents between the Rendezvous message _payload_ field and an event payload, use the
TibRvMsgSerializerWithXMLPayload serializer.

Deserializing from Rendezvous Message to Event
First level Rendezvous property values are used as values for matching event properties. Any
additional (non-matching) Rendezvous properties are ignored.

The _payload_ field contents are passed into the event payload. Supported _payload_ field datatypes
and Rendezvous wire format types are as follows:

Data Type Wire Format Type

String TibrvMsg.STRING
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Data Type Wire Format Type

TibrvXML TibrvMsg.XML

byte[] TibrvMsg.OPAQUE TibrvMsg.I8ARRAY

If the event defines a payload, but the incoming Rendezvous message does not have a _payload_ field,
TIBCO BusinessEvents attempts to map the entire message as the event payload.

Serializing from Event to Rendezvous Message
Event properties are transformed to first level Rendezvous message properties.

The event payload is passed to the Rendezvous message _payload_ field.

If the _payload_ field is of an unsupported type, or is missing, or if the event has not been configured
for a payload, the payload is ignored.

First level Rendezvous property values are used as values for matching event properties. Any
additional (non-matching) Rendezvous properties are ignored.

Avoding REGISTRATION COLLISION RVCM Advisory Messages
REGISTRATION COLLISION RVCM Advisory Messages should be avoided.

When you are configuring RVCM using a Rendezvous transport shared resource, an advisory message
named REGISTRATION.COLLISION RVCM can be thrown if the same CM name (or CMQ name) is used
on all engines.

To prevent name collisions that can result in thrashing, you must ensure that the CM names (and CMQ
names) are different on all engines. To do so, add global variables to the CM Name or CMQ Name, and
to the ledger file name if a ledger file is used for RVCM, to ensure the uniqueness of these names. Add
one or more of the following variables, depending on need (as explained below):
%%EngineName%%
%%ChannelName%%
%%ChannelURI%%

The %%EngineName%% variable is generally required for all names. You must start engines using
unique names so that the value of each engine's %%EngineName%%variable be different at runtime.

In addition, if different channels use the same RVCM shared resource, you also need to add %
%ChannelName%% or %%ChannelURI%%. Use %%ChannelURI%% in cases where channels using the
same RVCM shared resource have the same name but are in different folders.

You must define any of the above String type global variables you use. They are not predefined.
However, TIBCO BusinessEvents provides the value at runtime, so you can use any string value or use
an empty string as the value when you define the variables.

Working with Local Channels
Local channels are used in rules or rule functions to route events to an appropriate agent running in the
same engine (processing unit).

Local channels are useful in two cases:

● For applications using In Memory object management (generally used only for testing)
● For certain scenarios where an inference agent is co-deployed with a query agent. See TIBCO

BusinessEvents Event Stream Processing Query Developer’s Guide.
Local channels pass the same event object between the agents. Consuming the event in one agent does
not affect other agents that also received the event over a local channel. A use count is maintained for
each event to track how many agents have received the event but not consumed it. The use count of the
event is incremented depending on the number of agents it is routed to. When an event is consumed in
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one agent, TIBCO BusinessEvents deletes the reference to the event in that agent and it decrements the
use count of the original event instance.

Local channel destinations can use an event preprocessor and have no default events. To route an event
to a local channel’s destination, use the Event.routeTo() function. (You can use this function for other
purposes too.)

In the provided example, BE_HOME/Examples/MultipleSessionsAndLocalChannel, events containing
small orders are sent to the agent that deals with small orders as follows:
Event.routeTo(order, "/Channels/Local/toSmall", "");

The signature of this function is as follows:
SimpleEvent routeTo(SimpleEvent event, String destinationPath, String properties)

Adding a Channel

Procedure

1. In BusinessEvents Studio Explorer, right click the folder where you want to store the channel and
select New > Channel . You see the New Channel Wizard.

2. In the Channel name field, type a name for the channel. In the Description field, type a description.

You cannot change the name in the editor. To change the name of any project element,
right-click the element in Studio Explorer and select Refactor > Rename. See Element
Refactoring Operations for more details.

3. In the Driver type field, select the appropriate driver:

● Rendezvous
● Local
● HTTP
● JMS
● ActiveSpaces
● Hawk

If you select Local, channel configuration is complete.

4. Click Finish. You see the Channel editor.

Editing a Channel

Procedure

1. Edit Description as needed.

2. In the Driver type field, the driver you selected in the wizard is selected. If you want to change to a
different type of channel you can do so now. Select the appropriate driver:

● Rendezvous
● Local
● HTTP
● JMS
● ActiveSpaces
● Hawk
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3. For all channel types (except Local and HTTP), from the Method of Configuration drop-down list,
select one of the following:

● Properties - Select Properties to configure this channel resource using properties. When you
select Properties, a Properties section displays appropriate fields for the type of channel. See 
Channel Resource Reference for help in entering the correct values.

● Resource - Select Resource if you have a shared resource in your project whose properties you
want to reuse for this channel. For HTTP channels, Resource is preselected and cannot be
changed.

The path to the resource and the resource name should not contain any of the
keywords or other reserved words listed in TIBCO BusinessEvents Architect’s Guide.

4. For HTTP channels only, in the serverType field of the Extended Configuration section, TOMCAT
is preselected as the server type and cannot be changed.

5. If you selected Resource in the Method of Configuration field, in the Resource field click Browse
and select the shared resource you want to use.

6. If you are configuring an HTTP channel, click Advanced and configure tuning properties.

7. Continue to the section Adding a Destination to a Channel and add destinations to the channel as
needed.

57

TIBCO BusinessEvents® Developer's Guide



Communicating with Other Sources using TCP

In addition to Channels, TIBCO BusinessEvents can also communicate with other data sources using
TCP. You can create a local TCP server and a TCP client so that TIBCO BusinessEvents can
communicate with data sources not otherwise available through channels, using TCP.

TCP communication is available as a Communication Built-in Function in the Catalog Functions view.
Using this set of functions you do the following to communicate with TCP servers:

Procedure

1. Create a local TCP server in a startup function using TCP.createLocalServer().

2. Connect to a Remote TCP server as a client using.

3. TCP.connectToRemoteServer().

4. Register the session listener using TCP.registerSessionListener() .

5. Start the local server using TCP.startLocalServer().

6. Create callback rule functions and register them as callbacks to the TCP listeners. These callback
rule functions create events that are sent to an appropriate destination.
TCP.readIntoPayload(SessionName)

Example TCP Rule Function to Start a Local TCP Server
Here is a sample rule function to start a local TCP server:
void rulefunction RuleFunctions.InitTCPServers {
   attribute {
      validity = ACTION;
   }
   scope {
   }
   body {
      System.debugOut( "Initializing TCP servers" ) ;
      try {
         TCP.createLocalServer("MyTCPServer", "localhost", 
            System.getGlobalVariableAsInt("NSN/SocketAdaptor/Port", 8055));
            TCP.registerSessionListener("MyTCPServer",             "/RuleFunctions/
RawCDRCallback");
         TCP.startLocalServer("MyTCPServer");
         } catch (Exception ex) {
            System.debugOut("Exception occurred while initializing TCP server: " +
               ex@message);
         }
         System.debugOut("TCP server initialization done");
      }
   }

Example TCP Rule Function to Connect to a Remote TCP Server
Here is a sample rule function to connect to a remote TCP server as a client:
Events.RemoteMsgResponseEvent rulefunction RuleFunctions.RemoteTCPSender {
   attribute {
      validity = ACTION;
   }
   scope {
      String host;
      int port;
      String message;
   }
   body {
      String tcpNickName = "TCP-" + host + "-" + port + "-"
         + uri + "-" + closure + "-" + System.nanoTime();
      Events.RemoteMsgRequestEvent requestEvent =
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         Events.RemoteMsgRequestEvent.RemoteMsgRequestEvent(null, message);
      TCP.connectToRemoteServer(tcpNickName, host, port);
      TCP.write(tcpNickName, requestEvent);
      TCP.endWrite(tcpNickName);
      Events.RemoteMsgResponseEvent responseEvent =
         TCP.readIntoPayloadFully(tcpNickName,
         "/Events/RemoteMsgResponseEvent");
      TCP.disconnectFromRemoteServer(tcpNickName);
      return responseEvent;
   }
}

APIs for TCP Communication
The Catalog Functions view lists the following functions (APIs) for TCP communication:

● connectToRemoteServer()

● createLocalServer()

● disconnectFromRemoteServer()

● disconnectLocalSession()

● endRead()

● endWrite()

● readIntoPayload()

● readIntoPayloadFully()

● registerSessionListener()

● startLocalServer()

● stopLocalServer()

● write()

● Advanced

— getReaderInputStream()

— readIntoByteArray()

Documentation for functions is provided in the tooltips you can see when browsing the functions in
TIBCO BusinessEvents Studio. You can also see this documentation in the TIBCO BusinessEvents
Functions Reference, available in the HTML product documentation.
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Channel Resource Reference

Channels allow TIBCO BusinessEvents to listen to and send out messages. Channels contain
destinations.

You can configure channels of different types, using the appropriate driver. See TIBCO BusinessEvents
Architect’s Guide.

To configure an HTTP channel resource, select an HTTP connection resource. No other channel
resource fields require configuration.

Local channels are in memory; information in a local channel could be lost if the TIBCO BusinessEvents
engine fails.

Wizard and Configuration Section
The Wizard and the Configuration section have the following fields.

Field

Glo
bal
Var
? Description

Name No (Shown in the Wizard and then in the editor title only.) The name to
appear as the label for the resource. Names follow Java variable naming
restrictions. Do not use any reserved words.

Description No Short description of the resource.

Driver No Select the driver for the type of channel you are configuring:

● TIBCO Rendezvous
● Local
● HTTP
● JMS
● ActiveSpaces
● Hawk
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Field

Glo
bal
Var
? Description

Method of
Configuration

No Properties  - Select Properties to configure this channel resource using
properties. See:

● Configuration for TIBCO Rendezvous Channels
● Configuration for JMS Channels
● Configuration for ActiveSpaces Channels

Resource - Select Resource if you have a shared resource in your project
whose properties you want to reuse for this channel.

Note: The path to the resource and the resource name cannot contain
any of the words listed in TIBCO BusinessEvents Architect’s Guide.

Resource No If you choose Resource as the method of configuration, the Resource
field appears. Browse to and select the resource you want to use. As a
convenience, you can open the selected resource by clicking the
underlined label.

Configuration for TIBCO Rendezvous Channels

Service Yes The name of the service or port number through which Rendezvous
sends messages. In most cases you can leave this field empty, accepting
the default value.

For more information about the Rendezvous service parameter, see
TIBCO Rendezvous Concepts or TIBCO Rendezvous Administration.

Default is 7500 (defined in Global Variables).

Network Yes The network over which Rendezvous sends messages. In most cases
you can leave this field empty. For more information about the network
parameter, see TIBCO Rendezvous Administration.

Default is an empty string (defined in Global Variables).

Daemon Yes The location of the Rendezvous daemon, which is usually expressed as
a client socket number, for example 6555. In most cases, you can leave
this field empty, accepting the default value. For more information
about the daemon parameter, see TIBCO Rendezvous Concepts.

Default is tcp:7500 (defined in Global Variables).

Configuration for JMS Channels

ProviderURL Yes The URL at which TIBCO BusinessEvents can contact the Enterprise
Message Service server.

Example: tcp://localhost:7222

UserName Yes A valid username for the Enterprise Message Service server.
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Field

Glo
bal
Var
? Description

Password Yes The password assigned to the username, above, for the purpose of
accessing the Enterprise Message Service server.

IsTransacted Yes Accepts true or false. Specify true if the session has transaction
semantics. Specify false if it has non-transaction semantics. For more
information about the IsTransacted property, see TIBCO Enterprise
Message Service documentation.

ClientID Yes The unique client ID of the connection.

Configuration for ActiveSpaces Channels

Metaspace Name No The name of a particular metaspace instance in TIBCO ActiveSpaces
that the channel must connect to.

The metaspace must be created and initialized before the channel can
use it at runtime.
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Field

Glo
bal
Var
? Description

Discovery URL No Specifies how a metaspace instance discovers the current metaspace
members. Multicast discovery can use either PGM - Pragmatic General
Multicast or RV - TIBCO Rendezvous protocol.

If using PGM protocol, the multicast URL is expressed in the following
format:

tibpgm://destination port/interface;discovery group

address/optional transport arguments, where

● destination port specifies the destination port used by the PGM
transport. If not specified, the default value of 7888 is used.

● interface;discovery group address specifies the address of the
interface to be used for sending discovery packets, and the discovery
group address to be used. If not specified, it defaults to the default
interface and discovery address, 0.0.0.0;239.8.8.8.

● optional transport arguments specifies a semicolon-separated
list of optional PGM transport arguments. By default, the PGM
transport is tuned to provide the best performance according to the
most common deployment architectures. The values of those
optional arguments should be changed only when necessary and
with care, since any inappropriate values could easily result in
degraded performance of the product.

If using TIBCO Rendezvous, the multicast URL is expressed in the
following format:

tibrv://service/network/daemon, where

● service specifies the TIBCO Rendezvous service number (UDP
port) that will be used. If not specified, the value defaults to 7889.

● network specifies the interface and discovery group address that
will be used to send Rendezvous discovery packets. The format is:
interface; discovery_group_address

If not specified, the default interface and discovery group address
will be used. (tibrv://7889/;239.8.8.9/).

● daemon specifies where to find the Rendezvous daemon. If not
specified, it will try to connect to a local daemon on port 7500.

ListenUrl No The discovery mechanism is based on pure TCP.

All the designated well known metaspace members are identified by an
IP address and a port number. This address and port are specified by
the member’s Listen URL.

If not specified, the discovery process uses the default IP address and
the first free TCP port that can be acquired from the operating system
(starting 5000 and above).
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Field

Glo
bal
Var
? Description

RemoteListenUrl No This field is used to configure TIBCO ActiveSpaces Channel as a
remote-discovery proxy. In this case, any remote client can connect to
an ActiveSpaces metaspace via the ActiveSpaces Channel node.

EnableSecurity No Enables security for the ActiveSpaces channel when selected.

Note: Some fields are activated only for the specific security role or
authorization polcy.

SecurityRole No Security role of a node for the secure ActiveSpaces channel in the
metaspace. The values are:

● Controller is dedicated to enforcing a security domain's defined
security behavior for a metaspace associated with the security
domain. Security domain controllers are the only discovery nodes in
a metaspace.

● Requestor just requires access to the data in the data grid, such as a
seeder or a leech, and which need to be authorized by a controller.
Requesters can never be used a discovery nodes.

The controller nodes are configured with a security policy file. The
requester nodes provide a token file and additional credentials to the
controller for authentication. The controller performs authentication as
defined in its policy file and using the credentials provided by the
requester.

If the Controller option is selected, then the following fields become
active:

● Identity Password
● PolicyFile

If the Requestor option is selected, then the following fields become
active:

● Identity Password
● TokenFile
● Credential

Identity
Password

No The password for the identity key in the security policy file.

PolicyFile No Absolute path to the policy file which contains the security settings that
the controller node enforces. It is generated using the as-admin utility.

TokenFile No Absolute path to the token file which is used by requestor to connect to
a metaspace whose security is defined in the policy file.
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Field

Glo
bal
Var
? Description

Credential No Authentication policy to be used for authentication as specified in the
policy file. The values are:

● USERPWD - A user name and password based authentication is used.
It activates the following fields:

— Domain
— Username
— Password

● X509V3 - The authentication source is an LDAP configured with
certificate based authentication. It activates the following fields:

— KeyFile
— PrivateKey

Domain No Domain name for system based user authentication.

Username No User name for LDAP and system based authentication.

Password No Password for LDAP and system based authentication.

KeyFile No The absolute path for a file containing the key to use for LDAP with the
certificate based authentication.

PrivateKey No The password for the identity key in the LDAP identity file specified in
KeyFile
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Destination Resource Reference

Within each channel, destinations direct incoming and outgoing information. A channel resource is not
ready to use until it has at least one destination.

The Destinations section of a channel has the following fields.

Field
Global
Var? Description

Name No The name to appear as the label for the resource. Names follow Java
variable naming restrictions. Do not use any reserved words.

Description No Short description of the resource.

Default Event No The event to be created from incoming messages unless otherwise
specified. As a convenience, you can open the selected event resource
by clicking the underlined label.

Optional, but only if you always specify an event type in the incoming
message.

Not used for local channel.

Serializer/
Deserializer

No Specify a serializer class to convert messages to simple events and
simple events to messages.

Configuration for TIBCO Rendezvous Destinations

See TIBCO Rendezvous documentation for more details on these settings.

Subject Yes The TIBCO Rendezvous subject for incoming and outgoing messages.

RVCM Pre
Registration

Yes For TIBCO Rendezvous certified message publishers, specify pre-
registered listener names as a comma separated list.

LimitPolicy Yes How you want the Rendezvous listener to behave when it receives
more messages than the MaxEvents limit. Choose one of:

Discard_None (default)

Discard_First

Discard_Last

Discard_New

When MaxEvents or DiscardAmount are zero (unlimited), the
LimitPolicy must be Discard_None.

MaxEvents No Maximum number of message events that the queue can hold.

The default value, zero (0) means an unlimited number of events.
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Field
Global
Var? Description

DiscardAmount No The number of events to discard when the queue exceeds its
maximum event limit.

The default value, zero (0) means events are never discarded.

Configuration for JMS Destinations

See TIBCO Enterprise Message Service documentation for more detail on these settings.

Queue Yes Specifies whether the destination is a queue or a topic. Check the
checkbox if the destination is a queue. If the destination is a topic, do
not check it.

Name Yes Required. The name of the queue or topic.

(TIBCO BusinessEvents ignores JMS destinations with null or empty-
string queue or topic names. It logs an error message for the ignored
destinations. If a JMS message is sent out through an ignored
destination, TIBCO BusinessEvents throws an exception and the
message is not sent out. TIBCO BusinessEvents also does not receive
JMS messages (events) through these ignored destinations.)

Selector Yes Specifies a filter to pick up messages from the destination. This is a
standard JMS selector based on SQL92 semantics.

DeliveryMode No The delivery mode property instructs the server concerning persistent
storage for the message. Select one of the following:

PERSISTENT (default) — In JMS message headers this is represented
by the code 2.

NON-PERSISTENT — In JMS message headers this is represented by
the code 1.

RELIABLE — This value is an extension to the standard, used in
TIBCO Enterprise Message Service. In message headers this is
represented by the code 22.

You can also set a delivery mode in an event.

AckMode No The acknowledgement mode. See JMS Message Acknowledgement
Mode for a table explaining the various modes.

You can also set an acknowledgement mode in a node’s engine
properties. The setting in the destination overrides the engine property
setting.

Default is EXPLICIT_CLIENT_ACKNOWLEDGE

Priority No The message priority. Takes a numerical value between 0 and 9. Larger
numbers represent higher priority.

You can also set a priority in an event.

Default is 4
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Field
Global
Var? Description

TTL No The length of time that the message will live (in milliseconds) before
expiration. If set to 0, the message does not expire.

You can also set a TTL (JMSExpiration) in an event.

Default is 0

Durable
Subscriber
Name

Yes For destinations that are JMS Topics, if you provide a
DurableSubscriber Name, the destination becomes a JMS durable topic
subscriber with the specified name. If you do not provide a value, the
destination becomes a non-durable topic subscriber.

The value of this property can be any unique string and can include
any global variables. TIBCO BusinessEvents provides a set of case-
sensitive variables that produce a unique DurableSubscriberName
string.

Default is: %%EngineName%%:%%SessionName%%:%%ChannelURI%%:%
%DestinationName%%

Configuration for Local Destinations

Local destinations do not use serializers, deserializers, or default events.

Size No The maximum number of events to be held in the queue. The default is
zero (0), which allows unlimited events in the queue.

TimeOut No Time to wait when sending an event to this local destination:

-1  Waits indefinitely
 0  Does not wait
>0  Waits for the number of milliseconds specified

Default is -1.

Configuration for HTTP Destinations

Is Page Flow No Enables Action Rule Function based approach. If checked, the system
disables the Default Event and Serializer/Deserializer fields for input.

ContextPath No Context URI for the web application. The field is active for input if the
Is Page Flow checkbox is checked.

Action Rule
Function

No The Action Rule function to be executed when an HTTP message
arrives at the context URI for the web application. The field is active
for input if the Is Page Flow checkbox is checked.
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Working with JMS Channels

This chapter provides additional information about working with JMS channels.

Selecting a JMS Serializer
When working with the JMS channels, choose the serializer that handles the JMS message types that
will be sent to the destination you are configuring.

Which Serializers to Use for JMS Message Types

Message Type

BytesMessage
Serializer/

UtfBytesMessag
e Serializer

TextMessa
ge
Serializer MessageWithNoBody (1)

Message Supported Supported Supported

BytesMessage Supported (N/A) Supported

MapMessage Supported Supported Supported

ObjectMessage Not Supported Not
Supported

Not Supported

StreamMessage Not Supported Not
Supported

Not Supported

TextMessage (N/A) Supported Supported

(1) MessageWithNoBody corresponds to the BasicMessageSerializer option in TIBCO
BusinessEvents Studio.

For MapMessage messages, you create properties whose names match the message keys.

Payload Handling
All serializers support reading and writing application header properties and JMS header properties.

The difference between the serializers is in how they handle payloads.

BytesMessageSerializer
The BytesMessageSerializer decodes the body as a sequence of bytes and parses them to create an
XML structure according to the payload definition in the event.
The BytesMessageSerializer is used to receive JMS messages coming in as a stream of uninterrupted
bytes in the message body.
Typically, BytesMessageSerializer is a low level serializer and can have performance implications.
Choose the serializer for a defined message type (MapMessage, TextMessage, and so on) that most
closely matches the expected usage.
For incoming messages of type JMS BytesMessage, the serializer converts the message bodies to event
payloads. The payloads are XML String type, but are not human-readable. However, you can access
them using XPath functions. For outgoing events, the serializer converts XML payloads to JMS
BytesMessage message bodies.
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The BytesMessageSerializer class is the default serializer.

UtfBytesMessageSerializer
The UtfBytesMessageSerializer is similar to the BytesMessageSerializer except that it serializes the
payload using writeUTF() instead of writeBytes(), and deserializes the payload using readUTF()
instead of readBytes().
For outgoing events, the serializer converts XML payloads to JMS BytesMessage message bodies.

TextMessageSerializer
The TextMessageSerializer decodes the text from the message as an XML string.
For incoming messages, the TextMessageSerializer serializer converts JMS TextMessage mes using
XPath functions. For outgoing events, the serializer converts XML payloads to JMS TextMessage
messages.

MessageWithNoBody
The MessageWithNoBody serializer does not serialize or deserialize the payload.
This serializer corresponds to the BasicMessageSerializer option in TIBCO BusinessEvents Studio.
For outgoing events, the serializer converts the payload to messages of type Message.

See JMS Header Properties in Incoming and Outgoing Messages in TIBCO BusinessEvents Developer’s
Guide.

Creating Unique JMS DurableSubscriber Name Properties
For destinations that are JMS Topics, if you provide a DurableSubscriber Name when you configure
the destination resource, the destination becomes a JMS durable topic subscriber with the specified
name. This section explains how you can ensure that the DurableSubscriber Name value is unique.

● When using topic destination with a durable name in applications using In Memory OM and fault
tolerance, do not provide a value for the Client ID setting and do not check the Auto-generate Client
ID check box in the JMS shared resource.

● Do not use durable topic destinations for multi-agent applications, even when only one agent
instance is active at a time (that is, even when Agent Classes > AgentClassName > Max Active is set
to 1). Instead, use queue destinations.

The value of the DurableSubscriber Name property can be any unique string and can include any
global variables. TIBCO BusinessEvents provides a set of case-variables that produce a unique
DurableSubscriberName string:
%%Deployment%%:%%EngineName%%:%%SessionName%%:%%ChannelURI%%:%%DestinationName%%

The first variable %%Deployment%% is a standard TIBCO global variable. The other three are only for
use with the DurableSubscriberName property within TIBCO BusinessEvents. For details see 
Variables to Use with DurableSubscriberName.
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Variables to Use with DurableSubscriberName
Do not attempt to use %%EngineName%%, %%SessionName%%, %%ChannelURI%%, or %%DestinationURI%%
in any area of TIBCO BusinessEvents software except the DurableSubscriberName property.

DurableSubscriberName Variables

Variable Description

%%EngineName%% The name of the TIBCO BusinessEvents engine. The name used
is established using a series of checks. See Determining the
Engine Name in TIBCO BusinessEvents Administration for
details.

%%SessionName%% The name of the agent class that is associated with the durable
subscriber. Agent classes are defined in the CDD resource. See
Collections, Agent Classes, and Processing Units in TIBCO
BusinessEvents Configuration Guide for details.

%%ChannelURI%% The path to the channel within the TIBCO BusinessEvents
project:
/folder/.../channel_name

%%DestinationName%% The name of the TIBCO BusinessEvents destination, within the
channel specified in %%ChannelURI%%.

Setting the JMS Message Acknowledgement Mode
JMS channels support connection to TIBCO Enterprise Message Service destinations. The default
acknowledgement mode is EXPLICIT.

You can set the acknowledgement mode either of these two ways:

● In the AckMode field of a destination resource.
● Using a configuration property.

The destination setting overrides the property setting. To set the acknowledgement mode using a
configuration property, use one of the following, depending on whether you are using topics or queues:
be.channel.tibjms.topic.ack.mode acknowledgement_mode_number
be.channel.tibjms.queue.ack.mode acknowledgement_mode_number

Where acknowledgement_mode_number is one of the numbers that represent an acknowledgement
mode, as shown in Table 12.

Note that in TIBCO Enterprise Message Service, mode names are slightly different. They are prefixed
with TIBEMS-. See TIBCO Enterprise Message Service User’s Guide for more details.

JMS Message Acknowledgement Modes

No. Mode Description

1 AUTO_ACKNOWLEDGE

Specifies that the session is to automatically acknowledge consumer receipt of
messages when message processing has finished.
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No. Mode Description

2 CLIENT_ACKNOWLEDGE

Specifies that the consumer is to acknowledge all messages that have been delivered
so far by the session. When using this mode, it is possible for a consumer to fall
behind in its message processing and build up a large number of unacknowledged
messages.

See Using CLIENT_ACKNOWLEDGE Mode with Websphere MQ and Cache-Aside
for required configuration for Websphere MQ when cache-aside database write
strategy is used.

3 DUPS_OK_ACKNOWLEDGE

Specifies that the session is to lazily acknowledge the delivery of messages to the
consumer. “Lazy” means that the consumer can delay acknowledgement of
messages to the server until a convenient time; meanwhile the server might
redeliver messages. This mode reduces session overhead. However, should JMS fail,
the consumer may receive duplicate messages.

23 EXPLICIT_CLIENT_ACKNOWLEDGE (TIBCO Proprietary)

TIBCO Enterprise Message Service extension to JMS acknowledge modes.

This is the default.

EXPLICIT_CLIENT_ACKNOWLEDGE is like CLIENT_ACKNOWLEDGE except it
acknowledges only the individual message, rather than all messages received so far
on the session.

One example of when EXPLICIT_CLIENT_ACKNOWLEDGE would be used is when
receiving messages and putting the information in a database. If the database insert
operation is slow, you may want to use multiple application threads all doing
simultaneous inserts. As each thread finishes its insert, it can use
EXPLICIT_CLIENT_ACKNOWLEDGE to acknowledge only the message that it is
currently working on.

24 EXPLICIT_CLIENT_DUPS_OK_ACKNOWLEDGE (TIBCO Proprietary)

TIBCO Enterprise Message Service extension to JMS acknowledge modes.

EXPLICIT_CLIENT_DUPS_OK_ACKNOWLEDGE mode is like TIBEMS-DUPS-OK-
ACKNOWLEDGE except it "lazily" acknowledges only the individual message, rather
than all messages received so far on the session.

22 NO_ACKNOWLEDGE (TIBCO Proprietary)
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No. Mode Description

TIBCO Enterprise Message Service extension to JMS acknowledge modes.

Suppresses the acknowledgement of received messages. After the server sends a
message to the client, all information regarding that message for that consumer is
eliminated from the server. Therefore, there is no need for the client application to
send an acknowledgement to the server about the received message. Not sending
acknowledgements decreases the message traffic and saves time for the receiver,
therefore allowing better utilization of system resources.

Note
 Sessions created in NO_ACKNOWLEDGE receipt mode cannot be used to create
durable subscribers.

Note
 Also, queue receivers on a queue that is routed from another server are not
permitted to specify NO_ACKNOWLEDGE mode.

Using CLIENT_ACKNOWLEDGE Mode with Websphere MQ and Cache-Aside
The cache-aside database write strategy is multi-threaded. However, when Websphere MQ messages
are sent using CLIENT_ACKNOWLEDGE_MODE, each message must be handled from start to finish using a
single thread. To address this issue do the following:

Procedure

1. Define the destination using Caller’s Thread in the Threading Model setting (in the CDD Collections
tab or Agent Classes tab).

2. To ensure sequential operations set the following property in the CDD file at the appropriate level:
   Agent.agentClassName.enableParallelOps=false

Setting this property to false means that all post-RTC operations are done on a single thread.

When JMS Messages are Acknowledged
When TIBCO BusinessEvents acknowledges JMS messages depends on the JMS acknowledgement
mode, time to live (TTL) setting, and object management (OM) type, as shown in the table below.

When JMS Messages are Acknowledged

JMS Acknowledgement Mode OM Type Acknowledged

AUTO_ACKNOWLEDGE
DUPS_OK_ACKNOWLEDGE

On receipt

NO_ACKNOWLEDGE Never

CLIENT_ACKNOWLEDGE
EXPLICIT_CLIENT_ACKNOWLEDGE 
EXPLICIT_CLIENT_DUPS_OK_ACKNOWL
EDGE

Cache Post RTC

In
Memory

When retracted (when the event is deleted
(using the Event.consumeEvent function) or
when the event reaches the end of its time to
live (TTL) period.
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For more details about message acknowledgment with Cache OM, see Post-RTC and Epilog Handling
and Tuning Options in TIBCO BusinessEvents Architect’s Guide.

Using JMS Header Properties in Incoming and Outgoing Messages
Information in this section assumes you are familiar with JMS and its header properties. Consult your
JMS provider documentation for information. This section explains only how TIBCO BusinessEvents
supports use of these properties.

Setting Certain Header Properties in Destinations
In the JMS destination Configuration section, you configure the following three header properties:

● DeliveryMode (JMSDeliveryMode)

● Priority (JMSPriority)

● TTL (JMSExpiration)

JMS header properties defined in events take precedence over properties defined in
destinations.

Setting Header Properties Using Header Properties from Incoming JMS Messages
You can configure events created from incoming JMS messages to have properties that match the JMS
header properties. You can then use those event properties to set JMS header properties in outgoing
messages.

These event properties must match the JMS header fields. You must use the names as shown in JMS
Header Field Names. You only have to configure event properties for those fields that you want to use.
Incoming JMS message header properties will then populate the corresponding TIBCO BusinessEvents
event properties.

Setting JMS Header Properties in Outgoing JMS Messages Using Event Properties
Similarly outgoing JMS message header properties will be populated by the corresponding TIBCO
BusinessEvents event properties.

Note that the JMSMessageID and JMSTimeStamp properties are generated when the message is sent.
You cannot set these properties manually.

See How TIBCO BusinessEvents Sets the JMSReplyTo Header in Outgoing Messages for special
handling of the JMSReplyTo header.

JMS header properties defined in events take precedence over properties defined in destinations.

You can add the JMS properties to the Base event in your project so that the properties are inherited by
all other events.

See JMS Header Field Names for details on all properties.

How TIBCO BusinessEvents Sets the JMSReplyTo Header in Outgoing Messages

TIBCO BusinessEvents cannot act as a client in a JMS request-response scenario because TIBCO
BusinessEvents currently cannot dynamically create a destination to listen for JMS messages.

If an event has a string type property named JMSReplyTo (case sensitive), TIBCO BusinessEvents reads
this event property value as a JMS queue or topic name, according to the event's default destination
type. TIBCO BusinessEvents looks up the javax.jms.Destination on the connected JMS server using
this queue or topic name. If TIBCO BusinessEvents cannot find one, it creates a new
javax.jms.Destination using the given queue or topic name. TIBCO BusinessEvents then sets the
JMSReplyTo header property of the outgoing JMS message using this destination
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If you use the catalog function Event.replyEvent(requestEvent, replyEvent) during the RTC in
which the requestevent is received, then the replyevent is sent to the destination in the JMSReplyTo
header property of the JMS message associated with the requestevent.

JMS Header Field Names
The table below shows the names you must use to define event properties corresponding to JMS header
field names, as well as some details about the purpose of each property. The property names are not
case sensitive.

You can use global variables in all the advanced properties. For more details, see Global Variables.

JMS Header Field Names

Field name Type Description

JMSDestination Object The destination (queue or topic) to which the message is
sent.

JMSDeliveryMode Integer The delivery mode specified by the sender. This property
instructs the server concerning persistent storage for the
message. Value can be:

2 — interpreted as PERSISTENT (default).

1 — interpreted as NON-PERSISTENT.

22 — interpreted as RELIABLE. This value is an
extension to the standard used in TIBCO Enterprise
Message Service.

The integer values are interpreted as the text names of
delivery modes.

You can also set a delivery mode for a destination. See 
Setting Certain Header Properties in Destinations .

JMSExpiration Long The length of time that the message will live (in
milliseconds) before expiration. If set to 0, the message
does not expire.

You can also set an expiration (TTL) for a destination. See 
Setting Certain Header Properties in Destinations .

JMSPriority Integer The message priority, a numerical value between 0 and 9.
Larger numbers represent higher priority.

You can also set a priority for a destination. See Setting
Certain Header Properties in Destinations .

JMSMessageID String An ID that uniquely identifies each message sent by a
provider.

A generated value overrides any value set in the
corresponding event property.

75

TIBCO BusinessEvents® Developer's Guide



Field name Type Description

JMSTimestamp Long The time when the message was handed off to a provider
to be sent. The message may be sent later than this
timestamp value.

A generated value overrides any value set in the
corresponding event property.

JMSCorrelationID String A correlation ID that can be used to link messages. For
example, you can link a response message to a request
message. Optional.

JMSReplyTo String Name of the JMS destination (queue or topic) to send the
message reply to. If null, TIBCO BusinessEvents does not
set the outgoing message’s property.

Optional.

Note
: Do not set the value to an empty string (""). If you do,
TIBCO BusinessEvents sets the queue or topic name to
an empty string which creates an exception, and the
message is not sent.

See How TIBCO BusinessEvents Sets the JMSReplyTo
Header in Outgoing Messages .

JMSType String The message type identifier, if used by the provider.

JMSRedelivered Boolean If this field is set, it is possible that the message was
delivered to the client earlier, but not acknowledged at
that time.

SOAP over JMS Support in WSDL Import and Export
SOAP and JMS are supported in WSDL Import and Export for events, channels, rules, rulefunctions
and catalog functions.

WSDL Import

The WSDL Import wizard generates resources for handling SOAP and JMS bindings.

Events

One Event type named /Events/SoapJms. This event inherits from SOAPEvent and provides a set of
properties that may be useful for SOAP and JMS. Events are operation specific events and they are
imported similiarly as for the SOAP and HTTP WSDL Import.

Channels

A JMS channel by default is located at /Channels/SoapJms for each different set of parameters, with
one shared JMS connection resource.

By default the resource is in the Transport folder of the imported service folder. One destinations for
each different set of destination parameters is designated.

By default the destination is named destinationName, which uses the serializerSoapMessageSerializer
and the default event type /Event/SoapJms. See the RegisterSoapEventUris function below, which
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allows the deserialer know how to deserialize message into operation specific events instead of using
the destination default.

Rules

There is one rule for each operation, which is imported similarly as for the SOAP and HTTP WSDL
Import.

By default, the rule replies with a SOAP fault stating that the operation is not implemented.

RuleFunctions

There is one RuleFunction for each operation, which is imported similarly as for the SOAP and HTTP
WSDL Import.

If desired, the RuleFunction can be used as a preprocessor function.

The one RuleFunction is named, RegisterSoapEventUris.

By default, it is avaialbe in the Transport folder of the imported service folder. This registers in the JMS
SoapMessageSerializer, and event type for each operation that is reachable by a SOAP and JMS
binding. It should be invoked as a startup function.

Catalog Functions

A serializer and deserializer for SOAP and JMS has been added to the JMS destinations. This serializer
handles the conversion between the JMS messages and SoapEvent events. Two help catalog functions
are provided as well:

Catalog Function Description

SOAP.registerEventUri() Voids registerEventUri(String event Uri, String
destinationUri, String serviceName, String
soapAction, String Preprocessor)

Associates an event type to a given input
destination, target service, and SOAP action.
This is used by the SOAP and JMS deserializer to
generate events of specific types (eventUri)
instead of using the default event type
resolution mechanism.

● eventUri: String path of an event type in the
project.

● destinationUri: String path of the TIBCO
BusinessEvent destination receiving the
message. If this is empty, it matches all of the
destinations.

● serviceName: String name of the target
service declared in the message received. If
this is empty, it matches all of the service
names.

● soapAction: String value of the soapAction
parameter in the message received.

● Preprocessor: String path of the preprocessor
in the project.
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SOAP.newCorrelationId() String newCorrelationId(String
responseEventUri)

Creates a new correlation ID for use when
sending a message in a request and response
case. This is used by the SOAP and JMS
deserializer to generate a response event of a
specific type, instead of using the default event
type resolution mechanism.

● responseEventUri: String path of an event
type in the project.

● returns: String correlation ID.

In the context of TIBCO BusinessEvents, the two tasks of a message serializer are deserialization from
the transport-level message to an event and serialization from an event to the transport-level message.

WSDL Export

The WSDL Export was implemented to support SOAP and JMS, but it has some limitations. The
following include its limitations:

1. It uses the TIBCO format and not W3C.

2. It relies on the presence of an event registration start up function with a body that looks like
something that is generated during WSDL Import.

3. It relies on a folder structure that is similiar to what is generated during import.

4. It does not export all of the possible information, for example, the reply-to names.

The import of a WSDL, then an export to another WSDL should result in similiar WSDLs, though not
identical.
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Working with HTTP Channels

Working with HTTP channels allows you to add an HTTP connection, add a destination, create events,
configure rules, set up fault tolerance, and create resources to work with SOAP and a WSDL File.

Before you can configure TIBCO BusinessEvents to receive and send HTTP requests, ensure the
following:

● Configure proxy for both SSL and non-SSL so that the end target servers can be routed through the
proxy. Do not interpret that authentication at any level is supported.

● Use catalog functions ending with ViaProxy.

● Create a connectioninfo object and pass it through the HTTP function.

Once HTTP.ConnectionInfo is created, pass the object through the HTTP.sendRequest() method.

SOAP Channels
An HTTP channel is an internal HTTP server. When the TIBCO BusinessEvents engine starts, it starts
the internal HTTP server, which listens to the requests on the port specified in the HTTP Connection
resource.

SOAP version 1.1 is supported. TIBCO BusinessEvents supports only document/literal type of encoding
of SOAP requests.

A SOAP event is an extension of a SimpleEvent. To create a SOAP event, you create a SimpleEvent that
inherits from a SOAPEvent. This creates a default schema in the event payload. Then you edit the
schema and introduce header and body elements as necessary.

Using an HTTP channel and a destination configured to use the SOAP serializer and deserializer,
TIBCO BusinessEvents can act as a web services platform that sends and receives SOAP requests, and
performs whatever operations are provided by the web service.

TIBCO BusinessEvents can import a WSDL file and create the required project artifacts based on it,
such as events, rules, rule functions, channels, and destinations. For more details, see Creating
Resources Using the WSDL Import Utility in

TIBCO BusinessEvents can also export a SOAP based rule function to a WSDL. The export utility scans
the project for rule functions that take a SOAP event as the input, and generates a WSDL operation for
each one. For more details, see TIBCO BusinessEvents Developer’s Guide, Exporting Resources as a WSDL
File.

See TIBCO BusinessEvents for SOAP Server and Client Configuration for more details.

Adding an HTTP Connection
Add an HTTP Connection resource to your project. In the Host and Port fields, specify the host and
port to which HTTP clients send requests.

In the Host field, enter the name or IP address of the machine running TIBCO BusinessEvents. This is
the HTTP server.

In the Port field, enter any available port on the host machine. This is the port on which the server
listens for HTTP requests.

To configure an HTTPS (Secure) Connection
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 Check the SSL checkbox, click the Configure SSL button, and complete the pop-up dialog settings.
The server must authenticate to the client. In the Identity field, provide the location of the Server
Identity File. (See For SSL Only — Add an Identity Resource).

In one-way SSL, the server authenticates itself to the client using a Server Identity File, but the client
does not have to authenticate to the server.

In two-way SSL, the server authenticates itself to the client using a Server Identity File and the client
also authenticates to the server using the Client Identity file.

Check the Requires Client Authentication checkbox. This enables the Trusted Certificates Folder field,
where you provide the Client certificates.

Adding an Identity Resource — For SSL Only
TIBCO BusinessEvents supports use of an identity file for SSL. Before you configure the secure HTTP
connection, add an Identity resource to your project and configure it.

In the URL field, specify the project path of the keystore file, which must be within the project folders.

In the File Type field, specify the keystore file type, and in the Password field, provide the password for
the keystore file.

Adding an HTTP Channel
Add a channel to your project and configure it as follows:

1. At the New Channel Wizard, provide a name and description, and in the Driver field select HTTP.
Click Finish.

2. In the Channel editor Channel tab, update the description as desired. The Driver field is set to HTTP
(as set in the wizard). The Method of Configuration is preset to Resource and cannot be changed.

3. In the Resource field, browse to the HTTP connection resource you configured in Add an HTTP
Connection.

4. Click Advanced, and configure run-time configuration properties. These properties provide
information such as the location of the document root folder. Some properties are for SSL
configuration of HTTP Component servers.

Adding a Destination
Add a destination to the channel in the usual way. The fields for destination differs based on different
approaches.

To follow the action rule function based approach
Select the Is Page Flow check box and specify the appropriate Context Path and Action Rule function
for the destination. Specify the context path in the same format as the server would receive the
requestURI in the HTTP request.

To follow the event based approach
In the Serializer field select the appropriate serializer:
com.tibco.cep.driver.http.serializer.RESTMessageSerializer

Specify the default event in the usual way as needed by your project requirements.

HTTP clients of the TIBCO BusinessEvents server would use the complete destination URI, after the
host and port for example, http://www.acme.com:5560/Transport/Channel/MyDestination.
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Creating Events as Needed and Setting Default Destinations
Skip this step for action rule function based approach.

In the event based approach
For receiving HTTP requests and sending responses, configure events in the usual way, and select an
HTTP-based destination as the default destination.

Configuring Rules and Rule Functions
Configure rules and rule functions according to your needs and HTTP request processing approach.

In the action rule function based approach
For example, in response to a POST request you might do the following:

● Create a servlet request object for the HTTP request using the catalog functions to extract data
from the HTTP request.

● Identify the POST request method from the HTTP request and process the parameters and data
extracted

● Create a response message to be used in preprocessor or rule or to be sent directly to the HTTP
client.

In the event based approach
For example, in response to a POST request you might do the following:

● Create a concept instance, using XPath functions to extract data from the POST data in the request
event payload

● Create a response event and use Event.replyEvent() to send back an empty response using the
request event’s default destination.

As another example, in response to a GET request you might do the following:

● Identify a concept instance using a property in the request event (created on arrival of the GET
request message).

● As needed, identify or generate data to return and create a response event to hold that data.

● Return the data using Event.replyEvent.

In the CDD Configure the Processing Unit
In the Cluster Deployment Descriptor (CDD) configure the processing unit for deployment as needed.

Working with HTTP Requests
An HTTP request is mapped to an event.

HTTP requests are parsed and executed using either of the following approaches:

Event based approach
HTTP request is mapped to an event using deserializer.

Action Rule Function based approach
HTTP request parameters and data are retrieved using HTTP catalog functions and processed using
rule function.
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The Is Page Flow parameter of the destination identifies the approach followed by destination for
processing HTTP requests. If the Is Page Flow parameter is set to true the HTTP request is
processed using the Action Rule Function based approach otherwise Event based approach is used.
This section explains the two different approaches for working with HTTP requests, and how to add
an HTTP channel and destination.

For instructions on setting up a channel, see TIBCO BusinessEvents Developer’s Guide, Adding a
Channel.

HTTP Requests and Events with the REST Serializer
RESTMessageSerializer, which is set while configuring the channel, maps HTTP requests to TIBCO
BusinessEvents.

HTTP headers and HTTP parameters in the GET method are mapped to similarly named event
properties. When both parameters and headers are specified, parameters take precedence.

Each HTTP Header consists of a name and field value, which are mapped into an event property name
and value. The POST data in the request must match with the payload as defined in the corresponding
event. If there is no payload defined for the event, the POST data is translated into a ByteArray
payload, and is not accessible via the mapper. In other words, only XML payloads are visible via the
mapper.

The transfer encoding (charset) in the Content-Type header indicates what type of transformation is
applied to the POST data (message body) to safely transfer content between sender and recipient. If the
Content-Type header is missing, UTF-8 is used as the default transfer encoding.

When you want the REST serializer to deserialize a GET request into an event with a payload, include
the _payload_ request parameter. The string value of the _payload_ parameter will always be used as
payload in the event.

Avoid sending long requests using GET. For large payload data requests, it is recommended to use the
POST method.

For HTTP responses, all event properties are translated to similarly named HTTP headers and the
payload is sent as HTTP content.

Sending Non-ASCII Content to Event Properties

The HTTP 1.1 specification states that only ASCII characters can be sent in HTTP headers.

To send non-ASCII event properties in GET methods, use HTTP parameters. HTTP parameters are
passed as the QueryString of the request URI, that is, the part of the URI that contains data to be
passed to web applications.

To decode the QueryString, use either the URI Encoding or the body encoding. The body encoding is
specified in the contentType HTTP header. Select either the URI Encoding or Use Body Encoding for
URI setting in the HTTP channel Advanced tab.

Mapping of HTTP Request URI to Destination

An HTTP request URI must map to a valid TIBCO BusinessEvents destination. If not, an error is
returned, and the message is discarded.

In the event based approach, once the destination is established, the HTTP message is converted either
into an event based upon _ns_/_nm_, or into the default event associated with this destination.

In this case TIBCO BusinessEvents server looks for the destination having the same URI as the
requestURI.

For example, the requestURI for the request https://localhost:7000/Transport/Channel/
StudentDestination is /Transport/Channel/StudentDestination. TIBCO BusinessEvents engine
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maps the request with a destination having URI /Transport/Channel/StudentDestination if it
exists.

Action Rule Function Based Approach
HTTP request can be processed in TIBCO BusinessEvents Studio without mapping to an event.

An HTTP request can be processed in two ways:

HTTP Request Processing

The TIBCO BusinessEvents server parses the HTTP request received from client. The server extracts the
request header and identifies the request URI of the request. The request URI should map to the context
specified in the destination defined for the channel. In this case TIBCO BusinessEvents server looks for
the destination having the same context path as the requestURI.

For example, the requestURI for the request https://localhost:7000/Transport/Channel/
StudentDestination is /Transport/Channel/StudentDestination. TIBCO BusinessEvents engine
maps the request with a destination having context path /Transport/Channel/StudentDestination
if it exists.

See Sample Code for Action Rule Function.

Deploying Multiple Web Applications

You can deploy multiple web applications on single channel. Specify the *.WAR file or a valid J2EE web
application folder under the Web Applications section in the advanced tab.Specify the context URI and
resource path for the web application. Resource path identifies the actual path of web application
resources. In case of a *.WAR file resource path is the location of the war file, and in case of the J2EE
web application folder the resource path is the location of the base folder of the web application.

Sample Code for Action Rule Function

Action rule function defined in the destination uses catalog functions to get required data and
parameters from the HTTP request. The rule function processes these parameters and creates a
response, similar to a preprocessor. TIBCO BusinessEvents supports all HTTP methods stated in the
HTTP 1.1 specification for Action Rule Function based approach.
void rulefunction RuleFunctions.Callback {
   attribute {
      validity = ACTION;
   }
   scope {
      Object asyncContextObject;
   }
   body {
      //getting servlet request and response objects
      Object servletRequest = HTTP.Servlet.getServletRequest(asyncContextObject);
      Object servletResponse = HTTP.Servlet.getServletResponse(asyncContextObject);
      System.debugOut("##Servlet request method : " + 
HTTP.Servlet.Request.getMethod(servletRequest));
      System.debugOut("##Servlet request content : " + 
HTTP.Servlet.Request.getRequestContent(servletRequest));
      System.debugOut("##Servlet request Requester Address : " + 
HTTP.Servlet.Request.getRequestorAddress(servletRequest));
      System.debugOut("##Servlet request Request URI : " + 
HTTP.Servlet.Request.getRequestURI(servletRequest));
      //getting parameters
      String[] params = HTTP.Servlet.Request.getRequestParameters(servletRequest);
      for(int i=0;i<params@length;i++)
      {
         System.debugOut("## Servlet request Parameters  :" + 
HTTP.Servlet.Request.getRequestParameter(servletRequest,params[i]));
      }
      //getting headers
      System.debugOut("## Servlet request Header Accept  : " + 
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HTTP.Servlet.Request.getRequestHeader(servletRequest,"Accept"));
      System.debugOut("## Servlet request Header Accept-Encoding  : " + 
HTTP.Servlet.Request.getRequestHeader(servletRequest,"Accept-Encoding"));
      System.debugOut("## Servlet request Header Accept-Language  : " + 
HTTP.Servlet.Request.getRequestHeader(servletRequest,"Accept-Language"));
      System.debugOut("## Servlet request Header Accept-Charset  : " + 
HTTP.Servlet.Request.getRequestHeader(servletRequest,"Accept-Charset"));
      System.debugOut("## Servlet request Header Connection  : " + 
HTTP.Servlet.Request.getRequestHeader(servletRequest,"Connection"));
      System.debugOut("## Servlet request Header User-Agent: " + 
HTTP.Servlet.Request.getRequestHeader(servletRequest,"User-Agent"));
      System.debugOut("## Servlet request Header Content-Length  : " + 
HTTP.Servlet.Request.getRequestHeader(servletRequest,"Content-Length"));
      System.debugOut("## Servlet request Header Content-Type  : " + 
HTTP.Servlet.Request.getRequestHeader(servletRequest,"Content-Type"));
      System.debugOut("## Servlet request Header Host  : " + 
HTTP.Servlet.Request.getRequestHeader(servletRequest,"Host"));
      HTTP.Servlet.Response.setResponseHeader(servletResponse, "Content-type", 
"text/plain");
      HTTP.Servlet.Response.setResponseContent(asyncContextObject, "response", 
true);
   }
}

Setting Up Fault Tolerance for the HTTP Channel
Use the Apache HTTP server (“httpd”) and mod_jk to setup fault tolerance to the TIBCO
BusinessEvents HTTP channel and a third party fronting server. These properties are used in addition
to sharing the cache server between the nodes in the cluster.

Procedure

1. Create two new property files with suitable names. For example, Ajp_1.properties and
Ajp_2.properties.

2. Add the ajp connector port property in the two newly created property files.
In Ajp_1.properties:
<channel path>.ajp.connector.port=8011

In Ajp_2.properties:
<channel path>.ajp.connector.port=8012

3. Specify the new property files as part of the TRA file of individual engines. Ensure that there is one
properties file per engine.
java.property.be.channel.external.config.file=<location of properties file>

For example,
java.property.be.channel.external.file=/tibco/app/conf/Ajp_1.properties

java.property.be.channel.external.file=/tibco/app/conf/Ajp_2.properties

4. Configure the Apache HTTP server (“httpd”) as a fronting webserver.
a) Add the worker.properties file in Apache httpd under the config folder.
b) Set the Apache http for load balancing in the worker.properties file.
c) Configure two workers to listen to the above specificed ajp ports.
d) Disable one worker (for example, worker 2) by default, so that no requests are sent to it.
e) Configure another worker (worker1), so that in case of a failure, it redirects all incoming requests

to the disabled worker (worker2).

The worker.propeties file should contain the following properties:
worker.list=balancer
worker.balancer.type=lb
worker.balancer.sticky_session=0
worker.balancer.balance_workers=worker1,worker2
worker.worker1.type=ajp13
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worker.worker1.host=localhost
worker.worker1.port=8011
worker.worker1.redirect=worker2
worker.worker2.type=ajp13
worker.worker2.host=localhost
worker.worker2.port=8012
worker.worker2.activation=disabled

Worker1, in case of a failure, now becomes the active worker.

5. Add Tomcat connectors mod_jk.so under the modules folder.

You can download mod_jk from the following location:

http://tomcat.apache.org/download-connectors.cgi

6. Configure Apache httpd to load this module.
a) Redirect all requests to the load balancer defined earlier.
b) Add the following snippet to httpd.conf, after completion of all the basic module load

statements:
LoadModulejk_modulemodules/mod_jk.so
<IfModule jk_module>
JkWorkersFile conf/worker.properties
JkLogFile logs/mod_jk.log
JkLogStampFormat "[%b %d %Y - %H:%M:%S] "
JkRequestLogFormat "%w %V %T"
JkLogLevel info
JkOptions +ForwardKeySize +ForwardURICompat -ForwardDirectories
<Location//WEB-INF/>
deny from all
</Location>
JkMount /* balancer
</IfModule>

7. Start Apache server; Start both the instances of be-engines running the HTTP based project.

8. Open the browser and client server.
a) Enter the url http://localhost/<context-path>, without any port.

The request is now routed to the active worker (worker1) only, since the other worker (worker2) is
disabled. You can verify through logs that logs are being created for one be-engine only.

9. Shutdown the active be-engine associated with the active worker (worker1).

All subsequent requests from the client now route to other worker (worker2). To verify, check the
logs in the corresponding be-engine instance.

HTTP Channel Advanced Configuration Settings
The following settings configure the internal Tomcat HTTP server used by the channel. They are set in
the Advanced tab of the HTTP channel resource editor.

You can use global variables in all the advanced properties. For more details, see Global Variables.

HTTP Channel Advanced Configuration Settings (Sheet of )

Property Notes

Server Type

The only server type in this release is TOMCAT

Debug Request Info
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Property Notes

Flag that identifies if the information is displayed for request debugging.

Access Log Valve

Enables access logging on HTTP channels.

In the advanced properties of the channel, if DebugRequestInfo is enabled, it
enables other two debug fields DebugLogFolder and DebugLogPattern.
DebugLogFolder specifies the location of generating the log file. Default is a new
logs folder in the currently running folder. It uses the default log pattern. You can
change the log pattern using Tomcat documentation.

Connection Timeout (msec)

The number of milliseconds the HTTP server waits after accepting a connection, for
the request URI line (that is, the first part of the request message) to be presented.

The value 0 means no timeout.

The default is 60000.

Accept Count

The maximum queue length for incoming connection requests when all request
processing threads are in use. Any requests received when the queue is full are
refused.

The value -1 means that a default of 10 is set.

The default is -1.

Socket Output Buffer Size

The size in bytes of the buffer to be provided for socket output buffering.

The value -1 means that the use of a buffer is disabled.

The default is 9000.

Max Processors

The maximum number of simultaneous requests that can be handled by the HTTP
server.

Set to one of these:

● A value of 10 or greater. Values of less than 10 are treated as 10.
● The value -1 which means that the value of 200 is used.

The default is -1.

Connection Linger

86

TIBCO BusinessEvents® Developer's Guide



Property Notes

The number of milliseconds during which the sockets used by the HTTP server
linger (that is, not complete immediately) when they are closed. Use of socket linger
allows time for a graceful shutdown sequence to complete.

To disable use of socket linger, set to -1.

The default is -1.

Enable DNS Lookups

Set to true if you want the calls to request.getRemoteHost() to perform DNS
lookups and return the actual host name of the remote client. Set to false to skip
the DNS lookup and return the IP address as a string instead (thereby improving
performance).

By default, DNS lookups are disabled.

TCP No Delay

If the checkbox is checked, the TCP_NO_DELAY option is not set on the server socket.

If the checkbox is checked, the TCP_NO_DELAY option is set on the server socket.
Using TCP_NO_DELAY improves performance under most circumstances.

The default is checked.

Compression

Compression can be used to save server bandwidth. Uses HTTP/1.1 GZIP
compression.

The compression option set here is used together with the MIME types shown in the
Compressible Mime Types setting. Allowable values are:

off
 Disables compression. Values in the Compressible Mime Types setting are
ignored.

on
 Enables compression

force
 Forces compression.

An integer
 Specifies a threshold amount of data above which output is compressed. The unit
is bytes. For example, if set to 2048 then any file above 2MB will be compressed. If
content length is unknown, the output is always compressed. Compression
applies to MIME types shown in the Compressible Mime Types setting that are
over the threshold (or unknown.

The default is off.

Use Body Encoding for URI
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Property Notes

If checked, the encoding specified in the contentType HTTP header is used to
decode the request URI.

If unchecked, the value in URI Encoding field (or its default value) is used.

If the URI Encoding setting is specified, then the Use Body Encoding for URI
checkbox is ignored.

For an example showing contentType, see Working with Outgoing SOAP
Messages (Event Payloads) .

The default is unchecked.

URI Encoding

Specifies the character encoding used to decode the request URI. If not specified,
UTF-8 is used.

If specified, the Use Body Encoding for URI setting is ignored.

The default is UTF-8.

Max KeepAlive Requests

The maximum number of HTTP requests that can be pipelined until the connection
is closed by the server.

A value of 1 disables HTTP/1.0 keep-alive, as well as HTTP/1.1 keep-alive and
pipelining.

A value of -1 allows an unlimited amount of pipelined or keep-alive HTTP requests.

The default value is -1.

Max HTTP Header Size

The maximum size of the request and response HTTP header, specified in bytes.

The default is 4096, that is 4 KB.

Max HTTP Post Size

The maximum size of the POST data, specified in bytes, which is handled by the
container FORM URL parameter parsing. You can disable the limit by setting this to
less than or equal to 0.

The default is 2097152, that is, 2 MB.

Max HTTP Save Post Size
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Property Notes

The maximum size of the POST data, specified in bytes, which is saved or buffered
by the container during FORM or CLIENT-CERT authentication. For both types of
authentication, the POST data is saved or buffered before the user is authenticated.

For CLIENT-CERT authentication, the POST data is buffered for the duration of the
SSL handshake and the buffer emptied when the request is processed.

For FORM authentication the POST is saved while the user is redirected to the login
form and is retained until the user successfully authenticates or the session
associated with the authentication request expires.

A value of -1 means no limit.

A value of 0 disables the saving of POST data during authentication.

The default is 4096, that is 4 KB.

Protocol

Specifies the HTTP protocol to use. Options are as follows:

http  HTTP protocol.

https  For secure communications (SSL).

memory  Memory protocol.

ajp  Apache JServ Protocol, a binary protocol.

Default is http.

Max Spare Threads

The maximum number of unused request processing threads that are allowed to
exist until the thread pool starts stopping the unnecessary threads.

The default is 50.

Min Spare Threads

The number of request processing threads that are created when this Connector is
first started. The connector also makes sure that it has the specified number of idle
processing threads available. Set this to a value smaller than that set for Max Spare
Threads.

The default is 4.

Compressible Mime Types

This is a comma-separated list of MIME types for which HTTP compression may be
used.

This setting works with the Compression setting See notes for that setting for more
details.

The default value is text/html,text/xml,text/plain.

Restricted User Agents
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Property Notes

Used to limit support to specific browsers and versions of specific browsers.
Comma-separated list containing one or more browser names, such as Mozilla,
Internet Explorer. Prepend version with a slash, for example, Mozilla/4.0.

Document Root

The absolute path where static HTML files are stored. The HTTP server retrieves
pages from this location. This setting is used by internal TIBCO BusinessEvents
applications and may have limited application for other purposes.

Tip
 To enable clients of a TIBCO BusinessEvents HTTP server to view the imported
concrete WSDL, provide the URL to the document root folder.

No default value.

Document Page

The name of the default static HTML file stored in the document root. This setting is
used by internal TIBCO BusinessEvents applications and may have limited
application for other purposes.

SSL Server: Key Manager Algorithm

The key manager algorithm for the SSL Service provider.

The default is SunX509.

SSL Server: Trust Manager Algorithm

The trust manager algorithm for the SSL Service provider.

Ensure that a provider is available for any algorithm other than PKIX.

The default is PKIX.

SSL Server: Protocols

The SSL protocols that can be enabled on the server. Add each protocol using a
comma-separated list.

The default protocols are the ones supported by the SSL Provider. (SSLv3 and
TLSv1 are the most widely supported.)

Leave blank to use the default protocols for your SSL provider.

SSL Server: Ciphers
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Property Notes

The cipher suites (SSL protocols) used by the server. Add each suite name on a
separate line.

The following cipher suites are supported:
SSL_RSA_WITH_RC4_128_MD5
SSL_RSA_WITH_RC4_128_SHA
TLS_RSA_WITH_AES_128_CBC_SHA
TLS_DHE_RSA_WITH_AES_128_CBC_SHA
TLS_DHE_DSS_WITH_AES_128_CBC_SHA
SSL_RSA_WITH_3DES_EDE_CBC_SHA
SSL_DHE_RSA_WITH_3DES_EDE_CBC_SHA
SSL_DHE_DSS_WITH_3DES_EDE_CBC_SHA
SSL_RSA_WITH_DES_CBC_SHA
SSL_DHE_RSA_WITH_DES_CBC_SHA
SSL_DHE_DSS_WITH_DES_CBC_SHA
SSL_RSA_EXPORT_WITH_RC4_40_MD5
SSL_RSA_EXPORT_WITH_DES40_CBC_SHA
SSL_DHE_RSA_EXPORT_WITH_DES40_CBC_SHA
SSL_DHE_DSS_EXPORT_WITH_DES40_CBC_SHA

Leave blank to use the default cipher suites for your SSL provider.

Defining Event Properties for Standard HTTP Header Properties
You need to define corresponding event properties for HTTP header names so that the header names
are mapped to the event properties at run time.

Standard HTTP header properties can have a dash (-) in their names. While defining the corresponding
event properties for such header properties, use an underscore character (_) instead of a dash(-). A dash
is not allowed in the event property names.

Following is the list of the HTTP header properties. In this a dash is replaced by an underscore while
converting from HTTP headers to Event Properties, and vice-versa.
accept-charset
accept-encoding
accept-language
accept-ranges
cache-control
content-type
if-match
if-modified-since
if-none-match
if-unmodified-since
max-forwards
proxy-authorization
user-agent
content-encoding
content-disposition
content-language
content-location
content-md5
content-range
last-modified
proxy-authenticate
retry-after
set-cookie
transfer-encoding
proxy-authenticate
retry-after
set-cookie
transfer-encoding
www-authenticate

Defining the HttpStatusCode property to the event properties explicitly sets the HTTP status code.
HttpStatusCode can be an integer or a string, and is not case-sensitive.
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HTTP Functions for HTTP Request Messages Configuration
This section explains how HTTP functions are used to send secure and non-secure HTTP requests to
other servers, and work with responses received.

HTTP functions are located in the HTTP section of the Standard function catalog.

For configuring SSL over HTTP when the Identity Resource is of the type Certificate/KeyURL, you
need to setup Native Tomcat libraries. See TIBCO BusinessEvents Installation guide.

Generating a Self-Signed SSL Certificate (Keystore)
HTTPS requires use of an SSL certificate. It creates a keystore file and password for the specified type of
SSL certificate (keystore).

It is not recommended for production to use self-signed certificates.

If you use trusted certificates, see Loading Trusted Certificates.

Signature

Object createKeystore(String ksFilePath, String ksType, String ksPassword)

Description

Creates and returns a keystore object, using the given parameters.

Parameters

Name Type Description

ksFilePath String The absolute path of the keystore file.

ksType String The type of keystore.

JKS and PKCS12 are supported.

ksPassword String Obfuscated password for the keystore.

Returns

Type Description

Object The keystore object

Getting POST Data

Signature

Object getPostData(SimpleEvent event)

Description

Returns the POST data sent in an HTTP POST request (event).
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Parameters

Name Type Description

event SimpleEvent Request event sent on the HTTP destination. Must
not be null.

Returns

Type Description

Object The POST data

Loading Trusted Certificates

As explained in Add an HTTP Connection, ensure that certificates from trusted certificate authorities
are stored in the project, using an Identity resource in the TIBCO Shared Resources folder. Alternatively
use the BE_GLOBAL_TRUSTED_CA_STORE global variable to store a location of the certificates outside of
the project.

Signature

Object loadTrustedCertificates(String trustedCertsFolder, String passwordToSet)

Description

HTTPS requires use of an SSL certificate. This function loads a trusted certificate (that is, creates and
returns a keystore object) from the trusted certificates folder.

Parameters

Name Type Description

trustedCertsFolder String The project path to the folder containing the
certificates.

If trusted certificates are stored outside the project,
use the following construct in the function:
System.getGlobalVariableAsString("BE_GLOBAL
_TRUSTED_CA_STORE")

passwordToSet String Obfuscated password for the keystore.

Returns

Type Description

Object The certificate’s keystore object
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Sending an Event
To send an event as a request encapsulating request headers as properties.

Signature

Event sendRequest(String url, SimpleEvent requestEvent, String responseEventURI, 
long timeoutMillis, Object httpConnectionInfo)

Description

This function sends an event as a response to the request.

You can disable the cookies using the disableCookies() function. To ensure that the entire message
along with the response header and the request body is sent at once, use
disableExpectContinueHeader().

Parameters

Name Type Description

url String The URL for the endpoint that will receive this
request.

requestEvent SimpleEvent The event to serialize and send to the server.

responseEventURI String The fully-qualified path of an event. This event is
created when the response is received.

timeoutMillis Long The timeout interval for the operation.

If the value is -1, the server waits forever.

httpConnectionInfo Object HTTP Connection Info object.

Returns

Type Description

Event An event as a response to the request

Sending an Asynchronous Request (Not Secure)
To send requests to an HTTP server asynchronously, use this function.

Signature

String sendAsynchronousRequest(String url, SimpleEvent requestEvent, String 
correlationId, String successCallbackRuleFunctionURL, String 
errorCallbackRuleFunctionURL, String methodType, Object httpConnectionInfo)

Description

Sends a request to the server specified by the url parameter. When TIBCO BusinessEvents receives a
response, the callback function is called.

Returns a correlation ID, which is either passed as input, or is generated from the server if the
parameter is null. This ID enables you to correlate a request with its response.
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You can disable the cookies using the disableCookies() function. To ensure that the entire message
along with the response header and the request body is sent at once, use
disableExpectContinueHeader().

For handling timeout case, you can set the java property com.tibco.be.http.client.socketTimeout
with the required timeout period.

Parameters

Name Type Description

url String The URL for the server that will receive this request.

requestEvent SimpleEvent The event to serialize and send to the server.

correlationID String An optional ID to correlate the request and the
response.

If not specified, the ID is generated by the server.

successCallbackRule
FunctionURL

String The fully-qualified path of a rule function to be
invoked for success case. This rule function is called
when a successful response is received. The response
event would contain the correlation ID.

The rule function must have correlation ID,
RequestEvent, and ResponseEvent as parameters.

errorCallbackRuleFu
nctionURL

String The fully-qualified path of a rule function to be called
in case of an error. This rule function is called when
the response received indicates an error. The
response event would contain the correlation ID.

The parameter can be null.

The rule function must have correlation ID,
RequestEvent, and ResponseEvent as parameters.

methodType String The HTTP method type. Valid values are: GET or
POST.

httpConnectionInfo Object HTTP Connection Info object.

Returns

Type Description

String A correlation ID

Sending a Secure Asynchronous Request
To send asynchronous requests using SSL, use this function.

Description

This function is the same as the sendAsynchronousRequest() function.
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For secure communication, use sendAsynchronousRequest() function along with the
setSecureInfo() catalog function with the addition of the SSL-related parameters shown below:
Object connectionInfo= HTTP.ConnectionInfo.createHTTPConnectionInfo(true);
HTTP.setSecureInfo(Object connectionInfo, String sslProtocol, Object 
clientIdKeyStore, String clientIdPassword, Object trustedCertsKeystore, String 
trustedCertsPassword, boolean verifyHostName)

For handling timeout case, you can set the java property com.tibco.be.http.client.socketTimeout
with the required timeout period.

Parameters

All of the parameters for sendAsynchronousRequest() plus the following:

Name Type Description

clientIdKeystore Object The keystore object for client identity.

clientIdPassword String Password for the client ID keystore.

trustedCertsKeystore Object Keystore Object for trusted certificates.

trustedCertsPassword String Password for the trusted certificates keystore.

verifyHostName Boolean Flag for checking if a host name matches the
names stored in the server’s certificates.

httpConnectionInfo Object HTTP Connection Info object.

Returns

Type Description

String A correlation ID

Sending a Secure Synchronous Request
To send synchronous requests using SSL, use this function.

Description

This function is the same as the sendRequest() function.

For secure communication, use sendRequest() function along with the setSecureInfo() catalog
function for SSL-related parameters :
Object connectionInfo= HTTP.ConnectionInfo.createHTTPConnectionInfo(true);
HTTP.setSecureInfo(Object connectionInfo, String sslProtocol, Object 
clientIdKeyStore, String clientIdPassword, Object trustedCertsKeystore, String 
trustedCertsPassword, boolean verifyHostName)

Parameters

Name Type Description

url String The URL for the server that will receive this
request.
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Name Type Description

requestEvent SimpleEvent The event to serialize and send to the server.

responseEventURI String The fully-qualified path of an event. This event
is created when the response is received.

clientIdKeystore Object The keystore object for client identity.

clientIdPassword String Password for the client ID keystore.

trustedCertsKeystore Object Keystore Object for trusted certificates.

trustedCertsPassword String Password for the trusted certificates keystore.

verifyHostName Boolean Flag for checking if a host name matches the
names stored in the server’s certificates.

timeoutMillis Long The timeout interval for the operation.

If the value is -1, the server waits forever.

httpConnectionInfo Object HTTP Connection Info object.

Returns

Type Description

Event An event as a response to the request

Sending a Request via Proxy Server
To send requests via a proxy server, use this function.

Signature

Object setProxy(Object connectionInfo, String proxyHost, int proxyPort)

Description

This function updates the HttpConnectionInfo object with the proxy server details.

For secure communication, use the function as follows for both Synchronous and Asynchronous
requests:
Object connectionInfo= HTTP.ConnectionInfo.createHTTPConnectionInfo(true);
HTTP.setSecureInfo(Object connectionInfo, String sslProtocol, Object 
clientIdKeyStore, String clientIdPassword, Object trustedCertsKeystore, String 
trustedCertsPassword, boolean verifyHostName)
HTTP.setProxy(Object connectionInfo, String proxyHost, int proxyPort)

Parameters

Name Type Description

connectionInfo Object HTTP Connection Info object.
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Name Type Description

proxyHost String Proxy host.

proxyPort Integer Proxy port.

Returns

Type Description

Object Connection info object.

SOAP Channels
An HTTP channel is an internal HTTP server. When the TIBCO BusinessEvents engine starts, it starts
the internal HTTP server, which listens to the requests on the port specified in the HTTP Connection
resource.

SOAP version 1.1 is supported. TIBCO BusinessEvents supports only document/literal type of encoding
of SOAP requests.

A SOAP event is an extension of a SimpleEvent. To create a SOAP event, you create a SimpleEvent that
inherits from a SOAPEvent. This creates a default schema in the event payload. Then you edit the
schema and introduce header and body elements as necessary.

Using an HTTP channel and a destination configured to use the SOAP serializer and deserializer,
TIBCO BusinessEvents can act as a web services platform that sends and receives SOAP requests, and
performs whatever operations are provided by the web service.

TIBCO BusinessEvents can import a WSDL file and create the required project artifacts based on it,
such as events, rules, rule functions, channels, and destinations. For more details, see Creating
Resources Using the WSDL Import Utility in

TIBCO BusinessEvents can also export a SOAP based rule function to a WSDL. The export utility scans
the project for rule functions that take a SOAP event as the input, and generates a WSDL operation for
each one. For more details, see TIBCO BusinessEvents Developer’s Guide, Exporting Resources as a WSDL
File.

See TIBCO BusinessEvents for SOAP Server and Client Configuration for more details.
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Configuring TIBCO BusinessEvents as a SOAP Server and
Client

Using an HTTP channel and a destination configured to use a SOAP Serializer, TIBCO BusinessEvents
can act as a web services platform, sending and receiving SOAP requests.

You can configure the project manually or you can use a WSDL import utility, which simplifies
configuration.

This release supports SOAP version 1.1. Some understanding of SOAP protocol is required in order to
work with this feature. See http://www.w3.org/TR/soap/ for details.

When TIBCO BusinessEvents acts as a web service server, clients of the service can view the exported
concrete WSDL for the web service using the URL to the document root folder. You must place the
WSDL file in that location.

Overview of SOAP Related Resources
Project resources must be configured so that TIBCO BusinessEvents can send and receive SOAP
messages.

The resources to configure are as follows:

SOAP Destinations
When a correctly configured HTTP destination receives a SOAP request, the SOAP serializer
deserializes the SOAP message to its corresponding event. That event has to be inherited from a
SOAPEvent. The event payload contains the SOAP envelope.

SOAP Events
To create a SOAP event, create a SimpleEvent that inherits a SOAPEvent. It makes event configuration
easier. Its payload has a message root element having an Envelope child element. The root element
contains Header and Body elements, and the Body element has a Fault element. You can further
configure these elements using the payload editor.
SOAP messages (and events) can have attachments.

For outbound SOAP events, ensure that the default destination is specified. If it is not specified, an
incorrect SOAP message, with “Message” as its root instead of “Envelope”, is sent out.

Also, ensure that the default destination for the SOAP event uses
com.tibco.cep.driver.http.serializer.SOAPMessageSerializer.

SOAP Encoding
Only the SOAP document/literal form of encoding is supported.

Rules and Rule Functions
A rule in the project accesses the SOAP event payload as needed using the mapper or SOAP catalog
functions. The rule puts the SOAP response into the payload of a SOAPEvent that is sent to the client.
The SOAP serializer sends the SOAP response to the client.

SOAP Catalog Functions
SOAP catalog functions enable you to access and process the contents of the following elements in the
event payload of an incoming SOAPEvent, and add elements to the outbound SOAPEvent:

● Header

● Body

● Fault
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● Attachment

Mapping of SOAP Request URI to Destination
For SOAP requests, the header property SOAPAction represents the destination name, and the
requestURI represents the channel URI. TIBCO BusinessEvents combines the SOAPAction and
requestURI to create a destination URI. It maps the request with a destination having same URI as
the newly created URI.
For example, if the requestURI of a request is /QueryBooks and the value of SOAPAcion is
QueryBooksByAuthor, then TIBCO BusinessEvents engine maps the request with a destination
having /QueryBooks/QueryBooksByAuthor URI if it exists.

Manually Creating Resources to Work with SOAP Services
This section explains how you can manually create and configure project resources to work with SOAP
services

The section Creating Resources Using the WSDL Import Utility explains how to use the WSDL import
feature to create the resources.

Procedure

1. Configure the HTTP Channel and SOAP Destination

Configure an HTTP channel, an HTTP connection resource for the channel. Connection
configuration is the same for SOAP and HTTP channels, except for the serializer. For SOAP
destinations, use the following serializer:

com.tibco.cep.driver.http.serializer.SOAPMessageSerializer

After you complete Add a SOAPEvent (and Other Ontology as Needed), set that SOAPEvent as the
default event for the destination.

2. Add a SOAPEvent (and Other Ontology as Needed)

Configure the SOAPEvents that will receive the SOAP requests and send out SOAP responses. Also
configure any other ontology as needed. SOAPEvent is an event type provided with TIBCO
BusinessEvents. However it is created in a two-step manner:
a) Add a simple event in the usual way.
b) In the Inherits From field, select SOAPEvent.
c) Set the default destination to the destination you created in Configure the HTTP Channel and

SOAP Destination.

The payload of a SOAPEvent is automatically configured with the structure of a SOAP message.
It has Header and Body elements, and within the Body element, a Fault element. You can further
configure the Header and Body elements using the payload editor.

3. Configure Rules and Rule Functions using SOAP Functions

In general the procedure of serving requests and sending requests to other servers is the same for
SOAP services as for other HTTP interactions. One rule function is used as the event preprocessor.

In addition, you must configure rules and rule functions to access information from the SOAP
messages in the inbound events, and to populate outbound events with SOAP message details. Set
two SOAPevents you configured in Add a SOAPEvent (and Other Ontology as Needed) as input
and return arguments of the preprocessor. See Parsing and Building SOAP Messages for details.

4. Configure an Event Preprocessor
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Open the project CDD for editing, and configure an event preprocessor for the destination you
configured in Configure the HTTP Channel and SOAP Destination. Use the rule function you
configured in Configure Rules and Rule Functions using SOAP Functions.

Creating Resources Using the WSDL Import Utility
WSDL (Web Services Description Language) is an XML format for describing web services as a set of
endpoints operating on messages containing either document-oriented or procedure-oriented
information.

● Only document style WSDLs with literal encoding are currently supported.
● Only In-Only and In-Out Message Exchange Patterns (MEPs) are currently supported.

TIBCO BusinessEvents can parse an imported WSDL file and create the required project artifacts based
on its contents: the channels and destinations (concrete WSDLS only), events, rules, and rule functions.

Both abstract and concrete WSDL files can be used. When you import an abstract WSDL, channel and
transport information is not available and you must create those resources manually. Concrete WSDLS
contain information that is used to create these resources automatically.

You then implement the newly created rules and rule functions to provide the expected behavior for
the web service described in the WSDL file.

Importing a WSDL File
First you must import the WSDL file into the project. Then you can use the WSDL import utility.

Procedure

1. Import the WSDL file into the project, as follows.
a) In Studio Explorer, right-click the project folder (or the project root) where you want to store the

WSDL file and select Import. You see the Import wizard.
b) At the Select dialog, select General > From File System . Click Next.
c) At the File system dialog, click Browse, select the directory that contains the WSDL file you want

to use, and click OK.
d) The File system dialog displays the directory in the left panel and its files in the right panel.

Check the checkbox to select the file you want to use. Click Finish.

The WSDL file is imported into the project.

2. Create project artifacts from the WSDL file as follows.
a) In Studio Explorer, right-click anywhere in the project and select Import. You see the Import

wizard.
b) At the Select dialog, select TIBCO BusinessEvents > WSDL . Click Next.
c) At the WSDL Import dialog, click Browse and select the WSDL file you imported in step 1, then

click OK.
d) The WSDL Import dialog displays again, showing the selected WSDL. Click Finish.

If the WSDL file you select is an abstract WSDL, you see a warning letting you know that a
channel will not be created. See the section introduction for more details about abstract WSDL
files.

The project artifacts are created within a folder named using part of the WSDL file name.

3. Save the project.
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Re-importing a WSDL File
When you import a WSDL file, TIBCO BusinessEvents creates the project artifacts. If any changes are
made to the WSDL file after the import, you must perform the following steps to use the updated
WSDL:

Re-importing a WSDL file fails if the project artifacts are already present.

Procedure

1. Navigate to the project directory and rename the WSDL file.

2. Copy the updated WSDL file to the same directory. Ensure that the name of the WSDL file is the
same.

3. In Studio Explorer, select the WSDL file and then select Edit > Delete from the top menus to delete
the WSDL file.

4. Refresh the project (keyboard shortcut F5) and then select Project > Clean from the top menu.

5. If you have configured mappings in the project, check for errors caused by broken links in the
mapper.

6. Open the mapper and click on the Mapper Check and Repair button and check only the mappings
in red.

7. Click Ok to fix the mappings.

8. If there are new or changed elements, you may have to manually map the new or changed
elements.

Exporting Resources as a WSDL File
The WSDL export utility allows you to export rules and rule functions that have a SOAPEvent as a
parameter, as a WSDL file.

TIBCO BusinessEvents supports WSDL 1.1 specification. See the following page for more details:

http://www.w3.org/TR/wsdl

WSDL Filenames
must conform to the NCName datatype. See the following page for more details:

http://www.w3.org/TR/REC-xml-names/#NT-NCName

Some Japanese characters, such as half-width Katakana, have issues when they are used in XML
names. See the following document for more details:

http://www.w3.org/Submission/japanese-xml/

Exporting Project Artifacts as WSDL shows how related project resources are exported as a WSDL file.
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Exporting Project Artifacts as WSDL

Project Folders and Resources WSDL Artifact after Exporting

RuleFunction

Use the rule function specified as the input
event’s default destination as the SOAPEvent’s
preprocessor.

That rule function must have the “SOAPEvent
for input” as the input and the “SOAPEvent for
output” as the return type.

Forms the <wsdl:operation> operation.

SOAPEvent

● SOAPEvent for the WSDL input argument

OR
● SOAPEvent for the WSDL output argument

Use the event you configured in Add a
SOAPEvent (and Other Ontology as Needed) .

Creates a message. The contents of Envelope >
Header > Body become message parts.

HTTP Channel

Channel with HTTP as the Driver, Resource as
the Method of Configuration, with a pointer to
the HTTP Connection.

The URI of the channel forms the
<soap:address> URI.

HTTP Connection for HTTP Channel

Host and port are used.

The name of the connection forms the
<wsdl:port>. Host and port of the connection
form the <soap:address> host and port.

Destination for HTTP Channel

With SOAPMessageSerializer as the default
serializer.

The destination used is the default destination of
the SOAPevent.

Forms the soapAction attribute of the operation.

The destination name becomes soapAction
specified for that particular operation.

CDD

In the Agent Classes tab, Input Destination
Collections list, the Preprocessor specified for
the input SOAPEvent’s default destination.

Place the input destination directly under the
agent class input destination collections, and not
under Collections > Input destination.

Associates soapAction to the operation in the
HTTP binding.

Exporting a Rule or Rule Function as a WSDL

Procedure

1. Right-click the project, and click Export...

2. In the Export dialog, select WSDL under TIBCO BusinessEvents, and click Next.
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3. Select the WSDL location by specifying the path, and type a valid NCName for the WSDL file.

4. Select the CDD file of the project.

5. Click Finish.

6. Save the project.

Parsing and Building SOAP Messages
This section explains how to use the SOAP functions to parse information from incoming requests, and
to construct outgoing messages (responses and requests) in your rules and rule functions.

This manual does not explain how to work with the SOAP protocol. For example, you should
understand how the Actor and MustUnderstand attributes in SOAP headers are used to process the
message as it passes from its originator, through intermediary applications, to its ultimate destination.

Working with Incoming SOAP Messages (Event Payloads)
An incoming SOAP message can be a request, or a response, depending on whether TIBCO
BusinessEvents is acting as the server or the client. TIBCO BusinessEvents can also act as an
intermediate node along the path of a SOAP message to its ultimate destination. This section explains
how to parse (get) information out of the incoming event payload, which contains the SOAP message.

To Parse the SOAP Envelope

String getEnvelope(SimpleEvent inSoapEvent)

Given a request SOAPEvent, this function returns the SOAP envelope in the request event payload, for
example:
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sch="http://www.tibco.com/schemas/SoapOverHttp/Schema/Schema.xsd" >
  <soapenv:Header/>
    <soapenv:Body>
      <sch:root>
        <sch:First>1</sch:First>
        <sch:Second>2</sch:Second>
      </sch:root>
    </soapenv:Body>
  </soapenv:Envelope>
</message>

Parsing (and Optionally Removing) Headers and Header Attributes
String[] getHeaders(SimpleEvent inSoapEvent, String actor, Boolean removeHeaders)

If the actor parameter has a null value then all the immediate children of the Header element are
retrieved:
getHeaders(inSoapEvent,null,false)

Otherwise, the header specified by the actor attribute is retrieved. For example, given this Headers
element in a SOAP event payload:
    <soapenv:Header>
      <t:user xmlns:t="http://schemas/xml.com" soapenv:mustUnderstand="true"
            soapenv:actor="http://localhost:9090/Service">jon</t:user>
      <t:user_surname xmlns:t="http://schemas/xml.com"
                    soapenv:mustUnderstand="true"
                    soapenv:actor="http://localhost:9090">smith</t:user_surname>
    </soapenv:Header>

If you specify the following:
getHeaders(inSoapEvent,"http://localhost:9090/Service",false)

To remove the specified header part or parts, set the final parameter to true. (The SOAP specification
states that if a header is processed it should be removed. You would remove a header if TIBCO
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BusinessEvents is acting as an intermediary node and the request created using the SOAP functions
will be sent on to another server.)

Then the first Headers element is returned:
      <t:user xmlns:t="http://schemas/xml.com" soapenv:mustUnderstand="true"
            soapenv:actor="http://localhost:9090/Service">jon</t:user>

You can also retrieve the attributes of a SOAP Header element:

String[] getSOAPHeaderAttribute(SimpleEvent inSoapEvent, int index, String

attribute)

You can also remove all or selected headers using one of these functions:
removeHeaderPart()
removeHeaderParts()

Parsing the SOAP Body (SOAPBodyParts)
Two functions are available for getting SOAP body parts.
String[] getAllSOAPBodyParts(SimpleEvent inSoapEvent)
String[] getSOAPBodyParts(SimpleEvent inSoapEvent, String name, String namespace)

The getAllSOAPBodyParts() function simply returns all SOAP body parts.

The getSOAPBodyParts() function allows you to specify which parts are of interest. Given a body
part name and a namespace for a specified SOAPEvent, it returns a String array of matching SOAP
body parts in serialized form. Name and namespace parameters cannot be null.

Example

Given this function:
String[] body_part= getSOAPBodyParts
(soapeventin,"root",http://www.tibco.com/schemas/SoapOverHttp/Schema/Schema.xsd)

And this soapeventin event payload:
<?xml version="1.0" encoding="UTF-8"?>
<message>
  <soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sch="http://www.tibco.com/schemas/SoapOverHttp/Schema/Schema.xsd" 
xmlns:temp="http://temp/">
  <soapenv:Header/>
    <soapenv:Body>
      <sch:root>
        <sch:First>1</sch:First>
        <sch:Second>2</sch:Second>
      </sch:root>
      <sch:parent2>
        <sch:child1>3</sch:child1>
        <sch:child2>4</sch:child2>
      </sch:parent2>
    </soapenv:Body> </soapenv:Envelope>

You would get this as the SOAP body part:
body_part[0]=
<?xml version="1.0" encoding="UTF-8"?>
<ns0:root xmlns:ns0="http://www.tibco.com/schemas/SoapOverHttp/Schema/Schema.xsd">
  <ns0:First>1</ns0:First>
  <ns0:Second>2</ns0:Second>
</ns0:root>

Parsing Attachments
The following functions enable you to work with SOAP attachments in the request message:
getNumberOfAttachments(SimpleEvent inSOAPEvent)
getAttachmentContentID(SimpleEvent inSOAPEvent, int Index)
getAttachmentContentType(SimpleEvent inSOAPEvent, int Index)
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getAttachmentContent(SimpleEvent inSOAPEvent, int Index)
getAttachmentContentByContentID(SimpleEvent inSOAPEvent, string contentID)

The content ID is the attachment identifier. You can select which attachment to work with using its
index position. First get the count of the attachments using getNumberOfAttachments(). Then using
the index, you can get the content ID and content type, as well as the attachment content itself.

The content is returned in byte form, so after you get the content, you must then use other functions to
make the content human-readable.

For an example, see http://www.w3.org/TR/SOAP-attachments#SOAPReferenceToAttachements.

Parsing SOAP Fault XML Nodes
The following functions enable you to work with the standard SOAP Fault XML nodes from the
payload of a SOAP event:
getFault (SimpleEvent, soapEvent)
getFaultActor (SimpleEvent, soapEvent)
getFaultCode (SimpleEvent, soapEvent)
getFaultString (SimpleEvent, soapEvent)

Working with Outgoing SOAP Messages (Event Payloads)
You can add header parts, body parts, fault parts and attachments to the outgoing SOAP message
(whether it is a response or a request).

The signatures of the relevant functions are as follows:
addHeaderPart(SimpleEvent outSOAPEvent, String headerPartXml)
addSOAPBodyPart(SimpleEvent outSOAPEvent, String bodyXML)
addSOAPHeaderAttribute(SimpleEvent outSOAPEvent, int index, String attribute, 
String value)
addFaultPart(SimpleEvent outSOAPEvent, String faultCode, String faultMessage, 
String faultActor, String faultDetailString)
addAttachment(SimpleEvent outSOAPEvent, String contentID, String content, String 
contentType, String contentEncoding)

TIBCO BusinessEvents adds each type of fragment to the appropriate part of the event payload: header,
body, or fault. The fragments must be well-formed XML. You can also add attachments.

For example, to add a body part containing information for a response you would include all the
required details including any namespace information:
SOAP.addSOAPBodyPart(outSOAPEvent,"<ns0:BookStore xmlns:ns0=\"http://
www.abc.com/xsd/books\"><ns0:Book><ns0:Author>J.K.Rowling</ns0:Author></ns0:Book></
ns0:BookStore>");

The specified body part is added to the correct place in the outline structure of the SOAP message,
which is provided by the SOAPEvent. The resulting payload would look similar to the following:
<SOAP-ENV:Envelope xmlns:SOAP-ENV="http://schemas.xmlsoap.org/soap/envelope/">
  <SOAP-ENV:Body>
    <ns0:BookStore xmlns:ns0="HTTP://www.abc.com/xsd/books">
      <ns0:Book>
        <ns0:Author>J.K.Rowling</ns0:Author></ns0:BookStore>"
      </ns0:Book>
    </ns0:BookStore>
  </SOAP-ENV:Body>
</SOAP-ENV:Envelope>

Understanding the WSDL to Project Resource Mapping
A WSDL file describes a web service. The WSDL Import utility imports a WSDL file and generates
TIBCO BusinessEvents project artifacts using elements in the WSDL. TIBCO BusinessEvents can import
abstract and concrete WSDL files. The source of the WSDL could be, for example, a ActiveMatrix
BusinessWorks SOAPRequestReply activity.

For WSDL import to be successful, all names in the WSDL must conform to TIBCO BusinessEvents
folder and entity naming requirements.
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Example WSDL
The table following this example shows which WSDL elements and attributes are used to create TIBCO
BusinessEvents project artifacts.

Elements and attributes used in the import are highlighted in bold text. Differences between import
from abstract and concrete WSDL files are also highlighted. See Imported WSDL Project Artifacts for
more details.
<?xml version="1.0" encoding="UTF-8"?>
<!--Created by TIBCO WSDL-->
<wsdl:definitions omitted to keep the example short>
   <wsdl:types      <xsd:schema xmlns:xsd="http://www.w3.org/2001/XMLSchema" 
xmlns="http://www.books.org" elementFormDefault="qualified" 
attributeFormDefault="unqualified" targetNamespace="http://www.books.org">
. . . . . . Elements omitted
      </xsd:schema>
   </wsdl:types>
. . . . . . Elements omitted

Note: In an abstract WSDL the following elements are used in the import. However in 
a concrete WSDL, the <wsdl:binding> elements are used instead.

                     <wsdl:portType name="GetBookPortType"
                   >       <wsdl:operation name="GetBook"
                   >          <wsdl:input message="tns:GetBookRequestMessage"/
                   >          <wsdl:output message="tns:GetBookResponseMessage"/
                     </wsdl:operation>
   </wsdl:portType>

Note: This is a concrete WSDL example, so the <wsdl:binding> elements are used in 
the import. (In an abstract WSDL, the <wsdl:portType> element contents are used 
instead.)

<wsdl:bindingname="getBookBinding" 
                              type="tns:GetBookPortType">
      <soap:binding style="document"
                transport="http://schemas.xmlsoap.org/soap/http"/>
      
                              <wsdl:operation 
name="GetBook"         <wsdl:documentation>The operation has no documentation
         </wsdl:documentation>
         
                              <soap:operationstyle="document" 
                              soapAction="/Service/getBook"/>
         
                              <wsdl:input            <soap:body use="literal" 
parts="part1"/>
            <soap:header use="literal"
                     message="tns:TransactionRecordMessage" part="user"/>
         </wsdl:input>
         
                              <wsdl:output            <soap:body use="literal" 
parts="part1"/>
            <soap:header use="literal"
                     message="tns:TransactionRecordMessage" part="transactionID"/>
         </wsdl:output>
      </wsdl:operation>
   </wsdl:binding>
   
                              <wsdl:service name="getBook"      
                              <wsdl:port 
name="getBookHttpPort"binding="tns:getBookBinding">
         
                              <soap:address location="http://ACME:9090/Service/
getBook"/>
      </wsdl:port>
   </wsdl:service>
</wsdl:definitions>
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Example Project Folder Structure
Suppose you import the example WSDL above into a Studio project called Library. The imported and
generated project artifact names would appear as shown in the Project Folders and Resources column
in the table below. Folders that are added by TIBCO BusinessEvents are shown in bold. The example is
a concrete WSDL. In the WSDL Source column the source of folder and resource names is given for
abstract as well as concrete WSDL sources.

Imported WSDL Project Artifacts

Project Folders and Resources Project Resource Type WSDL Source

Library Project root folder N/A

  getBook/ Folder For concrete WSDLS:
<wsdl:service>

For abstract WSDLS:
<wsdl:service> is not present,
so the folder structure starts
from the folder created from
<wsdl:portType>.

    GetBookPortType/ Folder For abstract and concrete
WSDLs:
<wsdl:portType>

      getBook/Events/ TIBCO BusinessEvents
folder

        GetBookRequestMessage Event <wsdl:input>

For abstract WSDLs, in
<wsdl:portType> section.

For concrete WSDLs, in
<wsdl:binding> section.

        GetBookResponseMessag
e

Event <wsdl:output>

For abstract WSDLs, in
<wsdl:portType> section.

For concrete WSDLs, in
<wsdl:binding> section.

      getBook/RuleFunctions/ TIBCO BusinessEvents
folder

        GetBook Rule function <wsdl:operation>

For abstract WSDLs, in
<wsdl:portType> section.

For concrete WSDLs, in
<wsdl:binding> section.
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Project Folders and Resources Project Resource Type WSDL Source

      getBook/Rules/ TIBCO BusinessEvents
folder

         GetBookPortType Folder Abstract WSDL:
<wsdl:portType name>

Concrete WSDL:
<wsdl:binding type>

           GetBook Rule <wsdl:operation>

For abstract WSDLs, in
<wsdl:portType> section.

For concrete WSDLs, in
<wsdl:binding> section.

Import from Concrete WSDLs Only

If the import is from a concrete WSDL, the HTTP Connection resource, Channel resource and
Destination resource are added using details in the <wsdl:service> section of the WSDL.

If the import is from an abstract WSDL, you must create these resources manually.

      getbook/Transports/ TIBCO BusinessEvents
folder

        getBookHTTPPort HTTP Connection <wsdl:port>

The host and port come from the
<soap:address location>

      Service/ TIBCO BusinessEvents
folder

        getBook Channel

See Channel Folders .

<soap:address location>

(from the last part of the location
URL)

          Service_getBook Destination

See Destination Names

<soap:operation 
soapAction>

How Project Artifacts are Named

Channel Folders

Given a concrete WSDL, folders are created for all the elements after the port, up to the last forward
slash of the location URL. The text after the last forward slash is the channel name. For example, given
the following location URL:
http://ACME:9090/Service/Trial/getBook

The folder structure would be /Service/Trial and the channel name would be getBook.

109

TIBCO BusinessEvents® Developer's Guide



Destination Names

In a concrete WSDL, the SOAPAction attribute of a <soap:operation> element specifies the URL of a
destination. It also becomes the destination name. Forward slashes (/), colons (:), and periods (.) are
converted to underscore characters (_) to form the name. For example:
http://www.acme.com/TNT/webservices/getByteField

Becomes:
http___www_acme_com_TNT_webservices_getByteField

Rules and Rule Functions

For each operation, the import utility creates a rule and a rule function. The rule has no body. The rule
functions have SoapEventOut as the return type. Null value is returned by default.

For example, the GetBook operation becomes a GetBook rule in the GetBookPortType folder which is
in the Rules folder, and also a GetBook rule function in the Rulefunctions folder.

You implement the rules and rule functions in your project according to the web service you want to
implement.

Events

The <wsdl:input> element becomes a request event and the <wsdl:output> element becomes a
response event. Each event type inherits from the SoapEvent event type.

Event names come from the message attributes. In the example, the request event is
GetBookRequestMessage and the response event is GetBookResponseMessage.

Faults

Faults specified in a WSDL are used in the outbound SOAP event, as the Fault element.
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Working with Hawk Channels

Before proceeding to configure the Hawk channel, you must edit the configuration file studio.tra at
BE_HOME\studio\eclipse\configuration.

Perform the following steps:

1. Add the following environment variables:
tibco.env.HAWK_HOME=<absolute_path_where_TIBCO Hawk_is_installed>
tibco.env.TRA_HOME=<absolute_path_where_TIBCO Rendezvous_is_installed>

Depending on the transport used by the Hawk Connection shared resource, you must set one of the
following:
tibco.env.RV_HOME=<absolute_path_where_TIBCO Rendezvous_is_installed>
tibco.env.EMS_HOME=<absolute_path_where_TIBCO Enterprise Message 
Service_is_installed>

2. Edit the Studio extended classpath and append the following:
;%HAWK_HOME%/lib;%RV_HOME%/lib;%TRA_HOME%/lib;%EMS_HOME%/lib

3. Restart TIBCO BusinessEvents Studio to pick up the updated values if it is already started.

Hawk Channels
The Hawk channel allows TIBCO BusinessEvents to receive events from the Hawk monitor and
transform them to events in TIBCO BusinessEvents.

In order to use the channel to receive events from the TIBCO Hawk monitor, you must configure one or
more destinations for the channel. Destinations represent different types of monitors listening to
different Hawk events. The following monitor types are available:

AlertMonitor
AlertMonitor is used to listen on the events for any alerts being posted.

RuleBaseListMonitor
It is used to listen on the events for changes in the rulebase. For example, if some rulebases are added,
updated, or removed.

Agent Monitor
It is used to listen on the events for any changes in the status of the agents. For example, the status
may change from alive to expired.

MicroagentListMonitor
It is used to listen on the events for any microagents added or removed.

ErrorMonitor
It is used to listen on the event for errors.

WarningMonitor
It is used to listen on the event for warnings.

Microagent Method Subscription
It is used to subscribe to a microagent method at specified time intervals.

You need to create a channel with a driver type Hawk as described in TIBCO BusinessEvents Developer’s
Guide, Adding a Channel.
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Setting Up the Runtime Configuration
Before using the Hawk channel at runtime, edit the configuration file be-engine.tra at BE_HOME\bin
and set the following variables:

Procedure

1. Add or edit the environment variable HAWK_HOME:
tibco.env.HAWK_HOME=<absolute_path_where_TIBCO Hawk_is_installed>

2. Depending on the transport used by the Hawk Connection shared resource, set one of the
following:
tibco.env.RV_HOME=<absolute_path_where_TIBCO Rendezvous_is_installed>
tibco.env.EMS_HOME=<absolute_path_where_TIBCO Enterprise Message 
Service_is_installed>

Using the Hawk Destination and Event Wizard
The Hawk Destination and Event Wizard can be invoked from BusinessEvents Studio Explorer, select
File > New > Other > TIBCO Channel Wizards > Hawk Destination and Event.

You can choose one of the wizard types:

● Create a Destination and Event   Creates a destination and a simple event for the specified Hawk
channel.

● Create Event for Hawk Catalog Function   Creates a simple event for catalog functions that invoke
a specified microagent method from a rule or rulefunction.

Creating a Destination and Event Using the Wizard

Procedure

1. Start the Hawk Destination and Event Wizard as described in Using the Hawk Destination and
Event Wizard and select the wizard type Create Destination and Event. Click Next.

2. On the Select Channel dialog, select the Hawk channel from the list for which you need to create a
destination and event. Click Next.

3. On the Select Monitor Type dialog, select the monitor type for the Hawk channel. The monitor type
determines the type of Hawk events that will be monitored. Click Next.

If you selected MicroAgent Method Subscription, proceed to step 4. Else go to step 7.
4. The wizard detects the available Hawk agents and displays them on the Select Hawk Agent dialog.

Select a Hawk agent from the list and click Next.
5. The Select Hawk MicroAgent dialog displays. Select a microagent from the list of available Hawk

microagents and click Next.
6. The Select Hawk MicroAgent Method dialog displays. Select a method from the list of available

methods of the microagent. The tooltip displays the arguments for the selected method along with
their datatypes.

7. The Set File and Folder name dialog is displayed. Enter the name of the destination to be created,
the folder name where the event is to be stored, and the name of the event to be created.

8. Click Finish. A message ’Created the resources of Hawk Channel successfully.’ indicates that the
Hawk destination and the event have been created.

Navigate the project directory in BusinessEvents Studio Explorer to verify that the specified
destination and event have been created. The return elements for the selected method are added to
the event as properties.
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Creating Event for Hawk Catalog Function Using Wizard

Procedure

1. Start the Hawk Destination and Event Wizard as described in Using the Hawk Destination and
Event Wizard and select the wizard type Create Event for Hawk Catalog Function. Click Next.

2. On the Select Channel dialog, select the Hawk channel from the list for which you need to create an
event. Click Next.

3. The wizard detects the available Hawk agents and displays them on the Select Hawk Agent dialog.
Select a Hawk agent from the list and click Next.

4. The Select Hawk MicroAgent dialog displays. Select a microagent from the list of available Hawk
microagents and click Next.

5. The Select Hawk MicroAgent Method dialog displays. Select a method from the list of available
methods of the microagent.

6. The Set File and Folder name dialog is displayed. Enter the folder name where the event is to be
stored and the name of the event to be created.

7. Click Finish. A message ’Created the resources of Hawk Channel successfully.’ indicates that the
event has been created.

Navigate the project directory in BusinessEvents Studio Explorer to verify that the specified event
has been created in the specified folder.The return elements for the selected method are added to
the event as properties.

Hawk Channel Destination Reference

Field Name Description

Name Name of the destination to be created. The default name on the
screen is of the format NewDestination_n.

Description Description of the destination that is to be created.

Default Event The default event for the destination. You can browse and select
an existing event from the project.

Serializer/Deserializer The default serializer used to deserialize Hawk event to a
simple event in TIBCO BusinessEvents and to serialize an event
in TIBCO BusinessEvents to a Hawk event. You must configure
the serializer
(com.tibco.cep.driver.hawk.serializer.HawkSerializer)
for every destination created on the Hawk channel.
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Field Name Description

Monitor Type Type of monitor listening to different Hawk events. Choose one
of:

● AlertMonitor
● RuleBaseListMonitor
● AgentMonitor
● MicroAgentListMonitor
● ErrorMonitor
● WarningMonitor
● MicroAgentMethodSubscription

Subscription Method URI URI for the Hawk microagent subscription method.

When you use the TIBCO Channel Wizard to create a
destination, you can select a subscription method from the list
of available methods.

TimeInterval (seconds) Time interval (specified in seconds) between successive calls to
a subscription method.

Arguments Optional. The subscription method selected determines if the
arguments are required. Some methods do not require any
arguments.

Enter the arguments required by the selected subscription
method, if any.

If you create the destination using the TIBCO Channel wizard,
the wizard automatically enters the arguments for the selected
subscription method, if any.

114

TIBCO BusinessEvents® Developer's Guide



Working with ActiveSpaces Channels

This chapter provides additional information about working with the ActiveSpaces channel.

This section provides a brief introduction to the ActiveSpaces concepts and terminology that are useful
when working with the ActiveSpaces channel. See TIBCO ActiveSpaces documentation for more
information.

Metaspace
A metaspace is a virtual entity that contains spaces, which are containers that store the data used by
applications.

A metaspace is a container for managing system spaces, user spaces, and a group of members that are
working together in a cluster. The metaspace is the initial handle to ActiveSpaces. An application or
member first joins a metaspace, and through it, gets access to other objects and functionality.

A metaspace is created when the first process connects to it, and disappears when the last process
disconnects from it. The metaspace grows or shrinks automatically as members connect to it and
disconnect from it.

Initially, a metaspace contains only system spaces. As users create spaces in the metaspace, the
definition of those spaces (along with other administrative data) is stored in system spaces.

Multiple metaspaces may exist at the same time, each one containing a completely independent set of
spaces. This means, for example, that changes to a space called clients in a metaspace named Dev have
no impact on a space named clients in a metaspace named Prod. Since no single application can
connect to two different metaspaces using the same metaspace name, metaspaces should always use
different names.

Space
A space provides shared virtual storage for data. A space is:

● A container for a collection of entries that consist of a tuple and associated metadata.
● A shared entity. Many applications can access a space concurrently and each application has the

same coherent view of the data contained in the space. The spaces in ActiveSpaces are called tuple
spaces, and the items stored in them are called tuples.

A space can proactively notify applications of changes in the data contained in the space as changes
happen (push model), and can therefore be used as a coordination mechanism for building
distributed systems.

● A virtual entity that is distributed and implemented collaboratively by a group of processes located
on multiple hosts and communicating over the network.

ActiveSpaces handles changes in this set of processes automatically: processes may join or leave the
group at any time without requiring any user intervention. A space automatically scales up as the
number of processes in the group increases, and scales down when processes suddenly disappear from
the group or network. There is no negative impact on the data contained in the space when processes
leave the space.

System spaces are a set of administrative spaces that are created and maintained by ActiveSpaces and are
used to describe the attributes of the spaces.

User spaces are spaces that are defined by the user.

Members and Member Roles
Entities that need access to a space join the space as members.

Members can join a space as a seeder or as a leech:
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● Seeders play an active role in maintaining the space by providing CPU and RAM.
● Leeches play a passive role. They have access to space data but provide no resources.

Seeders
Seeder applications join the space and indicate their willingness to lend some of the resources of the
host where they are deployed to scale the service provided by ActiveSpaces. In effect, the seeding
applications have a portion of the Space embedded in their process.

ActiveSpaces distributes the data stored in the space evenly between all of the processes that have
joined the space as seeders. ActiveSpaces is an elastic distributed system. Seeders can join and leave the
space (effectively scaling it up or down) at any time without the need to restart or reconfigure any other
participant in the space. When this happens. the distribution of entries is automatically rebalanced if
necessary to maintain even distribution between the seeders.

Leeches
An application can also join a space as a leech, without contributing any of its host's resources to the
scalability of the space, and without experiencing any limitation in functionality or in its ability to use
the space. A leech (as opposed to a seeder) is a peer of the space that is not considered by the
distribution algorithm and therefore can join or leave the space without causing redistribution of the
data.

ActiveSpacesSerializer
The default serializer used to deserialize ActiveSpaces tuple to a simple event in TIBCO BusinessEvents
and to serialize an event in TIBCO BusinessEvents to an ActiveSpaces tuple. You must configure the
serializer (com.tibco.cep.driver.as.serializers.ActiveSpacesSerializer) for every destination
created on the ActiveSpaces channel.

Distribution role

The distribution role (Seeders or Leeches) is a level of participation of a space member and does not
indicate any limitation on use. Leeches have access to the same set of space operations as seeders. The
choice of distribution role must be made on a per space basis: it may be that the best solution is to join
some spaces as a seeder and others as a leech.

Consumption mode
ActiveSpaces can proactively notify applications of changes to the tuples stored in a space. You can
choose one of the consumption modes: Event Listener, Entry Browser, or Router.

When the consumption mode of a destination is event listener, the destination behaves like a subscriber in
a publish-subscribe messaging system. When certain data changes or certain events occur, a callback
function is invoked. You can choose the type of events to listen to: Put Event, Take Event, and Expire
Event.

When the consumption mode is entry browser, the destination can monitor the space for data changes or
certain events to occur, and can retrieve the tuple from the space using the browser type - Get or Take.

When the consumption mode is router, the destination feeds the events to only the specified listener.
This way, the application benefits from having multiple listener processes running.

The DistributionScope as well as the TimeScope properties now have options enabled that can be
specified for both EventListener and EventBrowser.
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Tuple
A tuple is similar to a row in a database table: it is a container for data. Specifically, it is a sequence of
named elements called fields (similar to the columns in a database table) which contain values of a
specific type. Each tuple in a space represents a set of related data.

Fields have a name and a type. A tuple can be seen as a kind of map on which fields can be 'put' or
'removed'. A tuple can also be seen as a self-describing message. Tuples are platform independent, and
can be serialized and deserialized.

Filters
Filters can be applied to both listeners and browsers, and also be used to evaluate a tuple against a
filter. Filters allow your application to further refine the set of tuples it wants to work with using a
space browser or event listener.

A filter string can be seen as what would follow the where clause in a select * from Space where…
statement.

Examples

   field1 < (field2+field3)
   state = "CA"
   name LIKE ".*John.*" //any name with John

Filters can make reference to any of the fields contained in the tuples. Filters do not provide any
ordering or sorting of the entries stored in the space.

Operators Supported in Filters

Table 18 shows the operators that are supported in the ActiveSpaces filters:

Operators for ActiveSpaces Filters

Operator Meaning

>, >= greater than

NOT or ! or <> not

* multiply

= equal

!= not equal

ABS absolute value

MOD or % modulo, as in ( MOD (x,y) or x % y)

NOT BETWEEN not between

BETWEEN between

|| string concatenation

NOT LIKE not like (regex)
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Operator Meaning

LIKE like (regex)

<, <= less than

+ addition

OR or

- subtraction

AND and

IN range, as in “age in (1,3,5,7,11)"

NULL does not exist

NOT NULL exists

IS only used with NULL or NOT NULL, as in “x IS NULL" or
"x IS NOT NULL"

NOR nor, as in “age NOT 30 NOR 40“

/* .... comments

// .... comments

Formats for Filter Values

Table 19 shows the formats for values used in filters.

Formats for Filter Values

Filter Value Format

octal value \oXXX

hexadecimal value \xXXX

exponents (as in 1E10 or 1E-10) XXXEYY

date time YYYY-MM-DDTHH:MM:SS

date YYYY-MM-DD

time HH:MM:SS:uuuu+/-XXXXGMT

true TRUE

false FALSE
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Working with ActiveSpaces Channels
In order to use the channel to monitor a space in ActiveSpaces, you need to add and configure one or
more destinations for the channel.

Creating a Destination and Event Using the Wizard for AS
TIBCO Channel Wizards provide an option to create a destination and event for a specific ActiveSpaces
channel.

The wizard requires the metaspace and spaces in TIBCO ActiveSpaces to be created and initialized.
Otherwise, no spaces are listed on the Select space dialog. You must create and initialize the metaspace
and then click Refresh to refresh the list of spaces that the channel can connect to.

Procedure

1. In BusinessEvents Studio Explorer, select the ActiveSpaces channel for which you need to create a
destination and event. From the menu, select File > New > Other > TIBCO Channel Wizards >
ActiveSpaces Destination and Event and click Next.

2. The Select Space dialog lists the available spaces for every ActiveSpaces channel in the project.

If no spaces are listed on the Select space dialog, check if the metaspace is created and
initialized. Create and initialize the metaspace, and then click Refresh to refresh the list of
spaces that the channel can connect to.

Select a space and click Next.

3. On the New SimpleEvent and Destination dialog, enter the values to configure the simple event and
destination for the selected channel and space.

Configuring an ActiveSpaces Destination and Event

Field Name Description

Simple Event

Name Name of the simple event to be created. The default name is of
the format <spaceName>Event.

Destination

Name Name of the destination to be created. The default name on the
screen is of the format <spaceName>Dest.

Default Event The default event for the destination. This is set to the
SimpleEvent specified to be created by the wizard.

Serializer/Deserializer The serializer used to map tuples in ActiveSpaces to simple
events in TIBCO BusinessEvents.

The default value is
com.tibco.cep.driver.as.serializers.ActiveSpacesSerializer.

See ActiveSpacesSerializer for more information.
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Field Name Description

Space Name Name of the space which the destination connects to. This space
is selected in the Select space dialog.

See Space for more information about spaces in TIBCO
ActiveSpaces.

Distribution Role The level of participation of the space member: seeder or leech.

See Distribution role for more information.

Filter String specified to evaluate tuples and refine the set of tuples to
work. A filter string can be seen as what would follow the where
clause in a select * from Space where… statement.

See Filters for more information.

Consumption Mode Specifies the consumption mode for the ActiveSpaces event as
one of:

● Event Listener - listens for specific events to occur, and
invokes a callback function from TIBCO ActiveSpaces.

● Entry Browser - can listen and retrive tuples from the space
using the Get or Take methods.

● Router - feeds the events to only the specified listener. This
way, the application benefits from having multiple listener
processes running.

See Consumption mode for more information.

Browser Type Available only when the consumption mode is Entry Browser.

Specifies the browser type used to retrieve tuples from a space.
You can choose either Get or Take.

The difference between the Get and Take browsers is that Get
retrieves a copy of the tuple from the space and Take retrieves
the tuple from the space, and there is no trace of the tuple in the
space after the Take event.

Put Event Available only when the consumption mode is Event Listener.

When selected, the Event Listener listens for any Put events on
the space and invokes a callback function when such an event
occurs.

Take Event Available only when the consumption mode is Event Listener.

When selected, the Event Listener listens for any Take events on
the space and invokes a callback function when such an event
occurs.

Expire Event Available only when the consumption mode is Event Listener.

When selected, the Event Listener listens for any Expire events
on the space and invokes a callback function when such an
event occurs.
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Field Name Description

Prefetch Available only when the consumption mode is Entry Browser.

Set the value in field to attain optimum performance. The
default value is -1 (prefetch all).

You can control the query limit for an ActiveSpaces channel using the property
be.engine.channel.as.querylimit. You can set this property in CDD so that the
channel can receive entries beyond 10000 (default in TIBCO ActiveSpaces). The default
value in TIBCO BusinessEvents is -1, which indicates no limit on queries.

4. Click Finish to create the destination and the simple event.

Result

The wizard adds the following properties to the simple event:
● id of type long
● consumption_mode of type string
● browser_type of type string
● event_type of type string

Configuring the Destination and Default Event Manually
You can add a destination to the ActiveSpaces channel manually, without using the TIBCO Channel
wizards.

The following procedure describes the steps to add and configure a destination for the ActiveSpaces
channel.

Procedure

1. In BusinessEvents Studio Explorer view, double-click the channel name to open the channel editor,
if it is not already open.

2. In the Destinations section, click Add.

3. Enter a Name and Description for the destination.

4. In the Default Event field, browse to and select the event to be created (by default) from incoming
messages received by this destination.

If you have not yet created the event, you can select the default event later. See Assigning a Default
Event to the Destination for details about the simple event.

5. Select the serializer/deserializer to be used:
com.tibco.cep.driver.as.serializers.ActiveSpacesSerializer.

6. Enter the values for the rest of the fields as described in Configuring an ActiveSpaces Destination
and Event.

Assigning a Default Event to the Destination
When creating a simple event manually, ensure that you add the property id of type long.

Procedure

1. To assign a default event to a destination, open the channel editor in BusinessEvents Studio
Explorer view.
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2. In the Default Event field, browse to and select the simple event created earlier.

Configuring Events to Work with ActiveSpaces Channel
You can configure events to interact with external ActiveSpaces metaspace.

Event properties are mapped to ActiveSpaces tuple fields and are utilized to place and receive tuples to
and from ActiveSpaces metaspaces.

For incoming events on ActiveSpaces destinations, event property values are set with the values
coming from the ActiveSpaces tuple.

For outgoing events sent on ActiveSpaces destinations, event properties are copied into the
ActiveSpaces tuple.

There is a special case to set and receive null tuple fields since null cannot be handled by event
properties. Event payload is used instead of event properties.

Each child of the root element is mapped to a tuple field. For incoming events, if an element of the
payload matches the name of a field in the ActiveSpaces space, that element will be set with the value
from the tuple. If the value of the field in the tuple is null, the attribute xsi:nil is set to true for that
element.

For outgoing events, if the name of the element matches the name of a field in the ActiveSpaces space,
that field is set with the value of the element. If the attribute xsi:nil=true is set in the element, the
value of the field in the tuple is set with null.

Configuring Security and Authentication For ActiveSpaces Channel
You can configure security for the ActiveSpaces channel and use LDAP or system based authentication.

Procedure

1. Open the ActiveSpaces channel file in the channel editor.

2. Select Properties or Resources as Method of Configuration.
The channel properties are displayed.

3. If Properties is selected, then enter the values for the following security fields (see Configuration
for ActiveSpaces Channels for more details on the properties).

● EnableSecurity (activates the other security fields)
● SecurityRole
● Identity Password
● PolicyFile
● TokenFile
● Credential
● Domain
● Username
● Password
● KeyFile
● PrivateKey

Some fields are activated only for the specific security role or authorization polcy.

4. If Resources is selected, then configure the ActiveSpaces connection resource for the security. The
security fields are same as mentioned in Step 3. See ActiveSpaces Connection Reference for more
details on the properties.
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Timescope Attributes for Entry Browsers and Event Listeners
For TIBCO BusinessEvents Release 5.2., the timescope attritubes for Entry Browsers and Event Listeners
can now be configured for an ActiveSpaces channel destination from TIBCO BusinessEvents Studio.

Entry Browers

Select one of the following values from the drop-down menu:

● All: The browser iterates through all of the entries stored in the space at creation time and continues
to iterate as changes occur in the space.

● New: The browser skips iterating through the entries stored in the space at creation time and only
iterates through new changes that occur in the space.

● Snapshot: The browser only iterates through entries stored in the space at creation time.

Event Listeners

Select one of the following values from the drop-down menu:

● All: The listener starts with all of the tuples currently in the space at creation time, which will be
presented as an inital ste of PUT events and then is continuously updated according to changes in
the space.

● New: The listener starts empty and is updated only with events related to new or updated tuples in
the space.

● Snapshot: The listener contains only PUT events corresponding to the tuples stored in the space at
creation time.
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● New_Events: The listener starts empty and is updated with all of the events that occur in the space
after creation time.
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Working with Events

TIBCO BusinessEvents supports three sorts of events: Simple events (usually referred to just as events);
time events, which are timers; and advisory events. This chapter explains how to use simple events.

A simple event defines an object that represents an occurrence of something. When the term "event" is
used without the qualifier advisory or time, it refers to a simple event.

● TIBCO BusinessEvents Getting Started provides a practical introduction to events, including use of
default events and default destinations.

● See TIBCO BusinessEvents Architect’s Guide, Channels, Destinations, and Events for a more
detailed information .

Overview of Simple Events
A simple event defines an obejct that represents an occurence of something.

When the term "event' is used wihtou the qualifer advisory or time, event referes to a simple event.

For more information, see the following:

● TIBCO BusinessEvents Getting Started guide provides a practical introduction to events, including the
use of default events and default destinations.

● TIBCO BusinessEvents Architect's Guide provides a detailed overview and information about
Message Acknowledgment, Default Destinations and Default Events, Simple Events -- Time to Live
and Expiry Actions.

Using Inheritance
Use of inheritance can simplify event configuration.

A child event inherits:

● All the parent event’s properties.
● The parent event’s expiry action (if set). However, an expiry action set in the child event overrides

the parent event expiry action.

A parent event cannot have a payload. Also, all child events of an event with TTL=0 must
also use TTL setting TTL=0 .

Events that are related to each other directly or indirectly by inheritance cannot have distinct properties
that share a common name. Therefore the following restrictions apply:

● If two events are related by inheritance, you cannot create a new property in one with a name that is
already used in the other.

● If two unrelated events have properties that share a name, you cannot create an inheritance
relationship between the two events.

Working with Events in Rules
At runtime, event instances that are created using rules are not automatically asserted.

You must explicitly assert such events, for example using the Event.assertEvent() function.

Events that are created from incoming messages, on the other hand, are automatically asserted.

STIBCO BusinessEvents includes two functions that allow you to send simple events out to another
application: Event.sendEvent() and Event.routeTo().
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● Event.sendEvent() automatically sends the event to its default destination.

● Event.routeTo() takes a destination as an argument, ignoring the event’s default destination.

With routeTo you can direct an event to a destination on a different channel from the event’s
default destination. You can also override the properties of the destination, for example, the subject.

You cannot, however, override the properties of the channel itself, for example, the network field in
a Rendezvous channel.

You can use two methods to schedule simple events:

● Rule-based time events schedule the assertion of simple events.
● Scheduler functions schedule the sending of simple events to their default channels.

Adding a Simple Event

This section provides summary steps for adding a simple event. See Simple Event Reference for details
on how to complete the values.

Procedure

1. In BusinessEvents Studio Explorer, right click the folder where you want to store the event and
select New > Simple Event . You see the New Simple Event Wizard.

2. In the Simple Event Name field, type a name for the event. In the Description field, type a
description as desired.

You cannot change the name in the editor. To change the name of any project element,
right-click the element in BusinessEvents Studio Explorer and select Refactor > Rename .

3. Click Finish. You see the Simple Event Editor.

4. Complete the Standard tab and Advanced tab sections as explained in Simple Event Reference.

5. Save the resource.

The ability to add metadata groups and properties is provided for customization purposes
and is not documented.

Defining Payloads Using XML Schema Files
You can define the XML schema file within TIBCO BusinessEvents Studio, or import an existing one.
Then you can reference the schema when defining the payload.

To access an XML payload in rules you can use the @payload attribute, as well as Event, Mapper, and
XPath functions. For simple XML payloads you can use string functions.

Defining an XML Schema File in TIBCO BusinessEvents Studio
An Eclipse resource is available for this task.

Procedure

1. Right-click the folder where you want to add the resource and select NewOtherXMLXML Schema
and click Next.

2. Enter a name and click Finish.

3. In the XML schema editor use the Design or Source tabs as preferred to define the schema. Refer to
Eclipse help for details.
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Importing an XML Schema File
An Eclipse resource is available for this task.

Procedure

1. From the File menu select ImportFile System.

2. At the Import from File System wizard, browse to a folder and select the desired schema file within
that folder.

3. In the Into Folder field, specify the project folder where you want to put the file.

4. Set the overwrite and folder options as desired, then click Finish.

Using an XML Element in a Schema File in an Event Payload
To use an XML element in a schema file as the root element of the event payload, do the following.

Procedure

1. In the event's Advanced tab, click the Add (+) button. You see a root node in the left panel.

2. In the Content field, select XML Element Reference.

3. In the Schema field click the Browse (binocular) button.

4. You see the Select a Resource dialog. Depending on the XML schema files available in the project,
multiple entries may be grouped according to location (on the By Location tab) and namespace (on
the By Namespace tab). Select one XML schema resource from either of these tabs.

5. In the Element panel, select the element you want to use as the root element for the payload. (You
can also change this in the Payload section of the Event's Advanced tab.)

6. Click OK to return to the Advanced tab. The word root in the left panel is now replaced with this
element name.

7. Save the resource.

Simple Event Reference

Simple Event resources are used to define an object that represents an occurrence, such as sending an
invoice, debiting an account, and so on.

You can modify and enrich events before they are asserted into the Rete network. Rule evaluation
depends on event values at time of assertion, so they can be changed only before assertion.

If you are working with a project imported from a release earlier than 5.0.0, you may see metadata
properties. However, do not use them. Instead use the settings and properties in the Domain Objects
section of the CDD file as needed.
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Wizard and Configuration (Standard Tab)
The Wizard and the Configuration section have the following fields.

Field
Global
Var? Description

Name No Not shown as a field because it cannot be changed. The name appears
in the Wizard, and in the title of the event.

The name to appear as the label for the resource. Names follow Java
variable naming restrictions. Do not use any reserved words. Names
must be unique within a folder. See Identifier Naming Requirements.

Description No Short description of the resource.

Inherits From No This event inherits from the event you select here. Leave blank if you
do not want to use inheritance. As a convenience, you can open the
selected event resource by clicking the underlined label.

Time to Live Yes Specify a numerical value and a time unit.

Time units can be specified from the drop-down list available to the
right of the Time to Live field. Choose one of: milliseconds, seconds,
minutes, hours, and days. The default time unit is seconds.

The numerical value is interpreted as follows:

● One or higher (>0): the event expires after the specified number of
units elapse.

● Zero (0): the event expires after the completion of the first RTC
cycle.

● A negative integer (<0): the event does not expire, and must be
explicitly consumed. The value -1 is generally used to indicate an
event that does not expire.

See Declaration and Expiry Action (Advanced Tab) .

Default
Destination

No When the destination is not otherwise specified (for example in rules
or rule functions), events of this type are sent to the destination you
select here. You can send an event to the default destination of its
event type using the Event.sendEvent() function. As a convenience,
you can open the selected destination resource by clicking the
underlined label.

Retry On
Exception

No When a destination’s event preprocessor fails due to an exception, the
behavior of an event instance of this type is determined by this check
box setting:

● When this checkbox is checked TIBCO BusinessEvents attempts to
reprocess the event instance that failed and retries indefinitely
with a delay of five seconds between retries.

● When the checkbox is unchecked TIBCO BusinessEvents does not
attempt to reprocess the event instance that failed.
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Properties (Standard Tab)
The Properties section has the following fields. Event properties generally map to incoming or outgoing
message properties.

Field
Global
Var? Description

Name No The name to appear as the label for the property. Names follow Java
variable naming restrictions. Do not use any reserved words. See 
Identifier Naming Requirements .

Note
In addition to standard naming restrictions, do not begin an event
property name with _ns_ or _nm_. These have a special use.
Also note that the propery name cannot begin with the character _.

For events used in JMS channels
 Names beginning with _jms or jms (case insensitive) are used only
for JMS header properties. You can, however, use properties
beginning jms_ (case insensitive) for event properties.

JMS Header Field Names shows the list of JMS header properties.
Consult the JMS specification for more details.

Type No One of: String, Integer, Long, Double, Boolean, DateTime

Note
For properties of type Double, all NaN (Not a Number) values are
converted to 0.00.

Domain No Click the search button and select the domain model you want to use
for this property. See Domain Models for details on adding domain
models.

Declaration and Expiry Action (Advanced Tab)

If the Time to Live field is zero or higher, define the action or actions to take when an event expires in
the Expiry Action section.

If an event is explicitly consumed in a rule, TIBCO BusinessEvents does not execute the expiry action.

The editor in the Expiry Action section is the same as the Rule function editor. See Rule Function
Resource Reference for details.

See TIBCO BusinessEvents Architect’s Guide for background details.

Payload (Advanced Tab)
An event can have a payload. The payload often corresponds to a message body. Payloads can be
defined using an XML schema. In the left panel you add groups (elements) and parameters (attributes).
You can add groups as children of a selected group, or at the same level, to define a hierarchy as
desired. In the right panel, you define the type of each element or parameter. The table below describes
the payload parameters available for each content type. The content types appear in the drop-down list
for the Content field in the Payload section:
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Simple Event Payload Element Parameters (Sheet of )

Content/Parameter Description

Complex Element An element that contains other elements. This is like a structure in a
programming language. The complex element can contain zero or more
elements of other types, including other complex elements.

Name The name of the element.

Cardinality Values for Cardinality:

● Required: The payload must include an instance of this element.
● Optional (?); The element is not required.
● Repeating (*); The element is a list that has zero or more instances.
● At least one (+): The element is a list that has one or more instances.

Element of Type An element with a specified data type. You can specify a scalar data
type (string, integer, and so on), you can reference an XML type, or you
can specify the TIBCO ActiveEnterprise Any data type.

Name The name of the element.

Cardinality See Cardinality under Complex Element.

Type The generic data type. For example, decimal or date/time.

Type The specific data type. For example, float or month. Refer to the TIBCO
ActiveMatrix BusinessWorks Palette Reference for a complete list.

XML Element Reference A reference to an element in a stored XML schema. See TIBCO
Designer documentation for more information about XML schemas.

Cardinality See Cardinality under Complex Element.

Schema Stored XML schema that contains the element or type you want to
reference.

Element The element within the stored XML schema that you want to reference.

Attribute of Type An attribute with a specified data type. You can specify a scalar data
type (string, integer, and so on), you can reference an XML type, or
specify the TIBCO ActiveEnterprise Any data type.

Name The name of the element.

Cardinality See Cardinality under Complex Element.

Type The generic data type. For example, decimal or date/time.

Type The specific data type. For example, float or month. Refer to the TIBCO
ActiveMatrix BusinessWorks Palette Reference for a complete list.
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Content/Parameter Description

Sequence A sequence of elements. Each item in the sequence is a structure of the
sub-elements of this element.

Cardinality See Cardinality under Complex Element.

Choice A choice of elements. The data type of this element can be one of the
sub-elements defined.

Cardinality See Cardinality under Complex Element.

All The data type of this element can be all of the data types of the sub-
elements defined.

Cardinality See Cardinality under Complex Element.

XML Group Reference A reference to an XML group in a stored XML schema. See TIBCO
Designer documentation for more information about XML schema.

Cardinality See Cardinality under Complex Element.

Schema Stored XML schema that contains the element or type you want to
reference.

Model
Group

Select the appropriate model group from the pull-down list.

Any Element A reference to any XML Element. You can use the Coercions button to
supply a reference to the XML Element for this item when it appears in
the input or process data.

Cardinality See Cardinality under Complex Element.

Validation Select the level of validation to be performed on the XML Element:

● Strict: Must validate by locating a declaration for the element.
● Skip: Do not validate.
● Lax: Validate if a declaration for the element is available.

Simple Event Attributes Reference

When using an event in a rule’s form editor, type eventname@ to see the list of its attributes.

You can use the following attributes in rules to return information about a simple event instance.

Attribute Type Returns

@id long The event’s unique internal ID.
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Attribute Type Returns

@extId string The event’s unique external ID. Optional.

The value of the extId is set at creation time, for example,
using the event’s ontology function, or the
Event.creatEvent() function. The value cannot be changed
after that.

Note
The extId value (if set) must be unique across all objects in
the cluster.

Tip
You can use the property
Agent.AgentClassName.checkDuplicates to check for
duplicate extIds across the cluster.

@ttl long The event’s time to live, where the assertion of the event defines
the start of the time to live period. You can specify the value in
the SimpleEvent resource TTL field. See Simple Event
Reference .

@payload string The payload as a string value. See Payload (Advanced Tab) for
more on specifying the payload in a SimpleEvent resource.

Working With Time Events
This section explains how to create and configure a time event.

Scheduled Time Events
TIBCO BusinessEvents offers two kinds of time events, repeating and rule-based. In addition you can
schedule events using functions.

Time events configured to repeat at intervals are not supported in multiple-agent (multi-engine)
configurations. Rule-based time events, however, are supported.

You can configure a time event to repeat at a configurable time interval. For example, if you configure a
time event to repeat every thirty seconds, then every thirty seconds TIBCO BusinessEvents creates a
new time event of that type.

You can configure a repeating time event to create a specified number of events at each interval. The
time interval begins during engine startup. See Engine Startup and Shutdown Sequence in TIBCO
BusinessEvents Administration for specific details.

Rule Based Time Events
A rule based TimeEvent resource has only a name and description.

You can then use it in a rule to schedule a simple event to be asserted, using its ontology function,
ScheduleTimeEventName() in a rule. You can schedule the event to be asserted after a period of time,
and you can pass information to the event and specify its time to live. You can call the
ScheduleTimeEventName() function in different places with different time delays.

You can use rule based time events in various ways. For example, you might write rules that check for
delays in order fulfillment:
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1. A new Order event is asserted, and Rule A (which has Order in its scope) creates a time event T and
configures it to be asserted in sixty minutes, and passes the order ID as the closure parameter value.
(Rule A also sends the order details to another system.)

2. Sixty minutes after Rule A executes, timer event T is asserted.

3. The assertion of time event T triggers Rule B, which has T in its scope. Rule B checks the order
status. If the order is delayed, it sends out an alert.

Adding a Time Event

See TimeEvent Resource Reference for information on how to complete the values.

Procedure

1. In BusinessEvents Studio Explorer, right click the folder where you want to store the time event and
select New > Time Event . You see the New Time Event Wizard.

2. In the Time Event Name field, type a name for the time event. In the Description field, type a
description.

You cannot change the name in the editor. To change the name of any project element,
right-click the element in BusinessEvents Studio Explorer and select Refactor > Rename .

3. Click Finish. You see the Time Event editor.

4. In the Type field, select the type of time event you want to create and configure accordingly:

● ruleBased: Select Rule Based. Use the event in a rule as explained in Configuring a Rule Based
Time Event in a Rule or Rule Function.

● repeat: The event occurs at specified intervals. Select Repeat and configure the time event
following guidelines in TimeEvent Resource Reference.

5. Click Apply and save the resource.

Configuring a Rule Based Time Event in a Rule or Rule Function

Procedure

1. Open the rule editor for the rule or rule function where you want to use the rule-based time event.

2. Display the Catalog Functions view if it is not available: Select Window > Show View > Other >
TIBCO BusinessEvents > Catalog Functions .

3. In the Catalog Functions view, expand Ontology Functions and drill down to the rule-based time
event. Expand the rule-based time event and select its ontology function (scheduleTimeEvent).

133

TIBCO BusinessEvents® Developer's Guide



4. Drag the time event’s ontology function into the Actions area of the rule (or Body area of the rule
function) and configure the parameters, following guidelines in Rule Based TimeEvent Function
Reference.

5. Save the resource.

TimeEvent Resource Reference

TimeEvent resources are used as timers. You can configure rule-based timers, which are scheduled in a
rule, and repeating timers, which are scheduled in the TimeEvent resource. Use time events to trigger
rules.

If you are working with a project imported from a release earlier than 5.0.0, you may see metadata
properties. However, do not use them. Instead use the settings and properties in the Domain Objects
section of the CDD file as needed.

Wizard and Configuration Tab
The Wizard and Configuration tab have the following fields.

Field
Global
Var? Description

Name No The name to appear as the label for the resource. Names follow Java
variable naming restrictions. Do not use any reserved words. Names
must be unique within a folder. See Identifier Naming Requirements .

For events used in JMS channels
 Names beginning with _jms or jms (case insensitive) are used only for
JMS header properties. You can, however, use properties beginning
jms_ (case insensitive) for event properties.

Description No Short description of the resource.

Type No
● ruleBased: The time event is scheduled by a rule.
● repeat: Time events are created periodically. Complete the rest of the

settings to define the period and number of events per interval.

Interval No Used with repeating time events only. Specify the interval between time
events using a numerical value and a time unit.

TIBCO BusinessEvents creates the first time event immediately after the
engine starts and then creates the next time event based on the interval.

A repeating time event expires after the completion of the first RTC cycle
(that is, the time to live code is set internally to zero).

Time units available are milliseconds, seconds, minutes, hours, and days.

Events per
Interval

No Used with repeating time events only. Enter the number of events to
create in each Repeat Every interval.

Default is 1.
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TimeEvent Attributes Reference

When using an event in a rule’s form editor, type eventname@ to see the list of its attributes.

You can use the following attributes in rules to return information about an event instance.

Attribute Type Returns

@id long The event’s unique internal ID.

@closure String
● For repeating time events: Not used (Null value).
● For rule based time events: A string that was specified when

the event was scheduled.

@interval long
● For repeating time events: The number of milliseconds

between creation of successive time events.
● For rule based time events: Not used (0 value).

@scheduledTime DateTime The time scheduled for asserting an instance of this event into
the Rete network.

● For repeating time events: calculated based on the time of
the last assertion of an instance of this event, and the
interval.

● For rule based time events: specified using the
ScheduleTimeEventName() function’s delay parameter.
See Rule Based TimeEvent Function Reference .

@ttl long
● For repeating time events: always 0 (zero).
● For rule based time events: specified using the ontology

function’s ttl parameter. See Rule Based TimeEvent
Function Reference .

Rule Based TimeEvent Function Reference

Signature

Event ScheduleTimeEventName(long delay, String closure, long ttl)

Domain

action

Description

For each rule-based time event you create, an ontology function is also created to enable you to
schedule the assertion of an instance of the event in a rule action. The function name follows this
format: ScheduleTimeEventName.
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Parameters

Name Type Description

delay long The event is created (and asserted) the specified
number of milliseconds after the rule action executes.

closure String The TimeEvent created will simply store the
information passed in the closure parameter. you can
put the closure string value in rule conditions to
specify the time events that will trigger the rule.

ttl long The event’s time to live. Follows the same rules as the
time to live setting in a simple event. See Simple
Event Reference .

Returns

Type Description

Event An instance of the event type specified in the function name
(ScheduleTimeEventName).

Using Scheduler Functions (Requires Cache OM)

The TIBCO BusinessEvents Express edition supports only In Memory object management. Therefore it
does not support scheduler functions.

You schedule simple events using scheduler functions. Events scheduled using these functions are sent
to their default destination.

You might use the event scheduler functions instead of a time event in the following cases:

● If you need to send any event on a schedule, you must use the scheduler. If you schedule a memory-
only simple event the schedule is persisted. If you schedule a memory only time event (using the
time event's function, not the scheduler functions) then the schedule is not persisted.

● If you need to create many, perhaps thousands, of schedules at one time, performance is better
using the event scheduler functions.

● Because schedule management and event sending can be handled by a cache agent, fewer resources
in the inference agents are required compared to time events. Additionally, with backing store
enabled the schedules are only loaded into memory a batch at a time, reducing the total memory
requirement compared to time events.

Creating a Scheduler

Procedure

1. Create a scheduler using the function Cluster.createScheduler().

You can do this, for example, in a startup rule function, or other rule function or rule:

void createScheduler(String schedulerName, long pollInterval, long refreshAhead)

schedulerName   A unique ID for the scheduler you are creating.
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pollInterval   TIBCO BusinessEvents checks the scheduler cache every pollInterval
milliseconds, for scheduler work items whose scheduledTime falls in the current interval.

refreshAhead  Time in milliseconds (into the future) used to pre-load the scheduled events from
the backing store.

In this release, the larger value of pollInterval and refreshAhead is used for both these
settings.

For example:
Cluster.createScheduler("myScheduler", 1000, 5000);

2. Schedule the Event to be Sent

Result

You use the function Cluster.scheduleEvent() to schedule an event to be sent at a certain time,
using a scheduler you created earlier. You can do this in a rule or rule function as needed:

void scheduleEvent(String schedulerName, String workKey, SimpleEvent evt, long
scheduledTime)

Where:

● schedulerName is the unique ID for the scheduler you created at an earlier time.

● workKey is a unique key that identifies the work item (that is, the scheduled task). This key can be
used to identify the work item later, for example to cancel it.

● evt is the simple event to be scheduled.

● scheduledTime is used to specify the time the event is sent to its default destination. The value is
interpreted as an absolute time. To schedule a time relative to the present, use the
System.currentTimeMillis() function, as shown below.

For example:

Cluster.scheduleEvent("MyScheduler", myworkKey, Event.createEvent("xslt:// details
omitted "), System.currentTimeMillis() + 5000)

Working with Advisory Events

You never have to add or configure an event of type AdvisoryEvent. Advisory events are asserted into
the Rete network automatically when certain conditions, for example, exceptions, occur. Add the
AdvisoryEvent event type to rule declarations to be notified of such conditions. Then use the event
attributes in the rule as needed (Advisory Event Attributes Reference).

More information is provided in TIBCO BusinessEvents Architect’s Guide, Events

Procedure

1. To add an advisory event to a rule, open the rule editor for the rule where you want to use the
advisory event.

2. Do one of the following:

● In the form-based editor, click the plus icon in the Declarations panel and select Advisory
Event from the list of resources.

● In the source editor, add a line like the following in the declare block:
AdvisoryEvent a;

In both cases you can change the alias as desired (from a to something else).
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3. Save the resource.

Result

The AdvisoryEvent event type has no properties. You can use its event attributes in rules to return
information about an advisory event. See Advisory Event Attributes Reference.

Advisory Event Attributes Reference

When using an event in a rule’s form editor, type eventname@ to see the list of its attributes.

The AdvisoryEvent event type has no properties. You can use the following attributes in rules to return
information about an advisory event. Add-on products may use additional advisory event types.

Name Type Description

@id long The event’s unique internal ID.

@extId String Null.

@category String Broad category of advisory:

Exception—Used for exceptions not otherwise caught.

Engine—Used for engine events. Also used for TIBCO
BusinessEvents-ActiveMatrix BusinessWorks integration projects.

Deployment —Used for hot deployment

@type String Type of advisory within the category. See Attributes Used for Each
Type of Advisory Event for details.

@message String Message content depends on the type of advisory event. See 
Attributes Used for Each Type of Advisory Event for details.

Attributes Used for Each Type of Advisory Event

Description @category @type @message

Exceptions
arising from user
code

Exception The Java class name of the
exception

The stack trace and a
message (if the exception
includes a message

TIBCO
ActiveMatrix
BusinessWorks

Activity Failure

Engine INVOKE BW PROCESS

Indicates a failure or cancellation
or timeout of the ActiveMatrix
BusinessWorks process.

The error message from
the failed ActiveMatrix
BusinessWorks process,
or the timeout message.

Engine is
activated

 Engine engine.primary.activated

Indicates the engine has been
activated.

Engine EngineName 
activated.

138

TIBCO BusinessEvents® Developer's Guide



Description @category @type @message

Hot deployment Deployment deployment.hotdeploy.success
 
deployment.hotdeploy.fail

Hot deployed project
ProjectPath

Failed to hot deploy
project ProjectPath
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Working with Concepts

This section explains how to work with concepts, and how to set up relationships between concepts.

Adding a Concept

Procedure

1. In BusinessEvents Studio Explorer, right-click the folder where you want to store the concept and
select New > Concept . You see the New Concept Wizard.

2. Type the values in the Concept Name and Description fields.

You cannot change the name in the editor. To change the name of any project element,
right-click the element in BusinessEvents Studio Explorer and select Refactor > Rename .

3. Click Finish.

4. In the Concepts Editor:

● Configure the remaining fields as explained in Wizard and Configuration Tab.
● As needed, add and configure properties as explained in Properties.

5. Save the resource.

The ability to add metadata groups and properties is provided for customization purposes
and is not documented. Metadata properties are also used for database concepts, a feature
available in TIBCO BusinessEvents Data Modeling. See TIBCO BusinessEvents Data
Modeling Developer’s Guide for details.

Adding Concept Relationships
See TIBCO BusinessEvents Architect’s Guide for information about concept relationships.

To Create an Inheritance Relationship

In the child concept resource’s Configuration section, identify the parent concept in the Inherits From
field.

Note that inheritance is set at the concept level. Other relationships are set at the concept property level.

Creating a Containment Relationship
A concept can be contained by only one concept at a time.

Procedure

1. In the container concept resource’s Property section, add and configure a property of type
ContainedConcept.

2. Configure the property as follows:

Name: Provide a helpful name. For example, "wheels" could indicate that this concept is contained
by a "car" concept (in an appropriate project).

Multiple: Check the checkbox if this property is an array.

Policy: Changes Only or All Values.

History: The number of historical values to keep.
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Creating a Reference Relationship
A concept can refer to itself, and can be referred to by more than one concept.

Procedure

1. In the Property tab of one of the concept resources, create a property of type ConceptReference.

2. Configure the property as follows:

Name: Provide a helpful name such as is a lineitem of to express the relationship.

Multiple: Check the checkbox if this property is an array.

Policy: Changes Only or All Values.

History: The number of historical values to keep.

See TIBCO BusinessEvents Architect’s Guide for more on this topic.

Editing or Deleting Concept Relationships
You cannot edit or delete the relationship using the concept view graphical user interface. Instead,
work with the concept properties directly in the Concept Editor.

Concept Resource Reference

Concept resources are descriptive entities similar to the object-oriented concept of a class. They describe
a set of properties. For example, one concept might be Department, and it could include department
name, manager, and employee properties.

If you are working with a project imported from a release earlier than 5.0.0, you may see metadata
properties. However, do not use them. Instead use the settings and properties in the Domain Objects
section of the CDD file as needed.

Wizard and Configuration Tab
The Wizard and Configuration tab have the following fields.

Field
Global
Var? Description

Name No The name to appear as the label for the resource. Names follow Java
variable naming restrictions. Do not use any reserved words. Names
must be unique within a folder. This field appears on the New
Concept Wizard. The name then appears in the title of the concept
editor.

Description No Short description of the resource.

This field appears on both the New Concept Wizard and in the
concept editor.
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Field
Global
Var? Description

Inherits From No If you want this concept to inherit all the properties of another
concept, browse to and select that concept.

Concepts that are related to each other directly or indirectly by
inheritance cannot have distinct properties that share a common
name. Therefore the following restrictions apply:

● If two concepts are related by inheritance, you cannot create a new
property in one with a name that is already used in the other.

● If two unrelated concepts have properties that share a name, an
inheritance relationship cannot exist between them.

State Models No State models that are owned by this concept. Models can be added
and removed as needed.

Requires TIBCO BusinessEvents Data Modeling.

Auto Start State
Model

No If checked then when a concept is asserted, at runtime, its main state
machine (if any) is started.

If unchecked, then state machines are started using this function in
rules:
Instance.startStateMachine()

The function has a parameter specifying whether child concepts’ state
machines are also started. For contained concepts, the value of the
Auto Start State Machine is not relevant and is not checked.

Requires TIBCO BusinessEvents Data Modeling.

Properties
The Properties tab has the following fields:

Field
Global
Var? Description

Name No The property name.

The property name cannot begin with the character _.
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Field
Global
Var? Description

Type No Any of the following types:

String, Integer, Long, Double, Boolean, DateTime,
ContainedConcept, ConceptReference

When you create a property of type ContainedConcept, you are
creating a containment relationship. The concept that you are
currently configuring is the container; the concept you specify as a
property is the contained concept.

A concept cannot contain itself. For instance, for a concept
A we cannot add a contained property of type A.

When you create a property of type ConceptReference you are
creating a property that references another concept.

See TIBCO BusinessEvents Architect’s Guide for more details.

Note
: For properties of type Double, when a backing store is used, all
NaN (Not a Number) values are converted to 0.00.

Multiple No Check the Multiple checkbox if this property is an array.

Consider, for example, an Order concept: In most cases, an Order
concept would allow only one value for the customer property but
multiple values for the line_item property. Selecting the Multiple
checkbox creates a property array.

Policy No TIBCO BusinessEvents can record historical values using either of
these policies:

Changes Only
TIBCO BusinessEvents records the value of the property every time
it changes to a new value.

All Values
TIBCO BusinessEvents records the value of the property every time
an action sets the value even if the new value is the same as the old
value.
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Field
Global
Var? Description

History No Determines if historical values are stored, and if so how many.

The default m aximum value is 32767.

Zero (0): TIBCO BusinessEvents does not store historical values for
the concept. It stores the value without a time and date stamp

One or more (>0): TIBCO BusinessEvents stores the property value
when the property changes, along with a date and timestamp, up to
the number specified. When the maximum history size is reached, the
oldest values are discarded as new values are recorded. See TIBCO
BusinessEvents Architect’s Guide for more details.

Note
: Use of a temporal function with a concept that has a history size of
0 may cause a runtime exception.

Metadata
The Metadata section is used in a special way with database concepts. Requires TIBCO BusinessEvents
Data Modeling. See TIBCO BusinessEvents Data Modeling Developer’s Guide for details. It is not used
otherwise (except for customization, which is not documented).

Concept Attributes Reference

When using a concept in a rule’s form editor, type conceptname.@ to see the list of its attributes.

You can use the following attributes in rules to return information about a concept instance.

Entity Attributes Type Returns

Concept @id long The concept instance’s unique internal
ID.

@extId string The concept instance’s unique external
ID. Optional.

The value of the extId is set at creation
time (for example, using the
Instance.createInstance()

function) and cannot be changed after
that.

Note
: The extId value (if set) must be
unique across all objects in the
cluster.

Tip
: You can use the property
Agent.AgentClassName.checkDupl

icates to check for duplicate extIds
across the cluster.
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Entity Attributes Type Returns

ContainedConcept @id long The contained concept instance’s
unique internal ID.

@extId string The contained concept instance’s
unique external ID.

@parent concept The parent concept instance. (This is
treated as a concept reference in the
language.)

ConceptReference @id long The contained concept instance’s
unique internal ID.

@extId string The contained concept instance’s
unique external ID.

@isSet boolean Available for any concept property
(not for referenced concepts). For
example, you can use:
acc.Balance@isSet. It indicates if a
property is assigned or not. If a
property is assigned, then @isSet
returns true.

Adding a Scorecard
Configuring a scorecard is similar to configuring a concept, except that scorecards do not have
relationships.

Procedure

1. In BusinessEvents Studio Explorer, right click the folder where you want to store the scorecard and
select New > Scorecard . You see the New Scorecard Wizard.

2. Type in the values for the Scorecard Name field and Description fields.

You cannot change the name in the editor. To change the name of any project element,
right-click the element in BusinessEvents Studio Explorer and select Refactor > Rename .

3. Click Finish.

4. In the Scorecard Editor, add and configure properties as explained in Concept Resource Reference.

5. Save the resource.

The ability to add metadata groups and properties is provided for customization purposes
and is not documented.

Using a Scorecard in Rules
After configuring a scorecard resource, use rules to gather the information you need in the scorecard.
To access the scorecard in a rule, use this syntax:
folder.folder.scorecard.property

For Example:
int i = SalesFolder.StatsScorecard.numOrdersProperty;
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Scorecard Resource Reference

Scorecard configuration is the same as concept configuration, except that scorecards have no
relationships with each other. Scorecards, therefore, have none of the properties used for setting up
relationships. Scorecard properties can be of any primitive type.

See Concept Resource Reference for details about scorecard properties
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Working with Rules and Functions

If you are using the source editor, adapt these instructions that focus on the form-based editor and
mention the equivalent settings in the source editor.

Rule Form Editor

Rule Source Editor
 * @description
 * @author
 */
rule Rules.ProcessDebits.ApplyDebit {
  attribute {
    priority = 1;
    forwardChain = true;
Optionally add entry for Rank as needed (Rank=RuleFunction), or enter in Form view.
  }
  declare {
    Events.Debit  debit;
    Concepts.Account  account;
  }
  when {
    //Checks whether the extId of an Account instance in working memory
    //matches the incoming event's account ID
    account@extId == debit.AccountId;
  }
  then {
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    //If Account Status is not Suspended, debits the account
    if (account.Status !="Suspended") {
    account.Debits=debit.Amount;
    System.debugOut("############### Debiting account <" +account@extId+ "> by $" 
+debit.Amount);
    account.Balance=account.Balance - debit.Amount;
    System.debugOut("############### New balance: $" + account.Balance);
    }
    else {
    System.debugOut("############### Cannot debit the suspended acount <" 
+account@extId +">");
    }
    Event.consumeEvent(debit);
  }
}
  

Adding a Rule

Procedure

1. In BusinessEvents Studio Explorer, right click the folder where you want to store the rule and select
New > Rule . You see the New Rule Wizard.

2. In the Rule Name field, type a name for the rule. In the Description field, type a description as
desired. (In the source editor the description appears in the @description line of the comments at
the top of the editor.)

You cannot change the name in the editor. To change the name of any project element,
right-click the element in BusinessEvents Studio Explorer and select Refactor > Rename .

3. Click Finish. By default, you see the source rule editor on opening the editor. It shows the outline
for a rule’s source code. Click the Form tab at the bottom of the editor to use the form editor.

At any time you can click the Form and Source tabs at the bottom of the editor to switch between
the form-based editor and the source editor as you work, depending on your preference.

Rule Editor Preference
 To set which mode the editor uses upon first opening, go to Window > Preferences >
TIBCO BusinessEvents > Rules and check or uncheck the Initially show ’Form’ tab
checkbox as desired.

4. In the Form editor Configuration section, add or edit a description as desired. (In the source editor
the description appears in the * @description line of the comments at the top of the editor.)

5. To control the order of rule execution:
a) If you want to control the order in which rules execute, set the Priority field accordingly. Highest

priority is 1. (In the source editor set priority = n where n is the priority number.)

If you want to also control the order in which rules with the same priority execute, set the Rank
field accordingly. Browse to and select the rule function you created for this purpose. (If you
want to use the source editor, add Rank=RuleFunction in the list of rule attributes.) See Using
Priority and Rank to Control Order of Rule Execution for details.

6. To disable forward rule chaining (the default behavior) uncheck the Forward Chain checkbox. (In
the source editor set forwardChain = false.)

7. In the Declarations section (equivalent to the declare statements in the source editor), drag an
ontology entity into the section, OR do the following:
a) Click Add to add resources that you will be using in your rule. You see the Select Rule

Declaration Arguments dialog.
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b) In the upper half of the Select Rule Declaration Arguments dialog, select the kind of entity you
want to use.

c) In the lower half of the dialog, select a resource from the filtered ontology tree, and click OK.
Your selection appears in the Declarations list. TIBCO BusinessEvents assigns an alias to the
resource. You can edit the alias.

d) To re-order the declarations, highlight a declaration and click the up or down arrow to move it.
This is relevant only in rule functions, to order the arguments.

Repeat to add more entity types as desired.

8. In the Conditions section (equivalent to the when statements in the source editor), write condition
statements (in the TIBCO BusinessEvents rule language).

Each line is a complete statement. Each condition must evaluate to a Boolean value. Each line is
joined to the others with an implicit AND operator. All of a rule’s conditions must evaluate to true
for the conditions to be satisfied. See Order of Evaluation of Rule Conditions in TIBCO
BusinessEvents Architect’s Guide for more information.

See Using Variables and Functions in the Rule Editor for more information on working in the rule
editor.

9. In the Actions section (equivalent to the then statements in the source editor), write action
statements (in the TIBCO BusinessEvents rules language).

10. Save the resource.

Rule Editor Reference

The rule editor and rule function editor are similar. This section focuses on the form-based rule editor.
You can adapt the information in the Area and Property section to apply to the different blocks of code
in the source editor.

Property Description

Configuration Section

Name 
(Wizard only)

The name to appear as the label for the resource. Do not use any reserved words.
Names must be unique within a folder. See Identifier Naming Requirements .

Description

(Editor and
Wizard)

Short description of the resource.

Priority

(Editor and
Wizard)

Specify a value between 1 and 10, where 1 is the highest priority and 10 is the
lowest priority. Rules with a higher priority execute before rules with a lower
priority.

See also Rank. Only set priority or rank where there is a reason to control the
order of rules. As a general practice, it is more efficient to let the engine
determine the order of rule firing.
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Property Description

Rank Specifies a rule function that controls the order of execution of rules with the
same priority. Validity must include Condition (that is, do not select Action Only
as the validity.)

See Using Priority and Rank to Control Order of Rule Execution for details.

Default is 0.0.

Forward Chain Determines if the rule is used in forward chaining. If the checkbox is unchecked,
changes made by this rule won’t trigger other rules.

Default is checked.

Declaration Section

Term A concept or event type in the project that you will use in your rule. Types you
add to the declaration define the scope of the rule.

For example, a concept definition such as /Concepts/Accounts/CheckAccount.

It is not necessary to add scorecards in the declaration in order to use them in the
rule.

Alias A name used to refer to the scope element in the body of the rule. You can change
the alias. Like resource names, aliases must be valid identifiers See Identifier
Naming Requirements .

Conditions Section

Each line in the Conditions area is a single expression that evaluates to true or
false. Each line is joined to the others with an implicit and operator.

For the OR operator, use a double pipe (||) on the same line.

TIBCO BusinessEvents evaluates single conditions from left to right. TIBCO
BusinessEvents optimizes the evaluation of multiple conditions (see Order of
Evaluation of Rule Conditions in TIBCO BusinessEvents Architect’s Guide.)

Actions Section

List of statements that will be executed when the rule is fired.

Adding a Rule Function
Regular rule functions have arguments and a body containing the code for the function. Virtual rule
functions have arguments but no body. Virtual rule functions are used only with the TIBCO
BusinessEvents Decision Manager add-on software. The implementation for virtual rule functions is
provided by one or more decision tables. See TIBCO BusinessEvents Decision Manager product
documentation for more details.

Adding a Rule Function

See Rule Function Resource Reference for details on completing values.
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Procedure

1. In BusinessEvents Studio Explorer, right click the folder where you want to store the rule function
and select New > Rule Function . You see the New Rule Function Wizard.
a) In the Rule Function Name field, type a name for the rule function.
b) In the Description field, type a description. (In the source editor the description appears in the *

@description line of the comments at the top of the editor).
c) Set the return type for the rule function. Default is void. Browse to select a return type as

needed. For return types that require additional configuration, such as ContainedConcept,
complete the configuration in the Rule Function editor.

d) If you want this rule function to be a virtual rule function (to be implemented by a decision
table), check the Virtual checkbox.

You cannot change the name in the editor. To change the name of any project element,
right-click the element in BusinessEvents Studio Explorer and select Refactor >
Rename . See Element Refactoring Operations for more details.

2. Click Finish. If you see the source editor, click the Form tab at the bottom of the editor to use the
form editor as desired.

At any time you can click the Form and Source tabs at the bottom of the editor to switch between
the form-based editor and the source editor as you work, depending on your preference.

Rule Function Editor Preference
 To set which mode the editor uses upon first opening, go to Window > Preferences >
TIBCO BusinessEvents > Rules and check or uncheck the following checkbox as desired:
Initially show ’Form’ tab in Rule Function Editor.

3. In the Form editor Configuration section, add or edit an alias and a description as desired. (In the
source editor the description appears in the * @description line of the comments at the top of the
editor and the Alias appears in the attribute list.).

4. If you did not do so in the Wizard, use the Return Type to select the return type of the rule function.

5. If you did not do so in the Wizard, set the Virtual check box according to your need. Check the
check box if you are creating a virtual rule function (to be implemented by a TIBCO BusinessEvents
Decision Manager decision table).

In the source editor, the signature of a virtual rule function is:
   virtual void rulefunction folder.RFName

Do not add code to the Body block in the source editor of a virtual rule function. If you do,
you see error messages if you try to save or to switch to the form-based editor.

6. From the Validity drop-down list, select the value that specifies where the rule function can be used
(source editor attribute equivalents shown in parentheses):

● Action (validity=ACTION)

● Action and Condition (validity=CONDITION)

● Action, Condition and Query (validity=QUERY)

Virtual rule functions have a non-editable validity setting of Action.

7. If the rule function returns a value, specify the Return Type, otherwise leave this field set to void.
(Appears in the signature of the rule function in the Source editor.)

Virtual rule functions have a non-editable return type of Void.
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8. In the Scope section (scope statements in the source editor) you define the arguments of the rule
function. Drag entities into the Scope area from BusinessEvents Studio Explorer, OR do the
following:
a) Click Add to add resources that you will be using in your rule function. You see the Select Rule

Function Scope Arguments dialog.
b) In the upper half of the Select Rule Function Scope Arguments dialog, select the type you want

to use.
c) If you want to specify an array, check the isArray checkbox. (You can specify a variable array in

the source editor in the usual way, for example, int[] myArr.)
d) If the type you select is an ontology type, in the lower half of the dialog, select a resource from

the filtered ontology tree.
e) Click OK.

Your selection appears in the list. TIBCO BusinessEvents assigns an alias to it. You can edit the
alias.

Add more entities as needed.

9. Add more arguments as needed, and use the up and down arrows to order the arguments as
needed.

10. In the Body section (Body statements in the source editor), use the TIBCO BusinessEvents rule
language to implement the function. (Virtual rule functions have only a signature, and no
implementation at design time.)

See Using Variables and Functions in the Rule Editor for more information on working in the rule
editor.

11. Save the resource.

Rule Function Resource Reference

Rule Function resources enable you to write rule functions that you can use in rules, as startup and
shutdown actions, and as preprocessors.

Virtual rule functions are decorated with a V.

Property Description

Configuration Section

Name 
(Wizard only)

The name to appear as the label for the resource. Names follow Java variable
naming restrictions. Do not use any reserved words. Names must be unique
within a folder. See Identifier Naming Requirements .

Description

(Editor and
Wizard)

Short description of the resource.

Return Type

(Editor and
Wizard)

If the rule function returns a value, specify the Return Type, otherwise leave set
to void.
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Property Description

Virtual

(Editor and
Wizard)

If set to yes, the rule function is a virtual rule function. Virtual rule functions have
arguments but no body. The Body section is disabled and so is the Return Type
field. The body is provided by a decision table. See TIBCO BusinessEvents
Decision Manager User’s Guide.

Alias Optionally, enter an alias for the rule function. Used as a short way to refer to the
rule function. You can use the alias, for example, to make query strings shorter (if
you have the TIBCO BusinessEvents Event Stream Processing add-on).

Validity Specifies where the rule function can be used. Possible values are as follows:

Action
 Indicates that this rule function can be used only in the Action block of a rule.

Action and Condition
 Indicates that this rule function can be used in the Action and Condition blocks
of a rule.

Action, Condition and Query
 Indicates that this rule function can be used in the Action and Condition blocks
of a rule, and can also be used in the text of a query (The query language
features are available only in TIBCO BusinessEvents Enterprise Suite).

Note
: Only Action rule functions can be used as startup rule functions or shutdown
rule functions.

Scope Section

Term The type of the argument. Arguments and return type can be any of the
following, including arrays of these datatypes:

● Primitive, that is any of: String, int, long, double, boolean, DateTime,
Object

● Concept
● Event
● Specific type of Concept
● Specific type of Event

The Object data type is used to pass parameters between standard and user-
defined functions and external Java sources.

Alias Each argument requires a type and an alias. Names must be valid identifiers.

Body Section

List of statements that will be executed when the rule function executes.

Using Variables and Functions in the Rule Editor
This section provides some tips on working in the rule editor. The rule editor is used for TIBCO
BusinessEvents rules, rule functions, and state machine rules.
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Using Catalog Functions in the Rule Editor
To use catalog functions in an editor choose one of the following methods.

Procedure

1. When adding code in the rule editor, do one of the following.

● Type the function name, starting with the folder path to the function.

Do not enter the catalog name (which appears in the list of catalog functions in the Catalog
Functions view, and looks like a top-level folder). Type a period at the end of the folder name.
A popup window shows all folders and functions within the folder whose name you typed.
For example type Database. to see a list of all functions in the Database folder.

● Open the Catalog Functions view. To open the view click as follows:

Window > Show View > Other > TIBCO TIBCO BusinessEvents > Catalog Functions.

Drill down on categories within the catalog to expand to lists of functions and drag the desired
function to the rule editor.

2. Provide parameter values as indicated by the tooltip. You can hover the cursor over a function to
display a tooltip showing the function’s arguments. You can also see the tooltip contents in the
online reference, TIBCO BusinessEvents Functions Reference.

Result

See TIBCO BusinessEvents Architect’s Guide for descriptions of the various function catalogs, and an
explanation of the decorations that appear on many function names. For information about configuring
mapper functions see Using the Function Argument Mapper.

Using Global Variables in the Rule Editor
To use a global variable in the rule editor, use one of the System.getGlobalVariableAs* functions.
For example:
System.getGlobalVariableAsString("Hostname", "Localhost")

Where Hostname is the name of the variable and Localhost is an optional literal value to use if the
variable is not found.

Do not use this syntax: %%Global.Variable.Name%%.

See Global Variables for more details about global variables.

Using the Function Argument Mapping Wizard
For functions known as mapper functions you can use the Function Argument Mapping wizard to map
inputs from a source to the function arguments.
See Mapping and Transforming Data for a reference to using the Function Argument Mapping wizard.

In the TIBCO BusinessEvents language, array indexes start from zero (0). However, in XSLT and XPath
languages, they start from one (1). It’s important to remember this difference when using the rule
language in the rule editor, and when working in the XSLT mapper and the XPath builder.

Procedure

1. Open the Function Argument Mapping wizard n either of the following ways:

● In the rule editor, type the category of function you want to use and select a mapper function
from the list of functions in that category. The function argument area contains the text
"xslt://". Ctrl+click the text "xslt://" to open the Function Argument Mapping wizard.
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● Type the name of a mapper function category into the Actions or Conditions areas, then type
an open parenthesis ( "(" ) TIBCO BusinessEvents displays "xslt://". Ctrl+click the text
"xslt://" to open the Function Argument Mapping wizard.

● Type the entire string to specify the function category path and name, followed by
("xslt://"). Then control-click the text "xslt://" to open the Function Argument Mapping
wizard.

2. In the Function Argument Mappingwizard, under the Function section, take appropriate action. For
example, if you are using Instance.createInstance(), click the Browse button to the right of the
Entity Path field and select a concept type so you can create an instance of it.

3. Under the Input section, on the left side, TIBCO BusinessEvents displays a list of variables
associated with the project, and on the right, a list of properties for the selected resource type.

4. Drill down and expand the lists on both sides to expose the variables and properties.

5. Drag variables from the left to the appropriate property on the right.

The Function Argument Mapping Wizard in XPath 1.0 Project
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The Function Argument Mapping Wizard in XPath 2.0 Project

6. (XPath 1.0) If you want to define the arguments using more complex logic, type the code or click the
XPath Formula Builder  icon to use the XPath Formula Builder. See XPath Formula Builder.

7. (XPath 2.0) If you want to define the arguments using more complex logic, type the code in the
XPath Expression column or click the Show/Hide Edit Tab  icon to display the Edit Statement
tab. On the left side, click the Functions tab to see the available mapper functions and then drag and
drop the functions to the XPath Exression textbox. See XPath Formula Builder.

8. Click OK.

Using Priority and Rank to Control Order of Rule Execution
For each RTC, the rule agenda is sorted by priority and then within priority by rank, for those rules that
use the same ranking. Use of priority and rank is optional. You can also use priority without using
rank.

In the rule’s Rank field (or rule attribute, in the source view), you specify a rule function that returns a
double. The larger the return value, the higher the ranking. You can specify the same rule function in
different rules to perform ranking across tuples of those rules. Here are the requirements:

● The rule function must have a Validity setting that includes Condition (that is, do not set it to Action
Only).

● You can assign the same rule function to different rules as long as the following is true:

— The scope of the rule function includes only parameters found in all the rules that use the same
function. This can be a subset of what’s in the rule declaration. (As with rules, primitives are not
allowed.)

— The parameters must be used in the same order as they appear in the rule declaration.
● The rule function must return a double value. (The default value for the Rank field is 0.0.)
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Examples
For example, suppose two rules declare CustName and SupportLevel (plus other things that can be
different). You assign the same rule function to both rules. The function returns 3.0 for Gold support
level, 2.0 for Silver, and 1.0 for Bronze. As a result, among rule tuples with priority 1, those for
customers with Gold support execute before those for customers with Silver support, which execute
before those for customers with Bronze support.

Below is an example showing how rule priority and ranking determine the sort order. Suppose you
assign the same rule function for ranking rules 1, 2, and 3. At run-time these are some rule tuples to be
sorted in the agenda for an RTC:

Rule 1 (Tuple X) Priority: 5 Rank: 10.0

Rule 2 (Tuple A, B) Priority: 1 Rank: 1.0

Rule 2 (Tuple A, C) Priority: 1 Rank: -1.0

Rule 2 (Tuple A, D) Priority: 1 Rank: -2.0

Rule 3 (Tuple A) Priority: 4 Rank: 0.0

They are sorted and executed as follows. (This could change during a conflict resolution cycle, of
course, depending on the effect of rule actions.)

Rule 2 (Tuple A, B) Priority: 1 Rank: 1.0

Rule 2 (Tuple A, C) Priority: 1 Rank: -1.0

Rule 2 (Tuple A, D) Priority: 1 Rank: -2.0

Rule 3 (Tuple A) Priority: 4 Rank: 0.0

Rule 1 (Tuple X) Priority: 5 Rank: 10.0

Reverse Order Example

If you want the rule with the smallest return value to be ranked highest, multiply by negative one (-1.0)
to reverse the size of the values. For example suppose you want rules that were asserted earlier to
execute before those that were asserted later. The time values returned by three rules are 100, 150, and
300. Using -1.0 * time), they will be fired in the desired order: -100.0 (the largest value), then -150.0,
then -300.0.

Using the Quick Fix Feature in the Rule Editor
The Quick Fix feature enables you to create concepts, events, and rule functions without leaving the
rule editor. It also enables you to add properties to existing concepts and events. The feature is
available when an unknown reference appears in the rule or rule function code.

This feature is also used in the state modeler feature, available in TIBCO BusinessEvents Data
Modeling, wherever the rule editor is used.

If a qualified name has multiple unresolved references, for example,
Concepts.Something.Somethingelse, the Quick Fix feature only applies to the first unresolved
reference in the name.
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Using the Quick Fix Feature

Procedure

1. Type the code in the rule editor as if the entity, property, or rule function you want to use already
exists. See Quick Fix Feature Options for some examples.

You see a lightbulb icon in the left margin on any line where there are unknown references that you
can configure using Quick Fix.

2. To use the available Quick Fix options, click the lightbulb icon or press Ctrl+1. The options are
explained in Quick Fix Feature Options:

Result

Quick Fix Feature Options

Unknown Reference Quick Fix Editor

Unqualified name.
Example:
SomeName s;

A list of appropriate wizards appears so you can create a new
concept, simple event, or time event. The wizard you select opens so
you can define the entity.

Unqualified name followed
by parentheses. Example:
SomeName()

A link to the rule function creation wizard appears. Click it to open
the wizard and define the rule function.

Qualified name. Examples:
Rules.SomeName();
Concepts.SomeName s;

A Quick Fix option appears so you can automatically create the entity
or rule function in the given folder.

The folder must already exist in the project.

Qualifier is a concept or
event and reference is
unknown. Example:
Concepts.Person person;
person.someProperty = 
"123"

A Quick Fix option appears with the name: Create a property
definition in the entity’entityName’. Click the option to open the
New Property Definition dialog, and configure the details of the
property.

In the example, the someProperty property does not already exist as
a property of Concepts.Person.

The following table explains the arguments.
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Argument Notes

Object txns You can turn this argument into an Object[] within the rule function, for
example:
Object[] array = txns;

The resulting array can be used to obtain useful data:

● array[0] is a Concept[] containing all the Concept objects that:

— have been created in the current RTC,
— and have not been deleted.

● array[1] is a Concept[] containing all the Concept objects that:

— existed before the current RTC,
— have been modified in the current RTC,
— and have not been deleted.

● array[2] is a Long[] containing the id of all the Concept objects that:

— existed before the current RTC,
— and have been deleted in the current RTC.

● array[3] is a SimpleEvent[] containing all the SimpleEvent objects that:

— are going to be added to the cache.
● array[4] is a Long[] containing the id of all the Event objects that:

— existed before the current RTC, or arrived and started the RTC,
— and have been deleted in the current RTC.

int errorType Value can be one of:

-1 for errors happening during database operations.

-2 for errors happening when sending an event.

int errCode The error code, which is dependent on errorType:

● For database related errors:

— The error code as returned by SQLException, if available

— Else -100 if TIBCO BusinessEvents determines that the database is not
available

— Else -200, which means that this is an unknown error

● For sent event errors, the value is -1, meaning an internal error condition.

String errMsg The associated exception message.

long retryCount The number of times this transaction has been retried before the present call to
the callback.
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Tips for Working in the Rule Editor
Here are some tips for working with the Rule Editor

Switching between Form and Source Editors

You can freely switch between form and source editors for rules and rule functions. In each case the
editors stay synchronized with the latest changes.

You cannot switch from the source editor to the form editor if there are any syntax or resolution errors
in your code.

The Priority setting
is used by the runtime engine when determining the order in which rules are fired. Rules with a
number closer to one fire first. When there is no reason to force rules to execute in a particular order,
leave the Priority set to the default and let the runtime engine determine rule order.

Declaring multiple terms of the same type
 Allows the rule to consider multiple instances of the corresponding entity. Specify different aliases to
keep the terms distinct

Scorecards
 Scorecards are like concepts except that there is only one instance of a scorecard (or more accurately,
one instance per agent when multi-engine features are used). It is therefore not necessary to put
scorecards in the declaration of a rule because a scorecard never requires an alias. You can use
scorecard properties in conditions (just as you would concept properties). However, because a
scorecard doesn't have an alias, refer to it like a function, for example,
Folder.Folder.Scorecard.prop1

Standard Eclipse Features

In addition to some TIBCO BusinessEvents-specific features, the source and form rule editors support
standard Eclipse functionality such as the following: Undo and redo; copy and paste; breakpoint
features; standard text annotations (which can be changed using Preferences); text folding (source
editor only); Java outline view (source editor only).

When you’re working in the source editor, press Ctrl+Shift+L to see a list of keyboard shortcuts
available in that context. (This is a general Eclipse feature.)

Information Highlighted

Keywords, variables, and functions are highlighted in the text. Also, when you hover the mouse over a
resource such as a concept, event or function, information about it displays in a tooltip.

Syntax and resolution errors are automatically flagged by visual cues. They are underlined and also
display in the vertical and overview rulers.

Miscellaneous Tips

Some other tips are highlighted below.

Tips for Working in the Rule Editor

To do this... Do this...

Switch Between
Source and Form
Editors

Click the bottom tabs to switch between the source and form editors. The code
remains synchronized. However, you cannot switch if there are errors in the
code. First resolve the errors, then switch.
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To do this... Do this...

To Use Content
Assist to
Complete Values

The content assist feature helps you complete values using information that is
available in resources. For example, if you type the name of a concept type (or its
alias) and then a period, a list of the concept type properties appears for you to
select from.

The selection list also appears when the cursor is in an appropriate location and
you press Ctrl+Space, or if you right click and select Edit > Content Assist from
the context (right-click) menu.

To Comment
(and
Uncomment) a
Line

To comment out a line, or uncomment a line, press Ctrl+/ or select Edit > Toggle
Comment from the context menu.

To Search for
References

When the cursor is placed in an appropriate item in the code such as an entity or
function name, you can find all references to that item references in the rule
code. Press Ctrl+Shift+G, or select Search > Search for References from the
context (right-click) menu. The item references are highlighted in the text, and
an arrow appears in the vertical ruler.

To Jump to the
Definition of an
Item

To jump to the location where an item is defined, you can use two methods.

● Click in the item name and press F3, or right-click and select Open
Declaration.

● Press and hold the Control key while you move (hover) the mouse pointer
the text. When you hover over an item that displays an underline, Ctrl+click
the item to jump to the place where it is defined.

For example, you would jump from an alias to the declaration, and from an
entity or entity property to the entity’s editor.

Event Preprocessors
Event preprocessors are rule functions with one argument of type simple event.

Event preprocessors are not used for time or advisory events,and they are multithreaded.

An event preprocessor is assigned to a destination and acts on all events arriving at that destination.
Event preprocessors perform tasks after an incoming message arrives at the destination and is
transformed into a simple event, but before it is asserted into the Rete network (if it is — events can be
consumed in the event preprocessor).
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TIBCO BusinessEvents Express
Content relating to Cache OM and backing store is not relevant to TIBCO BusinessEvents Express
edition.

Time events do not go through an event preprocessor
If you are using Cache Only mode, take care when designing rules that execute as a result of a time
event. For example, a rule that has a join condition using a time event and a concept would not
execute if the concept is not loaded in the Rete network and so should not be used in an event
preprocessor if the concept is configured as Cache ONly mode.

Acknowledgement
Events consumed in a preprocessor are acknowledged immediately (and not after the post RTC
phase).

You can aggregate events, edit events, and perform other kinds of event enrichment in a preprocessor.
You can also use preprocessors as explained below.

You must set locks in the preprocessor when concurrency features are used to protect concept instances
during RTC. Locking ensures that updates to concept instances during an RTC do not conflict with
another set of updates to the same concept instances in another RTC. Locks are released at the end of
the RTC.

If you are using the Cache Only mode for any entities, you must also load the relevant entities from the
cache using an event preprocessor.

You can also use preprocessors to improve performance by avoiding unnecessary RTCs in the inference
engine. For example you can consume events that are not needed. Another way to use the preprocessor
for efficient processing is to transfer an event’s contents to a new concept that is not processed by the
agent's set of locally active rules. Such a concept is automatically asserted, does not trigger rules, and is
saved into the cache (depending on OM configuration) where it is available for processing by any agent
as needed.

Transaction Error Handler Rule Function
You can create a transaction error handler callback rule function that enables you to identify which post
RTC transactions failed or which events were not sent out during the post RTC phase. The transaction
error handler rule function is invoked each time a database transaction exception occurs, and each time
a send event exception occurs.

This feature requires cache-aside database write strategy. When backing store is enabled, the default
value for the property Agent.agentclassname.enableParallelOps is true. The feature is not
supported when the property value is set to false:
Agent.agentclassname.enableParallelOps=false

When the backing store is disabled, the default values for the cache-aside database write strategy and
the property Agent.agentclassname.enableParallelOps are false.

Set these two values to true explicitly in the CDD file in order to use the transaction error handler rule
function.

The error handler rule function provides full details of the failed transactions. The transaction details
provided in this callback function can be used for audit trail purposes. The engine continues retrying
the transaction or action as usual.

To Register the Rule Function

To register the rule function, add the following property to the be-engine.tra / project CDD file at an
appropriate level (for example, at the cluster level to affect all deployed engines). Set the value to the
project path of the error handler rule function:
be.engine.txn.error.function=projectPathToErrorHandlerRuleFunction
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Rule Function Signature

The required signature for the error handler rule function is:
int Name (Object txns, int errorType, int errCode, String errMsg, long retryCount)

The return value must be 0 (zero).

Aerguments are explained in Transaction Error Handler Rule Function Reference.

Transaction Error Handler Rule Function Reference
This table contains reference for the Transaction Error Handler rule function.

Argument Notes

Object txns You can turn this argument into an Object[] within the rule
function, for example:
Object[] array = txns;

The resulting array can be used to obtain useful data:

● array[0] is a Concept[] containing all the Concept objects that:

— have been created in the current RTC,
— and have not been deleted.

● array[1] is a Concept[] containing all the Concept objects that:

— existed before the current RTC,
— have been modified in the current RTC,
— and have not been deleted.

● array[2] is a Long[] containing the id of all the Concept objects
that:

— existed before the current RTC,
— and have been deleted in the current RTC.

● array[3] is a SimpleEvent[] containing all the SimpleEvent
objects that:

— are going to be added to the cache.
● array[4] is a Long[] containing the id of all the Event objects

that:

— existed before the current RTC, or arrived and started the
RTC,

— and have been deleted in the current RTC.

int errorType Value can be one of:

-1 for errors happening during database operations.

-2 for errors happening when sending an event.
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Argument Notes

int errCode The error code, which is dependent on errorType:

● For database related errors:

— The error code as returned by SQLException, if available

— Else -100 if TIBCO BusinessEvents determines that the
database is not available

— Else -200, which means that this is an unknown error

● For sent event errors, the value is -1, meaning an internal error
condition.

String errMsg The associated exception message.

long retryCount The number of times this transaction has been retried before the
present call to the callback.

Handling Post-RTC action errors:
When Post-RTC actions fail, such as acknowleding or sending a
message, action handlers try only 10 times with 500 milliseconds
sleep. The following parameter scan be configured:

● be.engine.txn.action.retrycount, default is 10.

● be.engine.txn.action.sleeptime, default is 500 milliseconds.

Handling Post-RTC database transaction errors:

In case of database exception, the numer of tries and waits between
each tries are handled by the following configuration parameters:

● be.engine.txn.database.retrycount, default is maximum
integer.

● be.engine.txn.database.sleeptime, default is 5000
milliseconds.

After the number of tries are exhausted, the transaction is aborted.

You can also perform additonal actions by registering an error
handler fule function as before:

See be.txn.error
function=projectPathToErrorHandlerRuleFunction.

When the number of tries are exhausted and the
transactions are aborted, it is likely that the cache and
database will be in an inconsistent state. Practice care when
setting a limit to the number of retries. Logs shold be also
monintored for database related exceptions and immediate
action should taken as soon as possible. It is also advised to
disable parallel operations if a limit is set to the number of
retries. In this case, multiple transactions are committed to
the database together and a single database failure can
affect multiple of them.
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Rule Template and Rule Template View

A rule template is a specialized type of rule, and a rule template view puts a user-friendly interface
around the rule template for use in Web Studio.

Rule templates and rule template views enable non-technical Web Studio users to define executable
rules (called business rules) within limits defined in the rule template.

Adding a Rule Template View
First add a rule template. One rule template can be associated with multiple views. .

Procedure

1. Right-click the folder where you want to store the rule template view, and select New > Other >
TIBCO BusinessEvents > Rule Template > View . You see the New Rule Template View Wizard.

2. In the Rule Template field, click Browse and select the rule template whose bindings you want to
use in this view.

3. In the Rule Template View Name field, type a name for the rule template view. In the Description
field, type a description.

You cannot change the name in the editor. To change the name of any project element,
right-click the element in BusinessEvents Studio Explorer and select Refactor > Rename .
See Element Refactoring Operations for more details.

4. Click Finish. You see the Rule Template View editor.

5. Add or edit the description.

6. As needed, browse and select a different rule template

7. As needed, click the Rule Template link to edit the selected rule template, for example to add new
bindings.

Bindings defined in the rule template appear in the Bindings section of the Presentation section.

8. In the Presentation tab, use plain text or HTML to define an input form. Drag and drop the
bindings into the Presentation section, or type them.
The syntax for a binding is as follows (the closing tag is required):
   <binding id="bindingName"></binding>

You can click the Preview tab to see how the view will appear in WebStudio.

9. Optional: Click the HTML tab and click Browse to select an HTML file, which can be used for the
input form.
Use the binding ID in the HTML file for creating the text box or dropdown for the binding. The
syntax for the binding is same as specified earlier step.

Currently, when you click on the Preview tab, the preview of the HTML file is not
displayed.

10. Save the resource.
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The Rule Template Editor
Comparing similar sections of the Rule Template editor and the Rule editor highlights the unique
features of rule templates.

Configuration Section

The Configuration section is the same as the Configuration section in a rule. Priority, ranking, and
forward chaining features work the same at runtime whether a rule is created using the Rule Editor or
the Rule Template Editor.

Declarations and Variables Section

The Declarations and Variables section (declare in the source view) is similar to the Declaration
section of a rule. However, in rule templates you can declare primitive types (as you can in rule
functions). You can also define initial expressions for primitive types, for example, int j = 50;.

Pre-conditions Section

The Pre-conditions section (when in the source view) is similar to the Conditions section of a rule.
However, WebStudio users can add additional conditions when defining individual business rules. The
Pre-conditions section specifies conditions that must be met in all instances of a rule template before the
rule’s actions execute.

Another difference is that the Pre-conditions section can contain non-conditional statements, for
example, local variable declarations, to provide more flexible and comprehensive condition checking
capabilities. Here is a simple example of such a section:
int i=con.prop1;
int j=con2.prop1;
i > j;
i == j;

This feature enables complex calculations to be done before the definition of the condition. The Pre-
conditions section could also contain conditions that might appear in any rule, such as the following:
con.prop1 > con2.prop1;

Action Context Section
The Action Context section (actionContext in the source view) has a similar purpose to the Actions
section of a rule.

The Action Context section (actionContext in the source view) has a similar purpose to the Actions
section of a rule. The Action Context section, however, defines all possible actions that can be taken by a
business rule (after all conditions are met). Only the action context statements that the WebStudio user
selects and defines as commands in the business rules are actually taken (depending on rule evaluation
at runtime).

Defining the superset of all possible actions simplifies and restricts the configuration of business rules
in WebStudio.

The actions are not completely defined in the rule template. Completing the definition of an action is a
WebStudio user task. If bindings are used (and a view) then in WebStudio, the business rule writer has
to enter only the binding values to complete the definition.

Action context statements are of three types: create, modify, and call, plus arbitrary actions, as
explained next.

Create Statements
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Create statements enable business rule developers to create new concepts or events. Create statement
uses fully qualified name for the concepts and events instead of simple name. For example:
create Concepts.Bulk bulk;

In the rule template, that is as far as you go. It’s up to the business rule developer to assign the specific
constructor values for the entity type.

Modify Statements
Modify statements enable business rule developers to modify concepts or events. For example:
modify bulk;

Only entities in the scope of the rule can be used. As with create statements, it is up to the business
rule developer to determine which properties to change and assign values to those properties.

Call Statements
Call statements enable business rule developers to call rule functions. Call statement uses fully
qualified name for the concepts and events instead of simple name. Call statement uses a variable to
store the return value. Call statement uses this return variable even if the return type is void. For
example:
call RuleFunctions.matchFound matchfound;

The business rule developer assigns the parameters for the rule function.

Arbitrary Actions
Rule template developers can add arbitrary actions as well as create, modify, and call statements. For
example:
create Concepts.Bulk bulk;
if (mybinding > 10) {
   MyRFs.myRF(otherbinding);
   mycon.prop1 = thirdbinding;
}

Bindings Tab
The form editor for rule templates provides an additional tab, the Bindings tab, with two sections that
are not found in the Rule editor: Bindings and Views (bindings and views in the source view).

Bindings

A binding is used like a local variable whose value is assigned by WebStudio users when defining
business rules.

When defining a rule template, you can use bindings in condition checks and in action statements. For
example, suppose you define a binding called dollarAmount. You could then define a condition as
follows:
output.UNIT_PRICE > dollarAmount;

At runtime, the UNIT_PRICE is checked against the specific dollar amount defined in the business rule.

Similarly, you could use the binding in an action statement as follows:
RuleFunctions.matchFound(match,null,dollarAmount);

When executed, the engine calls the matchFound rule function and passes the value of dollarAmount as
defined in the business rule.

Bindings are primitive types. You can optionally provide an initial value, and the value can be defined
using a domain model. You can specify a domain model by clicking in the Domain Model cell, and then
clicking the Browse icon. If a domain model is specified for a binding, the view defined for a rule
template displays the input field for the binding as a drop down box. In the following example, the
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String binding day is initially assigned to the value of Monday, and it is tied to the domain model
RuleFunctions.WeekDays.
String day = "Monday" (RuleFunctions.WeekDays);

Views

In the Views section of the Bindings tab, you select a view that you have already defined. The selected
view is used in WebStudio to present the rule template to the users and enable them to define the
business rules (that is, executable rules).

If you do not associate a view with a rule template, a builder-based interface is used.

Tips for Working in the Rule Editor
Here are some tips for working with the Rule Editor

Switching between Form and Source Editors

You can freely switch between form and source editors for rules and rule functions. In each case the
editors stay synchronized with the latest changes.

You cannot switch from the source editor to the form editor if there are any syntax or resolution errors
in your code.

The Priority setting
is used by the runtime engine when determining the order in which rules are fired. Rules with a
number closer to one fire first. When there is no reason to force rules to execute in a particular order,
leave the Priority set to the default and let the runtime engine determine rule order.

Declaring multiple terms of the same type
 Allows the rule to consider multiple instances of the corresponding entity. Specify different aliases to
keep the terms distinct

Scorecards
 Scorecards are like concepts except that there is only one instance of a scorecard (or more accurately,
one instance per agent when multi-engine features are used). It is therefore not necessary to put
scorecards in the declaration of a rule because a scorecard never requires an alias. You can use
scorecard properties in conditions (just as you would concept properties). However, because a
scorecard doesn't have an alias, refer to it like a function, for example,
Folder.Folder.Scorecard.prop1

Standard Eclipse Features

In addition to some TIBCO BusinessEvents-specific features, the source and form rule editors support
standard Eclipse functionality such as the following: Undo and redo; copy and paste; breakpoint
features; standard text annotations (which can be changed using Preferences); text folding (source
editor only); Java outline view (source editor only).

When you’re working in the source editor, press Ctrl+Shift+L to see a list of keyboard shortcuts
available in that context. (This is a general Eclipse feature.)

Information Highlighted

Keywords, variables, and functions are highlighted in the text. Also, when you hover the mouse over a
resource such as a concept, event or function, information about it displays in a tooltip.

Syntax and resolution errors are automatically flagged by visual cues. They are underlined and also
display in the vertical and overview rulers.
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Miscellaneous Tips

Some other tips are highlighted below.

Tips for Working in the Rule Editor

To do this... Do this...

Switch Between
Source and Form
Editors

Click the bottom tabs to switch between the source and form editors. The code
remains synchronized. However, you cannot switch if there are errors in the
code. First resolve the errors, then switch.

To Use Content
Assist to
Complete Values

The content assist feature helps you complete values using information that is
available in resources. For example, if you type the name of a concept type (or its
alias) and then a period, a list of the concept type properties appears for you to
select from.

The selection list also appears when the cursor is in an appropriate location and
you press Ctrl+Space, or if you right click and select Edit > Content Assist from
the context (right-click) menu.

To Comment
(and
Uncomment) a
Line

To comment out a line, or uncomment a line, press Ctrl+/ or select Edit > Toggle
Comment from the context menu.

To Search for
References

When the cursor is placed in an appropriate item in the code such as an entity or
function name, you can find all references to that item references in the rule
code. Press Ctrl+Shift+G, or select Search > Search for References from the
context (right-click) menu. The item references are highlighted in the text, and
an arrow appears in the vertical ruler.

To Jump to the
Definition of an
Item

To jump to the location where an item is defined, you can use two methods.

● Click in the item name and press F3, or right-click and select Open
Declaration.

● Press and hold the Control key while you move (hover) the mouse pointer
the text. When you hover over an item that displays an underline, Ctrl+click
the item to jump to the place where it is defined.

For example, you would jump from an alias to the declaration, and from an
entity or entity property to the entity’s editor.

Rule Template Views
A rule template view defines a visual presentation of the rule template to make it easy for the
WebStudio user to define a business rule.

The View uses rule template bindings to define an easy-to-use form-like interface where the WebStudio
user assigns values to the bindings, for example, threshold values. For example:
Require that all applicants have a minimum income of <binding id="minimumIncome"></
binding>, a minimum age of <binding id="minimumAge"></binding>, and restrict the 
credit type to <binding id="creditType"></binding>

If the binding is associated with a domain model, the WebStudio interface will display the input widget
as a drop down list. Otherwise, an input widget of the appropriate type is displayed, for example, a
check-box for a boolean field.
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Rule Template Editor Reference

The rule template, rule, and rule function editors are similar. This section focuses on the form-based
editor. You can adapt the information to apply to the different blocks of code in the source editor.

Property Description

Configuration Section

Same as the Rule Editor Configuration section. See Rule Editor Reference for details.

Declarations and Variables Section

Type Types you add define the scope. As in the Term section of a rule, you can specify
concept or event types in the project that you will use in your rule.

In addition you can specify variables using primitive types.

For example (in the source view):
Concepts.Accounts.CheckAccount checkacc;
int i = 123;

It is not necessary to add scorecards in the declaration in order to use them in the
rule or rule template.

Alias A name used to refer to the scope element or variable in the Pre-conditions (when)
and Action Context (actionContext) sections of the rule. Aliases must be valid
identifiers See Identifier Naming Requirements .

Expression If you specify a primitive you can also specify an expression.

Pre-conditions Section

Each line in the Pre-conditions area is a single expression. Expressions can be
local variable declarations, method calls and so on, as well as expressions that
evaluates to true or false such as are found in regular rules. Each line is joined
to the others with an implicit and an operator.

For the OR operator, use a double pipe (||) on the same line.

TIBCO BusinessEvents evaluates single conditions from left to right. TIBCO
BusinessEvents optimizes the evaluation of multiple conditions (see Order of
Evaluation of Rule Conditions in TIBCO BusinessEvents Architect’s Guide.)

Action Context Section

Defines the list of all possible actions that can be executed when a rule instance
based on this template is fired. Only the subset of these action context statements
that are defined as commands in the business rules, however, are actually
considered.

When you add an action context statement, you first select one of the action
types, then select an entity (create or modify action types) or rule function (call
action type).
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Functions

TIBCO BusinessEvents provides various built-in function to perform the standard tasks; however you
can also create your custom function to perform the task as per your requirement.

Catalog Functions
The functions registry includes various catalogs of functions provided with the product, and each
catalog organizes its functions into categories. You can use functions in rule conditions and actions and
in rule function bodies.

Some functions work together. For example, the Standard catalog function String.append requires
that you first use the function String.createBuffer, to create a buffer to which strings can be
appended.

To View the Catalog functions

All catalogs appear in the Catalog Functions view. To open the view navigate to Window > Show View
> Other > TIBCO BusinessEvents and select Catalog Functions. The catalog view appears on the right,
by default.

To View Documentation for Functions

Documentation for functions is provided in tooltips you can access while using the Catalog Functions
view. Hover the mouse over the function name to see the tooltips.

You can also access this documentation using the online functions reference, available in the HTML
version of the documentation, but not in PDF. To access the HTML version of documentation, visit 
https://docs.tibco.com/products/tibco-businessevents and open the Web Help.

Expand the contents panel to Online References > Online References, and on the right select the
TIBCO BusinessEvents Functions Reference link.

Built-in Functions
For all the built-in functions, this section lists the main categories in each function catalog (but not sub-
categories).

See TIBCO BusinessEvents Functions Reference for full details.

Standard Functions
The standard functions catalog contains the most used functions.

The standard function catalog includes the following categories:

Channel
These functions return information about destinations, and can resume and suspend a destination.

Cluster
Cluster functions help with multi-engine functionality.

Dashboard Function
Dashboard functions process an incoming request to generate an appopriate response. Starts
streaming updates, Stops streaming updates.

DataGrid
These functions are for use with Cache object management. See Cache Related Functions.
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Collections
Collections functions allow you to deal with various collections structures. The functions names are:

● Comparator

● Iterator

● List

● Map

● Set

● SortedMap

● SortedSet

Date
Date functions allow you to compare two DateTime values using only the date portion of the value.

DateTime
DateTime functions allow you to perform the date/time related tasks and more: add units of time to
DateTime, compare, retrieve, and format dates and times.

Engine
Engine functions allow you to retrieve information about the engine, for example, available memory
or the number of rules fired. The functions names are:

● Locale

● Profiler

● Rtc

● Variable

Event
Event functions allow you to assert, create, and send simple events and perform other event-related
tasks, for example, return the default destination URI of a simple event. The functions belonging to
this group are

● Exit functions

Exception
Exception functions enable you to create exceptions.

File
File functions provide various useful functions used when working with files.

Hawk function
Functions to interact with Hawk micro-agents methods.

HTTP
HTTP functions are used with the HTTP channel. The Functions that belong to this grouop are named

● Servlet functions
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Instance
Instance functions allow you to create and delete concept instances and perform other instance-related
tasks, for example, return an instance given an internal ID. The functions belonging to this grouop are
named:

● PropertyArray

● PropertyAtom

● Reflection

● StateMachine

Log
Log functions allow you to write statements in logs.

Math
Math functions allow you to perform advanced mathematical operations.

Metric Function
Creates a new Metric instance based on the data provided in the XSLT Mapper and adds it to the
working memory. Adding the instance to the working memory will cause any rule conditions that
depend on the concept to be evaluated.

Number
Number functions allow you to perform type conversions from and to numbers and return the
maximum and minimum values for a numeric type.

SOAP
SOAP functions enable you to work with SOAP messages sent through an HTTP channel.

String
String functions allow you to perform comparisons, searches, conversions, and other operations with
strings.

System
System functions allow you to send messages to a debug log, retrieve global variables, retrieve system
properties, and write data to a file. The functions that belong to this group are named:

● ID functions

● IO functions, which allow the writing and closing of specific files.

Temporal
Temporal functions allow you to examine and perform calculations on values stored in a property’s
history. For information about using temporal functions. The functions that belong to this group are
named:

● Calculus

● History

● Numeric

● Statistic

Util
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Util functions category has one sub-category for working with HashMaps.

VRF
VRF functions (that is, Virtual Rule Function functions) allow you to work with decision tables. See
TIBCO BusinessEvents Decision Manager User’s Guide for details.

XPath
XPath functions allow you to evaluate XPath expressions.

ActiveSpaces Functions

These functions allow you to interact with ActiveSpaces metaspaces. They are used with the
ActiveSpaces channels to perform operations on the ActiveSpaces metaspace and spaces connected by
the channel.

Process Orchestration Functions

These functions alow you to interact with process jobs. See TIBCO BusinessEvents Process
Orchestration documentation for details.

BusinessWorks Functions

BusinessWorks functions are used in ActiveMatrix BusinessWorks integration projects. See TIBCO
BusinessEvents Developer’s Guide, ActiveMatrix BusinessWorks Integration.

CEP Load Balancer Functions

Load balancer functions are used to configure and work with the load balancer. There are two types of
load balancer functions:

● Receiver functions, which allow you to create or discard a receiver, and retrieve the receiver’s
membership details.

● Router functions, which allow you to create or discard a router, and send an event to a remote
receiver.

CEP Pattern Functions

Pattern functions are used with the pattern matcher language for identifying patterns in events. See
TIBCO BusinessEvents Event Stream Processing add-on documentation for details.

CEP Query Functions

Query functions are used with the query language for querying data in the cache. See TIBCO
BusinessEvents Event Stream Processing add-on documentation for details.

Communication Functions

Communication functions provide a set of catalog functions that enables TCP communication. You can
create a local TCP server and a TCP client so that TIBCO BusinessEvents can communicate with data
sources not otherwise available through channels, using TCP.

Hawk Functions

Functions to interact with Hawk micro-agents methods.

DBMS Functions

Database functions are provided for working with database concepts. See TIBCO BusinessEvents Data
Modeling for more on database concepts.
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Security Functions

These functions are used internally by the TIBCO BusinessEvents Decision Manager add on, for
authentication.

Studio Functions

These functions allow you to use the Studio Util functions to build classes and EAR files.

Custom Functions
TIBCO BusinessEvents allows you to define custom functions and expose them as catalog functions or
mapper functions. By exporting the project containing the custom Java functions to a project libary, the
custom Java functions can be used in other projects.

Adding Custom Java Functions
Using TIBCO BusinessEventsyou can define custom functions and expose them as catalog functions. By
exporting the project containing the custom Java catalog functions to a project library, the custom Java
functions can be used in other projects.

Procedure

1. Define a simple Java class under the JavaSrc folder. For example, MyFunction.java.

2. To expose Java methods as functions, declare them as public static variables:
public static int sum(int a, int b) 
                                          {
                      int x = a+b;
                                                    return x;
                                          }

3. The annotation @BE Package is a class level annotation: add the class-level annotation @BEPackage
before any classes are declared.
@BEPackage(catalog = "arithmeticOperations", category = "arithmetic.operations", 
synopsis = "Performs few arithemtic operations")

4. The annotation @BEFunction defines the synopsis, signature, parameters, return types, descriptions,
examples and other relevant information about the function. The information provided in the
annotation is displayed in the tooltip for the catalog function.
@BEFunction(name = "SummationTest", 
            description="Adds two given numbers", 
            signature="int sum(int a, int b)",
                   freturn = 
@com.tibco.be.model.functions.FunctionParamDescriptor(name = "", type = "int", 
desc = "Returns the summation of a and b."),
            params = {
            @com.tibco.be.model.functions.FunctionParamDescriptor(name = "a", 
type = "int", desc = "First arg"),
            @com.tibco.be.model.functions.FunctionParamDescriptor(name = "b", 
type = "int", desc = "Arg two")
            },
            fndomain = {ACTION, CONDITION, QUERY, BUI}, 
version="1.0",see="",cautions="none", example=" ")
                    
                

5. Save the file.
Once you add and save the annotations, the custom Java functions are available in the Catalog
Functions view.
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Adding Libraries
TIBCO BusinessEvents core libraries are automatically added to the Java Build Path.

If the project library contains Java source files, then those Java source files must be added to the Java
build path source section. This ensures that the Java classes present in the project library are accessible
from the Java source file of the current project.

Importing Old Projects
When older projects are imported to a 5.2 environment, the project nature is updated to include the
Java nature. The .project file contains the following entries:
    <natures>
        <nature>com.tibco.cep.studio.core.studioNature</nature>
        <nature>org.eclipse.jdt.core.javanature</nature>
    </natures>

Compiling Project and Building an EAR File
There is no change in the process to compile and build an EAR file.

Click Project > Build Enterprise Archive from the menu to build an EAR file.

Debugging
While debugging the projects, you can use Java breakpoints to step into the custom functions code. Java
debug breakpoints and rulefunction breakpoints work seamlessly, allowing you to step into the code
after hitting a breakpoint and inspect the values of the variables as they change.

Annotations Reference

Reference for @BEPackage

Field Description

enabled This annotation allows the user to specify if an associated annotation is enabled or
disabled for use.

catalog Name of the catalog where the custom function will reside.

category Category for the custom functions defined in the class.

synopsis Brief description for the group of custom functions defined in the specified
directory.

Reference for @BEFunction

Field Description

enabled This annotation allows the user to specify if an associated annotation is enabled or
disabled for use.

deprecated This annotation element identifies if its associated method is deprecated or not.

name Name of the custom function.

synopsis Brief description of the custom function.
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Field Description

signature Signature for the custom function.

params List of parameters for the custom function.

freturn Return type of the custom function.

version The TIBCO BusinessEvents version from which a given catalog function became
public API.

see Refers to the other custom functions or java doc URLs.

mapper Used for functions that involve invoking a mapper UI on Ctrl-Click.

description Detailed description of the custom function.

async A boolean value indicating if the use of this function will cause the rules to be
evaluated again.

reevaluate A boolean value value indicating if the use of this function will cause the rules to
be evaluted again.

cautions List any cautions that may be applicable when using the custom function.

domain The specified domain, from which Java methods are accesible. Examples of
domain are ACTION, CONDITION, QUERY, BUI.

fndomain Describes an enumerated function execution domain.

example Example of the custom function.

Considerations when Defining the Functions
Java methods defining the functions can have primitive data types, or Concept, Event and Object. They
can return any primitive data types or Concept, Event and Object.

If the custom functions have primitive data types only, it will also be visible and uable in the mapper.
In that case, the category attributes of the @BEPackage annotation is used as the folder for your custom
functions.

The interface has some limitations as it does not allow static methods. Do not use annotations when
using interfaces. Create an interface as a normal java interface without any annotations and implement
it in a class without any annotations. To see these interface methods under the custom catalog function,
create a static overloading method with annotations.

For example:
public interface InterfaceProjectLibTest 
{

        public abstract String[] getAllDestinations();
    
           public abstract String getClusterName();
}

public class interfImpl implements InterfaceProjectLibTest
{
        static int count=0;
        @Override
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        public String[] getAllDestinations() 
        {
                Object[] ars= null;
                RuleSession rs = RuleSessionManager.getCurrentRuleSession();        
                String[] 
activdest=(String[])rs.invokeCatalog("Channel.getAllDestinations", ars);
                count = activdest.length;
                return activdest;
        }

        @Override
        public String getClusterName() {
               // TODO Auto-generated method stub
               Object[] ars= null;
               RuleSession rs = RuleSessionManager.getCurrentRuleSession();
               String clustername;
               clustername=(rs.invokeCatalog("Cluster.getClusterName", 
ars)).toString();
               return clustername;
        }
    
        @BEFunction(name = "getNoOfDests", signature= "getNoOfDests", 
description="Returns Number of destinations of the current rulesession")
        //@BEFunction
        public static int getNoOfDests()
        {
               interfImpl im = new interfImpl();
               im.getAllDestinations();
           +    System.out.println("count: " + count);
               return count;
        }
    
        @BEFunction(name = "ReturnAllDestinations", signature= "getAllDest", 
description="Returns all destinations of the current rulesession")    
        public static String[] getAllDest()
        {
               interfImpl im = new interfImpl();
               String[] activedests = im.getAllDestinations();
        
               return activedests;
        
        }

        @BEFunction(name = "ReturnClusterName", signature= "getClusName()", 
description="Returns the clustername")
        public static String getClusName()
        {
               interfImpl im = new interfImpl();
               String clustername=im.getClusterName();
               System.out.println("ClusterName is: " + clustername);
               return clustername;
        }
}

Ontology Functions
Ontology functions are generated by TIBCO BusinessEvents based on the concepts, events, and rules in
your project.

There are three types of ontology functions:

Constructors
They allow you to create a simple event or concept instance.

Time events
They allow you to create and schedule a time event. See Time Events.

Rule functions
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They allow you to invoke a rule function.

The Ontology Functions area uses the same folder structure as the project (or rather, a subset of that
structure).

Various ontology functions appear depending on the project and the add-on products installed:

● The ontology functions catalog lists all the entity types in a project. Each type has a function for
creating an instance of that type.

● Each rule function also has an ontology function enabling it to be invoked in rules.
● When TIBCO BusinessEvents Views is used additional ontology functions are available for each

entity type. See TIBCO BusinessEvents Views documentatoin for details.

Enabling Extended Functions
Extended functions (sometimes called hidden functions) may be made available by TIBCO Support to
address customer-specific use cases. They are also sometimes used to make legacy features available to
customer who wish to continue using them. To make them visible in the Catalog Functions view, do the
following:

Procedure

1. Open the following file for editing:
   BE_HOME/studio/eclipse/configuration/studio.tra

2. Add the appropriate property, using the specified name. For example, the following formats are
typically used:
   TIBCO.BE.function.catalog.function-catalog-name=true
   TIBCO.CEP.modules.function.catalog.function-catalog-name=true

3. Save the file and restart TIBCO BusinessEvents Studio.

Function Tooltips and Decorations
When you float the curser over a function in the registry, TIBCO BusinessEvents displays the
description and syntax in a tool tip next to the cursor. Functions that can be used with various product
features are decorated with small symbols that indicate useful information about use of the function.

Tool Tips

Tooltips also form the online reference to the function catalogs. See TIBCO BusinessEvents Functions
Reference.

You can create your own tool tips for custom functions. You can also turn off the tool tip display too
using Window > Preferences > TIBCO BusinessEvents preferences.

Decorations Indicating Where Functions can be Called

Some functions have limited application, and some can be used with various product features such as
in queries (available in TIBCO BusinessEvents Event Stream Processing add-on). the second ones have
decorations that cluster around the "f" next to the function name in the function catalog. A function can
have zero, one, or more decorations. The following figure shows all the available decorations. They are
described in the sections after the figure:
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Action-Only Functions

Some of these functions have side effects, for example they can change values. Other functions are
limited to actions for other reasons. These action-only functions are identified by a small a at the
bottom right of the . For example: .

Functions that can be used both in actions and in conditions have no decoration. They are considered to
have the default validity.

Mapper Functions

Functions that bring up the XSLT mapper and XPath builder are identified by a small m at the upper left
of the i , for example: .

Functions That Can Be Used in TIBCO BusinessEvents Decision Manager

Functions that can be used in TIBCO BusinessEvents Decision Manager are marked with a small table
icon,  for example (which is also an action-only function).

Functions That Can Be Used in Queries or with Pattern Matcher

Functions that can be used in queries or with Pattern Matcher are marked with a blue q for example,
. You can call such functions in a query string and in Pattern Matcher.

They are also valid in rule actions and conditions. See documentation for TIBCO BusinessEvents Event
Stream Processing add-on software for details on Pattern Matcher and query features.

Temporal Functions and Their Parameters
The set of Standard functions that come with TIBCO BusinessEvents includes functions that allow you
to perform calculations on numeric values sampled over time.

These functions are called temporal functions and they work exclusively with concept properties that
store numeric values. Temporal functions make use of the history ring buffer to sample a property’s
values over time.

Use of a temporal function with a concept that has a history size of 0 may cause a runtime exception.
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Temporal Functions Parameters

All temporal functions include these parameters, illustrated in Figure 3:

property
The property for which you want to sample values.

stime
The time from which you want to begin sampling values (the start time) measured in milliseconds
since 00:00:00 UTC on January 1, 1970.

etime
The time at which you want to stop sampling values (the end time) measured in milliseconds since
00:00:00 UTC on January 1, 1970.

sample_rate
The number of milliseconds between samples.

bound_by_stime
A flag indicating whether the start-time is flexible:

● True indicates that if the start time you provide is earlier than the timestamp for the oldest
available value, you want to perform the calculation starting with the oldest available value.

● False indicates that if the start time you provide is earlier than the timestamp for the oldest
available value, you want to abort the calculation.

Virtual Rule Functions and VRF Catalog Functions
The VRF category of functions (within the standard functions) are used only with TIBCO
BusinessEvents Decision Manager.

The VRF category of functions provide flexibility when you are working with virtual rule function
implementations. Virtual rule functions are implemented by decision tables.
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When you deploy multiple implementations (tables) for one virtual rule function, but use a function
that doesn’t specify the implementation by name, for example if you use
Functions.MyVirtualRuleFunction(), the default implementation is used. The default
implementation is whichever was the last implementation to be deployed. However, if you use hot
deployment, it may not be possible to determine which implementation was deployed last.

The VRF category of functions contains the following:
getVRFImplByName()
getVRFImplNames()
getVRFImpls()
invokeAllVRFImpls()
invokeVRFImpl()
invokeVRFImplByName()
invokeVRFImpls()

Defining the execution order of multiple decision tables for one VRF: When a VRF has multiple
implementations (decision tables), the order in which the decision tables execute can be defined using
each decision table’s Priority setting, which is set in the decision table Properties tab.

Adding a Virtual Rule Function

Procedure

1. Right-click the folder where you want to store the virtual rule function and select New > Rule
Function . You see the New Rule Function Wizard.
a) In the Rule Function Name field, type a name for the rule function.
b) In the Description field, type a description. (In the source editor the description appears in the *

@description line of the comments at the top of the editor).
c) Check the Virtual checkbox.

You cannot change a new resource name after you click Finish. (You can change the
description, however.)

2. Click Finish.

Click the tabs at the bottom of the editor to switch between the form-based editor and the source
editor as you work, depending on your preference. These instructions use the form editor and
mention the equivalent settings in the source editor.

3. In the Form editor Configuration section, add or edit a description as desired. (In the source editor
the description appears in the * @description line of the comments at the top of the editor).

4. If you did not do so in the Wizard, check the Virtual check box.

In the source editor, the signature of a virtual rule function is:
   virtual void rulefunction folder.RFName
Do not add code to the Body block in the source editor of a virtual rule 
function. If you do, you see error messages if you try to save or to 
switch to the form-based editor.

In virtual rule functions, the Validity field is set to Action and the Return Type is set to Void.
column, select where the rule function can be used (source editor equivalents shown in parentheses:

5. In the Scope section (scope statements in the source editor), drag an ontology entity into the Scope
area, OR do the following:
a) Click Add to add resources that you will be using in your rule function. You see the Select Rule

Function Scope Arguments dialog.
b) In the upper half of the Select Rule Function Scope Arguments dialog, select the type you want

to use.
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c) If the type you select is an ontology type, in the lower half of the dialog, select a resource from
the filtered ontology tree.

d) Click OK.

Your selection appears in the Declarations list. TIBCO BusinessEvents assigns an alias to it. You
can edit the alias.

Add more entities as needed.

6. Save the project.

Result

For example, here is the source view for a simple virtual rule function:
/**
 * @description Action to take when account is suspended
 */
virtual void rulefunction Rules.FollowUp {
  attribute {
    validity = ACTION;
  }
  scope {
    Concepts.Account account;
  }
  body {
  }
}

VRF Function Arguments

The VRF functions use various subsets of the following common arguments:

Common Arguments for VRF Functions

Name Type Notes

vrfURI String The universal resource identifier (URI) for the virtual rule
function. This is typically the full path to the virtual rule
function within the project directory. For example, in the
CreditCardApplication example, the virtual rule function
Person_VirtualRuleFunction() has the following URI:
/Virtual_RF/Person_VirtualRuleFunction

vrfImpl Object An object representing a virtual rule function
implementation. This argument is required when invoking
specific virtual rule function implementations.

implName String The name of a decision table (also known as a virtual rule
function implementation). For example, in the
CreditCardApplication example, the virtual rule function
BankUser_VirtualRuleFunction has an implementation
(decision table) called bankUser.

The implName argument is used to retrieve a corresponding
implementation object, or to execute an implementation.
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Name Type Notes

args Object array The arguments to be passed to one or more virtual rule
function implementations on invocation. These objects consist
of the concepts, events, scorecards, and so on. that are needed
by the implementation or implementations. For example, the
processApplication implementation in the
CreditCardApplication example project requires concepts
of type Application, BankUser, and
CreditCardApplication to be passed as arguments. In order
to invoke the processApplication implementation, an
instance of each concept type must be passed in the args
array.

returnValues Object array Not used in this release. This argument is used only for the
invokeVRFImpls function. When invoking multiple
implementations, the return value of each implementation is
stored in this array. The array will contain a null entry for
each implementation that does not return a value.

Cache Related Functions
Various standard functions in the Standard catalog Cluster.DataGrid category enable you to work
with objects in the cache.

This section relates to Cache OM functionality and is not relevant if you are using TIBCO
BusinessEvents Express edition

Cache load functions load items into the Rete network so they are available.

Tool tips in the user interface (and reproduced in the TIBCO BusinessEvents Functions Reference) explain
the details of how to use the functions. This section explains certain patterns of use.

These core functions are used with both the Oracle and TIBCO cache providers.

The previous versions of these core functions (which began with C_) are deprecated. Migrate projects
created in earlier releases to use the current names.

Query functions are not available for the TIBCO BusinessEvents DataGrid provider. Similar
functionality can be achieved using the TIBCO BusinessEvents Event Stream Processing add-on.

Functions for Loading Entities to Rete from Cache and Backing Store

CacheLoadConceptByExtId
CacheLoadConceptsByExtId
CacheLoadConceptById
CacheLoadConceptsById
CacheLoadEventByExtId
CacheLoadEventById()
CacheLoadParent()

CacheLoad*() functions are required for working with cache only cache mode. They load entities from
the cache (or backing store if not found in the cache) into the Rete network. See Loading Cache Only
Objects into the Rete Network in TIBCO BusinessEvents Architect’s Guide for details.

Use the CacheLoad*() functions in an event preprocessor. Only use them in rules for cases where the
ID or ExtId is not known in advance (in the preprocessor).

After cache-only concepts are loaded in this way, you can then use Instance.getByExtId() in rules.
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Never use Instance.getByExtId() unless you have first loaded the concept.
Instance.getByExtId() does not assert the concept but just returns it for use in rules, for example, as
read-only reference data.

Locking Functions

Lock()
UnLock()

In the event preprocessor, use the Lock() function to prevent other threads or engines from operating
on the same entity. The lock is automatically released at the end of the RTC.

Use Unlock() only in a preprocessor and only to handle cases where you need to release the lock
immediately instead of at the end of the RTC, for example because some information is missing that
would be required to go forward.

See Using Locks to Ensure Data Integrity Within and Across Agents in TIBCO BusinessEvents Architect’s
Guide for details on use of locks.

Indexing Function (For Coherence Clusters Only)

Index() creates an index on the specified property, which is useful when you run queries. However, a
simpler way is to use Present in Index checkboxes in the CDD.

Specialty Functions Not for General Use

The following functions are used only in certain applications:
CacheLoadConceptIndexedByExtId()
CacheLoadEntity()
CacheReevaluate()
EnableCacheUpdate()

Indexing for More Efficient Cache Queries

TIBCO BusinessEvents Express
 This section relates to Cache OM functionality and is not relevant if you are using TIBCO
BusinessEvents Express edition.

When you use Oracle Coherence as the cache provider, you can index concept and event properties to
make searches faster. You can index more than one of an entity type’s properties.

The query optimization you set up is used by C_Query*() functions, and by snapshot queries, available
in TIBCO BusinessEvents Event Stream Processing add-on.

You can create the indexes in the following ways.

Create Indexes Using a Coherence Function
This method applies to the Coherence cache provider only. It is not the preferred method. It is
recommended that you use the method explained in.

You can create an ordered or unordered index using the following function in a startup rule function.
C_Index(String cacheName, Object property, boolean isOrdered)

where:

cacheName is a String returned by C_CacheName().

property is the object returned by the appropriate C_DatatypeAtomGetter functions, for example,
C_StringAtomGetter().
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isOrdered is a Boolean: set to true to order the contents of the indexed information, and set to false if
you want to use an unordered index.

For example:
String cacheName = Coherence.C_CacheName("/Customer");
Object getter = Coherence.Extractor.C_IntAtomGetter("age");
Coherence.C_Index(cacheName, getter, true);

Creating an Index Using a Domain Object Override Setting
This method applies both to the TIBCO and Coherence cache providers. You can create an unordered
index in the project’s Cluster Deployment Descriptor (CDD) using a domain object setting.

Procedure

1. Open the project CDD in TIBCO BusinessEvents Studio and go to Cluster tab > Domain Objects >
Overrides.

2. Edit or create an override entry as needed for the desired entity or entities
3. In the override entry’s Properties Metadata section, select the Present in Index checkbox for the

property you want to index.
4. Save the CDD file.

Enabling Explicit Tuple Format for DataGrid Fields
You can set a property in the CDD so that they are instead stored as tuples. That is, TIBCO
BusinessEvents attempts to create explicit space structures for each entity type.

In Shared Nothing mode, explicit tuple format is assumed internally. You should not set this property
in Shared Nothing mode.

You can still use query language queries (as explained in Query the Cache Using BQL Queries) if
entities and their properties are stored as blobs. However performance is improved if they are stored as
tuples.

Only certain datatypes can be stored as tuples:

● Primitive datatypes
   int, long, boolean, string, datetime, contained, reference

Are stored as the equivalent TIBCO BusinessEvents DataGrid types:
   integer, long, boolean, string, calendar, long, long

● Concepts

— Concept property arrays are stored as blob columns
● Events

— Payload is a byte array or blob
● State Models
If an error occurs, for example due to an unsupported datatype, the item revers to its original blob
format.

Prerequisites

Procedure

● To enable explicit tuple format, at the cluster level, set the following field to true: "Store
Properties As Individual Fields".
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Query the Cache Using BQL Queries
In order to execute the queries, you must first enable a dynamic query session.

● This method relates to Cache OM functionality and is not relevant if you are using TIBCO
BusinessEvents Express edition.

● This method of querying a cache requires use of the TIBCO BusinessEvents Event Stream
Processing add-on product.

● The term BQL is an acronym indicating the TIBCO BusinessEvents Event Stream Processing query
language.

● This is the only method that works with TIBCO BusinessEvents DataGrid.
● For the Coherence cache provider you can also use the methods explained in TIBCO BusinessEvents

Architect’s Guide.

Procedure

1. Add a rule function in the inference agent that contains the following function:
Query.Util.startDynamicQuerySession().

Configure this as a startup rule function (in the CDD file). For more on dynamic query sessions see
TIBCO BusinessEvents Event Stream Processing Query Developer’s Guide.

2. Add another rule function. Configure it as an event preprocessor (in the CDD file).

3. In the event preprocessor function, create a query string that selects entities from the cache. You can
use any valid BQL query.

4. Use the query string in the following function:
  Query.Util.executeInDynamicQuerySession(queryString, null, true)

The function returns a list of entities from the cache.

5. Use the list returned as needed. For example, iterate over the list and load the entities, as shown in
the following example.

You can also do cache lookups using @id and @extId attributes.
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Example Rule Function for a TIBCO BusinessEvents DataGrid Cache

The following example preprocessor rule function code shows the techniques used for
querying a TIBCO BusinessEvents DataGrid cache. You can then use standard functions to
work with the entities returned by the query.
/**
 * @description
 */
void rulefunction RuleFunctions.InputEventPreprocessor {
  attribute {
    validity = ACTION;
  }
  scope {
    
    Events.InputEvent inputevent;
  }
  body {
    System.debugOut("Now starting InputEventPreprocessor");
    
    Concepts.Misc misc = Instance.getByExtId("misc");
    String[] EXTIDS_COLLECTION = 
Instance.PropertyArray.toArrayString(misc.EXTID_LIST);
    String queryString =
              "select c" +
              "\n from /Concepts/TestConcept as c" +
              "\n where c@extId in"
              + "(\""
              + EXTIDS_COLLECTION[0]
              + "\", \"" + EXTIDS_COLLECTION[1]
              + "\", \"" + EXTIDS_COLLECTION[2]
              + "\", \"" + EXTIDS_COLLECTION[3]
              + "\", \"" + EXTIDS_COLLECTION[4]
              + "\")";
    System.debugOut("Executing query: \n" + queryString);    
    Object resultList = Query.Util.executeInDynamicQuerySession(queryString, 
null, true);
    System.debugOut("Query returned: " + Query.Util.sizeOfList(resultList) + 
" rows");
    
    while(Query.Util.sizeOfList(resultList) > 0){
      Concepts.TestConcept c = Query.Util.removeFromList(resultList, 0);
      Cluster.DataGrid.CacheLoadEntity(c);
      
      System.debugOut("Now loading concept " + c + " in the pre-processor");
    }
  }
}

Oracle Coherence Cache Query Functions
Oracle Coherence Cache Query functions work only with a Coherence cluster.

For information on using Oracle Coherence with TIBCO BusinessEvents, see TIBCO BusinessEvents
Configuration Guide.

TIBCO BusinessEvents Express: This section relates to Cache OM functionality and is not relevant if
you are using TIBCO BusinessEvents Express edition.

Constants, Extractors, and Filters Categories

The Coherence category has Constants and Extractors functions which are used in conjunction with
functions in the Filters category.

● Extractor functions return values for properties of different types.
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● Constants functions wrap constants so they can be used in filter functions. For example if a filter
checks for X = 10, you would first wrap 10 using C_IntConstant().

● Functions in the Filters category enable you to use various criteria to identify a set of objects in the
cache for a query. You can pass the filter to a query function.

The C_RuleFunction() function allows you to specify a rule function containing a custom filter
condition.

Query Category

Query category functions operate only on the cache. Unlike the C_CacheLoad*() functions, the query
functions do not look in the backing store if objects are not found in the cache.

Do not use query functions that delete or modify values if a backing store is used. Instead use a query
to return the IDs of the entities you want to delete and use Instance.deleteInstance() or
Event.consumeEvent() as needed.
C_CacheInvoke()
C_CacheOnlyMode_DeleteConcepts
C_CacheOnlyMode_DeleteEntities
C_CacheOnlyMode_QueryConcepts
C_CurrentContext
C_EntryHasNext
C_EntryIterator
C_EntryNextValue
C_KeyHasNext
C_KeyIterator
C_KeyNextValue
C_QueryAction
C_QueryAndLoadConcepts
C_QueryConcepts
C_QueryEvents
C_QueryEvents_Order
C_QueryIDs

Query functions take various actions for a specified entity or set of entities. For example,
C_CacheInvoke() allows you to invoke a rule function for all matching entities in the cache.

For some functions you can specify the entities by passing a filter (from the Filters category).

Tool tips in the user interface (and reproduced in the TIBCO BusinessEvents Functions Reference) explain
how to use the functions singly or in combination to achieve the desired results.

The C_CacheOnlyMode*() functions are for use with entities that use cache-only cache mode.

Structure of a Function Catalog
A function catalog is an XML file that conforms to the schema file function_catalog.xsd.

This allows TIBCO BusinessEvents to integrate your custom functions with the function registry in
TIBCO BusinessEvents Studio. The function catalog must be in the XML format shown below and
described in Elements in the Function Catalog to map properly to the schema.

● Name the function catalog functions.catalog.

● Place functions.catalog in the root folder of the required Java archive resource (.jar) file.

Example Function Catalog
This example shows two functions from the standard functions catalog as an example to follow.
<?xml version="1.0" encoding="UTF-8" standalone="no" ?>
<catalog name="Standard">
   <category>
      <name>System</name>
         <function>
            <name>currentTimeMillis</name>
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            <class>com.tibco.be.functions.System.SystemHelper</class>
            <args></args>
            <async>false</async>
            <reevaluate>true</reevaluate>
            <isValidInQuery>true</isValidInQuery>
            <isValidInBUI>true</isValidInBUI>
            <helpUrl/>
         </function>
   </category>
   <category>
      <name>Event</name>
         <function>
            <name>createEvent</name>
            <class>com.tibco.be.functions.event.EventHelper</class>
            <args>stylesheet, entityArray</args>
            <isActionOnly>true</isActionOnly>
            <desc>Create a event using XSLT Mapper.
                  This returns a event entity</desc>
            <async>false</async>
            <mapper>
               <enable>true</enable>
               <type>xslt</type>
               <inputElement>
                  <xsd:schema xmlns:xsd="http://www.w3.org/2001/XMLSchema">
                     <xsd:element name="createEvent">
                        <xsd:complexType>
                           <xsd:sequence>
                              <xsd:element name="event" type="xsd:anyType"
                                           minOccurs="1" maxOccurs="1"/>
                           </xsd:sequence>
                        </xsd:complexType>
                     </xsd:element>
                  </xsd:schema>
               </inputElement>
            </mapper>
            <helpurl></helpurl>
            <isValidInBUI>true</isValidInBUI>
      </function>
   </category>
</catalog>

Elements in the Function Catalog
The Function Catalog consists of various elements and sub-elements described in this table.

Function Catalog Elements

Ele
men
t
Nam
e Sub-Elements Description

<cat

alog

name

="na

me">

The root element. Attribute: name="name" where name is a name
you provide for this functions catalog.

Example: <catalog name="custom">

<cat

egor

y>

This is a sub-element of <catalog>.

<category> is a nesting container for a set of related functions
within this function catalog.
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Ele
men
t
Nam
e Sub-Elements Description

<name> A name you provide for this category.

<fun

ctio

n>

A container for the information about a single function.

<name> The name of the function.

<class> The java class that implements the function.

<desc> Optional. A description of the function.

<async> Set to true if the function executes asynchronously.

Set to false if the function executes synchronously.

<helpurl> Not used in this release.

<args> A comma separated list of descriptive names for the function’s
arguments. TIBCO BusinessEvents takes the argument type from
the function itself.

<isActionOnly> If this function has side effects, for example, if it can modify
values, you can only use it in action rules. Set this parameter to
true to alert TIBCO BusinessEvents that this function has side
effects and is not valid in conditions. Otherwise, set to false.

Valid values: true, false.

<isValidInBui> If this function can be used in decision tables, set this element to
true. Otherwise, set to false.

Valid values: true, false.

<isValidInQuery> If this function can be used in queries, set this element to true.
Otherwise, set to false.

Valid values: true, false.

<reevaluate> Relevant only when a function is used in a condition.

Valid values: true, false.

Using the Reevaluate Element
The the <reevaluate> element of a function catalog is relevant only when a function is used in a
condition.

Its effect is as follows:

● If set to true:
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— TIBCO BusinessEvents does not memorize the result of the evaluation of the condition that
contains this function.

— If any of the conditions is re-evaluated, then this function is also re-evaluated.

For example, <reevaluate> is set to true for currentTimeMillis(). Given this condition:
stock.price > 10.0;
  currentTimeMillis() - stock.time > 600000;

If the condition stock.price > 10.0; is re-evaluated, then currentTimeMillis() is also re-
evaluated.

● If set to false:

— TIBCO BusinessEvents calls the function during the first evaluation and stores the result is
stored and used for subsequent condition evaluations.

— TIBCO BusinessEvents Studio re-evaluates the condition only if another part of the same
condition changes.

— In the above stock price example, if <reevaluate> were set to false, then the condition would
be re-evaluated only if stock.time changes.
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Rule Language Grammar

There are some basic concepts that you need to know about working with the rule language grammar.

Whitespace
Whitespace is used to separate tokens (identifiers, keywords, literals, separators, and operators) just as
it is used in any written language to separate words. Whitespace is also used to format code.

These are whitespace characters, excluding line terminators:

● the ASCII SP character, also known as space
● the ASCII HT character, also known as horizontal tab
● the ASCII FF character, also known as form feed

Line terminators include these characters:

● the ASCII LF character, also known as newline
● the ASCII CR character, also known as return
● the ASCII CR character followed by the ASCII LF character

Comments
Comments are used to comment a rule.

Comment rules are as follows:

/* text */   The text from /* to */ is ignored

// text      The text from // to the end of the line is ignored

Separators
Separators are used to separate statements, expressions, or arguments in a function.

The following tokens are used for separators:

; Statement separator for conditions and actions.

( Expression Grouping begin, or function argument list begin.

) Expression Grouping end or function argument list end.

, Argument list separator.

Identifier Naming Requirements

An identifier (or name, to use the user interface label) is an unlimited-length sequence of letters and
digits, the first of which must be a letter. Letters include uppercase and lowercase ASCII Latin letters A-
Z, a-z, and the underscore (_).
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Here are some guidelines for naming of identifiers:
● Do not use the dollar sign ($).
● Identifiers are case sensitive.
● Identifiers cannot have spaces (except shared resource identifiers).
● Identifiers may not be the same as any literal, keyword, or other reserved word. See Keywords and

Other Reserved Words and Literals .

Letters and digits may be drawn from the entire Unicode character set, which supports most writing
scripts in use in the world today, including the large sets for Chinese, Japanese, and Korean. This
allows programmers to use identifiers in their programs that are written in their native languages.

Digits include the ASCII digits 0-9, while two identifiers are the same only if they have the same
Unicode character for each letter or digit. Note that some letters look the same even though they are
different Unicode characters. For example, a representation of the letter A using \u0041 is not the same
as a representation of the letter A using \u0391.

Two example identifiers: new_order  E72526  creditCheck

Here is a more succinct way for programmers to understand the requirements:
<Identifier>  :=  [ <ID_START> { <ID_PART> }* ]
<ID_START> :=  except '$', any character for which 
java.lang.Character.isJavaIdentifierStart() returns true
<ID_PART> :=  except '$', any character for which 
java.lang.Character.isJavaIdentifierPart() returns true

Local Variables
Local variables of certain types are used in rule actions and rule functions.

The following types can be used:

● Primitives
● Concepts
● Events

Primitive Arrays
Primitive arrays with a fixed length can also be used when working with a rule language grammar .

Here are examples of array declaration, initialization, and array creation expressions:

● Array declaration and initialization:
   int i;               // int
   int[] ii = {1,2,i};  // array of int

● Array creation with initialization expression:
   ii = int[] {1,2,3};

● Array creation without initialization expression:
   int[] arr = int[5] {};
   arr = int[5]{};

● Getting the length of the array:
   int arrLength = arr@length;

Literals
Certain literals are used for the rule language grammar.

The TIBCO BusinessEvents rule language supports these literals:
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int
One or more digits without a decimal. May be positive or negative.

Examples:
4   45   -321   787878

long
An integer literal suffixed with the letter L. The suffixed L can be either upper or lower case, but keep
in mind that the lower case L (l) can be difficult to distinguish from the number one (1). 

Examples:
0l   0777L   0x100000000L   2147483648L   0xC0B0L

double
A number that can represent fractional values. D suffix is optional unless there is no decimal point or
exponent.

Examples:
1D   1e1   2.   .3   0.0D   3.14   1e-9d   1e137

String
Zero or more characters enclosed in double quotes (""). The string must be on one line. Use \n for
newlines. Use the plus sign (+) to concatenate string segments.

Examples:

● Empty string: "" (quotes with no space).

● Space character: " " (quotes with one or more spaces).

● Strings with values:
"P0QSTN3" "The quick brown fox had quite a feast!"

● Strings spanning multiple lines: 
"The quick brown fox " +

"had quite a feast!"

boolean
One of these two values:   true   false

Null
This value:   null

Escape Sequences
Escape sequences are used to represent characters when working with the rule language grammar.

You can represent characters in literals using these escape sequences:

Escape Sequences

Character Escape Sequence

backspace \b

horizontal tab \t
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Character Escape Sequence

linefeed \n

form feed \f

carriage return \r

double quote \"

single quote \’

backslash \\

Operators
Certain operators are defined for use with the rule language grammar.

Operators in this list are also used in the Java language and work the same as the Java operators:

Operators in the TIBCO BusinessEvents Rule Language

Operator Notes

++ –– increment, decrement

+ - unary plus, unary minus

* \ % multiplication, division, remainder

+ - addition, subtraction

> < >= <= greater than, less than, greater than or equal to, less than or equal
to

= assignment

== != equality, inequality (Does deep string comparison, unlike Java.)

&& || ! boolean AND, OR, NOT

-= += *= /= %= combined operation and assignment. As an example, expr += 2;
is the same as expr = expr + 2;

+= works on strings as well as numbers. For example, you have a
variable String s = "abc"; and then you use 
s+= "def"; and so the value of s becomes "abcdef"

instanceof Tests whether an object is an instance of specified type.
Restricted to use with concepts and events.

Example:
boolean b = customer instanceof USCustomer;
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Operator Notes

. property access

@ attribute access
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Keywords and Other Reserved Words

Certain keywords and reserved words cannot be used in the rule language grammar.

Do not use the words listed in this section as identifiers, resource names, or folder names. Case
sensitivity depends on context (as noted in documentation). The list also includes keywords and other
reserved words for all add-on products.
$lastmod
abs
abstract
accept
ACTION
AdvisoryEvent
alias
all
and
as
asc
assert
attribute
avg
backwardChain
between
body
boolean
break
by
byte
case
catch
char
class
Concept
CONDITION
const
ContainedConcept
continue
count
date
DateTime
days
dead
declare
default
delete
desc
distinct
do
double
emit
else
entity
enum
Event
except
exists
extends
false
final
finally
first
float
for
forwardChain
from
goto
group
having
hours
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id
if
implements
import
in
instanceof
int
interface
intersect
last
is_defined
is_undefined
key
last
latest
like
limit
lock
long
maintain
max
milliseconds
min
minutes
mod
moveto
native
new
not
null
object
offset
or
order
order
pending_count
package
policy
priority
private
protected
public
purge
QUERY
rank
requeue
return
rule
rulefunction
scope
seconds
select
short
SimpleEvent
sliding
static
strictfp
String
sum
super
switch
synchronized
then
this
throw
throws
time
TimeEvent
timestamp
transient
true
try
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tumbling
undefined
union
unique
using
validity
virtual
void
volatile
when
where
while

Keywords Reserved By Oracle

Certain keywords are reserved by Oracle and not necessarily by TIBCO BusinessEvents. Do not use
these words when creating backing store scripts, else an error might occur.
ACCESS
ADD
ALL
ALTER
AND
ANY
ARRAYLEN
AS
ASC
AUDIT
BETWEEN
BY
CHAR
CHECK
CLUSTER
COLUMN
COMMENT
COMPRESS
CONNECT
CREATE
CURRENT
DATE
DECIMAL
DEFAULT
DELETE
DESC
DISTINCT
DROP
ELSE
EXCLUSIVE
EXISTS
FILE
FLOAT
FOR
FROM
GRANT
GROUP
HAVING
IDENTIFIED
IMMEDIATE
IN
INCREMENT
INDEX
INITIAL
INSERT
INTEGER
INTERSECT
INTO
IS
LEVEL
LIKE
LOCK
LONG
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MAXEXTENTS
MINUS
MODE
MODIFY
NOAUDIT
NOCOMPRESS
NOT
NOTFOUND
NOWAIT
NULL
NUMBER
OF
OFFLINE
ON
ONLINE
OPTION
OR
ORDER
PCTFREE
PRIOR
PRIVILEGES
PUBLIC
RAW
RENAME
RESOURCE
REVOKE
ROW
ROWID
ROWLABEL
ROWNUM
ROWS
START
SELECT
SESSION
SET
SHARE
SIZE
SMALLINT
SQLBUF
SUCCESSFUL
SYNONYM
SYSDATE
TABLE
THEN
TO
TRIGGER
UID
UNION
UNIQUE
UPDATE
USER
VALIDATE
VALUES
VARCHAR
VARCHAR2
VIEW
WHENEVER
WHERE
WITH
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Attributes

TIBCO BusinessEvents provides attributes that you can use in rules to access information of various
kinds. Use the @ operator to access attributes.

Attributes

Entity Attributes Type Returns

SimpleEven
t

@id
                

long
                

The event’s unique internal ID.

@extId
                

string
                

The event’s unique external ID.

@ttl
                

long
                

The time to live of the event as
specified in the configuration. (This
is not the time-to-live remaining.)

@payload
                

string
                

The payload as a string value.

Repeating
TimeEvent

@id
                

long
                

The time event’s unique internal
ID.

@closure
                

string null.

@interval
                

long The number of units between
creation of successive time events.

@scheduledTime
                

dateTime The time scheduled for asserting
into the Rete network.

@ttl
                

long 0.

Rule-Based
TimeEvent

@id long The time event’s unique internal
ID.

@closure
                

string A string that was specified when
the event was scheduled.

@interval
                

long 0.

@scheduledTime
                

dateTime The time scheduled for asserting
into the Rete network.

@ttl
                

long The time to live of the event as
specified when scheduling the
event. (This is not the time-to-live
remaining.)
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Entity Attributes Type Returns

Advisory
Event

id long The advisory event’s unique
internal ID

extId String Null

category String Broad category of advisory, for
example, an exception.

type String Type of advisory within the
category.

message String Message for the user.

Concept @id
                

long The concept instance’s unique
internal ID.

@extId
                

string The concept instance’s unique
external ID.

ContainedC
oncept

@id
                

long The contained concept instance’s
unique internal ID.

@extId
                

string The contained concept instance’s
unique external ID.

@parent
                

concept The parent concept instance. (This
is treated as a concept reference in
the language.)

PropertyAt
om

@isSet
                

boolean True if the property value has been
set. Otherwise, false.

PropertyArr
ay

@length
                

int The number of PropertyAtom
entries in the array.

The internal ID is automatically generated by TIBCO BusinessEvents. You cannot set it.
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Working with Concept and Event Properties

Access concept properties and event properties can be used with the TIBCO BusinessEvents rule
grammar language.

Rule dependency and rule condition re-evaluation is performed only on concept properties.

This re-evaluation is not performed on an attribute such as @parent.

Accessing a Concept PropertyAtom
Access to a concept PropertyAtom is defined with the syntax.

Syntax for accessing a concept property :
instanceName.propertyName

where instanceName is the identifier of the concept instance, and propertyName is the name of the
concept property that you want to access.

For example to get the current value of the cost PropertyAtom:
int x = instanceA.cost;

For example, to set a value with the current system timestamp:
instanceA.cost = value;

If the history size is 0, TIBCO BusinessEvents does not record a timestamp.

Get and Set PropertyAtom Value With User-Specified Time
PropertyAtom can be set for the rule language grammar.

You can get and set PropertyAtom values as follows:

● Specify a time and get the PropertyAtom value stored in the history at that time using one of the
standard functions:
   type Instance.PropertyAtom.gettype(PropertyAtom propertyAtomName, \
                                  long time)

where type is the type of the PropertyAtom, propertyAtomName is the name of the PropertyAtom,
and time is the time from which you want to retrieve the value.

● Set a value in the PropertyAtom History using one of the standard functions:
   Instance.PropertyAtom.settype(PropertyAtom propertyAtomName, \
                               type value, long time)

where type is the type of the PropertyAtom and the type of the new value, propertyAtomName is
the name of the PropertyAtom, value is the value to store in the ring buffer, and time is the
timestamp for the new entry.

TIBCO BusinessEvents manages these requests as follows:

— If the ring buffer has vacancies, TIBCO BusinessEvents inserts the new entry into the correct
place based on its timestamp, shifts the older values out one place, and returns True.

— If the ring buffer is full, and the new value has a more recent timestamp than the oldest value,
TIBCO BusinessEvents inserts the new value into the correct place, shifts older values if
necessary, drops the oldest value, and returns True.

— If the ring buffer is full, and the new value has a timestamp that is older than the oldest value in
the ring buffer, TIBCO BusinessEvents does not insert the new value into the ring buffer, and it
returns False.
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Concept Property Arrays
To work with concept property arrays you need to follow certain rules.

Accessing a Concept Property Array

This is the syntax for accessing a concept property array:
instanceName.propertyName

where instanceName is the identifier of the concept instance, and propertyName is the name of the
concept property that you want to access.

Accessing a Value in a Concept Property Array

To access a value in a property array, identify the position in the array of the value as shown:
instanceName.propertyName[indexPosition]

For example:
String x = instanceA.lineItem[0];

This gets the current value of the first property atom in the array, lineItem, and assigns it to the local
variable, x.

Array index difference:  In the TIBCO BusinessEvents language, array indexes start from zero (0).
However, in XSLT and XPath languages, they start from one (1). It’s important to remember this
difference when using the rule language in the rule editor, and when working in the XSLT mapper and
the XPath builder.

Setting the Value for an Existing Concept Property Array Position

You can set the value of an existing position in an array. For example:
int[] ii = {1,2,3};
ii[2] = 1;

Adding a Value to a Concept Property Array

You can append a value to the end of a property array. You cannot, however, add a value to any other
position in an array. This is the syntax:
instanceName.propertyName[indexPosition] = value

To use the syntax shown above you must know the index position of the end of the array. You can
append a value to the end of an array without knowing the index position of the end of the array using
the @length attribute as shown:
instanceName.propertyName[instanceName.propertyName@length] = value

Deleting Values in a Property Array

This is the syntax for deleting an array property:
Instance.PropertyArray.delete(instanceName.propertyName,indexPosition);

Array identifier numbers are positional. When history is not tracked and you delete multiple items in
an array (using a for loop), delete higher position numbers before lower position numbers to ensure the
correct entries are deleted. For example, if you want to delete items in positions 1, 2, and 4, delete them
in this order: 4, 2, and then 1.

The array entry that held a deleted concept is removed, reducing the array size by one, and reducing by
one the index of every entry in the array at a higher index than the deleted one. If you delete entries
with lower position numbers first, the remaining lower numbers are then occupied by different items.

For example, if you delete the item in position 1, then the item that was in position 2 is now in position
1.
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Checking if Multiple Property of a Concept is Empty

If you have a concept (for example, CustomerConcept) which contains multiple property (for example,
address) and you did not pass any value to the address property when creating the concept then the
following check always returns false:
 customerConcept.address == null

The reason for this is that the multiple check on a concept property (simple property,
ContainedConcept, or ConceptReference) makes the property an array. Even if you do not add any
property, ContainedConcept, or ConceptReference to the multiple property, the property is an array
with the length zero but not null.

Thus, to resolve this, for a multiple property (simple property, ContainedConcept, or
ConceptReference), check the length of the property (array). The length zero indicates there is no
simple property, ContainedConcept, or ConceptReference.

Event Property
Event properties can be used in the rule language grammar by following certain rules.

This is the syntax for accessing an event property:
eventName.propertyName

For example:
String x = eventA.customer;

where eventName is the identifier of the concept instance and propertyName is the name of the event
property that you want to access.
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Exception Handling

The TIBCO BusinessEvents Rule Language includes try, catch, and finally blocks and has an error
type attribute @errorType.

The try, catch, and finally blocks behave like their same-name Java counterparts.

You can also use the special AdvisoryEvent event type to be notified of exceptions that originate in user
code but that are not caught with a catch block. To use the AdvisoryEvent, click the plus sign used to
add a resource to the declaration. AdvisoryEvent is always available in the list of resource.

Syntax
Exception handling syntax defines which combinations can be used.

These combinations are allowed:

● try/catch

● try/finally

● try/catch/finally

try
try {try_statements}   

catch
catch (Exception identifier ) {catch_statements }

finally
finally {finally_statements}

Examples
Exception handling syntax for the rule language grammar is presented through some examples.

try/finally Example

String localStatus = "default status";
try {
    //readStatus might throw an exception
    localStatus = readStatus();
} finally {
    //If readStatus() throws an exception, 
    //MyScorecard.status will be set to "default status"
    //but the exception won't be caught here.
    //Otherwise MyScorecard.status will be set to the
    //return value of readStatus()
    MyScorecard.status = localStatus;
}

try/catch/finally Example

String localStatus = "default status";
try {
    //readStatus might throw an exception
    localStatus = readStatus();
} catch(Exception exp) {
    System.debugOut("readStatus() threw an exception with message"
                     + exp@message);
} finally {
    //If readStatus throws an exception,
    //MyScorecard.status will be set to "default status"
    //Otherwise MyScorecard.status will be set to the
    //return value of readStatus()
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    MyScorecard.status = localStatus;
}

try/catch Example

String localStatus = "default status";
try {
    //readStatus might throw an exception
    localStatus = readStatus();
} catch(Exception exp) {
    System.debugOut("readStatus() threw an exception with message "
             + exp@message);
}
    //If readStatus throws an exception,
    //MyScorecard.status will be set to "default status"
    //Otherwise MyScorecard.status will be set to the
    //return value of readStatus()
MyScorecard.status = localStatus;

try/catch Example with Checking errorType and re-throw

String localStatus = "default status";
try {
    //readStatus might throw an exception
    localStatus = readStatus();
catch(Exception exp) {   
    if (exp@errorType == "java.lang.NullPointerException")   
         throw exp;  
    System.debugOut("readStatus() threw an exception with message " + exp@message); 
} 
//If readStatus throws an exception other than NullPpointerException, 
//MyScorecard.status will be set to "default status"
//If readStatus throws NPE, MyScorecard.status will be set to "default status" and 
NPE will be re-thrown.
//Otherwise MyScorecard.status will be set to the return value of readStatus()
MyScorecard.status = localStatus;
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Flow Control

The TIBCO BusinessEvents rule Language includes commands to perform conditional branching and
iteration loops.

if else
The if/else command allows you to perform different tasks based on conditions.

Syntax:
   if(condition){
       code_block;
   }
   else{
       code_block;
   }

for
The for command allows you to create a loop, executing a code block until the condition you specify
is false.

Syntax:
   for(initialization; continue condition; incrementor){
   code_block;
   [break;]
   [continue;]
   }

Where:

break allows you to break out of the loop.

continue allows you to stop executing the code block but continue the loop.

For example:
   for(int i=1; i<10; i=i+1){
   System.debugOut("Hello World!");
   }

This example prints "Hello World!" to debugOut ten times.

while
The while command allows you to perform one or more tasks repeatedly until a given condition
becomes false.

Syntax:
while(condition){
   code_block;
   [break;]
   [continue;]
}

Where:

break allows you to break out of the loop.
continue allows you to stop executing the code block but continue the loop.
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Rule Language Datatypes

Rule language datatypes are defined with conversion tables, with information about operators and
types, and with information about how TIBCO BusinessEvents handles inconstancy problems with
datatypes.

Concept Properties to XML Datatype Conversions

Concept Properties to XML Datatype Conversions

Int
     
     
   

Long Flo
at

Dou
ble

Bool
ean

Stri
ng

DateT
ime

ComplexT
ype

@ref
       
      Property Type

int L L L L L

long N L N N L

double N N N L L

String L L L L L L L

boolean L L

Datetime L L

ContainedConcep
t D

ConceptReferenc
e ID

N - Numeric conversion, loss of information possible (see note below).

L - Shallow copy — Copies only the current value.

D - Deep copy — Copies the entire structure of the contained concept (current values of all properties
only).

ID - Basically a shallow or reference-only copy. The copy refers to the same instance of the concept.

● History is never copied.
● Data loss is possible for conversions from String to a number datatype if the string represents a very

large number that would have to be clipped.
● Datatype conversion tables for events are located in the TIBCO Rendezvous and TIBCO Enterprise

Message Service documentation.

Compatibility of Operators with Types
Rule language grammar defines operators compatibility with types.

Compatibility is described as follows:
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Operator Matrix

Right Side of Operator

str int
lo
n

do
u boo ent obj dat

Left
Side
of
Opera
tor

str
            
    

=, +,
eq,
cmp,
inst

+ + + + + =, +, eq,
cmp, inst

+

int + =,
math,
eq,
cmp

=,
m
at
h,
eq
,
c
m
p

=,
ma
th,
eq,
cm
p

=, math,
eq, cmp

lon + =,
math,
eq,
cmp

=,
m
at
h,
eq
,
c
m
p

=,
ma
th,
eq,
cm
p

=, math,
eq, cmp

dou + =,
math,
eq,
cmp

=,
m
at
h,
eq
,
c
m
p

=,
ma
th,
eq,
cm
p

=, math,
eq, cmp

boo + =, eq =, eq

ent + =, eq,
inst

=, eq, inst
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Right Side of Operator

str int
lo
n

do
u boo ent obj dat

obj =, +,
eq,
cmp,
inst

=,
math,
eq,
cmp

=,
m
at
h,
eq
,
c
m
p

=,
ma
th,
eq,
cm
p

=, eq =, eq,
inst

=, eq, inst =, eq, inst

dat +, =, eq, inst =, eq, cmp,
inst

Abbreviation Meaning and Notes

boo Boolean.

cmp Comparison operators: <, >, <=, >=

dat Date/Time

dou Double

ent Entity. Type includes Concept, Event and Scorecard. Both operands must either be
of the same type or have a subtype-supertype relationship

eq Equality operators: ==, !=

inst instanceof

int Integer

lon Long

math Numerical operators: unary +, unary -, =, - , *, /, %

obj Object

str String

Correcting Inconsistencies of Type
TIBCO BusinessEvents attempts to correct inconsistencies of type whenever possible by converting
expressions to the appropriate type.

It converts expression types in the following cases:

● An expression uses the plus sign (+) with a string operand.
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● An arithmetic expression includes numbers of differing types.
● The value of an expression is assigned to a variable of a different type.
● The value of an expression is passed to a function that declares a different type.

There are some inconsistencies of type that TIBCO BusinessEvents cannot correct. For example, all
expressions within conditions must be of type boolean. If an expression within a condition evaluates to
anything other than boolean, it would be illogical for TIBCO BusinessEvents to convert the expression
to boolean. In cases like this, TIBCO BusinessEvents returns an error at compile time.

String Operands

When an expression uses the plus sign (+) with a string operand, TIBCO BusinessEvents treats the
expression as a request for concatenation rather than addition. It converts the second operand to a
string and concatenates the two strings.

For example:
"area code:  " + 650

    becomes
"area code:  650"

Arithmetic Expressions

The following information applies to these operators:
*  /  %  +  -  <  <=  >  =  ==  !=

When an expression uses one of the above arithmetic operators with two numbers of different numeric
types, TIBCO BusinessEvents promotes one of the two operands to the numeric type of the other. It
makes these promotions as follows:

● If either operand is a double, TIBCO BusinessEvents promotes the other to a double.
● Otherwise, if either operand is a long, it promotes the other to a long.

Assignment Conversion

If the value of an expression is assigned to a variable, TIBCO BusinessEvents converts the expression’s
type to that of the variable. This might include, for example, converting a double to an int, or
converting a generic model type to a more specific model type.

Function Argument Conversion

Conversions of function arguments are handled in the same way as assignment conversions.
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Mapping and Transforming Data

Variables in the scope of a rule or rule function can be mapped to arguments of a function used in that
rule or rule function.

See also XPath Formula Builder for related information, as well as Working with Rules and Functions.

The Function Argument Mapper allows you to supply the data that a function expects as input. For
instructions on accessing the Function Argument Mapping wizard in the rule editor see Using the
Function Argument Mappng Wizard.

XPath 1.0 and XPath 2.0

TIBCO BusinessEvents supports XPath 1.0 and XPath 2.0. The default is XPath 2.0 for the new projects.
TIBCO BusinessEvents uses the Standard Widget Toolkit (SWT) mapper to support XPath 2.0 and XSLT
2.0.

The following BE functions SWT mapper, and the underlying implementation of these functions uses
the related XML runtime:

● Event.createEvent
● Instance.createInstance
● All XPath.evalAs functions, for instance XPath.evalAsString

Using the SWT mapper for XPath 2.0, you can perform the mapping in the same way you can do for
XPath 1.0; however, the mapper uses the XPath 2.0 expressions. In contrast to XPath 1.0, the type
casting from one data type to other data type is not done implicitly in XPath 2.0. In XPath 2.0, you need
to perform the explicit typecasting using the constructor function. BusinessEvents also provides the
option in the Function Argument Mapping wizard to autofix the typecasting error.

In XPath 1.0, the mapper has two different windows the Function Argument Mapping and XPath
Function Builder; however, in XPath 2.0 both window are now combined in the same Function
Argument Mapping wizard. Thus, if your project uses XPath 1.0 then you will see the Function
Argument Mapping wizard and XPath Formula Builder in different windows. However, if your project
uses XPath 2.0 then you will see the Edit tab inside the Function Argument Mapping wizard (see 
Function Argument Mapping Wizard for XPath 2.0).

The mapper for XPath 1.0 had some TIBCO provided functions that were not part of the XPath 1.0
specifications, for instance format-dateTime. These functions are currently unavailable with the SWT
mapper for XPath 2.0, and the old XPath expression may give error, in such case you have to manually
fix those error.

All the following sections provides information on mapping data with respect to XPath 1.0 user
interface; however, you can perform all those functions in XPath 2.0. For reference on the user interface
for XPath 2.0, see Function Argument Mapping Wizard for XPath 2.0.

Function Argument Mapping Wizard for XPath 1.0
Using the Function Argument Mapping wizard for XPath 1.0 you can map the source data to the input
arguments of the mapper function. The wizard consists of two sections: Function and Input.

Function Section

The function section, in the upper part of the dialog, shows the view-only name of the function you are
working with and the editable entity path to the item whose properties and attributes you want to map
to the function arguments.

Input Section

In the input section, there are two panels:
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● Scope Variables Panel

The scope variables panel shows the list of properties and attributes available to the function, as
well as global variables defined in the project.

● Function Panel

The function panel uses an Extensible Stylesheet Language Transformation (XSLT) template that
specifies how scope variables should be transformed to provide the expected input. Normally, you
do not need detailed knowledge of XSLT to specify a function’s expected output. However, if you
are familiar with XSLT and you wish to see the actual code, you can right-click on any item in the
Function panel and choose Copy from the popup menu. Then open a blank text document and
choose Paste. The XSLT is displayed in your text document.

You can also use your own XSLT templates to perform transformations instead of using the
techniques described in the following sections. You can paste XSLT into your function input fields,
or into the XPath Formula field in XPath Formula Builder. (You cannot, however, paste XSLT
directly into the function argument in the rule editor.)

The Input tab consists of several toolbar buttons, popup menus, and icons to help in performing
mapping of data for XPath 1.0.

Toolbar and Right-Click Menu on the Input Section

The Scope Variables panel and the Function panel have several buttons for performing various
functions. There is also a popup menu when you right-click on elements in each panel. Table 38
describes the buttons and right-click menu items available in the panels of the Input tab.

Input tab toolbar buttons

Button
Right-Click
Menu Description

Scope Variables Panel

Coercions. Allows you to specify a type for Scope Variables elements
that are not a specific datatype. For example, a choice element can be
coerced into one of the possible datatypes for the element, or an element
of datatype any can be coerced into a specific datatype.

Type Documentation. Allows you to specify or view documentation for
schema elements.

Expand This menu item has two sub-menus: Content and All. Expand > Content
expands the current element so that all elements that are currently used
in a mapping are visible. Expand > All expands all sub-elements of the
currently selected element.

Show
Connected

Expands the elements in the Function area to display elements that are
mapped to the currently selected element or its sub-elements.

Delete Deletes the selected element.

Copy Copies the selected element. The element can be later pasted.

Function Panel
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Button
Right-Click
Menu Description

Shows or hides the mapping formulas for the input elements.

Move Up. Moves the selected element up in the Function tree.

Move Down. Moves the selected element down in the Function tree.

Move Out Move Out. Promotes the selected element to the next highest level in the
Function tree.

Move In Moves the currently selected element into a new statement. This
displays the Move Into New Statement dialog that allows you to choose
the statement you wish to move the element into. See XSLT Statements
for more information about XPath statements.

Delete Deletes the mapping for the selected element. If no mapping is defined,
the element itself is deleted (along with all child elements).

Note
 Elements are predefined. Do not delete elements. Deletion of an
element causes mapper validation errors due to the mismatch of the
right panel’s content with its schema.

Insert. Click Insert to pop-up a New XSLT Statement dialog where you
can define an XSLT statement. The statement is inserted in the function
input schema on the same level of the hierarchy as the currently
selected element.

You can add one XSLT statement at a time with this button. The right-
click menu item Statement provides a shortcut for multi-line statements,
such as Choice or If. See the description of the Statement menu item
below for more information.

Note
 Elements are predefined. Do not add new elements. Doing so causes
a mismatch of the right panel’s contents with its schema.

See XSLT Statements for more information about XSLT statements.

Add Child. Adds a statement for a child element to the currently
selected element.

Mapper Check and Repair. Verifies the XSLT template you have created
in the Function panel against the expected input. A list of errors and
warnings appear and you can choose which items you wish to fix.
TIBCO BusinessEvents attempts to fix simple problems such as adding
missing items that are expected.

See Incorrect Mappings for more information.
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Button
Right-Click
Menu Description

Edit Statement. Allows you to modify an XSLT statement for the
element.

See XSLT Statements for more information about XSLT statements.

Edit XPath Formula Builder. Invokes the XPath formula builder. You can use
this editor to create an XPath statement for this input element. See 
XPath Formula Builder for more information about XPath and the
XPath formula builder.

Expand This menu item has three sub-menus: Content, Errors, and All. Expand
> Content expands the current element so that all sub-elements that
have a mapping or expression are visible. Expand > Errors expands the
current element so that all sub-elements that have an error in their
expression are visible. Expand > All expands all sub-elements of the
currently selected element.

Show
Connected

Expands the elements in the Scope Variables panel to display elements
that are mapped to the currently selected element or its sub-elements.

Statement This menu item contains shortcuts that allow you to easily add the
desired XSLT statement(s) with one menu item instead of adding the
statement(s) with the Insert button. See Statement Menu Options for a
description of the sub-items of this menu.

Undo
operation

Rolls back the last operation performed. The name of the last operation
is shown.

Redo
operation

Performs the last operation that was undone with the Undo menu item.
The name of the last operation is shown.

Cut Deletes the selected element. The element can be later pasted to a new
location.

Copy Copies the selected element.

Paste Pastes the last element that was copied or cut.

Icons for Schema Element Datatypes

Schema elements also have a set of associated icons to indicate their type. Table 39 describes the icons
used for schema items.

You can use the Type Documentation button to obtain any available documentation on any node in the
Scope Variables or function input schema trees.

Icons for schema items

Icon Description

Complex element that is a container for other datatypes. This is also called a
branch in the schema tree.
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Icon Description

Simple string or character value.

Simple integer value.

Simple decimal (floating point) number.

Simple boolean value.

Simple Date or Time. This can be any of the following datatypes:

● Time
● Date
● Date & Time
● Duration
● Day
● Month
● Year
● Month & Year
● Day & Month

Simple binary (base 64) or hex binary value.

Represents a schema item that can be any datatype. Data in this schema
element can be any datatype.

Choice. Specifies that the actual schema element can be one of a specified set
of datatypes.

Qualifier Icons
Schema elements can have additional icons that specify qualifications. The qualifier icons have different
meanings depending upon where they appear. For example, a question mark icon signifies an element
is optional in the Scope Variables schema or in a hint in the Function panel. However, in an XSLT
statement, the question mark signifies the statement is "collapsed" and an implicit "if" statement is set,
but not displayed in the Function panel.

Table 40 describes the additional qualifiers that appear next to the name of schema items.

Additional icons for hints

Qualifier Scope Variables or Hint Statement

No qualifier indicates the element is
required.

N/A
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Qualifier Scope Variables or Hint Statement

A question mark indicates an optional
Item.

An implicit "if" statement is set for this
statement. This occurs when you map an
optional element from the Scope
Variables to an optional element in the
function input schema or if you specify
Surround element with if test on the
Content tab of the Edit Statement dialog.

An asterisk indicates the item repeats
zero or more times.

N/A

A plus sign indicates the item repeats
one or more times.

N/A

A null sign indicates the item may be set
to null.

A null sign indicates the item is
explicitly set to null.

You can set an element explicitly to null
by clicking the Edit Statement button for
the element, then checking the Set
Explicit Nil field on the Content tab of
the Edit Statement dialog.

Function Argument Mapping Wizard for XPath 2.0
Using the Function Argument Mapping wizard you can map the variable of the source to the argument
of a mapper function.

Functions Section

The Functions section is similar to the Function Argument Mapping wizard for XPath 1.0. It displays
the view-only name of the function you are working with and the editable entity path to the item,
whose properties and attributes you want to map to the function arguments.

Input Section

The Input section in the Function Argument Mapping wizard for XPath 2.0 is a combination of the
Input section of the Function Argument Mapping wizard for XPath 1.0 and XPath Function Builder. For
XPath 2.0, there is no separate XPath Function Builder but it has been merged in the Function
Argument Mapping wizard. However, the Function Argument Mapping wizard still performs the
same functions and in the same way with only the user interface changes.
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The Function Argument Mapping Wizard in XPath 2.0 Project

In the Input section, on the left side, there are three tabs: Data Source, Functions, Constants.

The Data Source tab is similar to the Scope Variables panel in the Function Argument Mapping wizard
for XPath 1.0. It lists the properties and attributes available to the function, as well as global variables
defined in the project.

The Functions and the Constants tab are the same tabs which are available in the XPath Formula
Builder for XPath 1.0. However, the Functions tab now contains the XPath 2.0 mapper functions. Some
of these new functions were provided by TIBCO in XPath 1.0, which are now part of the XPath 2.0
function library. See The XPath Formula Builder Reference for more details on these tabs.

On the right side, similar to the Function panel in the Function Argument Mapping wizard for XPath
1.0 the XSLT template is present which specify how the Data Source would be transformed to provide
the expected input. There is a toolbar which consists of the tools show the edit tab and auto-fix the
errors.

Function Argument Mapping Wizard for XPath 2.0 Toolbar

Icon Tool Desctiption

Remove Mapping Removes the selected mapping
from the selected attribute.
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Icon Tool Desctiption

Show Check and Repair Displays mapper check and
repair window similar to XPath
1.0. It verifies the XSLT
template you have created in
the Function panel against the
expected input. A list of errors
and warnings appear and you
can choose which items you
wish to fix.

TIBCO BusinessEvents
attempts to fix simple problems
such as adding missing items
that are expected and
typecasting errors.

Fix Typecasting Error Fixes the typecasting error in
XPath 2.0 where explicit
casting is not done. For
BusinessEvents, if the XPath
expression elements cannot be
implicitly cast, an error will be
displayed. For instance, if the
XPath expression is $price >
1000, and $price is defined as a
String, then an explicit cast
must be done (the XPath 1.0
mapper does this casting
implicitly).

Show/Hide Edit Tab Toggles the XPath expression
editor for building complex
XPath statement for the
selected input argument. See 
XPath Formula Builder for
XPath 2.0.

This builder functions in the
same way in which XPath
Function Builder was working
in XPath 1.0. See XPath
Formula Builder for more
details.

XPath Formula Builder For XPath 2.0

XPath 2.0 mapper do not have a separate window for XPath Formula Builder. The expression editor is
now part of the Function Argument Mapping wizard and can be shown by the Show/Hide Edit Tab
button.

Click the Show/Hide Edit Tab icon to display or hide the XPath Statement and XSLT Source tabs
where you can build the complex XPath expression. You can use the data scope variables, mapper
functions and constants from the respective tab on the left. In XPath 2.0, the behavior of the formula
builder remains the same as XPath 1.0. See XPath Formula Builder for more details on its functioning in
XPath 1.0.
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XPath Formula Builder for XPath 2.0

Mapping and Transforming Data to Function Input

Assigning an empty string ("") to a field in a mapper function results in a null string.

To map data, select an item in the Scope Variables panel, then drag and drop that item into the desired
schema element in the Function panel.

Simple mappings appear in the formula area to the right of the input element after you release the

mouse button. For more complex mappings, click the Edit Statement  icon (XPath 1.0) or Show/
Hide Edit Tab  icon (XPath 2.0).

Most options in the Edit Statement dialog are straightforward. However, there are some complex
scenarios that require multiple steps.

You may also wish to refer to XSLT Statements for a reference of XSLT statements when deciding
which XSLT statement can be used to achieve the result you desire.

You can specify XPath formulas to transform an element if you need to perform more complex
processing. The XPath Formula Builder allows you to easily create XPath formulas. For more advanced
use of XPath, see XPath Formula Builder. There are also a variety of third-party books and resources
about XSLT and XPath.

The datatypes of the function’s arguments display as hints. Once a mapping or formula is specified, a
hint becomes an XSLT statement. See Statements Hints and Errors for more information about hints
and statements.
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Statements Hints and Errors
When you display the Function tab, the existing statements are examined, and any input elements that
do not have a statement are displayed as hints. Hints are reminders that you can specify a statement for
the input element, but they are not stored as part of the XSLT template for the function’s input. Hints
are displayed in italics with a light blue background. Once you specify a mapping or a formula for a
hint, the input element becomes a statement. You can also drag the hint to the left past the dividing line
between the panels and the hint becomes a blank statement.

Once you specify a statement in the Function panel and click OK, it becomes part of the XSLT template
used to create the input data. Statements are only deleted if you manually delete them using the delete

button, or if you use the Mapper Check and Repair ( button to automatically fix errors. Therefore, if
the input schema for the function changes, your statements may no longer be valid. See Tester
Preferences for more information about using the Mapper Check and Repair button to fix statements in
the Function panel.

Any statement or hint that has an error is displayed in red. A hint is only displayed in red if it is a
required input element. All required input elements must have statements specified. The Mapper
Check and Repair button can help you automatically fix some errors. See Incorrect Mappings for more
information about fixing errors.

Buttons Menus and Icons
The Input tab contains several toolbar buttons, popup menus, and icons. This section describes the
various graphical elements of the Input tab.

Toolbar and Right-Click Menu on the Input Section

The Scope Variables panel and the Function panel have several buttons for performing various
functions. There is also a popup menu when you right-click on elements in each panel. Table 38
describes the buttons and right-click menu items available in the panels of the Input tab.

Input tab toolbar buttons

Button
Right-Click
Menu Description

Scope Variables Panel

Coercions. Allows you to specify a type for Scope Variables elements
that are not a specific datatype. For example, a choice element can be
coerced into one of the possible datatypes for the element, or an element
of datatype any can be coerced into a specific datatype.

Type Documentation. Allows you to specify or view documentation for
schema elements.

Expand This menu item has two sub-menus: Content and All. Expand > Content
expands the current element so that all elements that are currently used
in a mapping are visible. Expand > All expands all sub-elements of the
currently selected element.

Show
Connected

Expands the elements in the Function area to display elements that are
mapped to the currently selected element or its sub-elements.
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Button
Right-Click
Menu Description

Delete Deletes the selected element.

Copy Copies the selected element. The element can be later pasted.

Function Panel

Shows or hides the mapping formulas for the input elements.

Move Up. Moves the selected element up in the Function tree.

Move Down. Moves the selected element down in the Function tree.

Move Out Move Out. Promotes the selected element to the next highest level in the
Function tree.

Move In Moves the currently selected element into a new statement. This
displays the Move Into New Statement dialog that allows you to choose
the statement you wish to move the element into. See XSLT Statements
for more information about XPath statements.

Delete Deletes the mapping for the selected element. If no mapping is defined,
the element itself is deleted (along with all child elements).

Note
 Elements are predefined. Do not delete elements. Deletion of an
element causes mapper validation errors due to the mismatch of the
right panel’s content with its schema.

Insert. Click Insert to pop-up a New XSLT Statement dialog where you
can define an XSLT statement. The statement is inserted in the function
input schema on the same level of the hierarchy as the currently
selected element.

You can add one XSLT statement at a time with this button. The right-
click menu item Statement provides a shortcut for multi-line statements,
such as Choice or If. See the description of the Statement menu item
below for more information.

Note
 Elements are predefined. Do not add new elements. Doing so causes
a mismatch of the right panel’s contents with its schema.

See XSLT Statements for more information about XSLT statements.

Add Child. Adds a statement for a child element to the currently
selected element.
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Button
Right-Click
Menu Description

Mapper Check and Repair. Verifies the XSLT template you have created
in the Function panel against the expected input. A list of errors and
warnings appear and you can choose which items you wish to fix.
TIBCO BusinessEvents attempts to fix simple problems such as adding
missing items that are expected.

See Incorrect Mappings for more information.

Edit Statement. Allows you to modify an XSLT statement for the
element.

See XSLT Statements for more information about XSLT statements.

Edit XPath Formula Builder. Invokes the XPath formula builder. You can use
this editor to create an XPath statement for this input element. See 
XPath Formula Builder for more information about XPath and the
XPath formula builder.

Expand This menu item has three sub-menus: Content, Errors, and All. Expand
> Content expands the current element so that all sub-elements that
have a mapping or expression are visible. Expand > Errors expands the
current element so that all sub-elements that have an error in their
expression are visible. Expand > All expands all sub-elements of the
currently selected element.

Show
Connected

Expands the elements in the Scope Variables panel to display elements
that are mapped to the currently selected element or its sub-elements.

Statement This menu item contains shortcuts that allow you to easily add the
desired XSLT statement(s) with one menu item instead of adding the
statement(s) with the Insert button. See Statement Menu Options for a
description of the sub-items of this menu.

Undo
operation

Rolls back the last operation performed. The name of the last operation
is shown.

Redo
operation

Performs the last operation that was undone with the Undo menu item.
The name of the last operation is shown.

Cut Deletes the selected element. The element can be later pasted to a new
location.

Copy Copies the selected element.

Paste Pastes the last element that was copied or cut.

Icons for Schema Element Datatypes

Schema elements also have a set of associated icons to indicate their type. Table 39 describes the icons
used for schema items.

You can use the Type Documentation button to obtain any available documentation on any node in the
Scope Variables or function input schema trees.
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Icons for schema items

Icon Description

Complex element that is a container for other datatypes. This is also called a
branch in the schema tree.

Simple string or character value.

Simple integer value.

Simple decimal (floating point) number.

Simple boolean value.

Simple Date or Time. This can be any of the following datatypes:

● Time
● Date
● Date & Time
● Duration
● Day
● Month
● Year
● Month & Year
● Day & Month

Simple binary (base 64) or hex binary value.

Represents a schema item that can be any datatype. Data in this schema
element can be any datatype.

Choice. Specifies that the actual schema element can be one of a specified set
of datatypes.

Qualifier Icons
Schema elements can have additional icons that specify qualifications. The qualifier icons have different
meanings depending upon where they appear. For example, a question mark icon signifies an element
is optional in the Scope Variables schema or in a hint in the Function panel. However, in an XSLT
statement, the question mark signifies the statement is "collapsed" and an implicit "if" statement is set,
but not displayed in the Function panel.

Table 40 describes the additional qualifiers that appear next to the name of schema items.
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Additional icons for hints

Qualifier Scope Variables or Hint Statement

No qualifier indicates the element is
required.

N/A

A question mark indicates an optional
Item.

An implicit "if" statement is set for this
statement. This occurs when you map an
optional element from the Scope
Variables to an optional element in the
function input schema or if you specify
Surround element with if test on the
Content tab of the Edit Statement dialog.

An asterisk indicates the item repeats
zero or more times.

N/A

A plus sign indicates the item repeats
one or more times.

N/A

A null sign indicates the item may be set
to null.

A null sign indicates the item is
explicitly set to null.

You can set an element explicitly to null
by clicking the Edit Statement button for
the element, then checking the Set
Explicit Nil field on the Content tab of
the Edit Statement dialog.

Specifying Constants
For each element in the Function input schema tree, you can specify a constant. Constants can be
strings or numeric values. To specify a string, enclose the string in quotes. To specify a number, type
the number into the schema element’s mapping field. The following illustrates specifying the string
"USA" for the Country item and 94304 for the PostalCode item of a function input schema.

Constants can also be used in functions and search predicates. To learn more about complex XPath
expressions that use functions and search predicates, see XPath Formula Builder.

Date and Datetime Strings in Constants
In constant expressions used in bindings, datetime values are read in according to the ISO 8601
standard, as described in the XML Schema specification. For example, the value:
"2002-02-10T14:55:31.112-08:00"

is 55 minutes, 31 seconds and 112 milliseconds after 2pm on February 10th, 2002 in a timezone that is 8
hours, 0 minutes behind UTC.
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If no timezone field is present, the value is interpreted in the timezone of the machine that is
performing the parsing. This can lead to complications if you are processing data from different
timezones, so you are encouraged to always use timezones.

When TIBCO BusinessEvents generates datetime strings UTC time is always used. The output for the
example above is:
2002-02-10T14:55:31.112Z

which is the equivalent time in the UTC timezone.

Data Validation
Data passed as input to a function is validated to ensure that it conforms to its specified datatype.

Table 41 describes the validation behavior. Datatype validation listed with the prefix xsd: is defined in
the namespace http://www.w3.org/2001/XMLSchema. See XML Schema Part2: Datatypes specification at
http://www.w3.org/TR/2004/PER-xmlschema-2-20040318/ for more information on the proper
representation of these datatypes. Datatype validation listed with the prefix xdt: is defined in the
namespace http://www.w3.org/2003/11/xpath-datatypes. See Xquery 1.0 and Xpath 2.0 Functions and
Operators specification at http://www.w3.org/TR/2003/WD-xpath-functions-20031112/ for more
information on the proper representation of these datatypes.

Datatype validation

Data Type Validation

boolean xsd:boolean

double xsd:double

string xsd:string

dateTime xsd:dateTime

long xsd:long

int xsd:int

Incorrect Mappings
Any incorrect statements are displayed in red in the Function panel.

Errors can occur for a number of reasons. For example,

● a required element has no statement, and therefore must be specified
● the function’s input schema has changed and existing statements may no longer be valid
● the XPath formula for an element may contain an error

You should correct any errors before attempting to test or deploy your process definition.

To help find potential problems in your mappings, click the Mapper Check and Repair button. This
button displays a dialog with all potential problems in the specified mappings. You can select the Fix
checkbox for potential errors, and TIBCO BusinessEvents will attempt to fix the problem.

Some potential problems in the Mapper Check or Repair dialog cannot be fixed easily, and therefore
there is no checkbox in the Fix column for these items. For example, if an element expects a string and
you supply a complex type, the corrective action to fix the problem is not clear, and therefore TIBCO
BusinessEvents cannot automatically fix the problem. You must repair these items manually.
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XPath 2.0

For XPath 2.0, in addition to the earlier specified errors, you can also see the errors when there is no
explicit typecasting of different data types, such as, mapping a boolean value ($processapplication/
start) to a input of data type double. In such cases, you can fix the typecasting error in following
ways:

● Click the Fix Typecasting Error  icon to autofix all typecasting errors.

● Open Check and Repair window and select the Fix checkbox for the typecasting error to fix the
selected error.

● Perform explicit typecasting using the constructor functions, such as, for earlier example use
xsd:double($processapplication/start) to explicitly typecast the boolean value to double.

Repair Incorrect Mappings
If you want to return to the original expected Function input and remove all of the currently specified
mappings, perform the following:

Procedure

1. Delete the root element of the function’s input by selecting it and clicking the Delete button.

Click the Mapper Check and Repair ( ) button.

2. In the Mapper Check and Repair dialog Fix column, select the checkboxes for all items.

3. Click OK.

Result

Alternatively, you can simply select the root input element and press the delete key on your keyboard
as a shortcut for the procedure above.

After deleting all mappings and schema items and then repairing the input schema, the function’s
input reverts to the state before you open the Argument Mapping Wizard for the first time for this
function.

Shortcuts
The Move In, Insert, Add Child, and Edit Statement buttons on the toolbar are ways to manually
manipulate XSLT statements in the Function panel. These buttons, however, only add or modify one
statement at a time. Also, there are some situations where you wish to convert a hint into a statement
without performing any mapping. This section describes shortcuts for manipulating XSLT statements.

Statement Menu Options
When you select an element in the function input schema and right-click, a menu appears. The
Statement menu item contains several sub-items that are useful shortcuts for creating XSLT statements.

● Surround with Choice — a shortcut for adding a choice statement and its associated conditions or
otherwise statements around the currently selected element.

● Surround with If — a shortcut for adding an if statement and placing the currently selected element
as the sub-element of the if.

● Surround with For-Each — a shortcut for moving the current element into a For-Each statement.
● Surround with For-Each-Group — a shortcut for moving the current element into a For-Each-Group

statement and adding a Group-By grouping statement.
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● Duplicate — a shortcut for creating a duplicate of the currently selected element (including any
mappings or XPath formulas for the element). The duplicate is added below the currently selected
element.

● Insert Model Group Content — a shortcut for inserting the contents of a selected model group into
the mapper tree. The selected element in the function input schema is replaced by the contents of
the model group you select.

Dragging to the Left
Dragging an element in the function input schema to the left past the divider between the two areas of
the Input tab changes a hint into an XSLT statement.

This shortcut is useful in the following situations:

● When you have a complex element with no sub elements and no content.
● When you have a choice element, dragging to the left brings up the Mapping Wizard and allows

you to choose a type for the element.
● When you have an element of type Any, dragging to the left brings up a dialog that allows you to

specify the type for the element.

Cutting and Pasting
The Function panel is an XSLT template for specifying the function’s input schema. You can choose any
element in the Function panel and select Copy from the right-click menu or press the Control-C keys to
copy the XSLT statement for the element. Once the XSLT is copied, you can paste it into a text editing
tool to view or modify the code.

You can also paste arbitrary XSLT code into the Function panel using the right-click menu or the
Control-V keys. Pasting XSLT code from the copy buffer places the code above the currently selected
element in the Function panel.

Automatic Testing (at Runtime)
When you map Scope Variables elements to Function elements, the behavior of the mapping depends
upon the types of elements you are mapping. In the simplest case of mapping a required element in the
Scope Variables schema to a required Function element, the value of the Scope Variables element is
assigned to the required Function element.

However, when elements are optional or nillable, more complex tests are necessary. When you drag the
Scope Variables element to the Function element, the necessary tests are automatically placed into the
Function XSLT template.

This section describes the result of mapping different types of elements. The types of mappings are
described, then an example is given that illustrates these mappings and shows the XSLT code that is
generated automatically when these mappings are performed at runtime.

Required to Required

Specifies that the statement should always include the required Function element and its value should
be obtained from the required Scope Variables element that the element is mapped to.

Optional to Optional

Specifies that the statement should test if the Scope Variables element is present, and if so, include the
optional element in the function’s input. If the Scope Variables element is not present, the optional
element is omitted from the function’s input.
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Nillable to Nillable

Specifies that both the Scope Variables and Function elements can be nil. Therefore, the value of the
Function element is set to the value of the Scope Variables element. The value of the Function element
is set explicitly to nil if that is the value of the Scope Variables element.

Optional to Nillable

Specifies that the statement should test if the optional Scope Variables element exists. If the element
exists, the Function element should be created and set to the value of the Scope Variables element. If the
Scope Variables element does not exist, the element is omitted from the function input schema.

Nillable to Optional

Specifies that the statement should test if the Scope Variables element has a value specified, and if so,
the optional element in the Function panel should be set to the value of the Scope Variables element.
Otherwise, if the Scope Variables element is nil, the optional element is omitted from the Function
panel.

Optional & Nillable to Optional & Nillable

Specifies that if the optional Scope Variables element exists, then include the optional Function element
in the input schema. If the Scope Variables element is nil, set the value of the Function element
explicitly to nil. If the Scope Variables element is not nil, set the value of the Function element to the
value of the Scope Variables element. If the Scope Variables element is not present, then omit the
optional element from the function input schema.

Examples of Mappings
Some mappings require several steps to achieve the desired results. This section describes some
complicated mapping scenarios and how to achieve the desired mappings using the tools available.

There are many methods to insert or modify XSLT statements in the function input schema. The
examples in this section illustrate the simplest procedures to obtain the desired results. However, you
do not have to follow the same procedures outlined in this section to achieve the correct set of
statements.

Setting an Element Explicitly to Nil
In some situations, you may wish to set an element explicitly to nil. One situation is when you wish to
insert a row into a database table and you wish to supply a NULL for one of the columns.

Procedure

1. Select the input element you wish to set to nil.

Click theEdit Statement  icon (XPath 1.0) or Show/Hide Edit Tab  icon (XPath 2.0) on the
Input tab toolbar.

2. (XPath 1.0) Click the Content tab of the Edit Statement window and select the Set Explicit Nil
checkbox.
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The element’s formula becomes blank and is not editable (because nil is the value of the element)
and the explicit nil qualifier icon appears next to the statement .

3. (XPath 2.0) Select the Set Explicit Nil checkbox under the Statement Type section under the Edit
Statement tab.

Merging Input from Multiple Sources
You may have multiple items in the Scope Variables that you wish to map to one repeating element in
the Function panel.

For example, you may have multiple formats for customer records and you wish to create a single,
merged mailing list containing all customers in one format.

Example Schema of Merging Input From Multiple Sources

Procedure

1. Select the repeating element in the Function panel, right-click, and select Statement > Duplicate
from the menu.

Because you are creating two different formulas for mapping, you need two copies of the repeating
element, one for each format. The resulting output contains only one repeating customer element,
but the two copies in the Function panel make it simpler to perform two different mappings.
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2. Map one of the elements from the Scope Variables to the first copy of the repeating element in the
Function. For example, map $Retrieve-Customer-Type1/Customer to MergeMailingList/
CustomerList/Customer.

The Mapping Wizard dialog appears and presents choices for what you would like to accomplish.
Choose the For Each option and click Next.

The mapping wizard asks if you wish to automatically map items with the same names. Click
Finish to accept the default mappings.

3. Map the other element from the Scope Variables to the second copy of the repeating element in the
Function. For example, map $Retrieve-Customer-Type2/Record to MergeMailingList/
CustomerList/Customer.

In the Mapping Wizard dialog, choose the For Each option and click Next.
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The mapping wizard presents you with an option to automatically map elements with the same
name. Click Finish to accept the default mappings.

4. Select the Address element and click the XPath Formula Builder icon in the Input tab toolbar. In the
XPath Formula Builder, drag a concat() function into the XPath Formula field. This function is
used to concatenate the three elements in the Record element in the Scope Variables area to one
Address element in the function’s input.

Click the Data tab, then drag the $current()/Address/street element into the << string1 >>
placeholder in the concat() function.
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Drag the $current()/Address/state element into the << string2 >> placeholder in the concat()
function. Then, add a comma to the end of the function to include a third string to concatenate.
Drag the $current()/Address/zip element into the position of the third string in the concat()
function.

5. Click Apply, then click Close to dismiss the XPath Formula Builder dialog.

6. This results in the following mapping:

Converting a List Into a Grouped List
You may need to convert a flat list of items into a more structured list.

For example, you may have a list of all orders that have been completed. You may want to organize
that list so that you can group the orders placed by each customer.
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Example Schema of List Conversion to a Grouped List

Procedure

1. Choose the repeating element in the function input schema that holds the grouped data. In this
example, that element is Orders. Right-click on this element and choose Statement > Surround
with For-Each-Group... from the pop-up menu. This is a shortcut to create a For-Each-Group
statement with the Orders element as a child element and a Grouping statement to contain the
element you wish to group-by.

Adding the Grouping statement creates the $=current-group() element in the Scope Variables
area. The Grouping statement creates the list grouped by the desired element, and the current-
group() function allows you to access the items in the Requests repeating element that correspond
to the group that is currently being processed.

2. Drag the repeating element from the Scope Variables area to the For-Each-Group statement.

3. Drag the element you wish to group by from the Scope Variables area to the Grouping statement in
the Function panel. In this example, customerID is the grouping element.
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4. Map the current-group() element in the Scope Variables area to the repeating element Order
under the Customer element in the Function panel.

The default choice in the mapping wizard for this mapping is to create a For-Each. Choose this
option in the mapping wizard.

This creates an item in the Order list for each item in the current customer ID group that is being
processed. The mapping wizard asks if you wish to map items with the same name in the current
group and the orders group.

5. Map the remaining element from the current-group() element into the desired element in the For-
Each group. In this case, quantity would map to Quantity automatically, and Item must be
mapped to ItemName.

6. Map the customerID element in the Requests element into the Customer element in the Function
panel.
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Merging Two Corresponding Lists
You may need to merge two lists that have corresponding items into one repeating element.

For example, you may have a list of student IDs and a list of grades, each grade corresponds to the
student ID in the same position in the student ID list.

Example Schema of Merging of Two List

Procedure

1. Map the first repeating element from the Scope Variables area into the Grades repeating element in
the Function panel. In this example, the $RetrieveStudentIDs/Students/Record is the first
repeating element.

This brings up the mapping wizard with the default choice of creating a For-Each statement. Click
Finish in the Mapping Wizard dialog to create the For-Each statement.
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2. Drag the second repeating element into the For-Each statement.

3. The Mapping Wizard dialog appears asking you to chose an option. Choose the Merge parallel
repeating structure option and click Next.

4. Merging two parallel repeating structures requires two variables. The mapping wizard prompts
you to name these two variables. One variable is to hold the position number of the current item
being processed, and the other variable is to hold the item in the second list that corresponds to the
position of the item in the first list. Create the variables with the default names supplied by the
mapping wizard, or choose your own names for these variables. Click Finish to proceed.

The two variables appear in the Scope Variables area once you have completed this step. The two
variables also appear in the Function panel with the correct XPath statement to produce the desired
result.

The $=[index=] element contains the XPath formula position() to set the element with the
current position number of the list item being processed. The $=[item=] element contains a
statement to retrieve the item in the second repeating element that corresponds to the position of
the item in the first list that is currently being processed.

5. Map the ID element to the StudentID element in the function arguments.
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6. Map the $=item/Grade element to the Grade element in the Function panel.

Coercions
In some situations, the datatype of a Scope Variables element may be undefined. In these situations,
you may know the datatype of the element, and you can coerce the element into a specific type. The
Coercions button in the Input tab toolbar allows you to create and manage your coercions.

The following example illustrates a schema with an element defined as the "any element" datatype. The
schema is for a generic incoming message that can have any type of body. In the example, however, the
any element is coerced into an Order type so that it can be mapped to a choice element.

Example Schema of Coersion

The following procedure describes how to coerce the Body element of the incoming message into a
specific datatype and map it to a choice element.

There are many ways of accomplishing the same result as this example. This example attempts to
illustrate the simplest method to achieve the desired result.
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Procedure

1. Select the element of type any element in the Scope Variables schema. Click the Coercions button in
the Input tab toolbar. In the Coercions dialog, click the Insert button (+) to add a coercion for the
currently selected element.

The Coercions dialog allows you to manage all of your coercions for a function in one dialog. You
can create, modify, or delete coercions for any element in the Scope Variables schema using this
dialog, not just the currently selected element. If you are creating a coercion for an element that is
not currently selected, use the XPath field to specify the location of the element.

Click the Element radio button to specify that you are specifying a schema element.

2. Click the Browse Resources button next to the Schema field to browse a list of schemas that can be
used. In the Select a Resource... dialog, select the schema that you would like to specify

Click OK to coerce the element into the datatype of the selected schema element. The following
would be the resulting schema where the element of the datatype any element has been replaced
with the Order schema.

3. Map the Name element to the Name element in the Function panel. Then, map the coerced Order
element to the choice element in the Function panel.
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The Mapping Wizard dialog appears and asks if you wish to create an Order or a
CreditLimitIncrease element. Select Order and click Next.

The Mapping Wizard then asks you to create a For Each. Even though there is only one element in
the Scope Variables schema (the Message element is not repeating), a For Each is used because this
construct allows you to map the individual items of the Order element. Click Next to continue.

The Mapping Wizard then asks if you wish to automatically map elements with the same name.
Click Finish to accept the default mappings.

4. The following is the completed mapping.
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XSLT Statements
Using the XSLT statement you can set up the transformation of mapping.

The following sections describe the XSLT statements you can add to your mapping. You can add or edit

these statements by clicking theEdit Statement  icon (XPath 1.0) or Show/Hide Edit Tab  icon
(XPath 2.0) , or these statements can be added automatically by selecting them from the dialogs that
appear when you drag and drop elements from the Scope Variables tree to the function argument tree.

The following sections discuss statement types (available in the Statement Type drop-down list in the
Edit Statement dialog).

Attribute
Allows you to specify an attribute, and optionally the namespace for the attribute. You can also specify
the type of value for the attribute.

XSLT Equivalent

The following is an attribute named "lastname".
<ns:attribute namespace="mns" name="lastName"/>

When attributes are created, you can optionally specify the kind of value the attribute will have and
whether the attribute should be surrounded by an if statement. For example, you can specify the value
of the last name attribute to be a constant, like so:
<ns:attribute namespace="mns" name="lastName"/>
   "Smith"
</ns:attribute>

Choose
Provides a way to select transformation to perform based on an expression. Specify the condition in the
when element as an XPath expression. You can optionally specify an otherwise condition for
processing all elements that do not meet any of the specified when conditions.

XSLT Equivalent

The following determines if the node set for FilesTransferred contains any files, and if so, performs an
action. If the node set is empty (no files were transferred), a different action is performed.
<ns0:choose xmlns:ns0="http://www.w3.org/1999/XSL/Transform">
   <ns0:when test="$FTP-Put/FTPPutOutputFile/FileTransferred" >
      < something here ... >
   </ns:0when>
   <ns0:otherwise>
      < something here ...>
   </ns0:otherwise>
</ns0:choose>
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Comment
Places a comment in the XSLT template. Comments are delimited by <!-- and -->.

XSLT Equivalent

<!-- comment here -->

Copy
Copies the selected node to the current node in the input tree. Only the node is copied, no children of
the node are copied.

XSLT Equivalent

<ns0:copy xmlns:ns0="http://www.w3.org/1999/XSL/Transform" select="$Query/
resultSet"/>

Copy-Contents-Of
Copies the selected node’s contents. This is useful if you wish to copy an element to a new element with
a different name.

XSLT Equivalent

<ns:element namespace="foo" name="bar">
   <ns:copy-of select="null/@*"/>
   <ns:copy-of select="null/node()"/>
</ns:element>

Copy-Of
Creates a copy of the selected node, including the node’s children. Both the copied node and the
destination node must have the same name and structure.

XLST Equivalent

<ns0:copy-of xmlns:ns0="http://www.w3.org/1999/XSL/Transform" select=""/>

Element
Creates an element with the specified name.

XSLT Equivalent

<elementName>value</elementName>

For-Each
Performs the specified statements once for each item in the selected node. This is useful if you wish to
process each item of a repeating element once.

XSLT Equivalent

The following iterates over the list of files transferred from a ActiveMatrix BusinessWorks FTP Put
activity and outputs an element with the name of each file for each file transferred.
<ns:for-each select="$FTP-Put/FTPPutOutputFile/FileTransferred">
   <fileName>
      <ns:value-of select="$FTP-Put/FTPPutOutputFile/FileTransferred/Name"/>
   </fileName>
</ns:for-each>
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For-Each-Group

Groups the items in a list by a specified element. This statement requires a Grouping statement to
specify which element to group-by. See Converting a List for an example of using the For-Each-Group
statement.

XSLT Equivalent

<ns0:for-each-group xmlns:ns0="http://www.w3.org/1999/XSL/Transform" select=""/>

Generate Comment
Places a comment element into the XSLT template. This comment will be generated into the function’s
output.

Comment elements have the following syntax:
<ns0:comment xmlns:ns0="http://www.w3.org/1999/XSL/Transform"/>

Generate PI
Places a processing instruction into the XSLT template.

XSLT Equivalent

<ns0:processing-instruction xmlns:ns0="http://www.w3.org/1999/XSL/Transform" 
name=""/>

If
An if statement is used to surround other statements in an XSLT template to perform conditional
processing. If the test attribute evaluates to true, the statements in the if are output, otherwise they are
not output.

XSLT Equivalent

The following if statement surrounds an attribute for processing order items.
<ns:if xmlns:ns="http://www.w3.org/1999/XSL/Transform" 
test="not(position()=last())">
    <ns:attribute name="OrderItem">
        <ns:value-of select=
  "$GetOrderInformation/OrderInformation/OrderDetails/OrderItem"/>
    </ns:attribute>
</ns:if>

Value-Of
Specifies a value-of statement. This is normally done implicitly by specifying the formula for an
element (field) in the mapping, but you may insert this statement explicitly.

XSLT Equivalent

<ns:value-of xmlns:ns="http://www.w3.org/1999/XSL/Transform" select=""/>

Variable
Adds a local variable for use in the current mapping. You can specify the name of the variable and
whether you wish the variable to have a select attribute.

When you add a local variable, it appears in the Function and Scope Variables panels. You can supply
any XPath expression to the new variable in the Function panel (either through mapping or through the
XPath Formula Builder).

Once the variable’s contents have been supplied, the variable (in the Scope Variables area) can be
mapped to any item.
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Adding a variable is useful when you wish to join two repeating elements into a single list, then map
the combined list to an item. Adding a variable is also useful if you perform the same computation
repeatedly. You can map the results of the computation to several items instead of recreating the
computation for each item.

Variables can also improve performance of mappings for large data structures. For example, if you
have a process variable with 40 sub-elements, and you map each of the sub-elements to a
corresponding input item, TIBCO BusinessEvents must retrieve the current process variable for each
XPath expression, in this case 40 times. If this mapping appears in a loop, the retrieval of the current
process variable occurs 40 times per iteration of the loop. With a variable, the data is retrieved only
once and used for all mappings containing the variable. Therefore, to improve performance, create a
local variable to hold process variables with a large number of elements and use the local variable in
XPath expressions instead of the process variable.

XSLT Equivalent

<ns0:variable xmlns:ns0="http://www.w3.org/1999/XSL/Transform" name="var" 
select="$RetrieveResults/resultSet"/>

XPath Formula Builder For XPath 1.0
TIBCO BusinessEvents uses XPath in the XPath Formula Builder, available in the Function Argument
Mapper tool. You can use XPath, for example, when defining payloads for events TIBCO
BusinessEvents also uses XPath as the language for defining conditions and transformations.

In XPath 1.0 , the XPath Formula Builder opens in a separate window; however, in XPath 2.0, the XPath
Formula Builder is part of the Function Argument Mapping wizard. They both function in the same
manner with only difference in user interface. See Function Argument Mapping Wizard for XPath 2.0
for more details on XPath Formula Builder for XPath 2.0.

XPath (XML Path Language) is an expression language developed by the World Wide Web Consortium
(W3C) for addressing parts of XML documents. XPath also has basic manipulation functions for strings,
numbers, and Boolean values.

To use XPath in TIBCO BusinessEvents, you need only be familiar with the basic XPath concepts, but
you may wish to learn more about XPath when building complex expressions.

For a complete description of XPath, refer to the XPath specification (which can be obtained from
www.w3.org).

TIBCO BusinessEvents uses XPath (XML Path Language) to identify elements whose content may be
used, for, example in an event payload. You can also use XPath to perform basic manipulation and
comparison of strings, numbers, and Boolean values.

Addressing Schema Elements
All Scope Variables and Function arguments are represented as an XML schema. Regardless of where
the data comes from or its format, TIBCO BusinessEvents represents the data as a schema tree. The data
can be simple (strings, numbers, Boolean values, and so on), or it can be a complex element. Complex
elements are structures that contain other schema elements, either simple elements or other complex
elements. Both simple and complex elements can also repeat. That is, they can be lists that store more
than one element of the given type.

XPath is used to specify which schema element you would like to refer to. Each schema has its own
associated structure, for example, a set of simple values or simple data and other complex data.

To reference a particular data item in a schema, you start with the root node and then use slashes (/) to
indicate a path to the desired data element. For example, if you wish to specify the Street attribute in
the ShipName complex element that is in the GetOrderInformation node, you would use the following
syntax:
$GetOrderInformation/ShipName/Street
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The path starts with a dollar sign to indicate it begins with a root node, then continues with node
names using slashes, like a file or directory structure, until the desired location is named.

Evaluation Context
XPath also has a method for referencing relative paths from a particular node. If you have an evaluation
context, or a particular starting node in a schema tree, you can specify the relative path to other
elements in the tree.

For example, if your evaluation context is $GetOrderInformation/ShipName, then you can reference
the sub-items of ShipName without specifying the entire path. If you wish to reference
$GetOrderInformation/RequiredDate, the relative path would be ../RequiredDate. The path is
relative to the evaluation context — RequiredDate is one level higher in the schema tree than the
elements of ShipName.

Namespaces
Some schema elements must be prefixed with their namespace. The namespace is automatically added
to elements that require this when creating mappings or when dragging and dropping data in the
XPath formula builder.

Search Predicates
An XPath expression can have a search predicate. The search predicate is used to locate a specific
element of a repeating schema item. For example, a $GetOrderInformation/OrderDetails/
OrderItem item is a repeating element. If you wish to select only the first item in the repeating element,
you would specify the following:
$GetOrderInformation/OrderDetails/OrderItem[1]

The [1] specifies the first element of a repeating item.

Sub-items can also be examined and used in a search predicate. For example, to select the element
whose ProductId is equal to "3A54", you would specify the following:
$GetOrderInformation/OrderDetails/OrderItem[ProductId="3A54"]

You can also use functions and expressions in the search predicate. For example, if you wish to find all
elements after the first, you would specify the following:
$GetOrderInformation/OrderDetails/OrderItem[position()>1]

See the Functions tab of the XPath Formula Builder for a list of available functions available and online
documentation.

Testing for Nil
Some elements can be explicitly set to nil. You can test an element to determine if it is set to nil or not.
For example, the following XPath expression returns true if the $Order/Item/OnSale element is set to
nil:
$Order/Item/OnSale/@xsi:nil="true"

Comments
You can add comments to XPath expressions using the XPath 2.0 syntax for comments. The syntax is:
{-- <comment here> --}

For example, the following XPath expression contains a comment:
$GetOrderInformation/ShipName/Street {-- returns the street --}
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The XPath Formula Builder
You access the XPath Formula Builder using a button in the Function Argument Mapping Wizard. First
select an item in the Function Argument panel (in the Input section). Then click the XPath Formula

Builder button ( ).

The XPath formula builder allows you to drag and drop schema elements and XPath functions to create
XPath expressions. The schema elements, when dragged into the XPath Formula field, automatically
become valid XPath location paths for the desired item. If a function is dragged into the XPath formula
window, there are placeholders for each parameter of the function. You can drag and drop schema
elements over the parameter placeholders to replace each placeholder.

Table 42 describes the different areas of the XPath formula builder.

XPath Formula Builder Reference

Element Description

Data tab Displays the Scope Variables schema tree. All elements in this tree
are available to drag and drop into the XPath Formula field.

Functions tab Displays the available XPath functions. These are categorized into
groups and each function can be dragged from the function list
into the XPath Formula field.

When the function is placed into the XPath formula, placeholders
are displayed for the function’s parameters. You can drag and
drop schema elements from the Data tab into the function’s
placeholders.

The result of evaluating the function is displayed in the
"Expression Evaluates To" panel. If there are any errors in the
expression, they are listed there as well.

For more information about XPath functions, see the description
of the function that is displayed when it is selected in the XPath
formula builder.

Constants tab Displays the constants available for use in XPath expressions.
These are categorized into groups and each constant can be
dragged from the constants list into the XPath Formula field.

Constants are useful for inserting special characters, such as tabs,
symbols, and so on, into XPath formulas. Constants are also
defined for commonly used items, such as date formats.

Documentation panel Appears below the Functions and Constants tabs. Describes each
selected function. As you click on a function in the Function tab,
the documentation panel gives a brief description of the function
and one or more examples. Similarly documentation for constants
in the Constants tab appears.

Evaluation Context field Displays the evaluation context of the expression field that the
editor was invoked from. See Evaluation Context for more
information about the evaluation context.

248

TIBCO BusinessEvents® Developer's Guide



Element Description

XPath Formula field Displays the XPath formula you wish to create. You can drag and
drop items from the Data tab or the Functions tab to create the
formula.

Expression Evaluates To Panel Displays the result of evaluating the formula shown in the XPath
Formula field. If there are errors in the formula, they are
displayed here.

Figure 4 illustrates using the XPath formula builder to create a valid function. The function
concatenates the data elements $GetCustomerInformation/Street and $GetCustomerInformation/
City and places a space between the two elements.

Creating an XPath formula

String Representations of Datatypes
When data must be represented in the input or output of an activity, the data is represented as a string.
This section explains the string representations of various datatypes. TIBCO BusinessEvents follows the
XPath 1.0 standard for representing all numeric datatypes. TIBCO BusinessEvents follows the XML
Schema canonical format for all other datatypes.

Numeric Datatypes

Numeric datatypes include all types derived from xs:integer, xs:decimal, xs:float, and
xs:double.

All decimal, float, and double numbers are compressed to an integer when represented, if there are
only zeros following the decimal point (for example, "1.000" is represented as 1). Scientific notation is
never used to represent a floating point number as a string (for example, "xs:double(’1.234E05’)" is
represented as 123400). Data is truncated if the number of digits exceeds the maximum precision for
the datatype (for example, "xs:float(’1.23456789’)" is represented as 1.2345679).

Both zero and negative zero are represented as 0. Positive and negative infinity are represented as
Infinity and -Infinity. Not a number is represented as NaN.

Boolean

The boolean datatype is used to indicate a true or false state.

xs:boolean(’true’) and xs:boolean(’1’) are represented by true. The XPath function true() is
also represented as true.
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xs:boolean(’false’) and xs:boolean(’0’) are represented by false. The XPath function false()
is also represented as false.

Date Datatypes

TIBCO BusinessEvents Function Argument Wizard (also known as the function argument mapper)
implements dates in one of two ways. Either a date is stored as the number of milliseconds since
January 1, 1970, or the date is implemented according to the XPath 2.0 or XQuery 1.0 standards as a set
of normalized components (xs:date, xs:time, xs:dateTime, and so on) with an optional time zone
offset. Activities that are associated with Java (for example, Java Code, Java Method, and so on) use the
first implementation. Activities that are associated with XML (for example, Mapper, Parse XML, and so
on) use the second implementation. The second implementation supports arbitrary precision of the
seconds component.

Conversion between these representations may result in a loss of information either because of the
difference in time zone representation or the precision of the seconds.

Date and Time Functions
There are some functions in the XPath formula builder that allow you to parse or format strings that
represent dates and times. These functions are:

● format-dateTime(format, dateTime)

● format-date(format, date)

● format-time(format, time)

● parse-dateTime(format, string)

● parse-date(format, string)

● parse-time(format, string)

The format parameter of these functions is based on the format patterns available for the
java.text.SimpleDateFormat Java class. In the format parameter, unquoted alphabetic characters
from A to Z and a to z represent the components of the date or time string. You can include non-pattern
alphabetic characters in the string by quoting the text with single quotes. To include a single quote,
use ’’. Table 43 describes the alphabetic characters and their associated presentation in a date or time
string.

Formatting characters in date or time strings

Letter Description Example

G Era

Four or more Gs return the full name of
the era.

AD

y year

Two ys return two-digit year.

2003; 03

M Month in year

Three or more Ms return text name.

August; Aug; 08

w Week in year 48
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Letter Description Example

W Week in month 3

D Day in year 254

d Day in month 28

F Day of week in month 3

E Day in week

Four or more Es return the full name of
the weekday.

Friday; Fri

a AM/PM marker

Four or more as return the full name.

AM

H Hour in day (0-23) 23

k Hour in day (1-24) 1

K Hour in AM/PM (0-11) 11

h Hour in AM/PM (1-12) 1

m Minute in hour 59

s Second in minute 48

S Millisecond 456

z Time zone represented as a GMT
offset.

GMT-08:00

Z RFC 822 four-digit time zone format -0800

all other letters Reserved

For any format pattern letter that returns a numeric value (for example, w, h, and m), the number of
letters in the format pattern represents the minimum number of digits. For formatting functions, if the
date or time has fewer digits than the number of pattern letters, the output is padded with zeros. For
parsing functions, when the date or time has fewer digits than the number of characters in the format
pattern, the extra characters are ignored, unless they are needed to determine the boundaries of
adjacent fields.

Table 44 illustrates some example date and time format patterns and the resulting string.

Example date and time format patterns

Date/Time Pattern Result

"yyy.MM.dd G ’at’ HH:mm:ss" 2003.3.11 AD at 09:43:56 
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Date/Time Pattern Result

"EEE, MMM d, ’’yy" Tue, Mar 11, ’03

"hh ’o’’clock’ a, zzzz" 9 o’clock AM, GMT-8:00

"K:mm a" 0:08 PM

"yyMMddHHmmssZ" 010704120856-700
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Cluster Deployment Descriptor

The Cluster Deployment Descriptor (CDD) is an XML file used to configure a project for deployment.

One EAR file and one CDD file define all the settings for all the engines and agents you want to deploy
for a single application.

TIBCO BusinessEvents Express: Content relating to Cache OM and backing store does not apply to
TIBCO BusinessEvents Express edition.

The CDD file is explained in detail in TIBCO BusinessEvents Configuration Guide.
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Integrating ActiveMatrix and BusinessWorks

Using the TIBCO ActiveMatrix BusinessWorks plug-in you can integrate ActiveMatrix BusinessWorks
5 and TIBCO BusinessEvents applications. Using the TIBCO BusinessEvents Java API you can integrate
with TIBCO BusinessWorks 6.

This integration enables each product to take advantage of the strengths of the other. For example,
ActiveMatrix BusinessWorks can use TIBCO BusinessEvents as a light-weight rules engine, and TIBCO
BusinessEvents can use transports available in ActiveMatrix BusinessWorks.

This guide assumes you know how to work with ActiveMatrix BusinessWorks processes. See TIBCO
BusinessWorks Process Design Guide if you need detailed guidance.

Integration components include an ActiveMatrix BusinessWorks 5 plug-in, which provides a palette of
TIBCO BusinessEvents activities, and various TIBCO BusinessEvents functions. See Integration
Components for details. You can use these components to do the following:

● More easily send and receive TIBCO BusinessEvents events using ActiveMatrix BusinessWorks 5
activities.

● Invoke TIBCO BusinessEvents rule functions from ActiveMatrix BusinessWorks 5 or 6.

This chapter explains how to configure the environment and use these features.

See the product readme for the supported version of TIBCO ActiveMatrix BusinessWorks.

Integration Components
Integration components include a palette of activities in ActiveMatrix BusinessWorks 5 or using the
TIBCO BusinessEvents Java API in BusinessWorks 6.

ActiveMatrix BusinessWorks 5 Activities Palette

RuleServiceProvider Configuration Resource

The RuleServiceProvider Configuration resource is used to identify the source of the ontology
definitions (in an EAR file) and the location of the TIBCO BusinessEvents application at runtime.

Event Related Activities

The Receive Event, Send Event, And Wait for Event activities enable you to work more easily with
TIBCO BusinessEvents events within ActiveMatrix BusinessWorks. The ontology definitions from the
TIBCO BusinessEvents application are available to these activities so you can easily configure them. See
the following sections:

● Receive Event Resource Reference
● Send Event Resource Reference
● Wait for Event Resource Reference

Invoke RuleFunction Activity

An Invoke RuleFunction activity invokes a TIBCO BusinessEvents rule function in a specified agent
instance and passes information to it. Execution is synchronous.

Design Considerations
This section presents some considerations to keep in mind when you are designing your integration
project.
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Integration Scope
You can only use TIBCO BusinessEvents resources that are included in the TIBCO BusinessEvents EAR
file referenced in the RuleServiceProvider Configuration resource.

TIBCO BusinessEvents and ActiveMatrix BusinessWorks must be installed on the same machine.

Thread Management
TIBCO BusinessEvents generates its own threads to execute the rule function that the ActiveMatrix
BusinessWorks process calls through the Invoke RuleFunction activity. Then the ActiveMatrix
BusinessWorks thread is released and the process is set to a pending state. When the rule function
returns, the ActiveMatrix BusinessWorks process resumes its Ready state.

The Invoke RuleFunction activity operates synchronously. It attempts to acquire a lock on the TIBCO
BusinessEvents RTC.

Check your execution path carefully to ensure that there are no threading issues leading to deadlock. In
general, make sure that no action in the entire execution path attempts to use the same working
memory that is already locked.

Configuring a RuleServiceProvider Configuration Resource
You reference a RuleServiceProvider Configuration resource in various activities so ActiveMatrix
BusinessWorks 5 can locate the TIBCO BusinessEvents resources used in the integration.

Procedure

1. Open the ActiveMatrix BusinessWorks project in TIBCO Designer and open the project folder
where you want to store the resource.

2. Right-click in the design panel and select Add Resource > TIBCO BusinessEvents Activities >
TIBCO BusinessEvents RuleServiceProvider Configuration.

3. Enter values in the Configuration tab, following guidelines in RuleServiceProvider Configuration
Resource Reference.

4. Click Apply and save the resource.

A RuleServiceProvider Configuration shared resource is also available In TIBCO
BusinessEvents Studio. It can be used during migration to display a migrated version 3.x
resource for informational purposes.

RuleServiceProvider Configuration Resource Reference

This resource specifies which TIBCO BusinessEvents project to use for the integration. See also 
Configuring a RuleServiceProvider Configuration Resource.

The Configuration tab has the following fields.
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Field
Global
Var? Description

Name No The name to appear as the label for the resource. Names follow
Java variable naming restrictions. Do not use any reserved words.
Names must be unique within a folder. See Identifier Naming
Requirements .

Description No Short description of the resource.

Repo URL/EAR
Path

Yes One of the following:

Path to and name of the TIBCO BusinessEvents EAR file. Ontology
definitions in this EAR file are used by activities in the TIBCO
BusinessEvents activities palette.

(At design or testing time you can use an exact copy of the EAR
that is used for production. You can use a global variable so that
you can define the location of the EAR at deploy time.)

or

The server-based repository URL for a TIBCO BusinessEvents
project that was deployed to a TIBCO Administrator domain.

Deployment
Descriptor Path

Yes Path to the CDD (Cluster Deployment Descriptor) file used by the
deployed TIBCO BusinessEvents application.

At design or testing time you can use an exact copy of the CDD
that is used for production. You can use a global variable so that
you can define the location of the CDD at deploy time.

Processing Unit
ID

ID of a processing unit in the specified CDD whose values are used
for the integration.

Working with Activities
This guide assumes you know how to work with ActiveMatrix BusinessWorks 5 processes. See TIBCO
BusinessWorks Process Design Guide if you need detailed guidance.

The TIBCO BusinessEvents Activities palette allows you to easily send and receive TIBCO
BusinessEvents events in TIBCO ActiveMatrix BusinessWorks applications.

Before you work with other activities, configure a RuleServiceProvider Configuration resource so that
the ActiveMatrix BusinessWorks project can locate TIBCO BusinessEvents resources. See 
RuleServiceProvider Configuration Resource Reference.

Work with the TIBCO BusinessEvents Activities

Procedure

1. Open the folder in which you want to add a process definition. Right-click in the design panel, and
select Add Resource > Process > Process Definition .
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2. Double-click the Process Definition resource to open it. You see the Start and End activities.

3. Right-click in the design panel, and select Add Resource > TIBCO BusinessEvents Activities .
Select activities as needed to configure the process. See the following for guidelines:

● Receive Event Resource Reference
● Send Event Resource Reference
● Wait for Event Resource Reference
● Invoke RuleFunction Resource Reference

4. Click Apply and save the resource.

Receive Event Resource Reference

This process starter starts a process when the specified simple event arrives from its default destination
channel, or from a destination specified in the configuration tab.

Configuration
The Configuration tab has the following fields.

Field
Global
Var? Description

Name No The name to appear as the label for the resource. Names follow
Java variable naming restrictions. Do not use any reserved
words. Names must be unique within a folder. See Identifier
Naming Requirements .

Description No Short description of the resource.

RuleServiceProvider
Configuration

Browse to and select the RuleServiceProvider Configuration
resource used in this process.

The lists of events and destinations shown in the Event
Reference and Custom Destination fields comes from the EAR
file referenced in the selected RuleServiceProvider
Configuration resource.

Event Reference No Browse to and select the simple event you want to receive.

Custom Destination No If you do not want to listen for the specified event on its default
destination, browse to and select an alternate destination.
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Misc
The Misc tab has the following fields.

Field Description

Sequencing Key This field can contain an XPath expression that specifies which processes should
run in order. Process instances with sequencing keys that evaluate to the same
value will be executed sequentially in the order the process instance was
created.

See TIBCO ActiveMatrix BusinessWorks Process Design Guide for more
information about controlling the execution order of process instances and
about XPath expressions.

Custom ID This field can contain an XPath expression that specifies a custom ID for the
process instance. This ID is displayed in the View Service dialog of TIBCO
Administrator, and it is also available in the $_processContext process
variable.

Output
The Output tab has the following fields.

Output Item
Data
Type Description

BEReceiveEvent
Output

complex Expand BEReceiveEventOutput to show the name, properties,
and attributes of the event received.

Send Event Resource Reference

Data from the ActiveMatrix BusinessWorks process context is used to send an event of a specified type
to its default destination or to a destination specified in the configuration tab.

Configuration
The Configuration tab has the following fields.

Field
Global
Var? Description

Name No The name to appear as the label for the resource. Names follow
Java variable naming restrictions. Do not use any reserved
words. Names must be unique within a folder. See Identifier
Naming Requirements .

Description No Short description of the resource.
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Field
Global
Var? Description

RuleServiceProvider
Configuration

Browse to and select the RuleServiceProvider Configuration
resource used in this process.

The lists of events and destinations shown in the Event Reference
and Custom Destination fields comes from the EAR file
referenced in the selected RuleServiceProvider Configuration
resource.

Event Reference No Browse to and select the simple event you want to send.

Custom Destination No If you do not want to send the specified event to its default
destination, browse to and select an alternate destination.

Input
The Input tab has the following fields.

Input Item
Data
Type Description

BESendEventInput complex Expand BESendEventInput to show the name, properties, and
attributes of the event type selected in the Configuration tab.

Wait for Event Resource Reference

This activity listens to the default destination of a specified event type or to a destination specified in
the configuration tab, and waits for a matched simple event.

Configuration
The Configuration tab has the following fields.

Field
Global
Var? Description

Name No The name to appear as the label for the resource. Names follow
Java variable naming restrictions. Do not use any reserved words.
Names must be unique within a folder. See Identifier Naming
Requirements .

RuleServiceProvider
Configuration

Browse to and select the RuleServiceProvider Configuration
resource used in this process.

The lists of events and destinations shown in the Event Reference
and Custom Destination fields comes from the EAR file
referenced in the selected RuleServiceProvider Configuration
resource.

Description No Short description of the resource.
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Field
Global
Var? Description

Event Reference No Browse to and select the simple event you want to wait for.

Custom Destination No If you do not want to listen for the specified event on its default
destination, browse to and select an alternate destination.

Event
The Event tab has the following fields.

Input Item
Global
Var? Description

Candidate Event
Key

No Use to filter events. Only events whose candidate event key matches
the key provided will trigger the activity.

For example you can use the event’s extID as the event key. You can
also use any of the event's properties as a matching candidate event
key. There can be multiple keys, but only the first one that matches is
considered.

As an example use of this property, suppose you want "Wait for
Event" to fire only for the 10th occurrence of an event. You would set
the Candidate Event Key value to 10. In the input tab, you would
map the input item key to a global variable that is incremented by 1
each time the event occurs.

Refer to ActiveMatrix BusinessWorks Palette Reference sections on other
"Wait For" types of activities (for example, for JMS queues or topics,
or for Rendezvous) for more information.

Event Timeout No If the event is received before the process reaches this activity, the
event waits for this number of milliseconds. If the timeout period
ends before the process reaches this activity, the event is discarded.

Input
The Input tab has the following fields.

Input Item
Data
Type Description

key String Candidate Event Key value (specified on the Event tab

processTimeout Integer The processTimeout value is the Event Timeout from Event tab
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Output
The Output tab has the following fields.

Input Item
Data
Type Description

BEReceiveEventOutput complex Expand BEReceiveEventOutput to show the name,
properties, and attributes of the event type selected in the
Configuration tab.

Rule Function Invokation from a Process
To enable an ActiveMatrix BusinessWorks 5 process to call a TIBCO BusinessEvents rule function, you
need to configure an Invoke RuleFunction activity.

See Integration Components for an introduction to the integration features.

● See Thread Management for important information about avoiding deadlock.
● Be careful in using the ThreadLocal variable because the thread of execution may not be same as

that in the prior activity.
● Concepts passed to the rule function are not automatically asserted. Similarly, events passed to the

rule function are not automatically asserted. You must assert them explicitly.
● Object support is not provided. You can't set Object in the scope of the rule function or as its

return value. You must specify a specific type of TIBCO BusinessEvents object or a primitive (other
than Object).

Specifying Input Arguments

All TIBCO BusinessEvents primitives (except Object) are supported. Appropriate boxing and unboxing
of XML primitive types to TIBCO BusinessEvents primitive types is handled. For more details, see Rule
Language Datatypes.

You can pass null values. Select the argument in the Activity Input panel of the Input tab. Click the Edit
Statement (exclamation point) button. In the Edit Statement dialog, Content tab, check the Set Explicit
Nil checkbox. If xsi:nil==true, then a null is passed as the argument.

Base Concept and Base Event are supported as argument types. You must map a specific type to the
base concept or base event. Open the Edit Statement dialog, and in the Type tab, check the Type
Substitution check box. In the Type field, select XML Type Reference. Select a Schema and a Type.

Using Synchronous Invocation
Execution is synchronous. The process waits for the rule function to return a value. The rule function
acquires a lock on TIBCO BusinessEvents working memory until the RTC cycle completes and then
returns a value to the process.

You can use more than one Invoke RuleFunction activity in a process only if each uses a different agent.

Using the lockWM Parameter
By default the working memory is locked during the invocation (that is, the value is true). You can
change this behavior by setting the lockWM parameter to false.

When you set the value to false, the rule function executes outside the context of the working memory.

The results must not modify concept instances or scorecards (as in the case of a preprocessor).
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Set the lockWM parameter to false for optimization purposes only and use with care. Set it to false only
if the call does not modify the working memory in any way. For example, use it to perform stateless
calls or calculations, or to create new concept instances or events, or for lookups and so on.

Overriding the Rule Function at Runtime
You can override which function is called at runtime. To do so, enter a global variable as the value for
rulefunction in the input tab. At runtime, you can specify a rule function with a different name but
the same signature as the one specified in the activity's Configuration tab.

You can only use rule functions that are in the TIBCO BusinessEvents EAR file deployed for the
integration project.

Working with Invoke RuleFunction Activities

See Rule Function Invokation from a Process for important information about using the Invoke
RuleFunction activity in your ActiveMatrix BusinessWorks 5 process.

Configure an Invoke RuleFunction Activity

Procedure

1. Start TIBCO Designer and open (or add) the ActiveMatrix BusinessWorks process in which you
want to use an Invoke RuleFunction activity.

2. Right-click in the design panel and select Add Resource > TIBCO BusinessEvents Activities >
Invoke RuleFunction . Link the activity to other activities as appropriate.

3. Complete the Configuration tab, following guidelines provided in Invoke RuleFunction Resource
Reference.

● Name the activity and give it a description as desired.
● Browse to and select the RuleServiceProvider Configuration resource that contains the

ontology for the project you are integrating with.
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● Browse to and select the TIBCO BusinessEvents rule function you want to invoke.

4. Select the Input tab. Expand each item to see all fields. Enter values or map values from process
data. Follow guidelines provided in Invoke RuleFunction Resource Reference.

5. Click Apply and save the resource.

Invoke RuleFunction Resource Reference

To enable an ActiveMatrix BusinessWorks 5 process to call a TIBCO BusinessEvents rule function, you
configure one or more Invoke RuleFunction activities according to your needs. Execution is
synchronous. See Working with Invoke RuleFunction Activities for more details.

Configuration
The Configuration tab has the following fields.

Field
Global
Var? Description

Name No The name to appear as the label for the resource. Names follow
Java variable naming restrictions. Do not use any reserved words.
Names must be unique within a folder. See Identifier Naming
Requirements .

Description No Short description of the resource.

RuleServiceProvider
Configuration

Browse to and select the RuleServiceProvider Configuration
resource used in this process.

The list rule functions you can select for the Rule Function field
comes from the EAR file referenced in the selected
RuleServiceProvider Configuration resource.

Rule Function No Select the desired rule function from the TIBCO BusinessEvents
project.
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Input
The Input tab has the following fields.

Field
Global
Var? Description

rulesession Yes Specifies the agent where the rule function is to execute.

Optional if the processing unit has only one agent

To specify a value, enter the agent name (as specified in the CDD
file).

rulefunction Yes Optional. Allows you to override the rule function specified in the
Configuration tab.

Enter a global variable that is used to specify the name of the rule
function at runtime. Do not enter the .rulefunction extension. The
rule function you specify must have the same signature as the
function specified in the Configuration tab (and a different name).
See Overriding the Rule Function at Runtime

lockWM Yes Default value is true. The working memory is locked during the
invocation.

You can set the value to false only if conditions explained in the
section Using the lockWM Parameter are met.

arguments No Displays the arguments for the rule function, if it has any.

Map the available process data to the activity input, or enter values
in the fields as appropriate for the datatype of each argument.

Output
The Output tab has the following fields.

Output Item
Data
Type Description

Return (Varies) The return type for the specified rule function. Return can be void
or any of the following types:

String, integer, long, double, Boolean, datetime, concept, event.

TIBCO BusinessWorks 6 Integration
With the use of the TIBCO BusinessEvents API, you can run a TIBCO BusinessEvents engine from
within BusinessWorks 6 to call rule functions, create events and concepts and assert events and
concepts.

For more information, see online Java API Reference and MissManners and RuleFunctionAPI examples
under BE_HOME/examples/standard to get familiar with the API.
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Procedure

1. Install TIBCO BusinessEvents Version 5.2.0, TIBCO BusinessWorks 6.

2. Import the TIBCO BusinessEvents project RuleFunctionAPI/RFAPI from the standard examples in
TIBCO BusinessEvents Studio.

● Create an EAR for the same project or
● Create a new TIBCO BusinessEvents project with Rulefunction and create and EAR for it.

3. Create a JAVA class to call the TIBCO BusinessEvents Rulefunction API.
a) Creat a JAR file from the same JAVA class.

4. Create a TIBCO BusinessWorks 6 application with the JAVA INVOKE activity with the TIBCO
BusinessWorks 6 Studio.

5. Add the JAR file and the required JARs from TIBCO BE_HOME/lib as listed below to add to TIBCO
BusinessWorks 6 application's build path libraries.
The following are the TIBCO BusinessEvents Library that are required:

● be-functions.jar

● cep-common.jar

● cep-kernel.jar

● cep-base.jar

● commons-lang3-3.2.jar

● cep-ui-rt-common.jar

● org.eclipse.uml2.uml.jar

● org.eclipse.uml2.types.jar

● TIBCOrt.jar

● javassist.jar

● antlr-3.2.jar

6. Configure the JAVA Invoke Activity by using the invoke method from the CallRuleFunction class to
call TIBCO BusinesEvents RuleFunction API.

7. Provide the required JAVA activity input parameters, such as REPO URL, TIBCO BusinessEvents
engine TRA file, CDD file, PU, Rulefunction name and so on.
These parameters are TIBCO BusinessEvents project artifacts required to call TIBCO BusinessEvents
RuleFunction.

8. Go to the TIBCO BusinessWorks 6 Application Module Dependencies and import the packages as
listed below required to call the TIBCO BusinessEvents RuleFunction API.
Packages required from TIBCO BusinessWorks 6 include:

● org.eclipse.emf.ecore.resource.Resource$Factory$Registry

● org.eclipse.emf.ecore.EObject

● org.eclipse.emf.common

● org.eclipse.emf.common.util.URI

● org.eclipse.emf.ecore.resource.impl.ResourceSetImpl

● org.eclipse.emf.ecore.impl.EPackageImpl

265

TIBCO BusinessEvents® Developer's Guide



● org.eclipse.emf.ecore.xml.type.XMLTypePackage

● org.eclipse.emf.ecore.xmi.impl.EcoreResourceFactoryImpl

● org.eclipse.emf.ecore.util.FeatureMap

● org.eclipse.emf.common.notify.Notification

● org.apache.log4j.Appender

● org.apache.log4j.spi.LoggerRepository

● com.tibco.xml.tns.impl.TargetNamespaceCache

● com.tibco.util.StringUtilities

● com.tibco.xml.schema.SmType

● org.eclipse.emf.ecore.xmi.XMLOptions

● com.tibco.xml.schema.impl.SmNamespaceProviderImpl

● com.tibco.xml.ws.wsdl.WsException

● com.tibco.xml.tns

● com.tibco.xml.tns.impl

● com.tibco.xml.tns.parse

● com.tibco.xml.tns.parse.helpers

● com.tibco.xml.data.primitive

● com.tibco.xml.datamodel

● com.tibco.io.xml

● com.tibco.xml.schema.channel.SchemaModelProvider

● com.tibco.xml.validation.kernel.DefaultSchemaCache

● com.tibco.xml.channel.error.helpers.ErrorThrower

● com.tibco.xml.schema.parse.SmParseSupport

● com.tibco.xml.schema.build.MutableSchema

● com.tibco.xml.datamodel.helpers.XiChild

● com.tibco.xml.schema.helpers.NoNamespace

● com.tibco.xml.schema.flavor.XSDL

● com.tibco.sax.ResolverUtilities

● com.tibco.xml.data.primitive.values.XsBoolean

● com.tibco.xml.datamodel.navigation

● com.tibco.xml.xquery

9. Deploy the application in TIBCO BusinessWorks 6 as "BW Application" or export the application to
EAR and deploy in the TIBCO BusinessWorks domain with TIBCO Enterprise Administrator.
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Working with TIBCO FTL

TIBCO FTL® messaging products are used for sending messages from one point to another. For Release
5.2, TIBCO BusinessEvents has added support for sending and receiving events using TIBCO FTL as
the medium.

TIBCO BusinessEvents can now receive incoming TIBCO FTL messages and send TIBCO FTL messages
across TIBCO BusinessEvents.

The purpose of the TIBCO FTL API is to demonstrate the use of TIBCO FTL as a means to send and
receive TIBCO BusinessEvents events, which can be done with ease.

TIBCO FTL Terminology

A publisher sends a particular form of message. The message format is defined using a JSON file.

A subscriber listens to the endpoint and receives messages. The information of a subscriber is also in the
JSON file in TIBCO BusinessEvents.

The publisher and subscriber both have a particular endpoint similar to a destination in TIBCO
BusinessEvents.

Endpoints can send different types of messages. Endpoints also simplify the arrangements when
multiple transports carry the same message stream. An endpoint abstracts all of the transport details
into a simple name, which insulates application programs from those details.

Transports immediately carry messages from publishers to subscribers. Messages do not pass through
an intermediary, such as a server. Transports neither store messages in transit, nor forward them later.

Sometimes a small enterprise needs only one communication fabric. However, at other times
development and test environments are needed, which must not interfere with a production
environment. Each of these environments requires a separate communication fabric, and isolating their
communication from one another must not occur. In TIBCO FTL, a realm represents one communication
fabric, with its endpoints, applications, application instances, transports, stores and formats.

A content matcher selects a subset of messages from a message stream according to the fields and values
in those messages. A subscriber uses a content matcher to express interest in the subset of messages
that the content matcher specifies. Therefore, without a content matcher, a subscriber receives all of the
messages that arrive at its endpoint. Thus, by using a content matcher, a subscriber receives only a
subset of those messages, specifically those messages that fit the matcher's specifications.

No outside field options aside from the fields mentioned in the message format in the JSON file should
be listed in the content matcher.

For more information regarding concepts and definitions related to TIBCO FTL, see TIBCO FTL®
Concepts.

Using TIBCO FTL in TIBCO BusinessEvents
TIBCO BusinessEvents makes use of event objects to communicate with TIBCO FTL. For maximum
performance, you must have the TIBCO FTL application, define endpoints, transport names, define
whether the transports will send or receive, and figure out the format.
The format on a given endpoint provides you to have different message formats passing through that
endpoint, which the port will listen to.

A port is where the server runs on. A certain format is given and you can define it in the TIBCO FTL
administration console. You can then use the administration console commands to place the
configuration into a JSON file.
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To use TIBCO FTL within TIBCO BusinessEvents, first install TIBCO FTL. Complete the following steps
to start the TIBCO FTL server and upload the TIBCO FTL channel example definitions into your TIBCO
BusinessEvents project:

Procedure

1. Change dir to ${TIBCO_HOME}\ftl\${ftl.version}\bin.

2. Start the FTL Realm Server by using tibrealmserver.bat.

3. To set up endpoints, message formats as well as the subscribers and publishers associated with
TIBCO BusinssEvents, upload the realm definition via tibrealmadmin.bat -rs http://
localhost:8085 -ur ${TIBCO_HOME}\be\${be.version}\examples\ftl\ftl-example.json.

4. Point your browser URL to http://localhost:8085 to see the TIBCO FTL administration console.
To add the realm definition to a JSON file, the following command can be used, but it is not
necessary for startup: tibrealmadmin.bat http://localhost:8083 -dr ${TIBCO_HOME}\be\$
{be.version}\examples\ftl\ftl-example.json.

After you start the TIBCO FTL server and upload the TIBCO FTL channel example definitions, and
when you will trigger an event using the readme.html file provided in the FTL Example, the
FTLRequestEvent.event gets triggered. This event performs the task of creating an FTL message
using the fields and the values defined in the HTML readme file: {TIBCO_HOME}\be\examples
\standard\FTL\readme.html.

The request is triggered, it triggers the SendMessageRule.rule send message rule. The send
message rule prompts the TIBCO FTL publisher to publish messages in the TIBCO FTL channel.

When the send message rule is triggered, the message arrives in the FTL channel. The subscriber is
already listening to that particular endpoint. Therefore, the subscriber receives the message. When
the subscriber receives the message, it converts the message into an event.

The conversion of the TIBCO FTL message into an event triggers the TIBCO FTL
Rules.ReceiveMessage.rule response event. The response event then prints all of the messages
from the subscriber. Finally, the event is consumed.

For more information on the API for using TIBCO FTL in TIBCO BusinessEvents, see
TIBCO BusinessEvents® Online Reference.
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Performance Profiler

You can run TIBCO BusinessEvents Performance Profiler utility to gather statistics about activities that
occur during each RTC cycle. This information helps to identify bottlenecks in the project, which can
often be addressed by redesigning rules or other aspects of a project.

The Profiler utility collects statistics relating to the run to completion (RTC) rule evaluation cycle in an
inference agent. The utility does not collect data about object management. It also does not collect data
for other types of agents. It helps you understand, for example, internal execution times and
frequencies of rules.

The Profiler records time spent during each RTC on activities such as number of times each condition
or action is performed, and total time spent on each condition and action. A complete RTC includes
conditions and actions, although any individual RTC might contain only conditions or only actions.

Statistics are collected for each completed RTC. When the Profiler is directed to stop during an RTC, it
continues to collect data for the current RTC until that RTC is completed.

When the Profiler is turned off, it continues to write statistics for the current session until that session is
completed. So the RTC in progress is always completed, even if the Profiler is directed to stop during
an RTC.

After the Profiler finishes, statistics data is written to the specified (or default) file and cleared from
memory. The engine continues to run. If the engine stops before before the Profiler completes, the file is
not created.

You can execute the Profiler and turn it off in three ways:

Using properties
 Profiler turns on when the agent initializes at system startup. Used to profile RTC time, including
startup rule functions.

Using TIBCO BusinessEvents catalog functions
 Profiler turns at the beginning of the next RTC after the function call, if it has not already been
enabled. (There is no effect if the Profiler is already on). Used to turn the Profiler on and off inside a
rule or rule function.)

Using a TIBCO Hawk method
 Profiler turns on by invoking a TIBCO BusinessEvents microagent Hawk method. Profiler is turned
on at the beginning of the next RTC after the method call, if it has not already been enabled. (There is
no effect if the Profiler is already on). Used to dynamically turn the Profiler on and off.

Using a TIBCO BusinessEvents Monitoring and Management method
 Similar to using a Hawk method.

The Delimiter Character
The Profiler is tab-delimited by default. The delimiter character can be changed adding the following
property in the CDD file:
be.engine.profile.delimiter

Specify the delimiter using a String value. Enclose the value in double quotes (the quotes are not used
as part of the delimiter).

For example to use an open curly brace as the delimiter, you would specify "{" as the value. Do not
choose a character used in rule conditions.

Use a single character if the application into which you will import the output uses a one-character
delimiter. When importing the file into Excel, do not check the “Treat consecutive delimiters as one”
option. Consecutive delimiters indicate a column that is empty.
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Also, when importing the file into Excel, set the timestamp field to Text (and not General, which is the
default).

Turning Profiler On and Off
There are different ways you can turn the Profiler on and off:

Using TIBCO BusinessEvents Monitoring and Management
If you have deployed the processing unit using TIBCO BusinessEvents Monitoring and Management
(MM), you can turn the Profiler on and off using the MM Console.

Use of MM is documented in the TIBCO BusinessEvents Administration guide. In particular, see TIBCO
BusinessEvents Configuration Guide.

Using Properties
Set the following properties in the Cluster Deployment Descriptor (CDD) Processing Unit tab, for all
processing units (engines) whose RTC performance you want to profile.

Profiler Configuration Properties (Sheet of )

Property Notes

be.engine.profile.Agent_Class_Name.enable

If set to true, enables Profiler for the specified agent class (Agent_Class_Name) when
the agent initializes.

Default is false.

be.engine.profile.*.enable

If set to true, enables the Profiler for all agents when each agent initializes, even when
a specified agent class Profiler is disabled.

Default is false.

be.engine.profile.Agent_Class_Name.file

The name of output file that the Profiler writes to, for the specified agent
(Agent_Class_Name).

Default behavior is as follows:

If be.engine.profile.*.file is specified and
be.engine.profile.Agent_Class_Name.file is not specified, then the file name is
the value of be.engine.profile.*.file, with the Agent_Class_Name appended.

If the properties be.engine.profile.*.file and
be.engine.profile.Agent_Class_Name.files are not specified the name is created
as follows: be-profile_Agent_Class_Name.csv

be.engine.profile.*.file
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Property Notes

The default (prefix for the) name of the output file that the Profiler writes to. In all
cases, the appropriate Agent_Class_Name is appended.

Default name is be-profile.csv and it is located under the current working
directory, if file name is not specified.

be.engine.profile.Agent_Class_Name.duration

Specifies the duration of profile data collection in seconds, for the specified
Agent_Class_Name).

When the duration period ends, the Profiler continues to collect statistics for the
current RTC until the RTC is completed, then outputs data and stops. So the RTC in
progress is always completed, even if the Profiler is directed to stop during an RTC.

If you set duration to a value of zero or less (<= 0), then profiling continues until agent
stops or Profiler is explicitly turned of using a function or Hawk method.

Default is -1.

be.engine.profile.*.duration

Specifies the duration of profile data collection in seconds, for all agents.

When the duration period ends, the Profiler continues to collect statistics for the
current RTC until the RTC is completed, then outputs data and stops. So the RTC in
progress is always completed, even if the Profiler is directed to stop during an RTC.

If you set duration to a value of zero or less (<= 0), then profiling continues until the
agents stop or Profiler is explicitly turned of using a function or Hawk method.

When be.engine.profile.Agent_Class_Name.duration and
be.engine.profile.*.duration are both present, the duration specified in
be.engine.profile.Agent_Class_Name.duration takes precedence.

Default is -1.

be.engine.profile.Agent_Class_Name.level

Level of depth that profile data will be collected for the specified agent
(Agent_Class_Name):

● -1: all levels of profile data are collected, including RTC level and conditions and
actions within the RTC.

● 1: Only RTC level of profile data will be collected (and no condition and action
data).

Default is -1.

be.engine.profile.*.level
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Property Notes

Level of depth that profile data will be collected for all agents:

● -1: all levels of profile data are collected, including RTC level and conditions and
actions within the RTC.

● 1: Only RTC level of profile data will be collected (and no condition and action
data).

When be.engine.profile.Agent_Class_Name.level and
be.engine.profile.*.level are both present, the level specified in
be.engine.profile.Agent_Class_Name.level takes precedence.

Default is -1.

Using Functions
This section assumes you understand how to use TIBCO BusinessEvents functions. It tells you which
functions to use and the effect of each function.

You can turn the Profiler on using the engine properties, and turn it off using a function or Hawk
method, as desired. See notes for be.engine.Agent_Class_Name.profile.duration and
be.engine.*.profile.duration in Profiler Configuration Properties .

To turn the Profiler on
 In your rule or rule function, use the following function to turn on the Profiler:
Engine.Profiler.startCollectingToFile(String fileName, int level, long duration)

The above function turns on the TIBCO BusinessEvents Profiler and starts collecting data for the
specified duration for the agent in which the rule or rule function that calls this function is executed.
The Profiler starts collecting data at the beginning of next RTC.

Profile data is output to the specified file in comma-separated value format at the end of the duration
period, unless the Profiler is turned off before the end of the duration, in which case it is output at the
end of the RTC that completes after the Profiler is turned off.

Input arguments are the same as the engine properties show in Profiler Configuration Properties:
String fileName: See be.engine.profile.Agent_Class_Name.file

int level: See be.engine.profile.Agent_Class_Name.level

long duration: See be.engine.profile.Agent_Class_Name.duration (Here Agent_Class_Name
is the current agent in which the rule or rule function that calls this function is executed.)

To turn the Profiler off
 In your rule or rule function, use the following function to turn off the Profiler:
Engine.Profiler.stopCollecting()

The above function turns off the TIBCO BusinessEvents Profiler and writes the profile data to a file for
the agent in which the rule or rule function that calls this function is included (the file is output at the
end of the RTC that completes after the Profiler is turned off). There is no effect if the Profiler is not
on.

Using TIBCO Hawk Methods
This section assumes you understand how to use TIBCO Hawk methods. It tells you which methods to
use and the effect of each method

You can turn the Profiler on using properties, and turn it off using a function or Hawk method, as
desired. See notes for be.engine.profile.duration in Profiler Configuration Properties .
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Before you Begin
 Ensure that the property hawk.enabled is set to true in the CDD at the cluster level before the TIBCO
BusinessEvents engine starts.

To turn the Profiler on
 Use the following method to turn on the Profiler:
StartFileBasedProfiler(String session, String fileName, int level, long duration)

The above method turns on the TIBCO BusinessEvents Profiler for the specified agent. The Profiler
starts collecting data at the beginning of next RTC for the specified duration.

This method works the same way as the Engine.Profiler.startCollectingToFile() function
(see Turning Profiler On and Off), except that it requires you to specify an agent class.

Input arguments are the same as the engine properties shown in Profiler Configuration Properties:

String session: If you want to monitor multiple agents, execute the method once for each, specifying
the agent class name in each case. If there is only one agent, the session parameter is optional.

String fileName: See be.engine.profile.Agent_Class_Name.file

int level: See be.engine.profile.Agent_Class_Name.level

long duration: See be.engine.profile.Agent_Class_Name.duration

If you attempt to turn on the Profiler when it is already running, an error is returned, but the running
Profiler is not affected.

To turn the Profiler off
 In your rule or rule function, use the following function to turn off the Profiler:
StopFileBasedProfiler(String session)

The above method turns off the TIBCO BusinessEvents Profiler and writes the profile data into a file
for the specified agent when the current RTC has completed. You must execute the method once for
each session, as needed.

If you attempt to turn off the Profiler when it is already off, an error is returned, but there is no effect
on the Profiler.

Profiler Reference
The table in this section explains each of the columns in the Profiler report. Data is grouped by
RTC_Stats_Type and Description. (Description contains information about the specific RTC.) All data
collected for conditions and actions performed during each RTC is listed within each RTC grouping.

Three rows of column headers for the RTC, condition and action are listed at the beginning of the file:

● One for statistics relating to the overall RTC
● One for statistics relating to conditions
● One for statistics relating to actions.

The first column of each data line is always the statistic type, which begins with one of RTC-,
CONDITION-, or ACTION-.

Data is also grouped, one row for the overall RTC, and zero or more rows for different conditions or
actions or both, as appropriate.
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Profiler Column Heading Reference (Sheet of )

Column Heading Notes

Statistics Relating to the Overall RTC

RTC_Stats_Type Type of rule evaluation cycle (RTC) There are 10 different types:
RTC:
RTC-Object-Asserted
RTC-Object-Modified
RTC-Object-Deleted
RTC-Event-Expired
RTC-Execute-Rule
RTC-Invoke-Action
RTC-Invoke-Function
RTC-Post-Process
RTC-Repeat-TimeEvent
RTC-Reevaluate-Element

 Timestamp The time at which the first RTC begins.

 Description Information relating to the current RTC_Stats_Type. For example,
the description of type RTC-Object-Asserted is the name of the
object being asserted.

 NumExecuted Total number of times the same RTC has been executed.

 TotalRtcTime Total time in milliseconds spent on the total number of executions
of the same RTC.

 AvgRtcTime TotalRtcTime / NumExecuted

 MaxRtcTime The maximum time in milliseconds spent on a single RTC.

 MinRtcTime The minimum time in milliseconds spent on a single RTC.

 MaxResolvedTime The maximum time in milliseconds spent to resolve a single RTC,
including condition evaluation and action execution, but
excluding operations related to object management (OM).

 MinResolvedTime The minimum time in milliseconds spent to resolve a single RTC,
including condition evaluation and action execution, but
excluding operations related to object management (OM).

Statistics Relating to Conditions

CONDITION_Stats_Type Type of rule Condition. One of the following:
CONDITION-Filter
Condition-Join

Timestamp The timestamp of the first time the RTC begins.

RuleDescription Name of the rule containing the condition, or name of state
machine transition rule containing the condition.
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Column Heading Notes

ConditionDescription Condition statement of a rule or a state machine transition rule for
user-defined condition, or predefined condition name for internal
conditions.

When a user-defined rule condition has a commented-out line, the
ConditionDescription of the next condition is
//… Only applies to CONDITION_Stats_Type

NumEvaluated Total number of times this condition is evaluated in the same
RTC.

NumEvalTrue Total number of times the Join condition is evaluated to true.

This value is the sum of NumEvalTruePropagatedLeft and
NumEvalTruePropagatedRight.

TotalTime Total time in milliseconds spent on the total number of condition
evaluations.

AvgTime TotalTime / (NumLeftSearch + NumRightSearch)

MaxTime The maximum time in milliseconds spent on a single condition
evaluation.

MinTime The minimum time in milliseconds spent on a single condition
evaluation.

NumEvalPropagatedLeft Number of times the join condition evaluation is triggered by
object assertion propagated from the left side of the condition.

NumEvalTruePropagatedLeft Number of times the join condition evaluates to true and
evaluation is triggered by object assertion propagated from the
left side of the condition.

AvgRateEvalTruePropagated
Left

Average rate that the condition evaluates to true and evaluation is
triggered by object assertion propagated from the left side of the
condition.

MaxNumEvalTruePropagatedL
eft

Maximum number of times the join condition evaluates to true
and evaluation is triggered by object assertion propagated from
the left side of the condition.

MinNumEvalTruePropagatedL
eft

Minimum number of times the join condition evaluate to true and
evaluation is triggered by object assertion propagated from the
left side of the condition.

NumEvalPropagatedRight Number of times the join condition evaluation is triggered by
object assertion propagated from the right side of the condition.

NumEvalTruePropagatedRigh
t

Number of times the join condition evaluates to true and
evaluation is triggered by object assertion propagated from the
right side of the condition.
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Column Heading Notes

AvgRateEvalTruePropagated
Right

Average rate that the condition evaluates to true and evaluation is
triggered by object assertion propagated from the right side of the
condition.

MaxNumEvalTruePropagatedR
ight

Maximum number of times the join condition evaluates to true
and evaluation is triggered by object assertion propagated from
the right side of the condition.

MinNumEvalTruePropagatedR
ight

Minimum number of times the join condition evaluate to true and
evaluation is triggered by object assertion propagated from the
right side of the condition.

Statistics Relating to Actions

ACTION_Stats_Type Type of Actions.

There are 10 RTC types and four action types. The four action
types are:
ACTION-Rule-Action
ACTION-Event-Expiry
ACTION-Invoke-Action
ACTION-Invoke-Function

Timestamp The timestamp of first time the action execution begins.

Description Information about the action corresponding to current action type.

For example, description of type ACTION-Rule-Action is the
name of the rule.

NumExecuted Total number of times the same action has been executed.

A complete action has two phases, action execution and operation.

TotalActionTime Total time in milliseconds spent on the total number of actions.
TotalActionTime = TotalExecutionTime + 
TotalOperationTime

AvgActionTime TotalActionTime / NumExecuted.

MaxActionTime The maximum time in milliseconds spent on a single action.

MinActionTime The minimum time in milliseconds spent on a single action.

TotalExecutionTime Total time in milliseconds spent on the total number of action
execution phases. Action execution time is the time Rete network
spends on executing the action, for example, time spent in
creating new objects, deleting existing objects, and so on.

AvgExecutionTime TotalExecutionTime / NumExecuted.

MaxExecutionTime The maximum time in milliseconds spent on a single action
execution.
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Column Heading Notes

MinExecutionTime The minimum time in milliseconds spent on a single action
execution.

TotalOperationTime Total time in milliseconds spent on the total number of action
operation phases. Action operation time is the time TIBCO
BusinessEvents spends on applying changes to the Rete network,
for example, time spent asserting newly created objects, or
retracting deleted objects.

AvgOperationTime TotalOperationTime / NumExecuted.

MaxOperationTime The maximum time in milliseconds spent on a single action
operation.

MinOperationTime The minimum time in milliseconds spent on a single action
operation.

MaxAgenda The maximum size of rule agenda as a result of all action
operations.

MinAgenda The minimum size of rule agenda as a result of all action
operations.
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Testing and Debugging Projects

This chapter explains how to test and debug projects within TIBCO BusinessEvents Studio.

The sections on debugger assume some familiarity with Eclipse Java debugger, as well as TIBCO
BusinessEvents.

Viewing the TIBCO BusinessEvents Studio Error Log
 Errors in TIBCO BusinessEvents Studio functionality are reported in the error log. You can view the
error log file in either of these ways:
● In TIBCO BusinessEvents Studio, navigate to Help > About TIBCO BusinessEvents Studio >

Installation Details > Configuration > View Error Log

● In the file system, navigate to Your_Workspace > .metadata > .log

You can create test data and set breakdpoints before you run debugger, or using views within the
Debug perspective.

Preparing to Run (Test) or Debug a Project

You can do these tasks in any order. For information on setting up see Tester Preferences.

Build an EAR File

Procedure

1. In TIBCO BusinessEvents Studio, select the project in the BusinessEvents Studio Explorer panel,
then select Project > Build Enterprise Archive.

2. If you want to build an EAR with debug information, check the Generate Debug > Info checkbox
(checked by default).

3. In the File Location field provide the path to the EAR file and specify the EAR file name, for
example, c:\myprojects\myproject.ear.

4. Generate the EAR file.

Create Test Data (as Desired)

You can create test data for use across multiple sessions, or you can provide rule input data while the
engine is running. See Test Data.

For Remote Debugging Only Configure Java Debug Interface (JDI)
To configure for remote debugging you configure the be-engine.tra file on the remote engine so the
engine uses Java Debug Interface (JDI) for remote debugging.

You then configure a debug configuration for remote debugging, as explained in Adding and Working
with Launch (Debug or Run) Configurations. You must specify the same JDI port number in the TRA
file and in the debug configuration.

Configure Java Debug Interface (JDI)

For each TIBCO BusinessEvents engine you want to enable for remote debugging, do the following.
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Procedure

1. Open the BE_HOME/bin/be-engine.tra file for editing.

2. Specify the port on which you want the engine to listen, using the environment variable
tibco.env.JDI_PORT, for example:
tibco.env.JDI_PORT 5192

Where 5192 is the default value. If multiple engines run on the same machine, ensure that each has
a unique port.

3. Uncomment the following line:
-Xrunjdwp:transport=dt_socket,address=%JDI_PORT%,suspend=na,server=y

4. Start or restart the engine with the -d (or -debug) command.

Adding and Working with Launch (Debug or Run) Configurations
Launch configurations are of two types: run configurations and debug configurations. All launch
configurations have the same basic fields, but debug configurations have extra settings for remote
debugging.

Before you begin
 Ensure that you know the EAR file location, the CDD file location, and the name of the processing
unit (configured in the CDD file) that you want to use. (The processing unit runs as an engine.)

Add and Work with Launch Configurations

A reference to the settings is provided in Launch Configurations Reference.

For remote debugging you first have to set properties in the remote engine TRA file. See For Remote
Debugging Only Configure Java Debug Interface (JDI) .

Procedure

1. Do one of the following:

● To create a debug configuration, click the down-arrow to the right of the debugger button

( ) on the toolbar. From the drop-down list, and select Debug Configurations. Or, select
Run > Debug Configurations .

● To create a run configuration, click the down-arrow to the right of the Run button ( ) on
the toolbar. From the drop-down list, select Run Configurations. Or, select Run > Run
Configurations .

You see the Debug Configurations or Run Configurations dialog.

2. Select an option from the list on the left:

● For testing or local debugging, select TIBCO BusinessEvents Application
● For remote debugging, select Remote TIBCO BusinessEvents Application.

3. Do one of the following depending on your needs:

● To edit a configuration, expand TIBCO BusinessEvents Application or Remote TIBCO
BusinessEvents and select an existing debug configuration.

● To add a new configuration, click the New Configuration ( ) button.
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● To duplicate a configuration, select the configuration and then click the Duplicate ( ) button.
Modify, then save as a new configuration.

● To delete a configuration, select the configuration and then click the Delete ( ) button.

When you add, edit or duplicate a configuration, Configuration fields appear in the right
panel.

4. If you selected TIBCO BusinessEvents Application in step 2, do the following:

● Select the Main tab and configure values as explained in Launch Configurations Reference.
● Select the Classpath tab and configure the classpath for external libraries or custom functions

as needed, for example if the project uses Rendezvous or JMS channels. See Working with
External Library and Custom Function Paths for details.

● Select the Environment tab and configure environment variables as needed, to run or debug
the project in TIBCO BusinessEvents Studio. You can add new variables. You can select and
then edit existing variables. You can append your edited variable to the existing environment
variable, or you can replace the existing environment variable with it. For example if a custom
function depends on a native library, you can add the path to that library using the PATH,
LD_LIBRARY_PATH, SHLIB_PATH, or LIBPATH variable, as appropriate for your operating
system.

On Linux platforms when TIBCO BusinessEvents DataGrid is used, you must set
LD_LIBRARY_PATH to AS_HOME/lib in the Environment tab.

● If you need to display characters that are not present in the system’s default charset on the
console, set the encoding to UTF-8.

● Select the Common tab and set the Encoding to Other. Then select UTF-8 from the drop-down
menu.

This procedure is documented in Plug-in Development Environment Guide > Reference >
Launchers > JUnit Plug-in Test Launcher > Common Tab.

● For information on standard Eclipse features incorporated into this area, see Eclipse help.

5. If you selected Remote TIBCO BusinessEvents Application in step 2, you must connect to the
remote engine. Click the Remote tab and specify the host name or IP address and port the engine is
running on. Use the same JDI port number in the TRA file and in the debug configuration (see For
Remote Debugging Only Configure Java Debug Interface (JDI)).

6. Click Apply to save configuration settings.

7. Do one of the following:

● Click Close and save the configuration you worked on.
● If you have done the setup as explained in this chapter and are ready to run or debug, click

Debug to save the configuration and launch the debugger, or click Run to save the
configuration and run the engine.

You can then assert test data as desired in order to observe the effect of the data on the engine.
See Asserting Rule Input Data.

Launch Configurations Reference

See Adding and Working with Launch (Debug or Run) Configurations for the related procedure.

The Source and Common tabs are standard Eclipse dialogs. See Eclipse help for details on use of those
tabs. If the project uses third party JARs, you must also reference them in the Classpath tab, and update
the Environment as needed.
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For Testing and Local Debugging

Field Notes

Name A descriptive name. It appears in the drop-down list of configurations.

Main Tab

Project Browse to select the name of the TIBCO BusinessEvents project to use for this
configuration. You can select from projects in the workspace. The project
currently selected in BusinessEvents Studio Explorer appears by default.

VM Arguments Optional. Provide options and parameters using -V, -D, -X and so on.

For example to set global variables use: -VVariable=value.

CDD File
Location

Browse to select the CDD file to be used for this launch configuration.

Processing Unit
Name

Select the name of the processing unit (PU) whose values are used for this
launch configuration. The drop-down list displays PUs available in the CDD
specified in the CDD File Location setting.

Working
Directory

The location of the working directory for the TIBCO BusinessEvents engine.
Used to store temporary files and logs. Browse to and select an existing
directory.

Path names that do not start with the root directory are assumed by the
operating system to start from the working directory.

EAR File Browse to select the EAR file to be used for this launch configuration.

The EAR file must be generated with the Generate Debug Info option checked.

For Remote Debugging
You can debug a running TIBCO BusinessEvents engine on the current machine or another machine

Field Notes

Name A descriptive name. It appears in the drop-down list of configurations.

Main Tab

Project Browse to select the name of the TIBCO BusinessEvents project to use for this
configuration. You can select from projects in the workspace. The name of the
TIBCO BusinessEvents project in the workspace. It must be the same as the
project that is running remotely.

Remote Tab
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Field Notes

Remote
Connection

Enter VM arguments for running the remote VM. Alternatively, add these to the
java.extended.properties property in the remote application’s runtime
properties (TRA) file. Default value is:
-Xdebug -
Xrunjdwp:transport=dt_socket,address=25192,suspend=n,server=y

Host The host name or IP address of the remote computer where you are running the
TIBCO BusinessEvents engine.

Default is localhost.

Port Communication port for the debugger, on the remote machine.

Default is 25192

Test Data
You can send data to the engine through channels in the normal way. You can also create data within
TIBCO BusinessEvents Studio for assertion into the running engine’s Rete network during testing and
debugging. Doing so means you don’t have to have the external resources in place in order to test or
debug the runtime.

You can create data while you are working in the debug perspective. You can also create and save test
data ahead of time and save it in your project for later use.

The internal data is used at the following bottom tabs, within the Rule Input tab:

Tester Data
This is concept and event instance data. You create it in the TIBCO BusinessEvents Development
perspective, right-click an entity and select Create Test Data. You use it in the Debug perspective:
select the Rule Input View > Tester Data tab.

Rule Data
This is data directly provided as rule input. It is created and edited in the Rule Input View > Rule Data
tab (in the Debug perspective).

How you use test data depends on what aspect of a project you want to test or debug.

If the test data gets asserted in Cache Agent then the studio shows a message "Test data cannot be
asserted" along with a "Can't assert Object when activeMode is false" message on console as cache
agents are not actively participating in processing inputs. Only Inference Agents processes inputs and
the test data should be asserted into Inference Agent.

Working with Concept and Event Test Data
You can enter data in the Test Data editor for event payloads, and for concept, event and scorecard
properties, including properties that are primitive types, array types, contained concepts, and reference
concepts. If the concept, event or scorecard properties are associated with a domain model, then the test
data gets populated with the values in the domain model. You can use global variables.

Creating Concept and Event Instance Test Data

Procedure

1. To create test data in BusinessEvents Studio Explorer (or in the Debug perspective BusinessEvents
Studio Explorer view), you can perform either of the following steps:
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● Right-click on an event or concept and click New, then Test Data or Project

● Right-click Project, then Test Data.

2. Right-click an event or concept and click Create Test Data.
The Test Data editor appears showing the event or concept properties as column headers.

3. In the Test Data editor, click Add to add rows for new instances. You can add your own unique
extId values to the test data input, as needed. You can also use global variables.

You can also remove existing rows by selecting one or more rows and clicking Remove.

4. Click Save. The entity’s test data is saved to an XML file stored within the TestData folder in the
project root.

The /TestData folder is the default location (see Tester Preferences).

Edit Test Data for Concepts and Events in BusinessEvents Studio Explorer
To add more test data or edit test data you created earlier, do the following.

Procedure

1. In BusinessEvents Studio Explorer, expand the TestData folder in the root of the project.

The /TestData folder is the default location.

2. Drill down to the test data you want to edit. The folder structure matches the project’s event and
concept folder structure.

3. Double-click the name of the test data file you want to edit. The test data editor opens. Add,
remove, and edit rows of test data as desired.

Test data filenames use the format eventName.eventtestdata and
conceptName.concepttestdata.

Edit Concept and Instance Test Data in the Rule Input View

Procedure

1. Open the Rule Input view, if it is not already shown. To make the Rule Input View visible, do one of
the following:

● Select the Debug perspective as follows: select Window > Open Perspective , or click the Open

Perspective ( ) button). Then select Other > Debug . The views associated with the Debug
perspective open.

● In the Window menu, click Show View > Other. Expand TIBCO BusinessEvents, and select
Rule Input. Click OK.

2. Click the Rule Input tab and then select the Tester Data bottom tab.

For each concept or event for which you created test data, you see one row showing the project path
to that concept or event.

3. Double-click the row for the concept or event whose test data you want to edit.

The Test Data editor appears, showing the rows of test data already created.

4. Edit as desired.

283

TIBCO BusinessEvents® Developer's Guide



Working with Rule Data
To create and save rule Data:

Procedure

1. Open the Rule Input view, if it is not already shown. To make the Rule Input View visible, perform
either of the following steps, as needed:

● Select the Debug perspective: Select Window > Open Perspective , or click the Open

Perspective ( ) button). Then select Other > Debug . The views associated with the Debug
perspective open.

● In the Window menu, click Show View > Other. Expand TIBCO BusinessEvents, and select
Rule Input. Click OK.

2. Provide input from the mapper as explained in Using the Function Argument Mapper.
3. Specify the Launch Target. This is generally the locally running engine. The other fields become

active.
4. Specify an event or concept in the Entity URI field. If you specify an event, then specify the

Destination URI. Specify the Rule Session (agent) to use.
5. Perform either of the following steps:

● Click Save to save the input values.

You can reuse these saved values for repetitive tests.
● Click Load to load the input values from an existing XML file.
● Click Assert to assert the data to a running engine.

Setting Breakpoints in Rules and Rule Functions
Setting breakpoints is an Eclipse feature. This section provides only basic information. You can also use
advanced features such as importing and exporting breakpoints, and using class prepare breakpoints.
See Eclipse help for more details on all breakpoint functionality. You can set or change breakpoints
during a debug session also.

You cannot step through custom Java code.

Procedure

1. In TIBCO BusinessEvents Studio, open the source editor for a rule or rule function.

You can work with breakpoints in the debugger perspective as well as in the TIBCO BusinessEvents
Studio development perspective.

2. To add a breakpoint put your cursor in the left margin (gray area) next to a row where you want to
add a breakpoint. Do one of the following:

● Right click and select Toggle Breakpoint.
● Double-click in the left margin.

A breakpoint icon appears in the left margin:
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3. Set and adjust breakpoints as needed. Select a break point, right click, and do any of the following:

● To disable a breakpoint, select Disable.
● To remove a breakpoint, select Toggle Breakpoint. (Or just double click the breakpoint.)
● To edit a breakpoint’s properties, select Breakpoint properties. A dialog displays (with mostly

runtime options). For example, you can use a class prepare breakpoint (so the running
program is suspended when the specified class or interface is first loaded by the Java VM).

A breakpoint may not be set exactly where you place it. This is because TIBCO BusinessEvents
ensures that breakpoints fall on an executable statement, and moves any that do not to the
nearest executable statement.

Executing step code line does not match rule editor code line
 This situation happens when there is a mismatch between the debug line
information stored in the EAR, and the information in the open rule editor. To
resolve the problem, recompile the EAR file.

Running Debugger
Make sure you have completed setup as needed. Then run debugger as explained below.

For projects containing an RV channel, add the path to the location of the RV libraries by adding
RV_HOME/lib to the existing path.

As needed, switch to Debug perspective. Select Window > Open Perspective , or click the Open

Perspective ( ) button). Then select Other > Debug .

Alternatively, wait till TIBCO BusinessEvents prompts you to change to debug perspective. This
happens when the debugger reaches the first breakpoint.

Click the down-arrow to the right of the debugger ( ) button. You see a drop-down list. Do one of
the following:

● Select a debug configuration from the list.

To add configurations to the drop-down list, select Organize Favorites from the list.

● Select Debug Configurations. At the Debug Configurations dialog select a debug configuration and
click Debug.

● Click the debugger ( ) button or Select Run > Debug . (Only if you have already launched
debugger with a configuration.)

Debugger starts a TIBCO BusinessEvents engine, using parameters provided in the launch
configuration, if any were provided.

Procedure

1. Assert data as explained in Asserting Rule Input Data.

2. View the results as explained in Viewing the Results.

3. Use the standard Eclipse commands such as step into (F5), step over (F6), step return, step return,
and so on, depending on what you want to examine.

See the options in the Run menu and in the Breakpoints tab for more options, and use Eclipse help
for details with these Eclipse features.

When you are finished, click the Terminate ( ) button to stop the engine.
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Running Tester
Make sure you have completed setup as needed. You can create test data before you run tester, or using
views within the Debug perspective. Other setup must be done before you begin.

For projects containing an RV channel, add the path to the location of RV libs:

See the following sections for details:

First do the setup needed for your testing. See the following sections:

● Preparing to Run (Test) or Debug a Project
● Adding and Working with Launch (Debug or Run) Configurations
● Test Data

Then run tester as explained below.

Run the Tester
As needed, switch to Debug perspective. Select Window > Open Perspective , or click the Open

Perspective ( ) button). Then select Other > Debug .

Select Run > Run Configurations or click the down-arrow to the right of the Run ( ) button and
choose Run Configurations.

If you have configured favorites, you can click the down-arrow to the right of the Run ( ) button
and choose a favorite.

Procedure

1. At the Run Configurations dialog select a run configuration and click Run.

If you have already started an engine using a run configuration and want to start it again,

click the Run (  ) button or Select Run > Run .

A TIBCO BusinessEvents engine starts, using parameters provided in the run configuration, if any
were provided.

2. Assert data as explained in Asserting Rule Input Data.

3. View the results as explained in Viewing the Results.

When you are finished, click the Terminate ( ) button to stop the engine.

Asserting Rule Input Data
You can assert either tester data, or rule data for use in Tester or Debugger.

To perform any task in the Rule Input tab, you must keep the engine running.

You can also send messages to destinations, as you would at runtime.

See also Test Data for details about creating and saving data.

Test data you created earlier for concepts, events, or scorecards appears in the Debugger perspective.
By default the view appears in the middle on the left.

For cache application using preprocessors to load a concept from cache, if an event does not have the
default destination then that destination has to be assigned to event before starting test in Rule Input
View.
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Assert Tester Data

Procedure

1. Select the Rule Input tab and then the Tester Data bottom tab.

2. One entity can have multiple rows of test data. To select which row or rows of test data to assert,
double click the entity’s URI in the Select Test Data view. It appears in the Test Data editor. Check
one or more checkboxes in the Use column as desired. You can repeat this step for all the entities
shown in the Select Test Data view, as needed.

You can edit the test data at this time too and you can add test data for more entities. See Working
with Concept and Event Test Data for details.

3. In the Input panel, Launch Target field, specify which engine to use.

Multiple engines can run in tester at the same time, for example, a cache agent engine, and an
engine running inference agents.

4. In the Input panel, Rule Session field, specify which agent to assert the data to.

One engine (processing unit) can have multiple inference agents.

5. Click Start Test.

You see console messages and results. See Viewing the Results for details about understanding the
results of a test or debugger run.

6. As appropriate, select more test data to assert (as in step 2), and again click Start Test. Once again,
analyze the results of asserting that data using the other views.
To Run Tester or Debugger with Rule Data

7. Open the Rule Input view, if it is not already shown. In the Window menu, click Show View >
Other . Expand TIBCO BusinessEvents, and select Rule Input. Click OK.

8. Do one of the following:

● Provide input from the mapper as explained in Using the Function Argument Mapper.
Optionally you can click Save and save the values to an XML file.

● Click Load to load the input values from an existing XML file.

9. Specify the Launch Target, Entity URI, Destination URI and Rule Session.

10. Click Assert.

Result

See Viewing the Results for details about understanding the results of a test or debugger run.

Viewing the Results

After data is asserted to the working memory (see Running Tester), a run to completion (RTC) cycle
occurs and you see the following:

● The Console tab displays engine console messages.
● The result data editor appears showing the results of the run. The editor title displays the result data

filename with the format Run-n.resultdata.

● The results of this test are stored in an XML format in a .resultdata file

By default the results are stored in the /TestData/Project Name/Processing Unit Name folder. See 
Tester Preferences for information on changing the location where test data is stored.
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You can also open the result data in its editor by double-clicking the .resultdata file in
BusinessEvents Studio Explorer.

Understanding Result Data

The Result Data view shows the results of a single RTC cycle. On the left of the view you see the
Created, Modified, and Deleted entities (if any).

Expanding each entity shows the rule that affected the entity, and also the causal object that triggered
the rule.

Click any entity to display its values in the Result panel.

Test results will not be shown for cache applications; they will be shown only for in memory
applications.

Viewing and Understanding Working Memory Contents
The Working Memory concepts or scorecards can be manipulated in Working Memory View. Option to
modify Working Memory Contents is available only in the Working Memory editor.
Change the property values in Working Memory View and click Modify.
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Prerequisites

Procedure

1. Click the Working Memory Contents icon on the tool bar, or from the Project menu.

2. Select the appropriate rule session (agent).

The number of objects in the working memory contents is specified in the Preferences. For more
details, see Tester Preferences.
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Shared Resources

Set of resourcescalled Shared Resources can be used for various purposes in your projects.

A RuleServiceProvider Configuration shared resource is available In TIBCO BusinessEvents Studio. It
can be used during migration to display a migrated version 3.x resource for informational purposes.
For integration with TIBCO ActiveMatrix BusinessWorks projects, use the RuleServiceProvider
Configuration activity, available in the TIBCO Designer palette of TIBCO BusinessEvents Activities. See 
ActiveMatrix BusinessWorks Integration .

Adding a Shared Resource

It’s a good idea to use global variables in shared resources so that projects can be quickly adapted to
run in different environments.

Procedure

1. In BusinessEvents Studio Explorer, right click the folder where you want to store the shared
resource and select New > Other .

2. In the Select a Wizard dialog, expand TIBCO Shared Resources and select the resource type you
want to add (see list in step 3) and click Next.

3. In the new resource wizard enter a name in the File Name field and click Finish.

You see the editor for the shared resource you selected. See the following sections for guidelines on
completing the fields:

● ActiveSpaces Connection Reference
● Hawk Connection Reference
● HTTP Connection Reference
● Identity Resource Reference
● JDBC Connection Reference, and also see Enabling the Test Connection Feature
● JMS Application Properties
● JMS Connection Reference, and also see Enabling the Test Connection Feature
● JNDI Configuration Reference
● Rendezvous Transport Reference

4. (Optional) View the Source tab. The source tab shows the XML source format for the shared
resource. You can edit the XML source directly, but this is not recommended because of the risk of
error. The resource editor provides validation checks.

Enabling the Test Connection Feature
To make the Test Connection feature work for JMS Connection and JDBC Shared Connection shared
resources, copy the relevant JAR files to the following directory:
BE_HOME/lib/ext/tpcl

(This directory is referenced in the extended classpath in the file BE_HOME/studio/eclipse/
configuration/studio.tra.)

If TIBCO BusinessEvents Studio is running when you copy the file or files, you must restart it for the
test connection feature to work.

For TIBCO Enterprise Message Service copy the jms-2.0.jar and tibjms.jar to the above location.

For WebSphere MQ, copy the MQ JAR files and the binding file to the above location.
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For DBMS products, copy the supported driver file you are using for the DBMS product.

ActiveSpaces Connection Reference

The ActiveSpaces Connection resource describes the connection to a TIBCO ActiveSpaces metaspace.
This section provides a reference to the fields. For procedures see Adding a Shared Resource.

Wizard and Configuration Tab
The Wizard and Configuration tab have the following fields.

Field
Global
Var? Description

Wizard

File Name No The name to appear as the label for the resource. Names follow Java
variable naming restrictions. Do not use any reserved words. Names
must be unique within a folder. See Identifier Naming Requirements .

Unlike other resource identifiers, however, shared resource
identifiers can have spaces in the name.

The name then appears in the title of the resource.

Configuration

Description No Short description of the resource.

Metaspace Name Yes Specifies a TIBCO ActiveSpaces metaspace. A metaspace is an
instance of a cluster of application processes deployed using TIBCO
ActiveSpaces. The application processes are typically deployed on
multiple hosts that are interconnected by a network.

The default value for this field is ’ms’.

MemberName Yes Name the AS channel will take when connecting to ActiveSpaces
metaspace
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Field
Global
Var? Description

Discovery URL Yes Specifies how a metaspace instance discovers the current metaspace
members. Multicast discovery can use either PGM - Pragmatic
General Multicast or RV - TIBCO Rendezvous protocol.

If using PGM protocol, the multicast URL is expressed in the
following format:

tibpgm://destination port/interface;discovery group

address/optional transport arguments, where

● destination port specifies the destination port used by the
PGM transport. If not specified, the default value of 7888 is used.

● interface;discovery group address specifies the address of
the interface to be used for sending discovery packets, and the
discovery group address to be used. If not specified, it defaults to
the default interface and discovery address, 0.0.0.0;239.8.8.8.

● optional transport arguments specifies a semicolon-separated
list of optional PGM transport arguments. By default, the PGM
transport is tuned to provide the best performance according to
the most common deployment architectures. The values of those
optional arguments should be changed only when necessary and
with care, since any inappropriate values could easily result in
degraded performance of the product.

If using TIBCO Rendezvous, the multicast URL is expressed in the
following format:

tibrv://service/network/daemon, where

● service specifies the TIBCO Rendezvous service number (UDP
port) that will be used. If not specified, the value defaults to 7889.

● network specifies the interface and discovery group address that
will be used to send Rendezvous discovery packets. The format is:
interface; discovery_group_address

If not specified, the default interface and discovery group address
will be used. (tibrv://7889/;239.8.8.9/).

● daemon specifies where to find the Rendezvous daemon. If not
specified, it will try to connect to a local daemon on port 7500.

ListenUrl Yes The discovery mechanism is based on pure TCP.

All the designated well known metaspace members are identified by
an IP address and a port number. This address and port are specified
by the member’s Listen URL.

If not specified, the discovery process uses the default IP address and
the first free TCP port that can be acquired from the operating system
(starting 5000 and above).

RemoteListenUrl Yes This field is used to configure TIBCO ActiveSpaces Channel as a
remote-discovery proxy. In this case, any remote client can connect to
an ActiveSpaces metaspace via the ActiveSpaces Channel node.
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Field
Global
Var? Description

EnableSecurity Yes Enables security for the ActiveSpaces connection resource when
selected.

Note: Some fields are activated only for the specific security role or
authorization polcy.

SecurityRole Yes Security role of a node for the secure ActiveSpaces channel in the
metaspace. The values are:

● Controller is dedicated to enforcing a security domain's defined
security behavior for a metaspace associated with the security
domain. Security domain controllers are the only discovery nodes
in a metaspace.

● Requestor just requires access to the data in the data grid, such as
a seeder or a leech, and which need to be authorized by a
controller. Requesters can never be used a discovery nodes.

The controller nodes are configured with a security policy file. The
requester nodes provide a token file and additional credentials to the
controller for authentication. The controller performs authentication
as defined in its policy file and using the credentials provided by the
requester.

If the Controller option is selected, then the following fields become
active:

● Identity Password
● PolicyFile

If the Requestor option is selected, then the following fields become
active:

● Identity Password
● TokenFile
● Credential

Identity
Password

Yes The password for the identity key in the security policy file.

PolicyFile Yes Absolute path to the policy file which contains the security settings
that the controller node enforces. It is generated using the as-admin
utility.

TokenFile Yes Absolute path to the token file which is used by requestor to connect
to a metaspace whose security is defined in the policy file.
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Field
Global
Var? Description

Credential Yes Authentication policy to be used for authentication as specified in the
policy file. The values are:

● USERPWD - A user name and password based authentication is
used. It activates the following fields:

— Domain
— Username
— Password

● X509V3 - The authentication source is an LDAP configured with
certificate based authentication. It activates the following fields:

— KeyFile
— PrivateKey

Domain Yes Domain name for system based user authentication.

Username Yes User name for LDAP and system based authentication.

Password Yes Password for LDAP and system based authentication.

KeyFile Yes The absolute path for a file containing the key to use for LDAP with
the certificate based authentication.

PrivateKey Yes The password for the identity key in the LDAP identity file specified
in KeyFile.

Hawk Connection Reference

The Hawk Connection resource describes the connection to a TIBCO Hawk domain through a specific
transport. This section provides a reference to the fields. For procedures see Adding a Shared Resource.

Wizard and Configuration Tab
The Wizard and Configuration tab have the following fields.

Field
Global
Var? Description

Wizard

File Name No The name to appear as the label for the resource. Names
follow Java variable naming restrictions. Do not use any
reserved words. Names must be unique within a folder.
See Identifier Naming Requirements .

Unlike other resource identifiers, however, shared
resource identifiers can have spaces in the name.

The name then appears in the title of the resource.
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Field
Global
Var? Description

Configuration

Description No Short description of the resource.

Transport No Type of transport used byHawk domain: Rendezvous or
EMS.

Domain Yes Name of the Hawk domain.

Transport: Rendezvous

RV_Service Yes Specifies the User Datagram Protocol (UDP) service group
used by the TIBCO Rendezvous daemon for session
communications. A service can be specified either by its
name or its port number. The default configuration uses
the service port number 7474.

RV_Network Yes Specifies the network to be used for outbound session
communications when a computer is connected to more
than one network. A network can be specified by its name
or by its IP address.

RV_Daemon Yes Specifies the TIBCO Rendezvous daemon that will handle
communication for the session. A local daemon is
specified by the communications type (always tcp) and a
socket number (e.g., 7474). The default configuration uses
the local daemon with the TCP socket number 7474.

Specify a remote daemon by inserting its host name or IP
address between the tcp entry and the port number of the
daemon parameter, for example:

tcp:remote_computer:7800

Transport: EMS

EMS_ServerURL Yes Specifies the EMS server to connect to. The server URL is
typically provided in the following format:

protocol://hostname:port-number

For example, tcp://myhost:7222

EMS_UserName Yes Specifies the username used to connect to the EMS server.

EMS_Password Yes Specifies the password for the username used to connect
to the EMS server.

HTTP Connection Reference

The HTTP Connection resource describes the characteristics of the connection used to receive incoming
HTTP requests. This section provides a reference to the fields. For procedures see Adding a Shared
Resource.
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The HTTP Connection resource can specify that the HTTPS (secure sockets layer or SSL) protocol must
be used by clients. If this is enabled, you can configure the SSL parameters for the HTTP server using
the Configure SSL Button. See Configure SSL for more information.

If you have multiple HTTP Connection resources specified by multiple HTTP Receiver process starters,
the HTTP servers require that all of the connections must be valid to initialize all HTTP Receivers.
Therefore, make certain that all HTTP Connection resources have valid configurations before testing or
deploying the project.

Wizard and Configuration Tab
The Wizard and Configuration tab have the following fields.

Field
Global
Var? Description

Wizard

File Name No The name to appear as the label for the resource. Names
follow Java variable naming restrictions. Do not use any
reserved words. Names must be unique within a folder.
See Identifier Naming Requirements .

Unlike other resource identifiers, however, shared
resource identifiers can have spaces in the name.

This field appears on the New HTTP Connection Wizard.
The name then appears in the title of the resource.

Configuration

Description Yes Short description of the resource.

Host Yes Specifies the name of the host that accepts the incoming
requests. For machines that have only one network card,
the default value localhost specifies the current
machine. For machines that have more than one network
card, this field specifies the host name of the card that will
be used to accept incoming HTTP requests.

Note
 Only one HTTP server can be started on each port.
Therefore, if you have a machine with multiple network
cards, make certain that all HTTP Connection resources
that use the same host name specify different port
numbers.

Note
 If there is more than one network card on the machine,
and you specify localhost in this field, then all
network cards on the machine will listen for incoming
HTTP requests on the specified port.

Port Yes Port number on which to listen for incoming HTTP
requests.
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Field
Global
Var? Description

Use SSL No Specifies whether incoming requests must use the HTTPS
(secure socket layer, or SSL) protocol. This protocol
authenticates the server to the client, and optionally
authenticates the client to the server.

Enabling this field allows you to specify SSL parameters
with the Configure SSL button (see Configure SSL ).

SSL Configuration
The SSL Configuration for HTTPS Connections dialog (accessed by configuring the Configure SSL
button) allows you to specify the SSL parameters for the HTTP connection.

The following are the fields in the SSL Configuration for HTTPS Connections dialog:

The HTTPComponent server type does not support Entrust based SSL.

Field Description

Requires Client Authentication Checking this field requires clients to present their digital
certificate before connecting to the HTTP server.

When this field is checked, the Trusted Certificates Folder
becomes enabled so that you can specify a location
containing the list of trusted certificate authorities.

Trusted Certificates Folder This field is only applicable when the Requires Client
Authentication field is checked.

This field specifies a folder in the project containing one or
more certificates from trusted certificate authorities. This
folder is checked when a client connects to ensure that the
client is trusted. This prevents connections from rogue
clients.

Identity This is an Identity resource that contains the HTTP server’s
digital certificate and private key. See Identity Resource
Reference for more information.

Strong Cipher Suites Only When checked, this field specifies that the minimum
strength of the cipher suites used can be specified with the
bw.plugin.security.strongcipher.minstrength custom
engine property. See TIBCO ActiveMatrix BusinessWorks
Administration for more information about this property.
The default value of the property disables cipher suites with
an effective key length below 128 bits.

When this field is unchecked, only cipher suites with an
effective key length of up to 128 bits can be used.
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Identity Resource Reference

The Identity resource encapsulates information that may be used to authorize a user, connection, and
so forth. The information you supply changes depending on the type of Identity resource you want to
use. This section provides a reference to the fields. For procedures see Adding a Shared Resource.

The identity certificate location, its type, and password can be specified as global variables.

Wizard and Configuration Tab
The New Identity Resource Wizard and the Configuration tab of the Identity Resource have the
following fields.

Field
Global
Var? Description

Wizard

File Name No The name to appear as the label for the resource. Names
follow Java variable naming restrictions. Do not use any
reserved words. Names must be unique within a folder. See 
Identifier Naming Requirements .

Unlike other resource identifiers, however, shared resource
identifiers can have spaces in the name.

This field appears in the New Identity Resource Wizard. The
name then appears in the title of the resource.

General

Description Yes Short description of the resource.

Type No The type of identity resource: Identify File, Certificate/
Private Key, or Username/Password (the default). See
sections below for details.

Identity File

Use this option if the certificate includes the private key information in the same file.

URL Yes Location of the certificate (which includes the private key).

File Type No Choose the certificate file type from the drop-down list:

Entrust

JCEKS

JKS

PEM

PKCS12

Password Yes Password for the certificate.
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Field
Global
Var? Description

Certificate/Private Key Identity

Use this option if the private key and the certificate are in two separate files.

Certificate URL No Location of the certificate. Click the browse icon or type in a
URL.

Key URL No Location of the private key file associated with the
certificate.

Key Password Yes Password used for private key.

Username/Password

Use this option if you want to use a username and password for authentication and do not want to
use a certificate.

Username Yes Name of the user for this identity.

Password Yes Password for the user for this identity.

JDBC Connection Reference

The JDBC Connection resource describes a JDBC connection. JDBC connections are used with backing
stores and with database concepts (available in the TIBCO BusinessEvents Data Modeling add-on). This
section provides a reference to the fields. For procedures see Adding a Shared Resource.

Wizard and Configuration Tab
The Wizard and Configuration tab have the following fields.

Field

Global

Var? Description

Wizard

File Name No The name to appear as the label for the resource. Names follow Java
variable naming restrictions. Do not use any reserved words. Names
must be unique within a folder. See Identifier Naming
Requirements .

Unlike other resource identifiers, however, shared resource
identifiers can have spaces in the name.

Configuration

Description Yes Short description of the resource.
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Field

Global

Var? Description

Connection Type No Specifies the kind of JDBC connection you wish to create. The
connection type can be one of the following:

● JDBC
● JNDI

The type of connection determines the other configuration fields
that appear.

JDBC Connection Type Configuration Fields

TIP
: Using global variables makes the project more portable

JDBC Driver Yes The name of the JDBC driver class. You can select from a list of
drivers or enter a driver manually. Listed drivers are as follows:

oracle.jdbc.OracleDriver (thin)

com.ibm.db2.jcc.DB2Driver (supported for database concepts
only)

com.microsoft.sqlserver.jdbc.SQLServerDriver

When you select a driver, the Database URL field is populated with
a template for the URL for the driver.

Database URL Yes The URL to use to connect to the database. A template of the URL is
supplied for the selected JDBC driver. You must supply the portions
of the URL that are in angle brackets, for example, the host, port
number, and database instance name.

You can configure Single Client Access Name (SCAN) for Oracle
database in a cluster with numerous nodes.

For more information on configuring SCAN, see Oracle Real
Application Cluster (RAC) in the TIBCO BusinessEvents Configuration
Guide.

Maximum
Connections

Yes The maximum number of database connections to allocate. The
default maximum is 10. The minimum value that can be specified is
1.

See Connection Pooling for more details, including related settings
that override this setting.

User Name Yes User name to use when connecting to the database.

Password Yes Password to use when connecting to the database.
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Field

Global

Var? Description

Login Timeout Yes Time (in seconds) to wait for a successful database connection. Only
JDBC drivers that support connection timeouts can use this
configuration field. If the JDBC driver does not support connection
timeouts, the value of this field is ignored. Most JDBC drivers
support connection timeouts.

JNDI Connection Type Configuration Fields

JNDI DataSource
Name

Yes The JNDI name specified for the DataSource.

Use Shared JNDI
Configuration

No When this field is checked, the JNDI Configuration field appears,
allowing you to choose a shared JNDI Configuration resource.

When this checkbox is unchecked, configuration fields appear.

JNDI
Configuration

No This field only appears when the Use Shared JNDI Configuration
field is checked. This field allows you to choose a JNDI
Configuration shared resource that specifies the JNDI connection
information.

JNDI Context
Factory

No The initial context factory class for accessing JNDI.
(javax.naming.Context.INITIAL_CONTEXT_
FACTORY). You can choose from the drop down list of supported
classes, or you can type in a different InitialContextFactory class
name.

JNDI Context
URL

Yes The URL to the JNDI service provider
(javax.naming.Context.PROVIDER_URL). An example URL is
provided when one of the supported JNDI context factory classes is
selected.

See your JNDI provider documentation for the syntax of the URL.

JNDI User Name Yes The user name to use when logging into the JNDI server
(javax.naming.Context.SECURITY_
PRINCIPAL). If the JNDI provider does not require access control,
this field can be empty.

JNDI Password Yes The password for logging into the JNDI server
(javax.naming.Context.SECURITY_
CREDENTIALS). If the JNDI provider does not require access control,
this field can be empty.

Connection Pooling
TIBCO BusinessEvents creates a pool of JDBC connections for every JDBC Connection shared resource
that uses the JDBC connection type. The maximum size of this pool is specified by the Maximum
Connections configuration field.

Resources such as backing stores and database concepts that use this JDBC Connection resource are
given a connection from the pool. Once the maximum number of connections is reached, resources
requesting a connection cannot proceed. Once a connection is freed by an activity, the connection is
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returned to the pool. Connections that are left open will eventually time out and be closed. These
connections can be reopened at a later time, until the maximum number of connections specified in this
field is reached.

For backing store connections, you can use additional connection pool properties, which override
equivalent settings in the JDBC Connection resource.

Test Connection Button

The Test Connection button allows you to test the connection specified in the configuration of this
resource. See Enabling the Test Connection Feature for a step you must take to enable the connection to
work.

JMS Application Properties
The JMS Application Properties resource describes any JMS message properties that a JMS application
expects. These properties can then be added.

For procedures see Adding a Shared Resource.

Wizard and Configuration Tab
The Wizard and Configuration tab have the following fields.

Field
Global
Var? Description

Wizard

File Name No The name to appear as the label for the resource. Names
follow Java variable naming restrictions. Do not use any
reserved words. Names must be unique within a folder. See 
Identifier Naming Requirements .

Unlike other resource identifiers, however, shared resource
identifiers can have spaces in the name.

Description Yes Short description of the resource.

Configuration

Properties Table
 A table listing any application-specific properties. Use the + and x buttons to the right of the table
to add and delete properties. Use the up and down arrow buttons to move selected properties to
the desired location in the table.

Property Name Yes Name of the column.

Type Yes The datatype of the property. Double-click the cell to cause
a drop down list of valid JMS datatypes to appear, and
choose a value.

Cardinality No Specifies whether the property is optional or required.
Double-click the cell to cause a drop down list of two values
to appear and select optional or required.
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JMS Connection Reference

JMS Connection resource describes a JMS connection. This section provides a reference to the fields. For
procedures see Adding a Shared Resource.

Wizard and Configuration Tab
The Wizard and Configuration tab have the following fields.

Field
Global
Var? Description

Wizard

File Name No The name to appear as the label for the resource. Names follow Java
variable naming restrictions. Do not use any reserved words. Names
must be unique within a folder. See Identifier Naming Requirements .

Unlike other resource identifiers, however, shared resource identifiers
can have spaces in the name.

This field appears on the New JMS Connection Wizard. The name then
appears in the title of the resource.

Configuration Tab

Description Yes Short description of the resource.

User Name Yes User name to use when logging into the JMS server.

If the JMS provider does not require access control, this field can be
empty.

Not all JMS servers require user names and passwords. Refer to your
JMS provider documentation and consult your system administrator to
determine if your JMS server requires a user name and password.

Password Yes Password to use when logging into the JMS server.

If the JMS provider does not require access control, this field can be
empty.

Auto-
Generate
Client ID

No Checking this field specifies you wish to automatically generate the
client ID if no client ID is specified or if the specified ID is already in use.
When this field is checked, if a value is specified in the Client ID field, an
attempt is made to use the specified value. However, if the specified
value is already in use, a new client ID is generated.

If this field is not checked, then the value specified in the Client ID field
is used. If no value is specified in the Client ID field, then no client ID is
set. If the value specified in the Client ID field is already in use, an
exception is thrown.
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Field
Global
Var? Description

Client ID Yes Client ID for the connection. Typically JMS providers have a provider-
specific format for client IDs. See your JMS provider’s documentation
for more information about client IDs. Each connection must use a
unique Client ID.

You cannot use the same JMS Connection resource for accessing both
topics and queues. You should create separate JMS Connection
resources if you wish to access both topic and queue destinations.

Use SSL No Specifies whether you wish to use SSL for the connection to the JMS
server. SSL is used when the Use SSL checkbox is checked. Click the
Configure SSL button to configure the SSL connection parameters.

Note: SSL is supported only when using TIBCO Enterprise Message
Service.

See Configure SSL for more information.

Use JNDI for
Connection
Factory

No Specifies whether JNDI should be used to look up the
ConnectionFactory object. If this field is unchecked, the Provider URL
and Use XA Connection Factory fields appear. If this field is checked,
JNDI configuration fields appear.

Provider URL Yes This field is only available when the Use JNDI for Connection Factory
field is unchecked.

This is the URL to use to connect to the JMS server.

Use XA
Connection
Factory

No This field is only available when the Use JNDI for Connection Factory
field is unchecked.

When checked, this field specifies that an XA connection factory is to be
used.

Connection
Factory SSL
Password

Yes This field is only available when the Use SSL checkbox is checked, and
the User Shared JNDI Configuration checkbox is unchecked.

The SSL configuration is specified in the ConnectionFactory object,
except for the client SSL password.

You can specify your client SSL password in this field, or you can leave
this field empty. If your password is not specified, the private key
password is used.

Use Shared
JNDI
Configuration

No When this field is checked, the JNDI Configuration field appears. It
allows you to choose a JNDI Configuration Reference .

When this field is unchecked, JNDI configuration fields appear.

JNDI
Configuration

No This field only appears when the Use Shared JNDI Configuration field is
checked.

This field allows you to choose a JNDI Configuration Reference that
specifies the JNDI connection information.
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Field
Global
Var? Description

JNDI Context
Factory

Yes This field only appears when the Use Shared JNDI Configuration field is
unchecked. Required. The initial context factory class for accessing JNDI.
(javax.naming.Context.INITIAL_CONTEXT_
FACTORY). You can choose from the drop down list of supported classes
or you can type in a different InitialContextFactory class name.

Note: TIBCO BusinessEvents attempts to find the class. However, you
may need to add the Java file supplied by your JNDI service provider to
the CLASSPATH environment variable to use JNDI.

JNDI Context
URL

Yes This field only appears when the Use Shared JNDI Configuration field is
unchecked. Required. This is the URL to the JNDI service provider
(javax.naming.Context.PROVIDER_URL). An example URL is provided
when one of the supported JNDI context factory classes is selected.

See your JNDI provider documentation for the syntax of the URL.

JNDI User
Name

Yes This field only appears when the Use Shared JNDI Configuration field is
unchecked. User name to use when logging into the JNDI server
(javax.naming.Context.SECURITY_
PRINCIPAL). If the JNDI provider does not require access control, this
field can be empty.

JNDI
Password

Yes This field only appears when the Use Shared JNDI Configuration field is
unchecked. Password to use when logging into the JNDI server
(javax.naming.Context.SECURITY_
CREDENTIALS). If the JNDI provider does not require access control, this
field can be empty.

Test Connection Button

The Test Connection button allows you to test the connection specified in the configuration of this
resource. See Enabling the Test Connection Feature for a step you must take to enable the connection to
work.

When JNDI is used (that is, when the Use JNDI for Connection Factory checkbox is checked), the Test
Connection button works only when the JNDI-related fields on the Configuration and Advanced tab
are correctly specified.

Advanced Tab
The Advanced tab has the following fields.

Field
Global
Var? Description

Topic Connection
Factory

Yes This field is only available when the Use JNDI for Connection Factory
field on the Configuration tab is checked.

The TopicConnectionFactory object stored in JNDI. This object is
used to create a topic connection with a JMS application.

See your JNDI provider documentation for more information about
creating and storing TopicConnectionFactory objects.
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Field
Global
Var? Description

Queue
Connection
Factory

Yes This field is only available when the Use JNDI for Connection Factory
field on the Configuration tab is checked.

The QueueConnectionFactory object stored in JNDI. This object is
used to create a queue connection with a JMS application.

See your JNDI provider documentation for more information about
creating and storing QueueConnectionFactory objects.

Optional JNDI
Properties

No Any additional properties to supply for the connection. You specify a
name, datatype, and value for each property.

These properties are typically vendor-specific. See your JNDI
provider documentation for more information about the available
properties.

Configure SSL
The SSL Configuration button allows you to configure the SSL connection parameters.

When using JNDI to lookup the JMS Connection factory, the parameters ssl_identity and
ssl_verify_host must be specified in the factories.conf file of the Enterprise Message Service
server.

The following table describes the SSL Configuration dialog.

Field Description

Trusted Certificates Folder Location of the trusted certificates on this machine. The trusted
certificates are a collection of certificates from servers to whom
you will establish connections. If the server you wish to
establish a connection presents a certificate that does not match
one of your trusted certificates, the connection is refused.

This prevents connections to unauthorized servers.

Trusted certificates must be imported into a folder, and then
you can select the folder in this field.

Identity The location of the client certificate.

You only need to specify the client certificate when the JMS
server requires client authentication.

See Identity Resource Reference for more information.

Trace Specifies whether SSL tracing should be enabled during the
connection. If checked, the SSL connection messages are logged
and sent to the console.

Debug Trace Specifies whether SSL debug tracing should be enabled during
the connection. Debug tracing provides more detailed messages
than standard tracing.
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Field Description

Verify Host Name Specifies whether you wish to verify that the host you are
connecting to is the expected host. The host name in the host’s
digital certificate is compared against the value you supply in
the Expected Host Name field. If the host name does not match
the expected host name, the connection is refused.

Note: The default context factories for TIBCO Enterprise
Message Service automatically determine if host name
verification is necessary. If you are using a custom
implementation of the context factories, your custom
implementation must explicitly set the verify host property to
the correct value. For example:
com.tibco.tibjms.TibjmsSSL.setVerifyHost(false)

Expected Host Name Specifies the name of the host you are expecting to connect to.
This field is only relevant if the Verify Host Name field is also
checked.

If the name of the host in the host’s digital certificate does not
match the value specified in this field, the connection is refused.

This prevents hosts from attempting to impersonate the host
you are expecting to connect to.

Strong Cipher Suites Only When checked, this field specifies that the minimum strength of
the cipher suites used can be specified with the
bw.plugin.security.strongcipher.minstrength custom
engine property. See TIBCO ActiveMatrix BusinessWorks
Administration for more information about this property. The
default value of the property disables cipher suites with an
effective key length below 128 bits.

When this field is unchecked, only cipher suites with an
effective key length of up to 128 bits can be used.

JNDI Configuration Reference

The JNDI Configuration shared resource provides a way to specify JNDI connection information that
can be shared by other resources. This resource can be specified in any resource that permits JNDI
connections. For example, JDBC Connection Reference can use JNDI connections. This section provides
a reference to the fields. For procedures see Adding a Shared Resource.

Wizard and Configuration Tab
The Wizard and Configuration tab have the following fields.

Field
Global
Var? Description

Wizard
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Field
Global
Var? Description

Name No The name to appear as the label for the resource. Names
follow Java variable naming restrictions. Do not use any
reserved words. Names must be unique within a folder. See 
Identifier Naming Requirements .

Unlike other resource identifiers, however, shared resource
identifiers can have spaces in the name.

This field appears on the New JNDI Connection Wizard. The
name then appears in the title of the resource.

Configuration

Description Yes Short description of the resource.

JNDI Context Factory Yes The initial context factory class for accessing JNDI.
(javax.naming.Context.INITIAL_CONTEXT_
FACTORY). You can choose from the drop down list of
supported classes.

Note: TIBCO BusinessEvents attempts to find the class.
However, you may need to add the JAR file supplied by
your JNDI service provider to the CLASSPATH environment
variable to use JNDI.

JNDI Context URL Yes The URL to the JNDI service provider
(javax.naming.Context.PROVIDER_URL). An example URL
is provided when one of the supported JNDI context factory
classes is selected.

See your JNDI provider documentation for the syntax of the
URL.

JNDI User Name Yes User name for logging into the JNDI server
(javax.naming.Context.SECURITY_
PRINCIPAL). If the JNDI provider does not require access
control, this field can be empty.

JNDI Password Yes Password for logging into the JNDI server
(javax.naming.Context.SECURITY_
CREDENTIALS). If the JNDI provider does not require access
control, this field can be empty.
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Advanced Section
The Advanced section has the following fields.

Field
Global
Var? Description

Validate JNDI
Security
Context

No Some application servers store the security context on the thread used
to establish the JNDI connection (at the time of this release, only the
WebLogic application server does this). In that case, the first activity
to use this resource establishes the security context, then subsequent
activities use the same security context, unless this field is checked.
Checking this field ensures that each activity that uses this resource
examines the security context to determine if the activity uses the
same security context as the security context established on the
thread. If they are different, the activity’s configured security context
is used.

Checking this field causes additional overhead for activities that use
this resource. Therefore, only check this field when necessary.

Optional JNDI
Properties

No The table in this field contains optional properties to pass to the JNDI
server. Use the +, X, and arrow keys to add, delete, and move
properties in the list. Each property requires the property name, the
datatype for the property, and the value for the property. See the
documentation for your JNDI provider for more information about
properties that can be passed to the JNDI server.

Rendezvous Transport Reference
The Rendezvous Transport resource describes a TIBCO Rendezvous transport. See the TIBCO
Rendezvous documentation for more information about specifying these fields.

This section provides a reference to the fields. For procedures see Adding a Shared Resource.

Wizard and Configuration Tab
The Wizard and Configuration tab have the following fields.

Field
Global
Var? Description

Wizard

Name No The name to appear as the label for the resource. Names
follow Java variable naming restrictions. Do not use any
reserved words. Names must be unique within a folder. See 
Identifier Naming Requirements .

Unlike other resource identifiers, however, shared resource
identifiers can have spaces in the name.

This field appears on the New Rendezvous Transport
Wizard. The name then appears in the title of the resource.

Configuration
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Field
Global
Var? Description

Description Yes Short description of the resource.

Daemon Yes In the case of TIBCO Rendezvous daemon running on the
same machine as TIBCO BusinessEvents engine, this is not
specified. If Rendezvous is running on a different machine,
then the Daemon field is specified as the remote host name
followed by the socket number.

For example:
ssl:acct:5785

Network Yes This field contains the host name, IP address, network name,
or interface name.

For example:
;224.34.103.4

Service Yes The TIBCO Rendezvous service name, specified in one of the
following formats: service name or port number.

Use SSL No The Use SSL checkbox specifies that Secure Sockets Layer
(SSL) should be used when communicating with the TIBCO
Rendezvous daemon. When this field is checked, the
Configure SSL button is enabled. See Configure SSL for more
information about configuring SSL parameters.

Configure SSL
The Configure SSL button allows you to configure the SSL parameters for communicating with the
TIBCO Rendezvous daemon. See the TIBCO Rendezvous documentation for more information about
how SSL is configured for TIBCO Rendezvous daemons and clients.

The SSL Configuration for TIBCO Rendezvous dialog has the following fields:

Field Description

Daemon Certificate File containing one or more certificates from trusted certificate
authorities. This file is checked when connecting to a daemon to ensure
that the connection is to a daemon that is trusted. This prevents
connections to rogue TIBCO Rendezvous daemons that attempt to
impersonate trusted daemons.

You can retrieve a daemon’s certificate using the administration
interface in TIBCO Rendezvous. See the TIBCO Rendezvous
documentation for more information about obtaining certificates
through the administration interface.
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Field Description

Identity This is an Identity resource used to authenticate to the TIBCO
Rendezvous daemon. The Browse button allows you to select from a list
of appropriately configured Identity resources. Only Identity resources
whose Type field is set to Identity File or Username/Password are
listed.

See Identity Resource Reference for more information.

Advanced Section
The Advanced section of the UI has the following fields.

Field
Global
Var? Description

RV Type No The type of TIBCO Rendezvous connection to use. This can be reliable
(standard RV transport), certified (RVCM), or Distributed Queue
(RVCMQ).

The fields of the Advanced tab correspond to the value selected for
this field.

Certified Transport

CM Name Yes The name of the delivery-tracking session. This name is in the same
format as TIBCO Rendezvous subject names.

Ledger File Yes The name and location of the persistent ledger file that tracks certified
messages. If not specified, the certified message ledger is kept in
process memory only.

Sync Ledger
File

Yes Specifies whether to keep the ledger file synchronous with the current
messages.

Relay Agent Yes Name of the relay agent to use. Relay agents are useful when clients
are disconnected from the network from time to time. The relay
agents store inbound certified messages and labeled messages (and
other messages related to certified delivery features) on behalf of their
disconnected client programs. When a client is connected, it receives
inbound messages immediately.

Require Old
Message

Yes Check this box if you wish to require the retention of messages for
which delivery has not been confirmed. These messages will be
resent.

Message
Timeout (sec)

Yes The time limit (in seconds) for certified message delivery.

Distributed Queue

CMQ Name Yes The name of the distributed queue. This name is in the same format
as TIBCO Rendezvous subject names.
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Field
Global
Var? Description

Worker Weight Yes The weight of the worker (this pertains to the worker processing
queue requests). Relative worker weights assist the scheduler in
assigning tasks. When the scheduler receives a task, it assigns the task
to the available worker with the greatest worker weight.

Worker Tasks Yes Sets the task capacity for the worker (this pertains to the worker
processing queue requests). Task capacity is the maximum number of
tasks that a worker can accept. When the number of accepted tasks
reaches this maximum, the worker cannot accept additional tasks
until it completes one or more of them.

Worker
Complete Time

Yes The amount of time the scheduler waits for a worker process to
complete. If the worker process does not complete in the specified
period, the scheduler reassigns the message to another worker.

Scheduler
Weight

Yes Weight represents the ability of this member to fulfill the role of
scheduler, relative to other members with the same name.
Cooperating distributed queue transports use relative scheduler
weight values to elect one transport as the scheduler; members with
higher scheduler weight take precedence. Acceptable values range
from 1 to 65535.

Scheduler
Heartbeat

Yes The scheduler sends heartbeat messages at this interval (in seconds).
All members with the same name must specify the same value for this
parameter. The value must be strictly positive.

Scheduler
Activation

Yes When the heartbeat signal from the scheduler has been silent for this
interval (in seconds), the member with the greatest scheduler weight
takes its place as the new scheduler. All members with the same
name must specify the same value for this parameter. The value must
be positive
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Domain Models

Domain model resources enable you to control user input for decision tables and test data. This chapter
describes how to add and import domain models and associate them with entity properties.

You can add domain models for concept, event, and scorecard properties. A domain model specifies
the values that you may find useful for defining ontology item properties. For example, instead of
typing text for a certain concept property, you can pick a value from a list, or enter a value within a
predefined range.

A domain model can extend another domain model. When defining a domain model you can specify
which domain model it inherits from.

Domain model entries are case sensitive. For example, m and M are recognized as different entries.

Domain models can be used in decision tables and in test data for Tester. Decision tables are available
in the TIBCO BusinessEvents Decision Manager add-on. See TIBCO BusinessEvents Decision Manager
documentation for details about working with decision tables.

You cannot add domain models for concept properties of the ContainedConcept or
ConceptReference type.

Set Up a Domain Model
Setting up domain models has two steps:

Procedure

1. Add domain models. For example, create a folder and add all the models you need for a project in
this folder. See Adding a Domain Model for details.

You can also import (and export) domain models. See Importing and Exporting Domain Models.

2. Associate domain models with properties. See Associating Domain Models with Properties for
details.

Result

When creating a decision table, domain models control the values you can use for a given property.

Domain Model Value Descriptions for User Friendly Presentation
All domain model values can have optional descriptions that appear in the domain model editor. A
preference determines whether domain model values or their descriptions appear in decision table
cells. For some applications displaying descriptions can make the table easier for users to understand.
For example suppose the value is a code such as 23, and the description is North West. Users will find it
is easier to work with the description than the code. As another example, for a Boolean data type, the
description can provide words such as Accepted and Rejected for the values True or False.

Adding a Domain Model
You can store domain models as desired, for example, in a folder called DomainModels. For each
domain model, you create a set of domain entries, where each entry represents a valid value for the
entity property that uses the domain model.

After you add a domain model, associate it with a property. See Associating Domain Models with
Properties
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Add a Domain Model

Procedure

1. Right-click the folder where you want to store the domain model, and select New > Domain
Model . You see the New Domain Model Wizard.

Alternatively, right-click a resource, and select New > Other . In the New dialog, select Domain
Model under TIBCO BusinessEvents.

2. In the Domain Model Name field, type a name for the domain model. In the Description field, type
a description.

You cannot change the name in the editor. To change the name of any project element,
right-click the element in BusinessEvents Studio Explorer and select Refactor > Rename .
See Element Refactoring Operations for more details.

3. Click Finish. You see the Domain Model editor.

4. In the Domain Type field, select the data type for this domain model. See Supported Data Types for
supported types.

5. As needed, complete the Inherits From field. If this domain model extends another domain model,
browse to and select that domain model.

6. In the Domain Entries section, click Add.

An empty row appears in the table of entries.

You can also select rows and click Duplicate to duplicate (and then modify) selected rows.

You can select a row and click Remove to remove individual rows that are not needed.

7. For each row you add, enter a description (optional) and in the Details section, define the domain
model entry.

The Details section presents appropriate fields for defining the type of domain model entry you
selected in step 4.

8. When you have created the entries for the domain model, save the domain model resource.

Adding Domain Entries
When you add a domain model, you first select its data type. The Domain Model editor then displays
an appropriate user interface for defining domain model entries of that data type.

The Domain Entries section is the same for all types. The Details section changes depending on what
data type you selected for the domain model.

Supported Data Types

Domain Models support the following data types:

● String
● Integer
● Long
● Double
● Boolean
● DateTime

Sections below show the user interface for each type.
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String

String entries are simple text strings.

Numeric values in a String domain type
 When you use a numeric value (Integer, Double, or Long) in a domain model of type String, TIBCO
BusinessEvents adds double quotes around the value. (These are visible after you save and reopen the
domain model.)

Integer, Double, Long

In a single domain model, you can enter single values, range values, or a mixture of both. Acceptable
values for integer, long, and double domain entries are the same as for the equivalent Java datatypes.

Text values in a numeric data type
 When you enter text in a domain model of type Integer, Double or Long, TIBCO BusinessEvents
marks it in red color, and indicates you to correct it.

The user interface is similar for all numeric datatypes.

You define whether each end of the range is inclusive. For complete coverage, ensure that there is no
gap and no overlap between ranges through consistent use of the Included check box.

Boolean

Boolean entry values are always true or false. The description can give the meaning of the pair of
choices, such as male or female, supported or unsupported, eligible or ineligible and so on.

DateTime

In a single domain model, you can enter single values, range values, or a mixture of both. You specify a
date and a time. A date and time picker enable you to select the date and time:

If you do not want to specify a time of day, set the time to midnight (12:00 AM) for the start date, and to
a minute before midnight (11:59:59 PM) for the end date of an inclusive range, or for a single date.

The calendar shows a 12-hour clock. PM numbers are converted to a 24 hour clock format in the value
table.

Importing and Exporting Domain Models
You can import domain model information from a database, from a Microsoft Excel spreadsheet, and
from the source of a database concept property. (Database concepts are available in the TIBCO
BusinessEvents Data Modeling add-on).

After you import a domain model, associate it with a property. See Associating Domain Models with
Properties

Import From the Source of a Database Concept

You can import all values from the database column that corresponds to a database concept property
for use as the domain model entry for that property. This is explained in TIBCO BusinessEvents Data
Modeling Developer’s Guide.
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Exporting To and Import From Excel
You can export a domain model to an Excel spreadsheet. The description for each domain model entry
goes in column A, and the value goes in column B. When you import from an Excel spreadsheet,
similarly, column A is used as the description, and column B is used for the value.

In TIBCO BusinessEvents Decision Manager, you can export decision tables to Excel and import them
from Excel. When you do so, you also export and import domain models associated with properties
used in a decision table column. See TIBCO BusinessEvents Decision Manager User’s Guide for details.

Importing Domain Model Entries from Excel

Procedure

1. In BusinessEvents Studio Explorer, do one of the following:

● Right-click the folder where you want to create the domain model and select Import > TIBCO
BusinessEvents > Domain Model .

● In BusinessEvents Studio Explorer, select any item in the project entity and select File > Import
> TIBCO BusinessEvents > Domain Model .

2. Click Next. You see the Import Domain Model Wizard.

If you invoked the import wizard by right-clicking a folder, that folder is selected as the parent
folder. You can choose a different one as desired.

3. In the Domain Import Source field, select EXCEL.

4. In the File Name field, enter a name for the domain model resource. Optionally enter a description.

5. In the Data Type field, select the appropriate data type for the domain model and click Next. You
see the next wizard page.

6. In the Select Excel File to Import field, browse and select the Excel file that has the domain model
information.

7. Click Finish. You see a message, "Domain Import Successful." Click OK.

8. You see the Domain Model editor. The column values appear as domain entries. You can add, edit,
duplicate, and remove entries as appropriate.

Export Domain Values to Excel

Procedure

1. In BusinessEvents Studio Explorer do one of the following:

● Right-click the domain you want to export and select Export > TIBCO BusinessEvents >
Export Domain to Excel .

● In BusinessEvents Studio Explorer, select any item in the project entity and select File > Export
> TIBCO BusinessEvents > Export Domain to Excel .

2. Click Next. You see the Export to Microsoft Excel File Wizard.

3. In the Select Excel File to Export to field, browse and select the Excel file to which you want to
export the domain model information.

To create a new Excel file, specify a filename that does not yet exist. If you specify an existing Excel
file, the file contents are replaced with the exported domain model information.
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4. In the Select Domain to Export area, expand the display and select the domain model you want to
export.

If you invoked the export wizard by right-clicking a domain model, that domain model is selected.
You can choose a different one as desired.

5. Click Finish. You see a message, "Export Domain Model to File Successful." Click OK.

Importing Domain Model Entries from a Database Table
When you import domain model information from a database, the result set from the SQL query is
transformed for use as domain model entries. This feature is supported with Oracle Database.

If imported from a database concept, database table, or a database query, you can update the domain
model by using the Reload Domain Model button available on the top bar of the Domain Model
editor.

Procedure

1. Add a JDBC Connection resource and configure it to connect to the database from which you want
to import the domain model. See JDBC Connection Reference for details.

2. In BusinessEvents Studio Explorer, do one of the following:

● Right-click the folder where you want to create the domain model and select Import > TIBCO
BusinessEvents > Domain Model .

● In BusinessEvents Studio Explorer, select any item in the project entity and select File > Import
> TIBCO BusinessEvents > Domain Model .

3. Click Next. You see the Import Domain Model Wizard.

If you invoked the import wizard by right-clicking a folder, that folder is selected as the parent
folder. You can choose a different one as desired.

4. In the Domain Import Source field, select DATABASE_TABLE.

5. In the File Name field, enter a name for the domain model resource. Optionally enter a description.

6. In the Data Type field, select the appropriate data type for the domain model and click Next. You
see the next wizard page.

7. In the JDBC Resource URI field, browse and select the JDBC Connection resource that connects to
the database you want to use.

The connection information from the JDBC Connection resource displays. You can override it here
as desired.

Click Next. You see a list of tables in the database. Expand the list of tables to see the columns that
match the datatype specified in step 6.

8. Do one of the following:

● Select one or more columns, then click the Create Domain for Selected Columns button.
Values of all columns are used for the domain model entries.

● Click Advanced and enter an SQL query whose resultset is used to create the domain entries.
This option enables you to make use of joins, where clauses, and so on. Then click Execute
Query.

9. Click Finish. You see a message, "Domain Import Successful." Click OK.

10. You see the Domain Model editor. The column values appear as domain entries. You can add, edit,
duplicate, and remove entries as appropriate.
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Associating Domain Models with Properties
You can associate domain models with concept, event, and scorecard properties.

If domain models have the same data type as that of the properties, you can associate multiple domain
models with multiple properties.

For example, an event and a concept have an OrderID property defined the same way, and both the
OrderID properties use an OrderIDModel domain model. In this case, the OrderIDModel domain
model is associated with the OrderID property of the event, as well as of the concept. However, the
concept or the event property is associated only with the OrderIDModel domain model.

Associate Domain Models with a Property

Procedure

1. Do one of the following:

● In BusinessEvents Studio Explorer, expand the concept, event, or scorecard to display its
properties. Right-click the desired property and select Associate Domains.

● In BusinessEvents Studio Explorer, open the desired concept, event, or scorecard editor. In the
Domain Model field of the desired property, click the browse icon.

The Associate Domains dialog appears.

2. Expand the project tree to display domain models, and select one or more as appropriate.

The displayed domain models have the same data type as that of the property.

3. Save the domain model resource.

Validating Data in Domain Models
You can validate duplicate entries and a mismatch of upper and lower range values while defining
domain models.

Duplicate Domain Values Not Allowed

Each domain value must be unique. If you accidentally enter duplicate values, the Problems view
displays helpful information. For example:

Mismatching Range Values Not Allowed

If you accidentally enter mismatching values in the Lower and Upper fields for range values, the
Problems view displays helpful information. For example:
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Display Models

Display Models provides a mechanism to define the display text for elements in WebStudio, such as,
properties. Instead of displaying the default element name, a more user readable name in any selected
language could be displayed.

You can provide a name for the artifact and its properties in your preferred language using Display
Model. Thus, you can see the artifact and its properties name in your language while using the
WebStudio. See TIBCO BusinessEvents WebStudio User's Guide for how it would appear in the
WebStudio.

Display Models are defined inside the TIBCO BusinessEvents Studio, similar to Concepts, Events, and
Rules. A Display Model is a specialized type of property file, and follows the familiar name/value pair
syntax for property files in Java. Display Models are the first class citizens inside the BusinessEvents
Studio project, and their file extension is .DISPLAY.

Naming

BusinessEvent assigns the Display Model name that matches with the associated BusinessEvents
project artifact (Concept or Event). For instance, for the Concept named Person.concept, the
corresponding Display Model artifact is named Person.display. This naming method simplifies the
syntax and allow for a loose coupling of the artifacts. However, the Display Model follows the standard
Java I18N naming conventions if language and country values are specified, that is the name of the file
is <artifact_name>_<language_code>_<country_code>.display. For example, if English is selected
as language and United States is selected as country, for the Concept named Person.display, the
Display Model file is saved with the file name Person_en_US.display

The Display Model also supports the code refactoring. If artifact is renamed then the Display Model file
associated with the artifact is automatically renamed. If the properties of the artifact is renamed then
the properties are also updated in the Display Model.

Syntax

The syntax for the Display Model files follows the standard Java property file syntax, that is, specifying
name and value pairs. There are three major parts of the file:

● For each artifact property, there is an optional text that is displayed in the WebStudio UI. The
simple syntax is as follows:
<property_name>=<display_text>

For example,
 Name.displayText=User Name

● Additionally, there is an optional property that allows properties to be hidden entirely from the
WebStudio UI, so that they are not accessible from the builder based Business Rule editor or
Decision Table editor.
<property_name>.hidden=true | false

For example,
 Name.hidden=true

● Finally, there is an optional property to specify the text to be displayed wherever the artifact itself is
shown in the WebStudio UI, for instance inside of the Group Contents window. The syntax for this
setting is:
displayText=<display_text>

For example, for an Applicant concept
 displayText=Credit Card Applicant
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Overriding Behaviors

As Concepts and Events can inherit properties from parent Concepts and Events, any visible property
from the artifact's hierarchy is also visible to the Display Model. For example, if the Concept Employee
inherits a property called Name from the Concept Person, it is valid to specify the display text for the
Name property inside of the Display Model for the Employee Concept. The Name property can have
different meaning for different concepts, and you can use display text to differentiate them.

You can also override a display text inside a Rule Template. This overriding behavior provides another
level of meaningful, context-aware specification of properties. A new display section could be added
to the Rule Template source, and the context-sensitive display text for each accessible property can be
specified using the dot notation. For example,
display {
             account.AccountID = "Personal Checking Account ID";
       }

Creating a Display Model
A Display Model provides the more readable name to the artifact properties and you can create it using
the TIBCO BusinessEvents Studio.

Procedure

1. Right click on any folder in the project and select New > Other. In the New dialog select TIBCO
BusinessEvents > Display Model.
The New Display Model Wizard window is displayed.

2. Enter the values of the following fields in the wizard and click Finish.
Field Description

Project Name of the project

Target Entity Project path of the artifact (concept or event) for which the display text is created.
Click Browse to browse and select the artifact of the project.

Language (Optional) Language for the display model. If none is selected, the default language
is English.

Country (Optional) Country for the display model. If none is selected, the default country is
United States.

The Display Model editor is displayed for adding the display text for the artifact and its arguments.
See Editing a Display Model for more details.

Result

If no language/country is chosen, a file with the default name of <artifact_name>.display is created.
If language and country values are selected, the name of the file follows the standard Java I18N naming
conventions, that is the name of the file is
<artifact_name>_<language_code>_<country_code>.display. For example, if English is selected
as language and United States is selected as country, for the Concept named Applicant, the Display
Model file is saved with the file name Applicant_en_US.display.

Editing a Display Model
You can define display text for each property of the artifact and also can hide a property from
displaying in WebStudio using the Display Model editor.
The following fields are not editable but can be setup only while creating Display Model.
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● Target Entity
● Language
● Country
● Variant

Procedure

1. In TIBCO BusinessEvents Studio, double click the Display Model file to open it in the form editor.

2. Enter the display text for the artifact (Concept or Event) in the Target Entity Display Text field.

3. In the Display Properties section, configure the display text for the properties of the artifact.
a) Click Add, select the properties for which you need to assign the display text, translate, or hide,

and click Finish
The selected properties are listed.

b) Select a property and enter the required display text in the Display Text field.
c) Select the Hidden checkbox, if you do not want the property to appear in the WebStudio UI.

4. After you have added the display text for the required properties, save the Display Model.
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Understanding Entity Caches

Understanding of entity caches is needed when working with the internal structures of the Oracle
Coherence caches.

This information is provided for those who want to understand the internal structures of the Oracle
Coherence caches used in Cache object management. It is not required for configuration tasks.

For each entity in working memory, a corresponding cache exists in the cache cluster. Internal entities
also have caches for various purposes, explained in this section.

Each entity cache has a name, which uses the following format:

cache-type.cluster-name.AgentClassName.entity-name

The elements of the above name are explained below

Cache Type (Caching Scheme)
Cache type is the type of caching scheme (as defined by its cache name in the coherence-cache-
config.xml descriptor), for example, dist-unlimited-bs.

Cluster Name

Cluster name is the value of the following property:
java.property.tangosol.coherence.cluster

Agent Name
This field of the cache name is blank because TIBCO BusinessEvents does not support agent-specific
entity caches.
All entities are globally scoped and available to all agents.

Entity Name
Two types of entities have caches:

● Internal entities: Internal entity names and caches are listed and described in Internal Entity
Caches,.

● Ontology entities: The ontology entity field of the entity cache name uses the entity’s generated
class name, which is similar to its design-time folder path and name, prefixed by be.gen. For
example:
be.gen.Concepts.LargeConcepts.ThisLargeConcept

Caches for Ontology Objects
Specific caches are used to store the objects of types defined in the ontology of the project.

The types of caches created for ontology objects depend on the caching scheme used. If the dist-
unlimited-bs caching scheme is used, then the cache names look like this:
dist-unlimited-bs$foo$$be.gen.Order

where foo is the cluster name.

Caches for Internal Entities
Specific internal caches use a pre-defined scheme in the cache configuration file.

Do not change this scheme. This information is provided for reference only.
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Internal Entity Caches

Entity (Cache) name Purpose of the Cache

Master Maintains the cluster state and is shared by all nodes.

Catalog Maintains a cached copy of all ontology definitions shared by all
nodes.

TypeIDs TypeIDs are internal numbers used to store the short number to
identify the URL of a concept instead the large string.

ObjectTableIDs Stores the key mapping for all objects in the cluster. The objects
themselves are stored in their respective caches.

ObjectTableExtIDs Stores the external key mapping for all objects that have an external
ID (extId).

AgentTable Stores all the agents and their respective states across all cluster
nodes and identifies the currently active and standby nodes.

AgentTxn-agentId
             

Each agent in the cluster has an AgentTxn-agentId cache. The
agentId is internally generated. It stores the change list for the
agent. The change list is used to replicate changes between active-
active and active-passive sets of agents in the cluster so that they
stay synchronized.

TimeQueue Maintains all entries that are time bound, for example, state
machines that can have timeouts at a state machine level or at a
state level. This cache maintains an index to all objects that must be
re-evaluated after a certain period of time.
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Handling Null Properties

There are several ways of handling null concept property values:

Enabling Use of the Nillable Attribute
The presence of the xsd:nillable attribute in an XSD element means that the corresponding element
in the XML file permits null values.

Setting tibco.be.schema.nil.attribs=true in studio.tra causes the xsd:nillable attribute
("xsd:nillable=true") to be set on all elements in the TIBCO BusinessEvents concept XSD. When an
element in the XML file generated using that XSD has a null value, the xsi:nil="true" attribute is set
on that element.

When set to false, the xsd:nillable attribute is not added and the corresponding XML file does not
treat empty elements as null values.

In the absence of the xsd:nillable attribute in the XSD element, a corresponding empty element in
the XML file is assumed to have a value. Elements that have no value are treated as empty strings ("").

Effect on schema generation tool
 The setting for this property affects the concept XSD files generated using the Generate Schema
utility.

Enabling Null Property Values to Appear When Serializing Concepts to XML
By default concept properties with null values are excluded when concept objects (instances) are
serialized to XML. You can override this behavior.

Setting the following property to false in the studio.tra file causes properties with null values to be
included in the XML representation of a concept:
tibco.be.schema.exclude.null.props=false

Examples of Nillable Attribute and Null Properties Settings
These examples illustrate the effect of the following properties on concept serialization:
tibco.be.schema.nil.attribs
tibco.be.schema.exclude.null.props

If Null Properties are Excluded

tibco.be.schema.nil.attribs= true or false
tibco.be.schema.exclude.null.props=true

Suppose a Customer concept instance has no value for its CustomerName property. By default, the
CustomerName property is excluded from the XML output. The output might look like the following:
<CustomerID>111</CustomerID>
<Country>Japan</Country>
<City>Tokyo</City>

If null properties are excluded when concepts are serialized, the tibco.be.schema.nil.attribs
property has no effect on concept serialization.

If Null Properties are Included and the Nillable Attribute is Set

tibco.be.schema.nil.attribs=true
tibco.be.schema.exclude.null.props=false
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The output for the Customer concept instance shown above would be as follows, where there is no
value for the CustomerName element in the concept instance:
<CustomerID>111</CustomerID>
<Country>Japan</Country>
<City>Tokyo</City>
<CustomerName
     xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"      xsi:nil="true"/>

If Null Properties are Included and the Nillable Attribute is not Set

tibco.be.schema.nil.attribs=false
tibco.be.schema.exclude.null.props=false

In this case, each null property is considered to be an empty string, and is represented, for example, as
follows:
<CustomerName/>

Special Treatment of Numeric and Boolean Null Values

If you enable null values to be output to XML (see Enabling Null Property Values to Appear When
Serializing Concepts to XML), then you may also want to configure additional properties for defining
how to treat null values for numeric types and Booleans, as explained in this section.

TIBCO BusinessEvents does not implicitly support null values for numeric types and Booleans. This
can lead to interoperability issues when working with external sources, such as databases, which do
permit blank (null) values.

To address such issues, you can enable special treatment of numeric null values at design time. At
runtime, TIBCO BusinessEvents then uses a special numeric value for each numeric datatype, and (by
default) Boolean:FALSE for Booleans, to represent a null value. Default special values are provided and
you can override the defaults at runtime (see Properties for Null Property Handling).

The special numeric values that indicate null are used in TIBCO BusinessEvents when serializing and
deserializing a concept to and from its XML representation, and when performing various operations
on database concepts and the database tables to which they are linked.

The special values that indicate null appear only in TIBCO BusinessEvents. The appropriate null value
is used in the XML or database representation of the concept property.

Conversely, when deserializing or importing a concept instance, TIBCO BusinessEvents represents null
values in the source using these special values that indicate null in the concept instance.

To enable special treatment of numeric null values, set the following property in studio.tra:
tibco.be.schema.treat.null.values=true

At runtime you can override the default values that indicate null. See Setting Runtime Properties for
Special Treatment of Null Values.

Summary

Set the following properties in BE_HOME/studio/eclipse/configuration/studio.tra as desired:

● To enable null property values to appear when serializing concepts to XML, add the following
property and set it to false:
tibco.be.schema.exclude.null.props=false

● To enable use of the nillable attribute in the concept XSD, add the following property and set it to
true:
tibco.be.schema.nil.attribs=true

● To enable special handling of null properties, add the following property and set it to true:
   tibco.be.schema.treat.null.values=true

325

TIBCO BusinessEvents® Developer's Guide



Setting Runtime Properties for Special Treatment of Null Values

If you have enabled special treatment of null numeric properties, you can override the default special
values that indicate null values of various datatypes in TIBCO BusinessEvents (shown in Property
Reference for Null Property Handling).

To override the default values do the following:

Procedure

1. In TIBCO BusinessEvents Studio, open the CDD editor for the project and add the following
properties at the cluster level properties sheet. Provide the special values as desired:

tibco.be.property.int.null.value=value

tibco.be.property.long.null.value=value

tibco.be.property.double.null.value=value

tibco.be.property.boolean.null.value=value

Choose values that will not be misinterpreted as literal values.

2. Save the file.

3. Deploy the project with the updated CDD file.

Property Reference for Null Property Handling
Set the following properties in the studio.tra file as needed to configure the output for your needs
before you generate the EAR file.

Properties for Null Property Handling

Property Notes

Properties Set in BE_HOME/studio/eclipse/configuration/studio.tra

tibco.be.schema.nil.attribs

Setting this property to true causes the xsd:nillable attribute
("xsd:nillable=true") to be set on all elements in the TIBCO BusinessEvents
concept XSD.

See Enabling Use of the Nillable Attribute

Possible values are true and false.

Default is false.

tibco.be.schema.exclude.null.props
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Property Notes

When this property is set to true, null-valued concept properties are not output
when the concept is serialized to XML.

When set to false, null-valued concept properties are output to XML.

See Enabling Null Property Values to Appear When Serializing Concepts to
XML .

Possible values are true and false.

Default is true.

tibco.be.schema.treat.null.values

Setting this property to true causes TIBCO BusinessEvents to use special
numeric values that indicate null for numeric datatypes. The special numeric
values are set using the properties listed next.

Possible values are true and false.

Default is false.

Properties Set in CDD at the cluster level

tibco.be.property.int.null.value
tibco.be.property.long.null.value
tibco.be.property.double.null.value
tibco.be.property.boolean.null.value

These properties define a special value that indicates null. Use a value that will
not be confused with an actual numeric value.

These properties are used only if tibco.be.schema.treat.null.values is set
to true.

Default values for each numeric datatype are the following Java constants:

int: Integer.MIN_VALUE

long: Long.MIN_VALUE

double: Double.MIN_VALUE

boolean: Boolean.FALSE

For Integer and Long these constants represent the most negative value. For
Double the constant represents smallest positive nonzero value (4.9e-324).
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Diagrams

TIBCO BusinessEvents provides several kinds of diagrams, which are visualization tools that help you
to understand and analyze even very large and complex projects.

The diagrams in TIBCO BusinessEvents are based on Unified Modeling Language (UML), but are not
completely compliant to UML.

Using the diagrams you can show or hide details. You can open editors for any project component in a
diagram. You can also create snapshot images of diagrams to share project information with other
personnel.

The main types of diagrams, and the project elements that use them, are as follows:

Selected Entity Project diagrams
These diagrams display all the selected project resources, and how they interact with one another.
External resources such as XSD and WSDL files are not shown. You can either create a project
diagram for an entire project, or only for the selected resources of a project. You can also choose to run
the project analyzer while creating a project diagram, which analyzes the project resources and gives a
report in the Problems view.

Dependency diagrams
These diagrams show the relationships between the selected project resource and its dependent
resources. They are available for channels, concepts, state models, scorecards, events (all types except
advisory events), rule functions, and rules.

Sequence diagrams
These diagrams show how project resources are called into use at run time. They are available for
events (all types except advisory events), rule functions, and rules.

Concept model diagrams
These diagrams show the concept model for a project. You can view a model diagram for all the
concepts in a project.

Event model diagrams
These diagrams show the event model for a project. You can view a model diagram for all the events
in a project, except for advisory events.

Add-on Products
State model diagrams are available in the TIBCO BusinessEvents Data Modeling add-on. Metrics
are available in the TIBCO BusinessEvents Views add-on. For metrics, you can view a dependency
diagram only by right-clicking in Project View. See the add-on product documentation for more
details

.

Types of Diagrams Available for Different Resource Types

Project Resource Project Dependency Sequence
Concept
Model

Event
Model

Channel Yes Yes

Concept Yes Yes Yes

Domain Yes Yes
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Project Resource Project Dependency Sequence
Concept
Model

Event
Model

State Model Yes Yes

Scorecard Yes Yes

Event Yes Yes Yes Yes

Rule Function Yes Yes Yes

Rule Yes Yes Yes

Shared Resource Yes Yes

Metric Yes Yes

Working with Diagrams
You can work with diagrams in a variety of ways for your own information, and you can use them to
share aspects of your project with others in a visual way that is easy to understand. This section
presents some common tasks and lists the various tools you can use to work with all types of diagrams.

● Configuring Diagram Preferences and Properties

— Diagram Preferences
● Diagram Properties

Use the following properties to handle diagrams that are too complex to display in a timely manner.
You can adjust the values in the BE_HOME/studio/eclipse/configuration/studio.tra file to
define upper limits:
#Diagram properties
be.studio.project.diagram.nrEdges=3000
be.studio.project.diagram.nrMaxEdges=1500

If the number of edges in the diagram exceeds the limit defined by
be.studio.project.diagram.nrEdges, then the usage links in the diagram are hidden. Usage
links are links from a rule or rule function to other rules or rule functions it uses.

If the number of edges in the diagram exceeds the limit defined by
be.studio.project.diagram.nrMaxEdges, then symmetric layout is run as default rather than
hierarchical because symmetric layout is faster and less expensive.

● Different Ways to Create Diagrams

You can create diagrams in various ways as shown in the table below.

Method of creating diagrams Diagrams you can create

In BusinessEvents Studio Explorer, right-click a resource or
a project, and select the appropriate menu option.

Selected Entity Project Diagram,
Concept Model Diagram, Event
Model Diagram
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Method of creating diagrams Diagrams you can create

In Studio Explorer, select a resource and right-click. Selected Entity Project Diagram,
Concept Model Diagram, Event
Model Diagram, Dependency
diagram

In a resource editor, click the appropriate diagram button
in the top right corner.

Concept Model Diagram 

Event Model Diagram  

Dependency Diagram 

Sequence diagram 

Concept Model Diagram, Event
Model Diagram, Dependency
Diagram, Sequence Diagram

In a Selected Entity Project diagram, right-click a resource. Dependency Diagram

In a Selected Entity Project diagram, right-click anywhere
on the canvas.

Selected Entity Project diagram

Common Tasks
You can perform the following common tasks on all types of diagrams:

● Hover the mouse over a resource to view a tooltip with details.
● Double-click any resource represented in the diagram to open its editor.
● Drag resources to any location in order to change the layout as desired.
● Drag any link to change the layout as desired.

● Click any arrowhead to move the arrow to any other element in the project. When you hover the

mouse over an arrowhead, you see a small graphic on it. ( )
● Double-click the black and white plus signs in a dependency or sequence diagram to unfold the next

level of dependency.

Diagram Tools
You can work with diagrams with the help of the following tools available from the Diagram menu:

● Interactive Tools, such as Select, Pan, Magnify, Marquee Zoom, Interactive Zoom, Link Navigator
● Layout, such as Default Layout, Circular Layout, Orthogonal Layout, Symmetric Layout, Rectilinear

Hierarchical Layout, and Oblique Hierarchical Layout
● Print tools: Print Setup, Print Preview, Print
● Export to Image
● Labeling
● Link Routing
● Incremental Layout
● Fit In Window
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The above tools are also available on the toolbar when you create or display a diagram. The toolbar also
has three additional tools listed below:

● Refresh Diagram
● Zoom Percentage
● Search Diagram Entities

Diagram menu and the toolbar described in this section are available only when you create or open a
diagram.

For more details about the diagram tools, see Diagram Options and Tools Reference.

Interactive Tools

To access the Interactive Tools, select Interactive Tools from the Diagram menu. They are also
available on the toolbar when you create or display a diagram. Interactive Tools let you select, pan, and
magnify diagrams. They also include tools such as marquee zoom, interactive zoom, and link
navigator. For more details about these tools, see Diagram Options and Tools Reference.

Layout

You can access the Layout menu from the Diagram menu. They are also available on the toolbar when
you create or display a diagram. Layout options let you change the layout of a diagram to Circular,
Orthogonal, Symmetric, or Hierarchical. For more details about these tools, see Diagram Options and
Tools Reference.

Context Menu Diagram Tools

Diagram tools are available as context menus for diagram canvas and objects. Context Menu Options
for Canvas and Objects lists these context menu options.
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Context Menu Options for Canvas and Objects

Context Menu Option Available for

Selected Entity Project Diagram Canvas – Selected Entity Project Diagram

Export to Image... Canvas – All diagrams

Print Setup... Canvas – All diagrams

Print Preview... Canvas – All diagrams

Fit In Window Canvas – All diagrams

Create Dependency Diagram Object – Selected Entity Project Diagram

Fold One Level Object – Selected Entity Project Diagram

Fold N Levels... Object – Selected Entity Project Diagram

Fold All Levels Object – Selected Entity Project Diagram

Edit Object – All diagrams

For more details about the diagram tools, see Diagram Options and Tools Reference.

Exporting a Diagram to an Image
Using the Export to Image option you can save the diagrams locally for later use.

Procedure

1. From the top menu, select Diagram > Export > to Image . You see the Export Drawing to Image
dialog.

2. Select the type of the image from the Type list.

3. In the File Name field, specify the file name along with the location.
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4. Select the check boxes Visible Window Only and Selected Objects Only as appropriate to specify
the content of the image.

Selected Objects Only gets enabled only if you select an object in the diagram.

5. Specify the Image Quality as appropriate.

6. Specify the size, and click OK.

Result

The diagram is exported to an image, and saved on the system.

Printing a Diagram
You can set up preferences, preview the print job, and then print the diagram.

Using the Print Setup dialog you can specify the print setup for a diagram.

Procedure

1. Display the diagram, and from the top menu select Diagram > Print Setup .

2. Select an appropriate option to print the entire diagram, or to print only the current window, or to
print the selection.

3. In the Scale By section, select an option to scale the diagram by pages, by actual size, or by zoom
level.

4. If you want multiple prints, you can specify if you want the page numbers and crop marks to be
printed, by clicking to select the respective checkboxes.

5. If you want a caption for your diagram, you can type a caption in the text box that appears on
enabling the Print Caption check box. You can also select a Font for this caption, and its position on
the page.

6. If you want to have borders for your diagrams, click to select the Print Border check box. Click
Color... to specify the color of the border.

7. If you want to print the background of the diagram, click to select the Print Background check box.

8. Use Page Setup to specify the size, orientation, and other page properties.

9. If you want to reset all the options to the defaults, click Defaults.
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10. Click OK.

11. To preview and print the diagram, select Diagram > Print Preview . An image of the diagram to be
printed is displayed.

12. From the top menu select Diagram > Print .

Setting Diagram Preferences
You can set the preferences for all types of diagrams.

Procedure

1. From the top menu, select Window > Preferences .

2. In the Preferences dialog, expand TIBCO BusinessEvents, and then expand Diagram.

3. Select any type of diagram.

On the right side, you see preferences for the selected diagram type.

4. Edit the preferences, and click Apply.

OR

To set all preferences to their default values, click Restore Defaults.

Project Analyzer and Selected Entity Project Diagrams

Project Analyzer and the Selected Entity Project diagram work together to provide insights into your
project. Project Analyzer is a document generated in the Problems view area. Selected Entity Project
diagram provides a visualization of the whole project or of selected project elements, including
dependencies. Selected Entity Project diagrams can display all the resources in a project, how they
interact with one another, and how they use or update other resources at run time. You can see
concepts, events, rules, rule functions, channels, destinations, score cards, shared resources, and all
other resources of a particular project in a Selected Entity Project diagram. It also shows all
dependencies in a project.

You can set preferences to determine whether project analyzer runs when you create a Selected Entity
Project diagram or not. You can use a menu option to create the project analyzer report without
creating the Selected Entity Project diagram.

Types of Links

A Selected Entity Project diagram has three types of links:

● Links, represented by continuous lines, indicate inheritance or containment.
● Scope Links, represented by dashed lines, indicate resources in the scope.
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● Usage Links, represented by dashed lines with dots, indicate resources that can be used.

Advantages of Project Analyzer and Selected Entity Project Diagrams
Using Project Analyzer and Selected Entity Project Diagrams together helps you understand your
project in these ways:

● Helps you understand how all the selected project resources are connected and how they interact.
● Analyzes rules and how they modify ontology.
● Lets you search entities in a diagram.
● Lets you choose the entities to be displayed in a diagram by using Project Filters.
● Displays statistics of project resources (number of concepts, events, state machines, and so on) in the

properties view.
● Enables you to share project design, logic, deployments with others in a format they can read

without having TIBCO BusinessEvents Studio, as well as print the entire project according to page
setup.

The Project Analyzer report helps you analyze the project by performing the following tasks:

● Finds rules that can never be fired
● Finds rule functions that are never used
● Finds events that are never used/may never be fired
● Finds destinations with no default events
● Finds domain models that are never used, or that are not associated with entity properties
● Finds state models that are orphaned, or that are not associated with any concepts

Project Analyzer and Selected Entity Project Diagrams
You can show the diagram for an entire project or for selected elements only. You can also filter the
diagram to show only certain types of project element.

You can choose whether to run Project Analyzer whenever you create a Selected Entity Project
diagram. To do this, from the Window menu, select Preferences > TIBCO BusinessEvents > Diagrams
> Project. Check the Run Analysis When Creating View check box, on the right.

You can also run Project Analyzer separately in either case. See Project Analyzer and Selected Entity
Project Diagrams .

To Run Project Analyzer Without Selected Entity Project Diagram

Right-click the top level project folder, and click Analyze. Project Analyzer displays the report in the
Problems view.

Create a Selected Entity Project Diagram

Procedure

1. Do one of the following to create a Selected Entity Project diagram for the entire project:

● In BusinessEvents Studio Explorer, right-click a project resource and select Create Selected
Entity Project Diagram.

● Double-click the *.projectview file in the Studio Explorer.

OR, to create a Selected Entity Project diagram for selected resources
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● In Studio Explorer, select resources of interest, right-click, and select Create Selected Entity
Project Diagram.

When you select a folder all elements in that folder are selected.

2. The Selected Entity Project diagram appears in the editor area. The diagram tab label reflects the
project name and the type of diagram: projectName.projectview, for example,
ExternalEventRepo.projectview.

By default, the Selected Entity Project diagram displays the selected objects and their immediate
dependencies.

3. You can change the depth of dependencies shown using preferences.

4. To filter what you see, select and clear the options in the Project Filter list within the Palette view.

5. Click Apply.

Result

Options show or hide elements of the specified type, or group them:

Show Options
Show Concepts, Show Events, Show Decision Tables, Show Domain Model, Show State Models, Show
Archives, Show Rules, Show Rule Functions, Show Scorecard, Show Channels, Show Scope Links,
Show Usage Links, Show Archived Destinations, Show Archived Rules, Show Archived Rules (All),
Show Rules in Folders, Show Tooltips. If add-on products are used additional options may appear.

Group Options
 Group Concepts, Group Events, Group Rules, Group Rule Functions. The filter options in the Palette
view are loaded from diagram preferences.

Dependency Diagrams
A dependency diagram shows the dependencies for a selected project resource or for the entire project
(Selected Entity Project Diagram).

When two resources are dependent and one changes, it can cause changes to the other resource as well.
You can control how many levels of dependencies to view in a dependency diagram - one, two, or all
levels.
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Rule actions are not represented in rule dependency diagrams. Use Debugger to analyze rule actions.
See Testing and Debugging Projects.

Create a Dependency Diagram

Procedure

1. Do one of the following:

● In BusinessEvents Studio Explorer, right-click a project resource and select Create Dependency
Diagram.

● Open the project element for editing and click the Dependency Diagram ( ) button in the
top right of the editor.

● In a Selected Entity Project diagram, right-click a resource and select Create Dependency
Diagram.

The dependency diagram appears in the editor area. By default, one level of dependency is
shown which displays only direct dependents. White crosses indicate hidden dependencies.
The default appearance is also driven by the diagram preferences.

The diagram tab label reflects the item being graphed and the type of diagram:
itemName.item-typedependencyview, for example, Transaction.eventdependencyview.

2. As desired, select a dependency level from the palette:

● One: Shows the direct dependencies of the selected item
● Two: Shows the direct dependencies of the selected item as well as the direct dependencies of

its direct dependencies
● All: Shows all dependency relationships that involve the selected item

Sequence Diagrams
Sequence diagrams capture the behavior of objects and the messages that are passed between them.
You can view sequence diagrams for rule functions, rules, and events.
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Create a Sequence Diagram
Open an event, rule function, or rule for editing and click the Sequence diagram ( ) button in the top
right of the editor.

The sequence diagram for the item appears in the editor area.

The diagram tab label reflects the item being graphed and the type of diagram: itemName.item-
typesequenceview. For example, Transaction.eventsequenceview.

Concept Model Diagrams
The concept model diagrams show inheritance, containment, and reference relationships between all
concepts in a project.

Concept model diagrams are created fresh each time you view them (they do not persist on disk).

Create a Concept Model Diagram
Do one of the following:

● Right-click a resource or a project in BusinessEvents Studio Explorer and select Create Concept
Model Diagram

● Open a concept editor and click the Concept Model Diagram ( ) button in the top right of the
editor

● Double-click the *.conceptview file in the Studio Explorer.

The concept model diagram for that project appears, showing only its direct dependents (Dependency
level One).

Event Model Diagrams
The event model diagrams show inheritance relationships between all types of events, except for
advisory events.

Event model diagrams are created fresh each time you view them (they do not persist on disk).
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Create an Event Model Diagram
Do one of the following:

● Right-click a resource or a project in BusinessEvents Studio Explorer and select Create Event Model
Diagram.

● Open an event editor and click the Event Model Diagram ( ) button in the top right of the
editor. The event model diagram for that project appears, showing only its direct dependents
(Dependency level One).

● Double-click the *.eventview file in the Studio Explorer.

Diagram Options and Tools Reference
Most diagram options and tools are self-explanatory, and are just shown in the images. This section
provides details for a few that require some explanation.

TIBCO BusinessEvents Diagram Tools Reference

Button Description

Interactive Tools Menu Options and Toolbar Buttons

Select
(Pointer) tool.

Pan
tool.

Magnify
 Select Magnify and hover over the diagram to display a magnified section of
the diagram.
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Button Description

Zoom
 Drag the cursor diagonally to define the area to which you want to zoom.

Interactive Zoom
 Drag the cursor up to zoom out. Drag the cursor down to zoom in.

Link Navigator
 Shows the path of a link using a simple animation.

Layout Menu Options and Toolbar Buttons

Default Layout
 Returns the diagram to the default layout. To display the layout list, click the
arrow next to the button and select a new layout from the list of options.

Circular Layout
 It is available in the layout list. See Circular Layout .

Orthogonal Layout
 It is available in the layout list. See Orthogonal Layout.

Symmetric Layout
 It is available in the layout list. See Symmetric Layout .

Hierarchical Layout (Rectilinear) 
It is available in the layout list. See Hierarchical Layout .

Hierarchical Layout (Oblique)
 It is available in the layout list. See Hierarchical Layout .

Other Diagram Menu Options and Toolbar Buttons

Print Setup
Sets options for printing the diagram or elements of the diagram. See Printing a
Diagram .

Print Preview
Lets you see how the printed diagram would look.

340

TIBCO BusinessEvents® Developer's Guide



Button Description

Print
Prints the diagram.

Export to Image
Exports the diagram to one of the five available image file formats, and lets you
save the image file locally for future reference. See Exporting a Diagram to an
Image .

Labeling
 Prevents labels from overlapping with other elements and labels in the
diagram.

Link Routing
 Redraws the diagram, attempting to redraw only the links, leaving resource
nodes in the same size and position where possible.

The behavior of link routing is affected by the preference options Fix Node Size
and Fix Node Position.

Incremental Layout
 See Incremental Layout .

Fit In Window
 Zooms the diagram to fit the size of the current diagram editor view.

Additional Toolbar Buttons

Refresh Diagram
If you make changes in the project, clicking Refresh Diagram updates the
diagram with the changes.

Zoom Percentage
 Zooms the diagram to the specified percentage.

Search Entities
Allows you to search for TIBCO BusinessEvents entities in the diagram.
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Layout Options
Layout options refer to the style of the diagram that is rendered in the diagram editor, Rule Debugger,
and Dependency panel.

Additional Layout Options

Various options affect the appearance of a diagram, no matter what layout is chosen. (The hierarchical
layout offers additional options.)

Circular Layout

This layout is useful for ontologies where nodes tend to have a clustered (ring or star) structure (where
each main node has a starburst of related nodes).

Orthogonal Layout

The orthogonal layout style uses only horizontal and vertical links. Diagrams are drawn quickly.

The algorithm places highly connected nodes closer together, resulting in a more compact diagram.
Even when lines overlap, the algorithm ensures that they are still easy to follow. Because this style has
no hierarchical or other visual constraints, the resulting diagrams are often very clear.

Symmetric Layout

The symmetric layout style looks for and emphasizes the symmetries in a project topology. It can
produce a pleasing visual result, if there are no reasons to arrange the nodes. For example, there is no
hierarchy or ring-clustering inherent in the structure of the nodes.

See Configuring Diagram Preferences and Properties for a property that affects whether symmetric or
hierarchical layout is used as the default, depending on number of edges.

Hierarchical Layout

The hierarchical layout style indicates dependencies by positioning the nodes at different levels. The
hierarchical layout style is useful when you need to show precedence relationships in the ontology.

Hierarchical layout is the default. However, see Configuring Diagram Preferences and Properties for a
property that affects whether symmetric or hierarchical layout is used as the default, depending on
number of edges.You can use Layout Preferences to determine in the direction of the hierarchy.

Preferences and options specific to the hierarchical layout are:

● Orientation Options (Edit > Preferences)—Left to Right, Top to Bottom, Right to Left, Bottom to Top
● Routing Options (View > Layout)—Orthogonal or normal (polyline) routing
● Routing Options (Edit > Preferences)—Orthogonal or polyline routing.

Incremental Layout

Choose Incremental Layout if you want the main arrangement of the diagram to remain stable when
you make changes to your project and only re-route the entities and links that have changed since the
last rendering.

Keeping most things in the same place makes it easier to see how changes you have made in the project
affect the diagram.

If you want to refresh the entire diagram, click the desired layout option. The program has greater
freedom to optimize the layout. The result is likely to be a more pleasing arrangement.

To perform an incremental layout update, do one of the following:
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● Select View > Layout > Incremental Layout

● Click the Incremental Layout button  on the toolbar

Preferences
You can set up preferences in TIBCO BusinessEvents Studio on different levels and for different
resources:

● TIBCO BusinessEvents (Top Level)

The top level preferences allow you do the following:

— Show or hide hover (tooltip) information in Catalog Functions view.
— Show or hide the confirm open perspective message pop-up.
— Switch or not switch to the default perspective every time an editor opens.
— Clear all the "do not show again" settings and show all hidden dialogs again.

● Build Path and Classpath Variables

Maintains a list of the classpath variables that have been defined. You can add, update, or remove
classpath variables.

● Code Generation

— Compilation Mode options are File System or In Memory
— Source Java Version options are 1.5 or 1.6
— Target Java Version options are 1.5 or 1.6

● Code Generation and Ignored Resources

Maintain the list of ignored resource patterns here: Code Generation > Ignored Resources. These
preferences define what file types are excluded from the EAR file shared archive section at build
time.

You can add and remove patterns, and select which existing patterns to ignore or stop ignoring.
● Compare/Merge, Decision Table

Compare/Merge preferences are used for comparing two decision tables. Decision tables are
available only when the TIBCO BusinessEvents Decision Manager addon is in use..

● Diagram Preferences

In addition to a global preferences section, there are sections for each type of diagram.
● Error/Warning Preferences

You can enable and disable error and warning messages for each type of resource in a project.
Resource extensions are shown so you can select which ones to enable or disable. By default all are
checked (enabled). If you make changes, a prompt appears asking if you want to rebuild the project.

● Printing Preferences

These preferences apply to printing of diagrams, windows, and selections.
● Rules and Rule Debug Preferences

In addition to the standard Eclipse Run/Debug preferences, TIBCO BusinessEvents requires some
rule debug preferences.

● Rules Management Server Preferences

These preferences are used with TIBCO BusinessEvents Decision Manager.
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Setting Preferences
To access preferences select Window > Preferences and expand TIBCO BusinessEvents.

Procedure

1. From the Window menu, select Preferences > TIBCO BusinessEvents.

2. Expand the options on the left and select each option to view a panel of options on the right.

Details on each set of options are provided in sections following.

3. Change the options from the list as desired, and then click Apply.

4. Click OK to see your preferred settings.

Decision Table Related Preferences

Decision Table Preferences

The Table View preferences set the initial state of the following features. Text in parentheses shows the
names of corresponding buttons in the Decision Table editor. The settings can be toggled in the UI, but
their initial state is set by preferences you set:

● Show column alias if present
● Automatically resize columns to fit content (Fit Content button)
● Automatically resize rows to fit content
● Automatically merge rows (Merge Rows button)
● Show expanded text (Show Text button)
● Show domain descriptions if present.
● Show column filter
● Show titled border
● Use existing IDs when importing
● Export column alias
● Automatically update decision tables on change in virtual rule function arguments
● Show condition area string
● The Use non-resizable editor sections option prevents or allows users from resizing editor sections.

Decision Table Analyzer Preferences

You can control the following behavior of the decision table analyzer, as well as its appearance:

● Highlight partial ranges
● Use domain model for table completeness
● Show analyzer contents while opening table.

Decision Table Appearance Preferences

These preferences let you set the color scheme for decision tables. For each item in the list, you can set
color preferences. For condition data and action data you can specify a font.

Compare/Merge Preferences

The tabbed dialog is in the TIBCO BusinessEvents preferences. It applies to decision tables.
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In the Structure Compare tab (shown above), set preferences for initial settings and colors. The effect of
your choices is shown in the lower panel.

In the Text Compare tab (shown below), you can set preferences for text. The effect of your choices is
shown in the lower panel.

The Merge tab has one option: Allow columns to be automatically merged.

Diagram Preferences

The diagram preferences apply to the following types of diagrams:

● Concept
● Dependency
● Event
● Process (This option is available only if TIBCO BusinessEvents Process Orchestration is installed.)
● Project
● Sequence
● State Model (This option is available only if TIBCO BusinessEvents Data Modeling is installed.)

Preferences set using a diagram’s palette are applicable only to the displayed diagram.

Preferences set using the Preferences dialog define the default preferences for diagrams of that type.

Preferences for specific diagrams override global preferences, where the same settings exist.

Global Diagram Preferences

Global Diagram Preferences

Option Description

Reset Tool After
Changes

If enabled, resets the tool to the Select tool after you add a node to the diagram.

Default: Enabled.

Auto Hide
Scrollbars

If enabled, then when the complete contents can display in the space available,
scrollbars are hidden.

If not enabled, scrollbars remain.

Default: Auto hide scrollbars is enabled.

Show Tooltips If enabled, you can see the tooltips when you hover the mouse on an element in
the diagram.

Default: Show Tooltips is enabled.

Link Types Shows the links as straight lines or curved lines.

Default: Straight.

Run Layout On
Changes

After adding or deleting a node or an edge, refreshes the layout of the diagram.
The layout options are None, Incremental, and Full.

Default: None.
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Option Description

Animation You can specify how a diagram behaves while it is changing from one layout
option to another. Animation options allow you to see the nodes and edges
moving from one arrangement to another. If you disable animation, the display
simply switches from one kind of layout to another.

Fade: When enabled, the diagram transitions from faded out to fully colored
state. The transition completes in the duration specified in the Layout duration
option.

Interpolation: When enabled, the nodes and edges appear to move from one
layout to another, when you select a different layout. The transition completes
in the duration specified in the Layout duration option.

Viewport Change: Enables the interpolation animation when the viewport
changes as a result of zooming. If enabled, the zoom change is reflected
gradually with animation.

By default, animation is enabled along with Fade, Interpolation and Viewport
Change.

Duration: The time taken by animation to complete.

Layout: Time, in milliseconds, for the layout change to complete. Applicable to
the interpolation and fade options.

Default for Layout: 500

Viewport Change: Time, in milliseconds, for the viewport change to complete.

Default for Viewport Change: 1000

Opaque
Movement

Interactive Zoom Sensitivity specifies the sensitivity of the mouse in interactive
zooming.

Pan Sensitivity specifies the sensitivity of the mouse in panning.

Default: Opaque Movement is enabled, Interactive Zoom Sensitivity is 200.0,
and Pan Sensitivity is 1.0.

Magnify Tool The size the zoom window, and the level of zoom.

Default: Window Size is 250, and Zoom Level is 3.

The preferences for all types of diagrams are listed in Specific Diagram Preferences (Alphabetical). The
preferences are organized alphabetically and not grouped according to the diagram types.

Specific Diagram Preferences (Alphabetical) (Sheet of )

Option Description

Cluster Layout
Style

Sets whether to show Selected Entity Project diagrams in a circular or
symmetric clustered layout.

Default: Circular.

Create view
when analyzing

If enabled, creates a Selected Entity Project diagram when you choose to run the
project analyzer.

Default: Disabled.
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Option Description

Dependency
Levels

Sets how many levels of dependencies to view in a dependency diagram - One,
two, or all.

Default: One.

Filter Options Sets whether to show various project resources in a Selected Entity Project
diagram: Show Concepts, Show Events, Show Decision Tables, Show Domain
Model, Show State Machines, Show Archives, Show Rules, Show Rule
functions, Show Scorecard, Show Channels, Show Scope Links, Show Usage
Links, Show Archived Destinations, Show Archived Rules, Show Archived
Rules (All), Show Rules in Folders, Show Tooltips, Group Concepts, Group
Events, Group Rules, and Group Rule Functions.

Default: All enabled except for Archived Rules, Group Concepts, Group Events,
Group Rules, and Group Rule Functions.

Fix node and
edge labels

Keeps the labels of the nodes and edges with their graphics.

Default: Enabled.

Grid Sets the display either to without grid, or grid with lines, or grid with points.

Default: Lines.

Layout Style Sets either the orthogonal or hierarchical layout.

Default: Orthogonal.

Layout Quality Options are Draft (lowest quality), Medium, and Proof (highest quality). It takes
longer to generate a higher quality diagram than a lower quality diagram. A
different algorithm is used in each case.

Default: Draft.

Link Routing Determines how links are routed when the hierarchical layout is used:

Orthogonal— Routes the links using horizontal and vertical straight line
segments (that is, using right angles)

Polyline—Routes the links using straight line segments with arbitrary angles

Overlapping lines are more likely with orthogonal routing than with polyline
routing. With polyline routing the routing algorithm adds path nodes as needed
to avoid overlapping lines.

Note that the line segments can be joined using straight lines or curves in both
cases.

Default: Orthogonal.

Link Routing—
Fix Node
Positions

This setting affects link routing behavior for all layout options.

If enabled, node positions do not change when you use the link routing feature.

If disabled, link routing changes node positions as needed for clarity.

Default: Disabled.
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Option Description

Link Routing—
Fix Node Sizes

This setting affects link routing behavior for all layout options except
hierarchical layouts.

If enabled, node sizes do not change when you use the link routing feature.

If disabled, link routing changes node sizes as needed for clarity.

Default: Disabled.

Orientation Defines the general direction in which the links display, to reflect hierarchical
relationships between the entities. TIBCO BusinessEvents diagrams are not
particularly hierarchical, but setting this option defines the general direction of
the layout.

Options are: Top to Bottom, Bottom to Top, Left to Right, and Right to Left.

Default: Top to Bottom.

Orthogonal Fix
Node Sizes

This setting affects link routing behavior for the hierarchical layout option only.

If enabled, node sizes do not change when you use the link routing feature.

If disabled, link routing changes node sizes as needed for clarity.

Default: Disabled.

Run analysis
when creating
view

Runs the Project Analyzer when creating a Selected Entity Project diagram.

Default: Enabled.

Run fast layout
for large
diagrams

Only for Selected Entity Project diagrams. If enabled, TIBCO BusinessEvents
filters out certain properties before generating a large Selected Entity Project
diagram to make it look simpler.

Default: Disabled.

Show all
properties in
Concept Node

If enabled, a diagram shows all properties of a concept node, instead of
showing only four default properties.

Default: Disabled.

Show all
properties in
Event Node

If enabled, a diagram shows all properties of an event node, instead of showing
only four default properties.

Default: Disabled.

Show Catalog
Functions

Sets whether to show catalog functions in a Sequence diagram.

Default: Enabled.

Show Catalog
Function Return
Links

Sets whether to show return links of catalog functions in a Sequence diagram.

Default: Disabled.

Show Expanded
Names

Sets whether to show expanded names in a Sequence diagram.

Default: Enabled.
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Option Description

Snap to grid If you move nodes in a diagram and the grid is shown, the nodes snap to the
grid lines if Snap to grid is enabled.

Default: Disabled.

Undirected
layout

Sets no orientation for the diagram.

Default: Disabled.

Tester Preferences

The Tester preferences section lets you configure the tester behavior. See Testing and Debugging
Projects.

Reference to Tester Preferences

Option Description

Output Directory The directory in which the result files are stored.

Default: /TestData/<Projectname>/<Processing Unit name>

No of WM
Objects

Maximum number of objects in working memory using a preference.

Default: 50

Auto scroll
Modified Result
Tables

If enabled, you see scroll bars for the cells in Result Test Data after clicking Fit
Content. These scroll bars move together for both the After and Before sections.

Default: Enabled

When you test a project, tester shows the values changed while running the engine and the instances
created in Result Test Data. To set the text color preferences for background and foreground of the
modified values, go to Window > Preferences > TIBCO BusinessEvents > Tester > Appearance .

Reference to Tester Appearance Preferences

Option Description

Background of
the modified
value

The background color of the changed values. Click the color box, which opens a
color palette. Select the new color from it.

Default: Light Pink

Foreground of
the modified
value

The text color of the changed values. Click the color box, which opens a color
palette. Select the new color from it.

Default: Blue

Font for the
modified value

The font in which the modified value appears. Click Change... to change the
font.

Default: Tahoma Regular 11
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